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Praise for The iPhone Developer’s
Cookbook -

“This book would be a bargain at ten times its price! If you are writing iPhone soft-
ware, it will save you weeks of development time. Erica has included dozens of crisp
and clear examples illustrating essential iPhone development techniques and many
others that show special effects going way beyond Apple’s official documentation.”

—Tim Burks, iPhone Software Developer, TootSweet Software

“Erica Sadun’s technical expertise lives up to the Addison-Wesley name. The iPhone
Developer’s Cookbook is a comprehensive walkthrough of iPhone development that will
help anyone out, from beginners to more experienced developers. Code samples and
screenshots help punctuate the numerous tips and tricks in this book.”

—TJacqui Cheng, Associate Editor, Ars Technica

“We make our living writing this stuff and yet I am humbled by Erica’s command of
her subject matter and the way she presents the material: pleasantly informal, then very
appropriately detailed technically. This is a going to be the Petzold book for iPhone
developers.”

—Daniel Pasco, Lead Developer and CEO, Black Pixel Luminance

“The iPhone Developer’s Cookbook should be the first resource for the beginning iPhone
programmer, and is the best supplemental material to Apple’s own documentation.”

—Alex C. Schaefer, Lead Programmer, ApolloIM, iPhone Application Development Specialist,
MeLLmo, Inc.

“Erica’s book is a truly great resource for Cocoa Touch developers. This book goes far

beyond the documentation on Apple’s Web site, and she includes methods that give the
developer a deeper understanding of the iPhone OS, by letting them glimpse at what’s

going on behind the scenes on this incredible mobile platform.”

—John Zorko, Sr. Software Engineer, Mobile Devices



“I've found this book to be an invaluable resource for those times when I need
to quickly grasp a new concept and walk away with a working block of code.
Erica has an impressive knowledge of the iPhone platform, is a master at
describing technical information, and provides a compendium of excellent
code examples.”

—John Muchow, 3 Sixty Software, LLC; founder, iPhoneDeveloperTips.com

“This book is the most complete guide if you want coding for the iPhone,
covering from the basics to the newest and coolest technologies. I built several
applications in the past, but I still learned a huge amount from this book. It is a
must-have for every iPhone developer.”

—Roberto Gamboni, Software Engineer, AT&T Interactive

“It’s rare that developer cookbooks can both provide good recipes and solid
discussion of fundamental techniques, but Erica Sadun's book manages to do
both very well.”

—Jeremy McNally, Developer, entp
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Preface

ew platforms match the iPhone’s unique developer technologies. The iPhone com-
Fbines OS X-based mobile computing with an innovative multitouch screen, location

awareness, an onboard accelerometer, and more. When Apple first introduced the
iPhone SDK beta in March 2008, developers responded in droves, bringing Apple’s
servers to its knees. In less than a week, developers downloaded the iPhone SDK more
than 100,000 times.

Since then, more than 50,000 applications have been delivered to the App Store for an

audience that now exceeds 30 million iPhones and more than 20 million iPod touches. As
the iPhone ecosystem continues to grow, The iPhone Developer’s Cookbook will continue to

evolve as an accessible resource for those new to iPhone programming.

What’s New in This Edition?

If you purchased the first edition of this book, you might ask yourself, Why do I need to
buy the new edition, too? The answer is pretty simple: Just compare the size of the two
books. This new edition is more than 200% larger than the original edition. That’s right,
we’ve packed on almost 500 pages of new material so we could cover everything that’s
new to the iPhone 3.0 SDK, as well as expand on some of the topics covered in the first
edition.

Some things you’ll find new to this edition include chapters or coverage on

How to use Xcode and Interface Builder
An Objective-C jump-start tutorial
Core Data for the iPhone

|

|

|

B MapKit and Core Location

B Using GameKit beyond games to add chat and Bonjour networking
B Advanced motion detection including shake-to-undo support

|

The new search display controller class, along with custom table headers and
footers

Apple’s new device capabilities specifications
In-App purchasing with StoreKit

Push notification, both from the client and server side

Searching for and playing media from the onboard iPod library
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B Video capture and editing, plus the new AV audio player and recorder classes
B How to leverage the Accessibility framework, including VoiceOver, in your app

B And much, much more!

You’ll also notice that we’ve taken your feedback to heart. When the first edition came
out, there was some confusion about who the target audience was for this book. Was it
for new developers or experienced developers? Well, we’ve taken care of that, too. While
this book is for experienced iPhone and Mac developers already familiar with
Objective-C, Xcode, and the Cocoa frameworks, this new edition includes an
“Objective-C Boot Camp” (see Chapter 3), and coverage of Xcode and Interface
Builder, to help developers who have experience working in other languages (or on
other platforms) quickly get oriented into the Mac/iPhone world.

While it is true that one book can’t be everything to everyone, we’re certainly giving
it a shot in this new edition. We hope you like the changes you see throughout this big-
ger book, and if you do, be sure to post a review on Amazon or send me a note
(erica@ericasadun.com).

Audience for This Book

This book is written for experienced developers who want to build apps for the iPhone
and iPod touch.You should already be familiar with Objective-C, the Cocoa frame-
works, and the Xcode Tools. That said, if youre new to the platform, this new edition of
The iPhone Developer’s Cookbook includes a quick-and-dirty introduction to Objective-C,
along with an intro to the Xcode Tools, to help you quickly get up to speed.

New to the Mac or iPhone?

If you have some C experience, or have spent some time with another object-oriented lan-
guage such as C++ or Java, we included a section in this Preface to help guide you down
the road to being a Mac developer. Be sure to read the section “Your Roadmap to
Mac/iPhone Development,” later in this Preface.

Although each programmer brings different goals and experiences to the table, most
iPhone developers end up solving similar tasks in their development work:

B “How do I build a table?”

B “How do I create a secure Keychain entry?”

B “How do I search the Address Book?”

B “How do I move between views?”

B “How do I use Core Location and the iPhone 3GS’s magnetometer?”

And so on. If you've asked yourself these questions, then this book is for you. Complete
with clear, fully documented examples, The iPhone Developer’s Cookbook will get you up



What You’'ll Need

to speed and working with the iPhone SDK in no time. Best of all, all of the code
recipes in the book have been tested—and put to the test in real-world applications—
offering you ready-to-use solutions for the apps you're building today.

What You’'ll Need

It goes without saying that, if you're planning to build apps for the iPhone or iPod
touch, you’re going to need at least one of those devices to test out your application. The
following list covers the basics of what you need to begin programming for the iPhone
or iPod touch:

B Apple’s iPhone SDK—The latest version of the iPhone SDK can be down-
loaded from Apple’s iPhone Dev Center (http://developer.apple.com/iphone). You
must join Apple’s (free) developer program before you download; however, if you
plan to sell apps through the App Store, you will need to become a paid iPhone
developer, which costs $99/year for individuals and $299/year for enterprise (i.e.,
corporate) developers. Registered developers receive certificates that allow them to
“sign” and download their applications to their iPhone/iPod touch for testing and
debugging.

University/Student Discounts

Apple also offers a University program for students and educators. If you are a CS student
taking classes at the university level, check with your professor to see if your school is
part of the University Program. For more information about the iPhone Developer University
Program, see http://developer.apple.com/support/iphone/university.

B An Intel-based Mac running Mac OS X Leopard or Snow Leopard—
Snow Leopard is recommended, as it offers access to Xcode 3.2 with its many new
features like “Build and Analyze.”You need plenty of disk space for development,
and your Mac should have at least 1GB RAM, preferably 2GB or 4GB to help
speed up compile time.

B An iPhone or iPod touch—Although the iPhone SDK and Xcode include a
simulator for you to test your applications in, you really do need to have an actual
iPhone and/or iPod touch if you're going to develop for the platform.You can use
the USB cable to tether your unit to the computer and install the software you’ve
built. For real-life App Store deployment, it helps to have several units on-hand,
representing the various hardware generations, so you can test on the same plat-
forms your target audience will use.

B At least one available USB 2.0 port—This enables you to tether a develop-
ment iPhone or iPod touch to your computer for file transfer and testing.

B An Internet connection—This connection enables you to test your programs
with a live Wi-Fi connection as well as with an EDGE or 3G service.

XXi
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B Familiarity with Objective-C—To program for the iPhone, you need to know
Objective-C 2.0.The language is based on ANSI C with object-oriented exten-
sions, which means you also need to know a bit of C, too. If you have pro-
grammed with Java or C++ and are familiar with C, making the move to
Objective-C is pretty easy. Chapter 3, “Objective-C Boot Camp,” helps you get up
to speed.

Note

Although the SDK supports development for the iPhone and iPod touch, as well as possible
yet-to-be-announced platforms, this book refers to the target platform as iPhone for the
sake of simplicity. When developing for the iPod touch, most of the examples in this book
are applicable; however, certain features such as telephony and onboard speakers are not
applicable to the iPod touch.

Your Roadmap to Mac/iPhone Development

As mentioned earlier, one book can’t be everything to everyone. And try as I might, if
we were to pack everything you’'d need to know into this book, you wouldn’t be able to
pick it up. There is, indeed, a lot you need to know to develop for the Mac and iPhone
platforms. If you are just starting out and don’t have any programming experience, your
first course of action should be to take a college-level course in the C programming lan-
guage. While the alphabet might start with the letter A, the root of most programming
languages, and certainly your path as a developer, is C.

Once you know C and how to work with a compiler (something you’ll learn in that
basic C course), the rest should be easy. From there, you’ll hop right on to Objective-C
and learn how to program with that alongside the Cocoa frameworks. To help you along
the way, I've put together the flowchart shown in Figure P-1 to point you at some
books of interest.

Once you know C, you've got a few options for learning how to program with
Objective-C. For a quick-and-dirty overview of Objective-C, you can turn to Chapter 3
of this book and read the Objective-C Boot Camp. However, if you want a more in-
depth view of the language, you can either read Apple’s own documentation, Object-
Oriented Programming with Objective-C 2.0," or you can opt to buy a book such as
Stephen Kochan’s Programming in Objective-C 2.0 (Addison-Wesley, 2009).

1 see http://developer.apple.com/mac/library/documentation/Cocoa/Conceptual/O0OP_0bjC/
OOP_ObjC.pdf.
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With the language behind you, next up is tackling Cocoa and the developer tools,
otherwise known as Xcode. For that, you have a few different options. Again, you can
refer to Apple’s own documentation on Cocoa and Xcode,” or if you prefer books, you
can learn from the best. Aaron Hillegass, founder of the Big Nerd Ranch in Atlanta,’ is
the author of Cocoa Programming for Mac OS X, now in its third edition. Aaron’s book is
highly regarded in Mac developer circles and is the most-recommended book you'll see
on the cocoa-dev mailing list. To learn more about Xcode, look no further than Fritz
Anderson’s Xcode 3 Unleashed from Sams Publishing. While the current edition doesn’t
cover iPhone-specific features of Xcode (which were introduced with Xcode 3.1), the
book will give you a solid grounding in how to use Xcode as your development
environment.

Note
There are plenty of other books from other publishers on the market, including the best-

selling Beginning iPhone 3 Development, by Dave Marks and Jeff LaMarche (Apress, 2009),
so don’t just limit yourself to one book or publisher.

To truly master Mac development, you need to look at a variety of sources: books, blogs,
mailing lists, Apple’s own documentation, and, best of all, conferences. If you get the
chance to attend WWDC or C4, you’ll know what I'm talking about. The time you
spend at those conferences talking with other developers and in the case of WWDC,
talking with Apple’s engineers, is well worth the expense if you are a serious developer.

How This Book Is Organized

This book offers single-task recipes for the most common issues new iPhone developers
face: laying out interface elements, responding to users, accessing local data sources, and
connecting to the Internet. Each chapter groups related tasks together, allowing you to
jump directly to the solution you're looking for without having to decide which class or
framework best matches that problem.

The iPhone Developer’s Cookbook offers you “cut-and-paste convenience,” which means
you can freely reuse the source code from recipes in this book for your own applications
and then tweak the code to suit your app’s needs.

2 gee the Cocoa Fundamentals Guide (http://developer.apple.com/mac/library/documentation/
Cocoa/Conceptual/CocoaFundamentals/CocoaFundamentals.pdf) for a head start on Cocoa, and
for Xcode, see A Tour of Xcode (http://developer.apple.com/mac/library/documentation/
DeveloperTools/Conceptual/A_Tour_of_Xcode/A_Tour_of_Xcode.pdf).

3 Big Nerd Ranch: http://www.bignerdranch.com.
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How This Book Is Organized

Here’s a rundown of what you find in this book’s chapters:

Chapter 1, “Introducing the iPhone SDK>”—Chapter 1 introduces the
iPhone SDK and explores the iPhone as a delivery platform, limitations and all. It
explains the breakdown of the standard iPhone application and helps you get start-
ed with the iPhone Developer Portal.

Chapter 2, “Building Your First Project”—Chapter 2 covers the basics for
building your first Hello World-style applications. It introduces Xcode and Interface
Builder, showing how you can use these tools in your projects. You read about basic
debugging tools, walk through using them, and pick up some tips about handy
compiler directives. You’ll also discover how to create provisioning profiles and use
them to deploy your application to your device, to beta testers, and to App Store.

Chapter 3, “Objective-C Boot Camp”—If you're new to Objective-C as well as
to the iPhone, you’ll appreciate this basic skills chapter. Objective-C is the standard
programming language for both the iPhone and for Mac OS X. It offers a powerful
object-oriented language that lets you build applications that leverage Apple’s Cocoa
and Cocoa Touch frameworks. Chapter 3 introduces the language, provides an
overview of its object-oriented features, discusses memory management skills, and
adds a common class overview to get you started with Objective-C programming.

Chapter 4, “Designing Interfaces”—Chapter 4 introduces the iPhone’s library
of visual classes. It surveys these classes and their geometry. In this chapter, you
learn how to work with these visual classes and discover how to handle tasks like
device reorientation. You'll read about solutions for laying out and customizing
interfaces and learn about hybrid solutions that rely both on Interface Builder-cre-
ated interfaces and Objective-C-centered ones.

Chapter 5, “Working with View Controllers®®—The iPhone paradigm in a
nutshell is this: small screen, big virtual worlds. In Chapter 5, you discover the vari-
ous view controller classes that enable you to enlarge and order the virtual spaces
your users interact with.You learn how to let these powerful objects perform all
the heavy lifting when navigating between iPhone application screens.

Chapter 6, “Assembling Views and Animations”—Chapter 6 introduces
iPhone views, objects that live on your screen.You see how to lay out, create, and
order your views to create backbones for your iPhone applications. You read about
view hierarchies, geometries, and animations, features that bring your iPhone
applications to life.

Chapter 7, “Working with Images’>—Chapter 7 introduces images, specifically
the UTImage class, and teaches you all the basic know-how you need for working
with iPhone images. You learn how to load, store, and modify image data in your
applications. You see how to add images to views and how to convert views into
images. And you discover how to process image data to create special effects, how
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to access images on a byte-by-byte basis, and how to take photos with your
iPhone’s built-in camera.

Chapter 8, “Gestures and Touches”—On the iPhone, the touch provides the
most important way that users communicate their intent to an application. Touches
are not limited to button presses and keyboard interaction. Chapter 8 introduces
direct manipulation interfaces, multitouch, and more.You see how to create views
that users can drag around the screen and read about distinguishing and interpret-
ing gestures.

Chapter 9, “Building and Using Controls”>—Control classes provide the basis
for many of the iPhone’s interactive elements, including buttons, text fields, sliders,
and switches. This chapter introduces controls and their use.You read about stan-
dard control interactions and how to customize these objects for your application’s
specific needs.You even learn how to build your own controls from the ground
up, as Chapter 9 creates a custom touch wheel.

Chapter 10, “Alerting Users”—The iPhone offers many ways to provide users
with a heads-up, from pop-up dialogs and progress bars to audio pings and status
bar updates. Chapter 10 shows how to build these indications into your applica-
tions and expand your user-alert vocabulary. It introduces standard ways of work-
ing with these pop-up classes and offers solutions that allow you to craft more lin-
ear programs without explicit callbacks.

Chapter 11, “Creating and Managing Table Views”—Tables provide a scroll-
ing interaction class that works particularly well on a small, cramped device. Many,
if not most, apps that ship with the iPhone and iPod touch center on tables,
including Settings, YouTube, Stocks, and Weather. Chapter 11 shows how iPhone
tables work, what kinds of tables are available to you as a developer, and how you
can use table features in your own programs.

Chapter 12, “Making Connections with GameKit and Bonjour”—
GameKit is Apple’s new ad hoc networking solution for peer-to-peer connectivity.
It’s built on a technology called Bonjour that offers simple, no-configuration com-
munications between devices. Chapter 12 introduces GameKit, allowing you to
build games and utilities that move information back and forth between iPhones
or between an iPhone and a desktop system. This chapter covers standard
GameKit, introduces GameKit Voice for walkie-talkie-style voice chats, and offers
some basic Bonjour programming that extends beyond GameKit limitations,
allowing you to expand your iPhone communications to the desktop.

Chapter 13, “Networking”—As an Internet-connected device, the iPhone is
particularly suited to subscribing to Web-based services. Apple has lavished the
platform with a solid grounding in all kinds of network computing services and
their supporting technologies. Chapter 13 surveys common techniques for net-
work computing and offering recipes that simplify day-to-day tasks.You read about
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network reachability, synchronous and asynchronous downloads, working with the
iPhone’s secure keychain to meet authentication challenges, and more.

Chapter 14, “Device Capabilities”—Each iPhone device represents a meld of
unique, shared, momentary, and persistent properties. These properties include the
device’s current physical orientation, its model name, battery state, and access to
onboard hardware. Chapter 14 looks at the device from its build configuration to
its active onboard sensors. It provides recipes that return a variety of information
items about the unit in use.You read about testing for hardware prerequisites at
runtime and specifying those prerequisites in the application’s Info.plist file. You
discover how to solicit sensor feedback and subscribe to notifications to create
callbacks when those sensor states change. This chapter covers the hardware, file
system, and sensors available on the iPhone device and helps you programmatically
take advantage of those features.

Chapter 15, “Audio, Video, and MediaKit”>—The iPhone is a media master;
its built-in iPod features expertly handle both audio and video. The iPhone SDK
exposes that functionality to developers. A rich suite of classes simplifies media
handling via playback, search, and recording. Chapter 15 introduces recipes that use
these classes, presenting media to your users and letting your users interact with
that media. You see how to build audio and video players as well as audio and
video recorders.You discover how to browse the iPod library and how to choose
what items to play.

Chapter 16, “Push Notifications>—When developers need to communicate
directly with users, push notifications provide the solution. They deliver messages
directly to the iPhone screen via a special Apple service. Push notifications let the
iPhone display an alert, play a custom sound, or update an application badge. In
this way, off-phone services connect with an iPhone-based client, letting them
know about new data or updates. Chapter 16 introduces push notifications. In this
chapter, you learn how push notifications work and dive into the details needed to
create your own push-based system.

Chapter 17, “Using Core Location and MapKit”—Core Location infuses the
iPhone with on-demand geopositioning based on a variety of technologies and
sources. MapKit adds interactive in-application mapping allowing users to view
and manipulate annotated maps. With Core Location and MapKit, you can develop
applications that help users meet up with friends, search for local resources, or pro-
vide location-based streams of personal information. Chapter 17 introduces these
location-aware frameworks and shows you how you can integrate them into your
iPhone applications.

Chapter 18, “Connecting to the Address Book—The iPhone’s Address
Book frameworks allow you to programmatically access and manage the contacts
database. Chapter 18 introduces the Address Book and demonstrates how to use its
frameworks in your applications. You read about accessing information on a con-
tact-by-contact basis, how to modify and update contact information, and how to
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use predicates to find just the contact you're interested in. This chapter also covers
the GUI classes that provide interactive solutions for picking, viewing, and modify-
ing contacts.

B Chapter 19, “A Taste of Core Data—Core Data offers managed data stores
that can be queried and updated from your application. It provides a Cocoa
Touch-based object interface that brings relational data management out from
SQL queries and into the Objective-C world of iPhone development. Chapter 19
introduces Core Data. It provides just enough recipes to give you a taste of the
technology, offering a jumping off point for further Core Data learning. You learn
how to design managed database stores, add and delete data, and query that data
from your code.

B Chapter 20, “StoreKit: In-App Purchasing”—New to the 3.0 SDK, StoreKit
offers in-app purchasing that integrates into your software. This chapter introduces
StoreKit and shows you how to use the StoreKit API to create purchasing options
for users. In this chapter, you read about getting started with StoreKit. You learn
how set up products at iTunes Connect and localize their descriptions. And you
see what it takes to create test users and how to work your way through various
development/deployment hurdles. This chapter teaches you how to solicit purchase
requests from users and how to hand over those requests to the store for payment.
This chapter covers the entire StoreKit picture, from product creation to sales.

B Chapter 21, “Accessibility and Other iPhone OS Services”—Applications
interact with standard iPhone services in a variety of ways. This chapter explores
some of these approaches. Applications can define their interfaces to the iPhone’s
VoiceOver accessibility handler, creating descriptions of their GUI elements. They
can create bundles to work with the built-in Settings applications so that users can
access applications defaults using that interface. Applications can also declare public
URL schemes allowing other iPhone applications to contact them and request
services that they themselves offer. This chapter explores application service inter-
action. It shows you how you implement these features in your applications. You
see how to build these service bridges through code, through Interface Builder,
and through supporting files.

B Appendix A, “Info.plist Keys”—This appendix gathers together many of the
keys available for the iPhone’s Info.plist file, the file that describes an application to
the iPhone operating system.

About the Sample Code

For the sake of pedagogy, this book’s sample code usually presents itself in a single
main.m file. This is not how people normally develop iPhone or Cocoa applications, or
should be developing them, but it provides a great way of presenting a single big idea. It’s
hard to tell a story when readers must look through 5 or 7 or 9 individual files at once.
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Offering a single file concentrates that story, allowing access to that idea in a single
chunk.

These samples are not intended as stand-alone applications. They are there to demon-
strate a single recipe and a single idea. One main.m file with a central presentation
reveals the implementation story in one place. Readers can study these concentrated
ideas and transfer them into normal application structures, using the standard file struc-
ture and layout. The presentation in this book does not produce code in a standard day-
to-day best practices approach. Instead, it reflects a pedagogical approach that offers con-
cise solutions that you can incorporate back into your work as needed.

Contrast that to Apple’s standard sample code, where you must comb through many
files to build up a mental model of the concepts that are on ofter. Those samples are built
as full applications, often doing tasks that are related to but not essential to what you
need to solve. Finding just those relevant portions is a lot of work. The effort may out-
weigh any gains. In this book, there are two exceptions to this one-file rule:

W First, application-creation walkthroughs use the full file structure created by Xcode
to mirror the reality of what you'd expect to build on your own. The walk-
through folders may therefore contain a dozen or more files at once.

B Second, standard class and header files are provided when the class itself is the
recipe or provides a precooked utility class. Instead of highlighting a technique,
some recipes offer these precooked class implementations and categories (that is,
extensions to a preexisting class rather than a new class). For those recipes, look for
separate .m and .h files in addition to the skeletal main.m that encapsulates the rest
of the story.

For the most part, the samples for this book use a single application identifier,
com.sadun.helloworld. You need to replace this identifier with one that matches your
provision profile. This book uses one identifier to avoid clogging up your iPhone with
dozens of samples at once. Each sample replaces the previous one, ensuring that
SpringBoard remains relatively uncluttered. If you want to install several samples at once,
simply edit the identifier, adding a unique suftix, such as com.sadun.helloworld.table-
edits.

Getting the Sample Code

The source code for this book can be found at the open source GitHub hosting site at
http://github.com/erica/iphone-3.0-cookbook-/tree. There, you find a chapter-by-
chapter collection of source code that provides working examples of the material cov-
ered in this book.

Sample code is never a fixed target. It continues to evolve as Apple updates its SDK
and the Cocoa Touch libraries. Get involved. You can pitch in by suggesting bug fixes
and corrections as well as by expanding the code that’s on offer. GitHub allows you to
fork repositories and grow them with your own tweaks and features, and share those
back to the main repository. If you come up with a new idea or approach, let us know.
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We’d be happy to include great suggestions both at the repository and in the next edi-
tion of this Cookbook.

Getting Git

You can download this Cookbook’s source code using the git version control system. A
Mac OS X implementation of git is available at http://code.google.com/p/git-osx-
installer. Mac OS X git implementations include both command line and GUI solutions,
so hunt around for the version that best suits your development needs.

Getting GitHub

GitHub (http://github.com) is the largest git hosting site, with more than 150,000 pub-
lic repositories. It provides both free hosting for public projects and paid options for pri-
vate projects. With a custom Web interface that includes wiki hosting, issue tracking, and
an emphasis on social networking of project developers, it’s a great place to find new
code or collaborate on existing libraries. You can sign up for a free account at their Web
site, allowing you to copy and modify the Cookbook repository or create your own
open source iPhone projects to share with others.

Contacting the Author

If you have any comments or questions about this book, please drop me an e-mail mes-
sage at erica@ericasadun.com, or stop by www.ericasadun.com for updates about the
book and news for iPhone developers. Please feel free to visit, download software, read
documentation, and leave your comments.


www.ericasadun.com
http://code.google.com/p/git-osx-installer
http://code.google.com/p/git-osx-installer
http://github.com
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Introducing the iPhone SDK

program. They are the first members of Apple’s new family of pocket-based

computing devices. Despite their diminutive proportions, they run a first-class
version of OS X with a rich and varied SDK that enables you to design, implement, and
realize a wide range of applications. For your projects, you can take advantage of the
iPhone’s multitouch interface and powerful onboard features using Xcode, Apple’s
integrated design environment. In this chapter, you discover the components of the SDK
and explore the product it creates: the iPhone application.You learn about Apple’s various
iPhone developer programs and how you can join.You explore the iPhone application
design philosophy and see how applications are put together. Finally, you read about setting
up your program credentials so you can put that philosophy to use and start programming.

The iPhone and iPod touch offer innovative mobile platforms that are a joy to

iPhone Developer Programs

Are you ready to start programming for the iPhone? Ready to see what all the fuss is
about? Apple’s iPhone Software Development Kit (SDK) is readily available to members
of Apple’s iPhone developer programs. There are four. These programs include the free
online program, the paid enterprise program for in-house development, the paid standard
program that allows developers to submit their products to the App Store, and a special
University program (see Table 1-1).

Table 1-1  iPhone Developer Programs

Program Cost Audience

Online Developer Free Anyone interested in exploring the iPhone SDK without
Program commitment

Standard iPhone $99/ Developers who want to distribute through App Store
Developer Year

Program
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Table 1-1  Continued

Program Cost Audience

OEnterprise $299/ Large companies building proprietary software for
iPhone Developer Year employees

Program

University iPhone Free Free program for higher education institutions that
Developer provide an iPhone development curriculum
Program

Each program offers access to the iPhone SDK, which provides ways to build and deploy
your applications. The audience for each program is specific.

Online Developer Program

The free program is meant for anyone who wants to explore the iPhone SDK program-
ming environment but who isn’t ready to pay for further privileges. The free program
limits you to Mac-only programming. While you can run your applications in the simula-
tor, you cannot deploy those applications to the device or sell them in App Store.

Although each version of the simulator moves closer to representing actual device
performance, you should not rely on it for evaluating your application. An app that runs
rock solid on the simulator may be unresponsive or even cause crashes on the actual de-
vice. The simulator does not, for example, support vibration or accelerometer readings.
These and other features present on the device are not always available in the simulator. A
discussion about simulator limits follows later in this chapter in the section “Simulator
Limitations.”

Standard Developer Program

To receive device and distribution privileges, you must pay the $99/year program fee for
the standard iPhone developer program. Once paid, you gain access to App Store distri-
bution and can test your software on actual iPhone hardware. This program adds ad hoc
distribution as well, allowing you to distribute prerelease versions of your application to
up to 100 registered devices. The standard program provides the most general solution for
the majority of iPhone programmers who want to be in App Store. If you intend to con-
duct business through selling applications, this is the program to sign up for.

Enterprise Developer Program

The $299/year Enterprise program is meant for in-house application distribution. It’s tar-
geted at companies with 500 employees or more. Enterprise memberships do not offer
access to the iPhone App Store. Instead, you can build your own proprietary applications
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and distribute them to your employees’ hardware through a private storefront. The Enter-
prise program is aimed at large companies that want to deploy custom applications to
their employees such as ordering systems.

University Developer Program

Available only to higher education institutions, the University Developer Program is a
free program aimed at encouraging universities and colleges to develop an iPhone devel-
opment curriculum. The program allows professors and instructors to create teams with
up to 200 students, offering them access to the full iPhone SDK. Students can share their
applications with each other and their teachers, and the institution itself can submit appli-
cations to App Store.

Registering

Register for the free program at the main iPhone developer site at http://developer.
apple.com/iphone.You can sign up for the paid programs, Standard or Enterprise, at
http://developer.apple.com/iphone/program.

Getting Started

Regardless of which program you sign up for, you must have access to an Intel-based Mac
running a current version of Mac OS X. It also helps to have at least one, and preferably
several, iPhone and iPod touch units to test on to ensure that your applications work
properly on each platform, including legacy units like the first generation iPhone and
iPod touch.

There are often delays associated with signing up for paid programs. After registering,
it can take weeks for account approval and invoicing. Once you actually hand over your
money, it may take another 24 to 72 hours for your access to advanced portal features to
go live.

Registering for iTunes Connect, so you can sell your application through App Store,
offers a separate hurdle. Fortunately, this is a process you can delay until after you’ve fin-
ished signing up for a paid program. With iTunes Connect, you must collect banking in-
formation and incorporation paperwork prior to setting up your App Store account.You
must also review and agree to Apple’s distribution contracts. Apple offers full details at
itunesconnect.apple.com.

Downloading the SDK

Download your copy of the iPhone SDK from the main iPhone developer site at http:
//developer.apple.com/iphone. Use your program credentials to access the download
page. So be sure you've signed up for one of the three programs before attempting to
download. The free program offers access only to fully released SDKs. The paid program
adds early looks at SDK betas letting you develop to prerelease firmware.
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The kit, which typically runs a few gigabytes in size, installs a complete suite of inter-
active design tools onto your Macintosh. This suite consists of components that form the
basis of the iPhone development environment. iPhone-specific components include the
following software:

» Xcode—Xcode is the most important tool in the iPhone development arsenal. It
provides a comprehensive project development and management environment,
complete with source editing, comprehensive documentation, and a graphical de-
bugger. Xcode is built around several open source GNU tools, namely gcc (com-
piler) and gdb (debugger).

» Interface Builder—Interface Builder (IB) provides a rapid prototyping tool for
laying out user interfaces graphically and linking to those prebuilt interfaces from
your Xcode source code. With IB, you place out your interface using visual design
tools and then connect those onscreen elements to objects and method calls in
your application.

= Simulator—The iPhone Simulator runs on the Macintosh and enables you to cre-
ate and test applications on your desktop.You can test programs without connecting
to an actual iPhone or iPod touch. The simulator offers the same API used on the
iPhone and provides a preview of how your concept designs will look. When
working with the simulator, Xcode compiles Intel x86 code that runs natively on
the Macintosh rather than AR M-based code used on the iPhone.

» Instruments—Instruments profiles how iPhone applications work under the
hood. It samples memory usage and monitors performance. This lets you identify
and target problem areas in your applications and work on their efficiency. Instru-
ments offers graphical time-based performance plots that show where your applica-
tions are using the most resources. Instruments is built around the open source
DTrace package developed by Sun Microsystems. Instruments plays a critical role in
tracking down memory leaks and making sure your applications run efficiently on
the iPhone platform.

s Shark—Shark provides performance optimization by analyzing where an applica-
tion spends most of it its time. It locates and identifies bottlenecks, enabling you to
speed your application performance.

Together, the components of this iPhone SDK suite enable you to develop your applica-
tions. From a native application developer’s point of view, the most important compo-
nents are Xcode, Interface Builder, and the simulator, with Instruments providing an
essential tuning tool. In addition to these tools, there’s an important piece not on this list.
This piece ships with the SDK but is easy to overlook. I refer to Cocoa Touch.

Cocoa Touch is the library of classes provided by Apple for rapid iPhone application
development. Cocoa Touch, which takes the form of a number of API frameworks, en-
ables you to build graphical event-driven applications using user interface elements such
as windows, text, and tables. Cocoa Touch on the iPhone is analogous to Cocoa and App-
Kit on Mac OS X and supports creating rich, reusable interfaces on the iPhone.
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Many developers are surprised by the size of iPhone applications; theyre tiny. Cocoa
Touch’s library support is the big reason for this. By letting Cocoa Touch handle all the
heavy UL lifting, your applications can focus on getting their individual tasks done.The
result is compact, focused code that does a single job at a time.

Using Cocoa Touch lets you build applications with a polished look and feel, consis-
tent with those developed by Apple. Remember that Apple must approve your software.
Apple judges applications on the basis of appearance, operation, and even content. Using
Cocoa Touch helps you better approximate the high design standards set by Apple’s native
applications.

Development Devices

A physical iPhone or iPod touch provides a key component of the software development
kit. Testing on the iPhone is vital. As simple and convenient as the SDK Simulator is, it
falls far short of the mark when it comes to a complete iPhone testing experience. Given
that the iPhone is the target platform, it’s important that your software runs its best on its
native system rather than on the simulator. The iPhone itself offers the fully leaded, un-
watered-down testing platform you need.

Apple regularly suggests that the development unit needs to be devoted exclusively to
development. Reality has proven more hit and miss on that point. When you first tether
your iPhone to your computer using a standard USB cable, Xcode detects your unit. If
you want to use your device for development, confirm that; otherwise, click Ignore.

Using a device as a development unit means that it is subject to onboard data changes
and might no longer work reliably as a field unit, but experience shows that once you're
past early betas of new SDKs that the devices seem to hold up fine for regular day-to-day
use. It’s still best to have extra units on hand devoted solely to development, but if you're
short on available units, you can probably use your main iPhone for development; just be
aware of the risks.

‘When developing, it’s important to test on as many iPhone platforms as possible. Be
aware that there are real platform differences between each model of iPhone and iPod
touch. For example, the second generation iPod has a built-in speaker; the first generation
does not. It also uses a faster processor than the first-generation iPod touch. iPhones have
cameras, which none of the current iPod touches offer. A discussion of model-specific
differences follows later in this chapter.

Simulator Limitations

Each release of the Macintosh-based iPhone Simulator continues to improve on previous
technology. That having been said, there are real limitations that you must take into ac-
count. From software compatibility to hardware, the simulator approximates but does not
equal actual device performance.

The simulator uses many Macintosh frameworks and libraries, offering features that are
not actually present on the iPhone. Applications that appear to be completely operational
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and fully debugged on the simulator may flake out or crash on the device itself. You sim-
ply cannot fully debug any program solely by using the simulator and be assured that the
software will run bug-free on the iPhone.

The simulator is also missing many hardware features.You cannot use the simulator to
test the onboard camera or accelerometer feedback. Although the simulator can read ac-
celeration data from your Macintosh using its sudden motion sensor if there’s one on-
board (usually for laptops), the readings will differ from iPhone readings and are not
practical for development or testing. The simulator does not vibrate or offer multitouch
input (at least not beyond a standard “pinch” gesture). Core location is fixed to the coor-
dinates of 1 Infinite Loop in California, that is, the Apple Headquarters building.

From a software point of view, the basic keychain security system is not available on
the simulator. You cannot register an application to receive push notification either. These
missing elements mean that there are certain kinds of programs that can only be properly
used when deployed to an iPhone.

Another difference between the simulator and the device is the audio system. The au-
dio session structure is not implemented on the simulator, hiding the complexity of mak-
ing things work properly on the device. Even in areas where the simulator does emulate
the iPhone APIs, you may find behavioral differences as the simulator is based on the Mac
OS X Cocoa frameworks.

That’s not to say that the simulator does not play an important testing role. It’s quick
and easy to try out a program on the simulator, typically much faster than transferring a
compiled application to an iPhone unit. The simulator lets you rotate your virtual device
to test reorientation, produce simulated memory warnings, and try out your UI as if your
user were receiving a phone call. It’s much easier to test out text processing on the simu-
lator because you can use your keyboard; this simplifies repeated text entry tasks such as
entering account names and passwords for applications that connect to the net.

In the end, the simulator offers compromise.You gain a lot of testing convenience but
not so much that you can bypass actual device testing.

Tethering

All interactive testing must be done using a USB cable. At this time, Apple provides no
way to transfer, debug, or monitor applications wirelessly. That means you do nearly all
your work tethered over a standard iPhone USB cable. The physical reality of tethered
debugging can be problematic. Reasons for this include the following points:

= When you unplug the cable, you unplug all the interactive debugging, console, and
screenshot features. So you need to keep that cable plugged in all the time.

= You cannot reasonably use the iPhone with a dock. Sure, the dock is stable, but
touching the screen while testing interfaces is extremely awkward when the iPhone
is seated at a 75-degree angle.

= The tether comes to the bottom, not the top of the unit, meaning it’s easy to catch
that cable and knock your iPhone to the floor.
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Obviously, untethered testing would vastly improve many of these issues. Unfortunately,
Apple has not yet introduced that option. If you like, you can Rube Goldberg-ize your
iPhone to get around these problems. One solution is to attach Velcro to the back of an
iPhone case—a case that leaves the bottom port connector open—and use that to stabi-
lize your iPhone on your desk. It’s ugly, but it keeps your iPhone from getting knocked to
the floor all the time.You can also now purchase third-party cradles for the iPhone that
help with development work. These stands hold the iPhone a few inches off the desk and
keep the cable directed toward the back.

Always try to tether your unit to a port directly on your Mac for best results. If you
must use a hub, connect to a powered system that supports USB 2.0. Most older key-
boards and displays only provide unpowered USB 1.1 connections. When testing, it helps
to choose a reliable, powered 2.0 port you can count on.

Understanding Model Differences

When it comes to application development, many iPhone apps never have to consider the
platform on which they’re being run. Most programs rely only on the display and touch
input. They can be safely deployed to all the current iPhone-family devices; they require
no special programming or concern about which platform they are running on.

There are, however, real platform differences. These differences are both significant and
notable. They play a role in deciding how you tell App Store to sell your software and
how you design the software in the first place. Should you deploy your software only to
the iPhone? To the iPhone and the second generation and later iPod touch? Or should
your application be targeted to every platform? Here are some issues to consider:

Camera

Each iPhone ships with a camera; iPod touches do not.These cameras are useful. You can
task the camera to take shots and then send them to Flickr or Twitter. You can use the
camera to grab images for direct manipulation, and so forth. The iPhone SDK provides a
built-in image picker controller that offers camera access to your users, but only on
camera-ready platforms.Video services are limited to the 3G S model and later.

‘When building camera-ready applications, know that you cannot deploy them to
iPods. Camera services are limited to the iPhone family. The first and second generation
iPhone’s built-in 2 megapixel camera will never win awards. The third generation camera
is much improved, offering autofocus, macro photography, video recording, and better
low-light sensitivity.

Speakers and Microphones

First generation iPod touches lack the built-in speaker found on the iPhone and the sec-
ond generation iPod touch. Although the 1G touch is perfectly capable of powering
third-party speakers through its bottom connector port, Apple considers those to be
unauthorized accessories and their use is rare.
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Don’t assume that end users will wear headphones when using applications. When de-
signing for the first generation iPod, carefully consider the role of audio cues. If they are
critical to the program, you may want to either recommend headphone use or consider
skipping the 1G iPod as a distribution platform.

The second generation iPod touch supports external headset microphones. The first
generation does not. If you do plan to deploy a recording application, make sure you
specify clearly that the iPod will require extra equipment to use those features.

The third generation iPhone 3G S provides a number of accessibility features includ-
ing voice control. It’s unclear at the time of writing whether voice control APIs will be
opened to iPhone developers.

Telephony

It may seem an overly obvious point to make, but the iPhone’ telephony system, which
handles both phone calls and SMS messaging, can and will interrupt applications when

the unit receives an incoming telephone call. Sure, users can quit out of apps whenever

they want on both iPhone and iPod platforms, but only the iPhone has to deal with the
kind of exit that’s forced by the system and not a choice by the user.

Consider how the difterent kinds of interruptions might aftect your application. It’s im-
portant to keep all kinds of possible exits in mind when designing software. Be aware that
the choice to leave your app may not always come from the user, especially on the iPhone.

Another fall-out of telephony operations is that more stuff ends up running in the
background on iPhones than on iPod touches. This means that as a rule, the amount of
free memory is likely to be reduced on the iPhone compared to the touch. This is one
reason that making the iPhone your primary development device over the iPod touch
may be a smart move. Working within the iPhone’s greater limitations may produce soft-
ware that operates robustly on both the iPhone and touch platforms.

Core Location Differences

Core location depends on three different approaches, each of which may or not be avail-
able on a given platform. These approaches are limited by each device’s onboard capabili-
ties. Wi-Fi location, which scans for local routers and uses their MAC addresses to search
a central position database, is freely available on all iPhone and iPod touch platforms.

Cell location, however, depends on an antenna that is available only on the iPhone.
This technology triangulates from local cell towers, whose positions are well defined from
their installations by telephone companies. The final and most accurate strategy, GPS loca-
tion, is available only to second generation iPhones and newer. GPS was not built into the
first generation iPhone and is not currently available to any iPod touch units.

The third generation iPhone 3G S introduces a built-in compass (via a magnetometer)
along with the Core Location APIs to support it.
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Vibration Support and Proximity

Vibration, which adds tactile feedback to many games, is limited to iPhones. iPod touches
do not offer vibration support. Nor do they include the proximity sensor that blanks the
screen when holding the iPhone against your ear during calls. Until SDK 3.0, using the
proximity sensor in your applications has been theoretically off limits although it was used
in a number of App Store products, most notably in the mobile Google application
(http://itunes.com/apps/googlemobileapp). Starting with version 3.0, the uIDevice class
offers direct access to the current state of the proximity sensor.

Processor Speeds

The second generation iPod touch features a 532MHz processor. The touch offered the
highest power processing in the iPhone line until supplanted by the iPhone 3G S, run-
ning at a reported 600MHz. Make sure to test your software on older, slower units as well
as on the newer ones. Application response time can and will be affected by the device on
which it’s being run.

If your application isn’t responsive enough on the older platforms, consider working
up your efficiency. There is no option in App Store at this time that lets you omit the first
generation iPhone from your distribution base.

OpenGL ES

OpenGL ES offers a royalty-free cross-platform API for 2D and 3D graphics develop-
ment. It is provided as part of the iPhone SDK. Not all iPhone models provide the same
OpenGL ES support. The iPhone 3G S and newer models support both OpenGL ES 2.0
and 1.1. Earlier models including the 2G and 3G iPhone, and the first and second genera-
tion iPod touch, run only OpenGL ES 1.1.The 2.0 API provides better shading and text
support, providing higher quality graphics.

To target all iPhones, develop your graphics using only 1.1. Applications leveraging the
2.0 API are limited to the iPhone 3G S and other future models.

Platform Limitations

When talking about mobile platforms like the iPhone, several concerns always arise,
such as storage, interaction limits, and battery life. Mobile platforms can’t offer the same
disk space their desktop counterparts do. Along with storage limits, constrained inter-
faces and energy consumption place very real restrictions on what you as a developer
can accomplish.

With the iPhone, you can’t design for a big screen, for a mouse, for a physical keyboard
(yet), or even for a physical always-on A/C power supply. Instead, platform realities must
shape and guide your development. Fortunately, Apple has done an incredible job design-
ing a new platform that somehow leverages flexibility from its set of limited storage, lim-
ited interaction controls, and limited battery life.
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Storage Limits

The iPhone hosts a powerful yet compact OS X installation. Although the entire iPhone
OS fills no more than a few hundred megabytes of space—almost nothing in today’s cul-
ture of large operating system installations—it provides an extensive framework library.
These frameworks of precompiled routines enable iPhone users to run a diverse range of
compact applications, from telephony to audio playback, from e-mail to Web browsing.
The iPhone provides just enough programming support to create flexible interfaces while
keeping system files trimmed down to fit neatly within tight storage limits.

Note
Each application is limited to a maximum size of 2GB. To the best of my knowledge, no ap-

plication has ever come close to this size, and many users complain when applications ex-
ceed about 10MB.

Data Access Limits

Every iPhone application is sandboxed. That is, it lives in a strictly regulated portion of the
file system.Your program cannot directly access other applications, certain data, and certain
folders. Among other things, these limitations minimize or prevent your interaction with
the iTunes library and the calendar.Your program can, however, access any data that is
freely available over the Internet when the iPhone is connected to a network, and, new to
3.0, you can access a shared systemwide pasteboard.

Memory Limits

On the iPhone, memory management is critical. The iPhone does not support disk-swap-
based virtual memory. When you run out of memory, the iPhone shuts down your appli-
cation—as Apple puts it, random crashes are probably not the user experience you were
hoping for. With no swap file, you must carefully manage your memory demands and be
prepared for the iPhone OS to terminate your application if it starts swallowing too much
memory at once. You must also take care concerning what resources your applications use.
Too many high-resolution images or audio files can bring your application into the au-
toterminate zone.

Apple system engineers suggest that applications need to stay within 20MB of RAM.
Here is the rough rule of thumb that circulates in developer circles. At about 20MB of
use, the iPhone begins to issue memory warnings. At around 30MB, the iPhone OS shuts
the application down.

Note

Xcode automatically optimizes your PNG images using the pngcrush utility shipped with the
SDK. (You find the program in the iPhoneOS platform folders in /Developer.) Run it from the
command line with the —iphone switch to convert standard PNG files to iPhone-formatted
ones. For this reason, use PNG images in your iPhone apps where possible as your
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preferred image format. The open source fixpng utility, which is hosted at http://www.
cyberhq.nl, goes the opposite way. It restores compressed images back to Mac-friendly
formats and is a valuable tool to have on hand for iPhone development. The venerable
Graphics Convert application (http://lemkesoft.com, $35) also offers iPhone PNG support.

Interaction Limits

Losing physical input devices and working with a tiny screen doesn’t mean you lose inter-
action flexibility. With multitouch, you can build user interfaces that defy the rules. The
iPhone’s touch technology means you can design applications complete with text input
and pointer control using a virtual screen that’s much larger than the actual physical reality
held in your palm.

A smart autocorrecting onscreen keyboard, built-in microphone (for all units except on
the iPod touch), and an accelerometer that detects orientation provide just a few of the
key technologies that separate the iPhone from the rest of the mobile computing pack.
‘What this means, however, is that you need to cut back on things such as text input and
scrolling windows.

Focus your design efforts on easy-to-tap interfaces rather than on desktop-like mim-
icry. Remember, you can use just one window at a time—unlike desktop applications that
are free to use multiwindow displays.

Note

The iPhone screen supports up to five touches at a time, although it’s rare to find any appli-
cation that uses more than two at once.

Energy Limits

For mobile platforms, you cannot ignore energy limitations. That being said, Apple’s SDK
teatures help to design your applications to limit CPU use and avoid running down the
battery. A smart use of technology (for example, properly suspending themselves between
uses) lets your applications play nicely on the iPhone and keeps your software from burn-
ing holes in users’ pockets (sometimes almost literally). Some programs, when left running,
produce such high levels of waste heat that the phone becomes hot to the touch and the
battery quickly runs down.The Camera application is one notable example.

Application Limits

Apple has instituted a strong “one-application-at-a-time” policy. That means as a third-
party developer you cannot develop applications that run in the background like Apple’s
Mail and Phone utilities. Each time your program runs, it must clean up and metaphori-
cally get out of Dodge before passing control on to the next application selected by the
user. You can’t leave a daemon running that checks for new messages or that sends out pe-
riodic updates.

11
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On the other hand, Apple does support push data from Web services as of firmware
3.0. Registered services can push badge numbers and messages to users, letting them
know that data is waiting on those servers. Chapter 16, “Push Notifications,” introduces
push notifications and shows you how to transmit these messages to users.

Note

According to the iPhone Terms of Service, you may not use Cocoa Touch’s plug-in architec-
ture for applications submitted to the App Store. You can build static libraries that are in-
cluded at compile time, but you may not use any programming solution that links to arbitrary
code at runtime.

User Behavior Limits

Although it’s not a physical device-based limitation, get used to the fact that iPhone users
approach phone-based applications sporadically. They enter a program, use it quickly, and
then leave just as quickly. The handheld nature of the device means you must design your
applications around short interaction periods and prepare for your application to be cut
off as a user receives a phone call or sticks the phone back into a pocket. Save your appli-
cation state between sessions and relaunch quickly to approximate the same task your user
was performing the last time the program was run. This can demand diligence on the part
of the programmer but is worth the time investment due to the payoff in user satisfaction.

SDK Limitations

As you might expect, building applications for the iPhone is similar to building applica-
tions for the Macintosh. Both platforms run a version of OS X.You use Objective-C 2.0
to develop your code.You compile by linking to an assortment of frameworks. In other
ways, the iPhone SDK is limited. Here are some key points to keep in mind:

= Garbage Collection is MIA and probably always will be. On the iPhone, you are re-
sponsible for retaining and releasing objects in memory. The missing Garbage Col-
lection can be explained in two ways. First, a constrained mobile platform like the
iPhone demands precise performance characteristics, especially for processor-intense
applications like games. Garbage Collection adds an unpredictable element to per-
formance; it must freeze threads when it cleans up memory. Second, limited mem-
ory does not allow garbage collection to be implemented in any sane and useful
manner. Garbage collected applications use a higher watermark for memory usage.
This subjects applications to more OS shutdowns.

= Many libraries are still only partly implemented. Core Animation is partially available
through the Quartz Core framework, but some classes and methods remain missing
in action. The lesson here is that you're working in early-release software even
though it has been quite some time since the first SDK debuted. Work around the
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missing pieces and make sure to submit your bug reports to Apple so that it (we
hope) fixes the parts that need to be used. Be aware that Apple has deliberately cut
access to some proprietary classes and methods. For example, you read EXIF orienta-
tion from images, but you cannot add that data; the method to do so is unpublished.

Note

Xcode’s compiler lets you mix C++ and Objective-C code in the same project. The resulting
Objective-C++ hybrid projects let you reuse existing C++ libraries in Objective-C applications.
Consult Apple’s documentation for details.

Using the Developer Portal

The iPhone developer program portal hosts all the tools needed to set up your system for
iPhone development. It is found at http://developer.apple.com/iphone/manage/
overview/index.action, and you will not have access to it unless you have signed up for
one of the two paid iPhone developer programs. Here is where you can set up your devel-
opment team, obtain your certificates, register development devices and application iden-
tifiers, and build your provisioning profiles so you can properly sign your applications.

Because the details are subject to change, this overview focuses on the big picture.
Should Apple alter any of the particulars, you’ll still know what the major milestones are,
so you can adjust accordingly. Figure 1-1 shows the key points of the process.

Set up a Team > Request
Certificates
Y
Register Devices Register Application Create Prqvisioning
Identifiers Profiles

Figure 1-1 Basic functions of the iPhone developer portal.

Setting Up Your Team

An iPhone development team consists of one or more members. The primary member of
the team, called the “agent,” is the original person who enrolled into the iPhone devel-
oper program. The agent has basic administrative powers over the account: He or she can
add other members to the team if this is not an individual account, approve certificate re-
quests, and so forth. In addition, the agent can grant administrative privileges to other
members, who are called, unsurprisingly, “admins.” Members without administrative privi-
leges can request new provisions and download them, but that’s pretty much the limit.
Admins can invite new members at the portal using the Team screen. This is also where
you can update e-mail, check on certificates, and add and remove members. Additional
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tabs in this screen let you check your technical support incidents and review your devel-
oper agreements with Apple.

Requesting Certificates

Certificates play a major role in iPhone development.You cannot deploy applications to
iPhones, even for testing, without a valid development certificate.You also need a distribu-
tion certificate for selling applications through the App Store.You can request and down-
load these certificates from the portal.

Start by generating a certificate request from your Macintosh’s Keychain Access utility.

1. Launch the program from the /Applications/Ultilities folder.

2. Choose Keychain Access > Certificate Assistant > Request a Certificate from a
Certificate Authority. Check your e-mail address, choose Saved to Disk, and click
Continue.

3. Select where to save the certificate (the Desktop is a good choice) and click Save.
Wait for the certificate to generate and click Done.

You then upload the request at the portal to create either your development or distribu-
tion certificate. The portal walks you through the process. Each certificate must be ap-
proved by the team agent before it is issued. Once approved, you can download it from
the Certificates window on the portal site.

Install the new certificate into your keychain by double-clicking it. Certificates are cur-
rently good for one year. Make sure you remove any expired certificates from your key-
chain as Xcode cannot readily distinguish between them.You will encounter problems
compiling until you do so. Select the expired certificate in the Macintosh Keychain Access
application (/Applications/Utilities/Keychain Access.app) and delete it.

In addition to these two certificates, you must also install the WWDR intermediate
certificate issued by Apple’s worldwide developer relations. It can be downloaded from the
portal or directly at http://developer.apple.com/ certificationauthority/ Apple WWDR CA.
cer. Make sure you add this to your keychain as well.

Should you need to develop on more than one machine at a time, you can export your
developer and distribution certificates from the Keychain Access Utility. Right-click a cer-
tificate and choose the Export option. Choose the .p12 Personal Information Exchange
option and click Save. Enter a password that you will remember and verify that password.
Click OK to continue. OS X prompts you to enter your admin password for your Macin-
tosh. Enter it and click Allow. Keychain Access generates the encrypted p12 file.You can
transfer this to another Macintosh system and double-click to install. The local keychain
will prompt you for the password.

Registering Devices

You must register all development iPhones at the program portal. You do so by providing
a device name and its unique device identifier (UDID).You can register up to 100 devices
at any time. Once registered, you may use that device for your development and ad hoc


http://developer.apple.com/certificationauthority/AppleWWDRCA.cer
http://developer.apple.com/certificationauthority/AppleWWDRCA.cer

Using the Developer Portal 15

provisions. To begin, start by viewing the Devices screen at the portal and clicking Add
Device. Enter a name, enter a UDID, and click Submit.

Finding UDID:s is not complicated:You can easily recover a device UDID from
iTunes. When docked, select the device name from the sources list (the left iTunes col-
umn) and view the Summary tab. Click the words Serial Number. This changes the dis-
play from Serial Number to Identifier (UDID). Choose Edit > Copy (Command-C) and
the UDID transfers to your system clipboard.You can then paste that number into a file.

Alternatively, have your users download a copy of Ad Hoc Helper (http://itunes.com/
apps/adhochelper) to their iPhone. It is a free utility that I created to help people e-mail
their device IDs directly to a developer. When launched, it automatically starts a new e-
mail that is populated with the user’s UDID. Users add your address as the recipient and
tap Send.

Apple offers several ways to register several devices at once. The most reliable option is
to enter several items into the Add Devices screen before clicking the Add Device button.
You can also use Apple’s iPhone Configuration Utility to manage UDIDs. It is available
for download at the portal site but has had its ups and downs in terms of stability.

Please note that Unregister does not immediately free up slots on your 100-slot devices
list. Due to some developers abusing the system there is a one-year time-out before a slot
can be reused.You can contact Apple and ask them to override this setting if there is a
valid reason that your slots need to be reused within the year.

Registering Application Identifiers

Each application you build should use an exclusive identifier. This string enables your ap-
plication to uniquely present itself to SpringBoard and guarantees that it will not conflict
with another application. Most typically, you build your identifiers using Apple’s reverse
domain notation, for example, com.sadun.myApplicationName, uk.co.sadun.myApplica-
tionName, org.sadun.myApplicationName, and so on. Avoid using any special characters
in your application identifiers.

You need not register each application at the portal, but you should register at least one
“wild-card” identifier. By this, I mean an identifier that uses an asterisk as a wild-card
matching character, for example, com.sadun.*.You can use this single identifier to create
provisions that work with all your applications, regardless of whether they are used only
during development or are destined for the App Store. A wild-card provision properly
signs all applications whose identifiers match its pattern.

The sole exception to this wild-card rule are application identifiers meant to be used
with push notifications. Chapter 16 details the difference, explaining why you must register
applications individually and how you can do so. Push-based applications aside, most devel-
opers can get by with registering a single wild-card application ID at the program portal.

For the most part, the samples for this book use a single application identifier,
com.sadun.helloworld.You need to replace this identifier with one that matches your pro-
vision profile. I mostly use just one identifier to avoid clogging up your iPhone with
dozens of samples at once. Each sample replaces the previous one, ensuring that Spring-
Board remains relatively uncluttered.
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Note
If you're wondering what those random characters that precede your registered IDs are, they

are Bundle Seed IDs and are meant to be used with applications that share keychain data.
Consult Chapter 13, “Networking,” and the Apple portal for more details about using seed IDs.

Provisioning

Provisioning profiles provide a way to associate registered developers and registered de-
vices with a specific iPhone development team. They are used in Xcode to sign your
code, authorizing the software to run on the device or to be allowed in the App Store.
Most developers use two key provisions: a wild-card development provision and a wild-
card distribution provision. In addition, most developers eventually build one or more ad
hoc provisions, which allow you to distribute your application outside the App Store to
devices you have registered at the portal.

Create your profiles at the Provisioning screen of the program portal. Choose the De-
velopment or Distribution tab, click Add Profile, check the certificate name box, and
choose your wild-card application ID. For development and ad hoc provisions, you must
select the devices that are included. Click Submit and then refresh the screen a few times.
It usually takes less than minute for the provision to be generated and made available for
download.

Should you need to add devices at a later time, you can easily do so. Expand the device
user base by editing your already-issued provisions. Choose Edit > Modify, check the new
devices, and click Submit. Re-download the updated provisioning profile by clicking
Download.

To install provisions, drag them onto the Xcode icon or (for development and ad hoc
provisions only) drop them into the Xcode Organizer window for the device. Xcode au-
tomatically reads them in and installs them into your home folder in ~/Library/Mo-
bileDevice/Provisioning Profiles. To remove a provision, use the Xcode organizer’s
Provisioning Profiles pane.

Note

If you'd rather manage your profiles from the command line, quit Xcode and delete them
from the profiles folder. The provisions do not retain their original names so be sure to
delete the correct file by using the command line grep utility (e.g. grep -i firstpush *)
or by peeking at the files in a text editor to find the right one.

Xcode automatically installs provisions onto devices to ensure that applications compiled
with those provisions can run properly. To remove a provision from a device, open
Settings > General > Profiles on the iPhone or iPod touch in question. Select a profile,
and click the red Remove button. When you remove a device provision, you won'’t be
able to run any applications signed with that provision.
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Assembling iPhone Projects

iPhone Xcode projects contain varied standard and custom components. Figure 1-2 shows
a minimal project. Project elements include source code, linked frameworks, and media
such as image and audio files. Xcode compiles your source, links it to the frameworks, and
builds an application bundle suitable for iPhone installation. It adds your media to this ap-
plication bundle, enabling your program to access that media as the application runs on
the iPhone.
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Figure 1-2  Xcode projects bring source code, frameworks, and media to-
gether to form the basis for iPhone applications.

iPhone code is normally written in Objective-C 2.0.This is an object-oriented superset
of ANSI C, which was developed from a mix of C and Smalltalk. Chapter 3,“Objective-C
Boot Camp,” introduces the language on a practical level. If you're looking for more infor-
mation about the language, Apple provides several excellent online tutorials at its iPhone
developer site. Among these are an introduction to object-oriented programming with
Objective-C and an Objective-C 2.0 reference (http://developer.apple.com/iphone/
library/documentation/Cocoa/Conceptual/Objective C/).

Frameworks are software libraries provided by Apple that supply the reusable class defi-
nitions for Cocoa Touch. Add frameworks to Xcode by dragging them onto your project’s
Frameworks folder. After including the appropriate header files (such as UIKit/UIKit.h or
QuartzCore/QuartzCore.h), you call their routines from your program.

Associated media might include audio, image, and video files to be bundled with the
package as well as text-based files that help define your application to the iPhone operat-
ing system. Drop media files into your project and reference them from your code.
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The project shown in Figure 1-2 is both simple and typical despite its fairly cluttered
appearance. It consists of five source files (main.m, MyAppDelegate.h, MyAppDelegate.m,
MyViewController.h, MyViewController.m) and two interface files (MyViewController.xib,
MainWindow.xib) along with the default iPhone project frameworks (UIKit, Foundation,
and Core Graphics) and a few supporting files (Default.png, icon.png, My-Info.plist).
Together these items form all the materials needed to create an extremely basic application.
As you discover in Chapter 2, “Building Your First Project,” Xcode can generate most
of these elements automatically for you.You can then edit them as needed to add
functionality.

Note

The My_Prefix.pch file is created automatically by Xcode. It contains precompiled header files.

The iPhone Application Skeleton

Nearly every iPhone application you build will contain a few key source files. Figure 1-3
shows the most common source code pattern: a main.m file, an application delegate, and a
view controller. These five files (more if you use Interface Builder .xibs) provide all the
components necessary to create a simple Hello World style application that displays a view
onscreen.

main() main.m
Y
Application MyAppDelegate.h
Delegate MyAppDelegate.m
Y
Vi MyView Controller.h
c Ifwll MyViewController.m
ontrotier My ViewController.xib

Figure 1-3 These files comprise the most com-
mon source code configuration for a minimal
iPhone application. You may or may not choose to
use a .xib file to define interfaces.

Some of these components may be familiar. Others may not. Here’s a rundown of the file

types:
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» The implementation files use a .m extension and not a .c extension. These .m files
contain Objective-C method implementations in addition to any C-style functions.
The project in Figure 1-3 uses three .m files.

= iPhone source files use the standard C-style .h extension for the header files. Header
files offer public declarations of class interfaces, constants, and protocols. You usually
pair each class implementation file (in this case the application delegate and view
controller .m files) with a header file, as you can see in Figure 1-3.

= XIB files (.xib) are created in Interface Builder. These XML-based user interface
definition files are linked to your application and called by your app at runtime in
their compiled .nib format. The project in Figure 1-3 uses a single .xib, which de-
fines the contents of the primary view. A standard Xcode project may add a Main-
‘Window.nib, which does little more than create a new, empty window.

Here is a quick rundown of those files, what they are and what role they play in the actual
application.

main.m

The main.m file has two jobs. First, it creates a primary autorelease pool for your applica-
tion. Second, it invokes the application event loop. These two elements provide critical el-
ements to get your application started and running. Here is what those two items are and
how they work.

int main(int argc, char *argv[])

{
NSAutoreleasePool * pool = [[NSAutoreleasePool alloc] init];
int retval = UIApplicationMain(argc, argv, nil, @"MyAppDelegate");
[pool release];
return retval;
}

Note
The argc and argv variables passed to main() refer to command-line arguments. Since
the iPhone does not use a command-line to launch its programs (all applications are run

from a common graphical user interface), these elements are not used. They are included
for consistency with standard ANSI C practices.

Autorelease Pools

Autorelease pools are objects that support the iPhone’s memory management system. This
memory system is normally based on keeping track of reference counts, that is, counting
how many objects refer to an allocated part of memory. Normally, you're responsible for
releasing those objects. That’s where the autorelease pool steps in. The pool automatically
sends a release message to all the objects it owns at the end of every event loop cycle so
you don’t have to.
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Autorelease objects are typically created with a pattern that looks like this:

[[[Someclass alloc] init] autorelease]

Once added to the autorelease pool, these objects pass their release responsibilities along
to the pool. At the end of the event loop, the pool drains and sends the releases.

The iPhone expects that there will always be an autorelease pool available so memory
can be recovered from these objects at the end of their lifetime. If you ever create a sec-
ondary thread in your application, you need to provide it with its own autorelease pool.
Autorelease pools and the objects they contain are discussed further in Chapter 3.

The UlApplicationMain Function

The urapplicationMain function provides the primary entry point for creating a new
application object. It creates the new application instance and its delegate. The delegate is
responsible for handling application status changes and providing program-specific re-
sponses to those changes.

The third and fourth arguments of the UIApplicationMain function specify the name
of the principal application class and its delegate. If the third argument is omitted (set as
nil), the iPhone defaults to using the standard uIApplication class.

UIApplicationMain also establishes the application’s event loop. An event loop repeat-
edly looks for low-level user interactions such as touches on the screen or sensor triggers.
Those events are captured by the iPhone’s kernel and dispatch an event queue, which is
forwarded to the application for handling.

Event loops let you design your program around callbacks. Callbacks are where you
specify how the application should respond to these events. In Objective-C, this corre-
sponds to method invocations. For example, you can build methods to determine how the
application should reorient itself when the user moves the screen from portrait to land-
scape or how views should update when a finger is dragged onscreen. This style of pro-
gramming is based on the underlying event loop, which is set up in main.m.

Application Delegate

An application delegate implements how your program should react at critical points in
the application life cycle. The delegate is responsible for initializing a windowing system at
launch and wrapping up business at termination. It also acts as the key player for handling
memory warnings. Here are the more important delegate methods that your applications
will implement:

» The applicationDidFinishLaunching: method—This method is the
first thing triggered in your program after the application object has been instanti-
ated. Upon launch, this is where you create a basic window, set its contents, and tell
it to become the key responder for your application.

» The applicationWillTerminate: method—This method enables you to
handle any status finalization before handing control back to SpringBoard. Use this
to save defaults, update data, and close files.
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» The applicationDidReceiveMemoryWarning method—When called,
your application must free up memory to whatever extent possible. This method
works hand in hand with the UIViewController’s didReceiveMemoryWarning:
method. If your application is unable to release enough memory, the iPhone termi-
nates it, causing your user to crash back to the SpringBoard. SpringBoard is the main
iPhone GUI that presents the application icons, allowing users to launch programs.

The application delegate also handles responsibility for when your application suspends or
resumes, such as when the user locks the screen.

After launching and loading the window, the application delegate takes a back seat.
Nearly all application semantics move over to some child of a UIvViewController class.
The application delegate typically does not take a role again until the application is about
to finish or if memory issues arise.

View Controller

In the iPhone programming paradigm, view controllers provide the heart of how an ap-
plication runs. Here is where you normally implement how the application responds to
selections, button presses, as well as sensor triggers. If you haven’t used Interface Builder to
create a precooked presentation, the view controller is where you load and lay out your
views. While the main.m and application delegate files are typically small, view controller
source code is normally extensive, defining all the ways your application accesses resources
and responds to users. Some of key methods include the following:

» The loadView and viewDidLoad methods—Assuming you aren’t using
XIB files to lay out your views, the loadview method must set up the screen and
lay out any subviews. Make sure to either call [super loadview] or, alternatively,
implement viewDidLoad, whenever you inherit from a specialized subclass such as
UITableviewController or UITabBarController.This allows the parent class to
properly set up the screen before you add your customizations to that setup. Apple’s
documentation and sample code encourage the viewDidLoad approach when basing
your code off specialized subclasses.

» The shouldAutorotateToInterfaceOrientation: method—Unless
you have pressing reasons to force your user to remain in portrait orientation, add
the should-autorotate method to allow the UIViewController method to auto-
matically match your screen to the iPhone’s orientation.You must define how the
screen elements should update.

» The viewWillAppear: and viewDidAppear: methods—These meth-
ods get called whenever a view is ready to appear onscreen or a view has fully ap-
peared onscreen. The viewwillappear: method should update information for
views that are about to display. When called, your view may not have been loaded
yet. If you rely on accessing IBOutlets connected to subviews, poke self.view to
ensure the view hierarchy gets loaded. Use viewDidAppear: to trigger behavior for
once the view is fully transitioned onscreen, such as any animations.
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The number and kind of XIB files varies with how you design your project. Figure 1-3
assumes you've created a single XIB for the view controller.You can use Interface Builder
to design additional components or skip IB entirely and create your interfaces program-
matically.

Note
Only uTview instances can directly receive touch calls; UIviewController objects cannot.

See Chapter 8, “Gestures and Touches,” to learn more about directly managing and inter-
preting touches and gestures in your application.

A Note About the Sample Code in This Book

For the sake of pedagogy, this book’s sample code usually presents itself in a single main.m
file. It’s hard to tell a story when readers must look through five or seven or nine individ-
ual files at once. Offering a single file concentrates that story.

These samples are not intended as stand-alone applications. They are there to demon-
strate a single recipe and a single idea. One main.m file with a central presentation reveals
the implementation story in one place. Readers can study these concentrated ideas and
transfer them into normal application structures, using the standard file system and layout.

There are two exceptions to this one-file rule. First, application-creation walk-throughs
use the full file structure created by Xcode to mirror the reality of what youd expect to
build on your own. The walk-through folders may therefore contain a dozen or more files
at once.

Second, standard implementation and header files are provided when the class itself is
the recipe or provides a precooked utility class. Instead of highlighting a technique, some
recipes offer these precooked class implementations and categories (that is, extensions to a
preexisting class rather than a new class). For those recipes, look for separate .m and .h files
in addition to the skeletal main.m that encapsulates the rest of the story.

iPhone Application Components

Compiled iPhone applications live in application bundles. Like their Macintosh cousins,
these application bundles are just folders named with a .app extension.Your program’s
contents and resources reside in this folder, including the compiled executable, supporting
media (such as images and audio), and a few special files that describe the application to
the OS.The folder is treated by the operating system as a single bundle.

Application Folder Hierarchy

iPhone bundles are simple. Unlike the Mac, iPhone bundles do not use Contents and Re-
sources folders to store data or a MacOS folder for the executable. All materials appear at
the top level of the folder. For example, instead of putting a language support (Iproj)
folder into Contents/Resources/, Xcode places it directly into the top .app folder.You can
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still use subfolders to organize your project, but these developer-defined folders do not
follow any standard.

The iPhone SDK’s core OS support includes the NsBundle class. This class offers access
to the files stored in the application bundle. NSBundle makes it easy to locate your
application’s root folder and to navigate down to your custom subfolders to point to and
load built-in resources like sounds, images, and data files.

Note

As on a Macintosh, user domains mirror system ones. Official Apple-distributed applications
reside in the primary /Applications folder. Third-party applications live in /var/mobile/
Applications. The underlying UNIX file system is obscured by the iPhone’s sandbox, which is
discussed later in this section.

The Executable

The executable application file of your application resides at the top-level folder of the ap-
plication bundle. It carries executable permissions so it can run and is signed as part of the
application bundle during the compilation process.You may only load and run applica-
tions that have been signed with an official developer certificate. Those certificates are is-
sued by Apple via the iPhone developer program portal at the official developer Web site.

Apple offers several kinds of signing profiles called mobile provisions that vary by how
the application will be deployed.You need separate provisions for applications that will be
tested during development on a local device, for applications that will be sent out to regis-
tered devices for testing, and for those that will be distributed through App Store.You've
already read about creating your provisions earlier in this chapter. The actual application
signing process is discussed in further detail in Chapter 2.

The Info.plist File

As on a Macintosh, the iPhone application folder contains that all-important Info.plist file.
Info.plist files are XML property lists that describe an application to the operating system.
Property lists store key-value pairs for many different purposes and can be saved in read-
able text-based or compressed binary formats. In an Info.plist file, you specify where the
application’s executable (CFBundleExecutable, “Executable file”) can be found, the text
that appears under the application icon (CFBundleDisplayName, ‘‘Bundle display name”),
and the application’s unique identifier (CFBundleIdentifier, “Bundle identifier).

Be careful when setting the display name. Titles that are too long to display properly
are truncated; the iPhone adds ellipses as needed. So your application named “My Very
First iPhone App” may display as “My Very E...” This provides less information to your
end user than a simpler title like “First App” would offer.

The application identifier typically uses Apple’s reverse domain naming format (for ex-
ample, com.sadun.appname). The identifier plays a critical role for proper behavior and
execution; it must not duplicate any other identifier on App Store. In use, the product
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identifier registers your application with SpringBoard, the “Finder” of the iPhone. Spring-
Board runs the home screen from which you launch your applications. The product iden-
tifier also forms the basis for the built-in preferences system called the user defaults.

The identifier is case sensitive and must be consistent with the provisions you generate
at the developer portal. Problems with misnamed bundle identifiers have cost developers
many hours of wasted time. Specify the identifier by editing your project’s settings in
Xcode (see Figure 1-4).

8,00 Target “BasicApp” Info

[ General  Build  Rules | Properties | Comments |

Executable: ${EXECUTABLE_NAME}

Identifier: com.yourcompany.5{PRODUCT NAME:rfc1034didentifier}

Type: APPL Creator: | 7777

Icon File:

Version: | 1.0

Principal Class:

Main Nib File: | MainWindow

Figure 1-4  Customize your application’s bundle identifier by editing target
properties. Edits here are reflected in your application’s Info.plist file. The
PRODUCT_NAME identifier is specified in your project’s settings.

Note

To change identifiers, open the Targets list in the Xcode project’s left-hand column. Double-
click Targets > Your Application Name. This opens the Target Info window. Click on the Prop-
erties tab and edit the Identifier from com.yourcompany to a reverse domain name that
represents your actual company. Enter your personal domain and let Xcode append the appli-
cation product name.

Application preferences are automatically stored in the application sandbox. The sandbox
mimics the domains and folders normally found on the core OS. On the iPhone, prefer-
ences appear in a local Library folder and use the application identifier for naming. This
identifier is appended with the .plist extension (for example, com.sadun.appname.plist),
and the preferences are stored using a binary .plist format.You can read a binary .plist by
transferring it to a Macintosh via Xcode’s organizer.

Note

To copy application data from the iPhone to your Macintosh, open the Organizer window
(Windows > Organizer). Select your device and then an item from the applications list. Click
the arrow next to the name to reveal the Application Data bundle and then drag that bundle
to the desktop. It expands to a standard folder named with the application identifier and the
date and time the data was retrieved.
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You can edit property list files directly in Xcode or use the Property List Editor that ships
as part of Xcode’ utilities. It’s located in /Developer/Applications/Utilities and offers a
user-friendly GUI. Use Apple’s plutil utility to convert property lists from binary to a text-
based XML format: plutil —convert xmll plistfile.Apple uses binary plists to lower
storage requirements and increase system performance.

As with the Macintosh, Info.plist files offer further flexibility and are highly customiz-
able. With them, you can set application-specific variables (UIRequiresPersistentWiFi)
or specify how your icon should display (UIPrerenderedIcon).These variables are pow-
erful. They can define multiple roles for a single application although this functionality is
not available to third-party development. For example, the Photos and Camera utilities are
actually the same application, MobileSlideShow;, playing separate “roles.” Appendix A,
“Info.plist Keys,” lists these keys in detail.

Other standard Info.plist keys include uIStatusBarsStyle for setting the look and
color of the status bar and uIStatusBarHidden for hiding it altogether.
UIInterfaceOrientation lets you override the accelerometer to create a landscape-only
(UIInterfaceOrientationLandscapeRight) presentation. Register your custom applica-
tion URL schemes (for example, myCustomApp://) by setting CFBund1eURLTypes. See
Chapter 21, “Accessibility and Other iPhone OS Services,” for more information about
URL schemes.

The Icon and Default Images

The icon.png image and Default.png are two key image files. Icon.png acts as your appli-
cation’s icon, the image used to represent the application on the SpringBoard home
screen. Default.png (also known as your “launch image”) provides the splash screen dis-
played during application launch.

Unlike Default.png, the icon filename is arbitrary. If you'd rather not use “icon.png,”
set the CFBundleIconFile key in your Info.plist file to whatever filename you want to use
but be aware that this might cause trouble when submitting your application to App
Store; iTunes Connects requires the application to use icon.png (or Icon.png) even if the
Info.plist specifies another name. This key is not set by default, so be sure to add a value
regardless of the art you use.

Apple recommends matching Default.png to your application’s background. Many de-
velopers use Default.png to launch images for a logo splash or for a “Please wait” message.
These go against Apple’s human interface guidelines (launch images should provide visual
continuity, not advertising or excuses for delays) but are perfectly understandable uses.
Xcode lets you take screenshots of your application in action using its Organizer window
(Window > Organizer). It also offers the option to set one of those shots as your
Default.png image.

The official application icon size is 57-by-57 pixels. SpringBoard automatically scales
larger art. Provide flat (not glossy) art with squared corners. SpringBoard smoothes and
rounds those corners and adds an automatic gloss and shine eftect. If for some compelling
reason you need to use prerendered art, set UIPrerenderedIcon to <true/> in your

Info.plist file.
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As with all on/off Info.plist items, make sure to set the value for UIPrerenderedIcon
to the Boolean value true (<true/>, the checked box in the Xcode GUI). Using a string
for “true” (<string>true</string>) may work on the simulator while producing no ef-
fect on the iPhone. Also remember that the 3.0 Xcode property list editor hides the actual
key name. Add a field for the “Icon already includes gloss and bevel effects” key and check
the box that appears in the value column.

When submitting your application to App Store, you need to create a high-resolution
(512-by-512 pixel) version of your icon. Although you can up sample your 57-by-57
icon.png art, it won't look good. Going the other way allows you to maintain high-quality
art that you can compress to your icon as needed. Keep your art simple and compressible.
An icon that looks stunning at 512x512 looks muddled and sloppy at 57x57 when overly
detailed.

Note
You may include a 29-by-29 pixel image called Icon-settings.png in your project. This image

represents your application in the Settings application. Most developers skip this option. If
not included, Settings simply scales your icon.png image.

NIB Files

Interface Builder creates .xib files that store precooked addressable user interface layouts in
XML format. (If you’re curious, you can open these files in your favorite text editor and
peek at the XML.) Most IB-based applications contain several .xib files that define various
view components. Typical .xib contents might include window layouts, custom table cells,
pop-up dialogs, and more.

When creating your application bundles, Xcode compiles the XML data into a NIB
package, which is placed alongside the executable and any other application components.
(NIB, somewhat archaically, stands for NeXT Interface Builder, which is the ancestor of
the OS X Interface Builder used to build iPhone applications.) The .nib files appear at the
top level of your application bundle and are used directly from your program when load-
ing screens.

Note

When you develop programs that do not use XIB Interface-Builder bundles, remove the
NSMainNibFile key from Info.plist and discard the automatically generated MainWindow.xib
file from your project. This reduces clutter in your program and keeps your application from
trying to load an interface file that you never fully defined. Set the fourth argument of
UIApplicationMain() inmain() to the class name of your application delegate.

Files Not Found in the Application Bundle

As with the Macintosh, things you do not find inside the application bundle include pref-
erences files (generally stored in the application sandbox in Library/Preferences), applica-
tion plug-ins (stored in /System/Library at this time and not available for general
development), and documents (stored in the sandbox in Documents).



iPhone Application Components

At this time, the iPhone SDK does not let you prepopulate these folders. Since your
program cannot edit or overwrite any files in the application bundle, copy any files that
need to be changed, such as database files, to another folder (Documents or Library) on
the first run of your program.

Another thing that seems to be missing (at least from the Macintosh programmer point
of view) is Application Support folders.You should copy your support data, which more
rightfully would be placed into an Application Support structure, to your Documents or
Library folders from the application bundle when your application is first launched.
Thereafter, check to make sure that data is there and recopy the data if needed.

IPA Archives

When users purchase your application they download a .ipa file from iTunes. This file is
actually a zipped archive. It contains a compressed payload, namely the app bundle you
built from the components just described. iTunes stores .ipa archives in the Mobile Appli-
cations folder in the iTunes Library. If you rename a copy of any .ipa file to use the .zip
extension, you can easily open it using standard compression software.

Each application is customized on download to ensure that it can only be installed and
run on the iPhone devices authorized by your iTunes account. This prevents the applica-
tion from being shared freely over the Internet. Although software pirates have created
cracking tools, these are not widely used in the wild. Apple’s basic protections ensure that
for the most part only those who have purchased and downloaded the application from
iTunes can run your software.

Sandboxes

The iPhone OS restricts all SDK development to application “sandboxes” for the sake of
security. The iPhone sandbox limits your application’s access to the file system to a mini-
mal set of folders, network resources, and hardware. In some ways, it’s like attending a re-
strictive school with a paranoid principal:

= Your application can play in its own sandbox, but it can’t visit anyone else’s sandbox.

= You cannot share toys.You cannot share data (except via the user-controlled system
pasteboard).You cannot mess in the administrative offices. Your files must stay in the
folders provided to you by the sandbox, and you cannot copy files to or from other
application folders.

= You cannot peck over the fence. Reading from or attempting to write to files out-
side your sandbox is grounds for App Store rejection.Your application is prevented
from writing to most folders outside the sandbox by the iPhone OS.

» Your application owns its own Library, Documents, and /tmp folders. These mimic
the standard folders you'd use on a less-restrictive platform but specifically limit
your capability to write and access this data.

In addition to these limitations, your application must be signed digitally and must au-
thenticate itself to the operating system with a coded application identifier, which you
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must create at Apple’s developer program site. Details on how to do this follow in
Chapter 2.

On the bright side, sandboxing ensures that all program data gets synced whenever
your device is plugged into its home computer. On the downside, at this time Apple has
not clarified how that synced data can be accessed from a Windows- or Macintosh-based
desktop application.

Note

Sandbox specification files (using the .sb extension) are stored in /var/mobile/Applications
along with each actual sandbox folder. These files control privileges such as read-and-write
access to various bits of the file system. As a developer, you will not be able to see or ma-
nipulate these files, but they are there, controlling the ways your app may or may not interact
with the operating system.

Programming Paradigms

iPhone programming centers on two important paradigms: objected-oriented program-
ming and the Model-View-Controller (MVC) design pattern. The iPhone SDK is de-
signed around supporting these concepts in the programs you build. To do this, it has
introduced delegation (controller) and data source methods (model) and customized view
classes (view). Here is a quick rundown of some important iPhone/Cocoa Touch design
vocabulary used through this book.

Object-Oriented Programming

Objective-C is heavily based on Smalltalk, one of the most historically important object-
oriented languages. Object-oriented programming uses the concepts of encapsulation and
inheritance to build reusable classes with published external interfaces and private internal
implementation. You build your applications out of concrete classes that can be stacked to-
gether like LEGO toys, because it’s always made clear which pieces fit together through
class declarations.

Pseudo-multiple inheritance (via invocation forwarding and protocols) provides an im-
portant feature of Objective-C’s approach to object-oriented programming. iPhone classes
can inherit behaviors and data types from more than one parent. Take the class
UITextView, for example. It’s both text and a view. Like other view classes, it can appear
onscreen. It has set boundaries and a given opacity. At the same time, it inherits text-spe-
cific behavior.You can easily change its display font, color, or text size. Objective-C and
Cocoa Touch combine these behaviors into a single easy-to-use class.

Model-View-Controller

MVC separates the way an onscreen object looks from the way it behaves. An onscreen
button (the view) has no intrinsic meaning. It’s just a button that users can push.That
view’s controller acts as an intermediary. It connects user interactions such as button taps
to targeted methods in your application, which is the model. The application supplies and
stores meaningful data and responds to interactions such as these button taps by producing
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some sort of useful result. MVC is best described in the seminal 1988 paper by Glenn
Krasner and Stephen Pope, which is readily available online.

Each MVC element works separately. You might swap out a pushbutton with, for ex-
ample, a toggle switch without changing your model or controller. The program continues
to work as before, but the GUI now has a difterent look. Alternatively, you might leave the
interface as is and change your application where a button triggers a different kind of re-
sponse in your model. Separating these elements enables you to build maintainable pro-
gram components that can be updated independently.

The MVC paradigm on the iPhone breaks down into the following categories:

» Model—Model methods supply data through protocols such as data sourcing and
meaning by implementing callback methods triggered by the controller.

» View—View components are provided by children of the uIview class and assisted
by its associated (and somewhat misnamed) UIViewController class.

» Controller—The controller behavior is implemented through three key technolo-
gies: delegation, target action, and notification.

Together, these three elements form the backbone of the MVC programming paradigm.
Let’s look at each of these elements of the iPhone MVC design pattern in a bit more
detail. The following sections introduce each element and its supporting classes.

View Classes

The iPhone builds its views based on two important classes: UIview and
UIViewController.These two classes and their descendants are responsible for defining
and placing all onscreen elements.

As views draw things on your screen, UIView represents the most abstract view class.
Nearly all user interface classes descend from UIView and its parent UIResponder.Views
provide all the visual application elements that make up your application. Important
UIView classes include UITextView, UIImageViews, UIAlertView, and so forth.The
UIWindow class, a kind of UIView, provides a viewport into your application and provides
the root for your display.

Because of their onscreen nature, all views establish a frame of some sort. This frame is
an onscreen rectangle that defines the space each view occupies. The rectangle is estab-
lished by the view’s origin and extent.

Views are arranged hierarchically and are built with trees of subviews.You can display a
view by adding it to your main window or to another view by using the addsubview
method to assign a child to a parent.You can think about views as attaching bits of trans-
parent film to a screen, each piece of which has some kind of drawing on it.Views added
last are the ones you see right away.Views added earlier may be obscured by other views
sitting on top of them.

Despite the name, the UIviewController class does not act as controllers in the MVC
sense. They more often act as view handlers and models than as controllers. Although
some will disagree, Apple terminology does not always match the MVC paradigm taught
in computer science classes.
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View controllers are there to make your life easier. They take responsibility for rotating
the display when a user reorients his or her iPhone. They resize views to fit within the
boundaries when using a navigation bar or a toolbar. They handle all the interface’s fussy
bits and hide the complexity involved in directly managing interaction elements.You can
design and build iPhone applications without ever using a UIViewController or one of
its subclasses, but why bother? The class offers so much convenience it’s hardly worth
writing an application without them.

In addition to the base controller’s orientation and view resizing support, two special
controllers, the UINavigationController and UITabBarController, nlagically handle
view shifting for you.The navigation version enables you to drill down between views,
smoothly sliding your display between one view and the next. Navigation controllers re-
member which views came first and provide a full breadcrumb trail of “back” buttons to
return to previous views without any additional programming.

The tabbed view controller lets you easily switch between view controller instances us-
ing a tabbed display. So if your application has a top ten list, a game play window, and a
help sheet, you can add a three-buttoned tab bar that instantly switches between these
views without any additional programming to speak of.

Every urviewController subclass implements a method to load a view, whether
through implementing a procedural loadview method or by pulling in an already-built
interface from a .xib file and calling viewDidLoad. This is the method that lays out the
controller’s main view. It may also set up triggers, callbacks, and delegates if these have not
already been set up in Interface Builder.

So in that sense alone, the UIViewController does act as a controller by providing
these links between the way things look and how interactions are interpreted. And, be-
cause you almost always send the callbacks to the UIvViewController itself, it often acts as
your model in addition to its primary role as a controller for whatever views you create
and want to display. It’s not especially MVC, but it is convenient and easy to program.

Controller

When Apple designs interactive elements such as sliders and tables, they have no idea how
you’ll use them.The classes are deliberately general. With MVC, there’s no programmatic
meaning associated with row selection or button presses. It’s up to you as a developer to
provide the model that adds meaning. The iPhone provides several ways in which prebuilt
Cocoa Touch classes can talk to your custom ones. Here are the three most important: del-
egation, target-action, and notifications.

Delegation
Many UIKit classes use delegation to hand oft responsibility for responding to user inter-
actions. When you set an object’s delegate, you tell it to pass along any interaction mes-
sages and let that delegate take responsibility for them.

A UITableView is a good example of this. When a user taps on a table row, the
UITableview has no built-in way of responding to that tap. The class is general purpose
and it has no semantics associated with a tap. Instead, it consults its delegate—usually a
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view controller class or your main application delegate—and passes along the selection
change through a delegate method. This enables you to add meaning to the tap at a point
of time completely separate from when the table class was first implemented. Delegation
lets classes be created without that meaning while ensuring that application-specific han-
dlers can be added at a later time.

The UITableview delegate method tableview: didSelectRowAtIndexPath: isa
typical example.Your model takes control of this method and implements how it should
react to the row change.You might display a menu or navigate to a subview or place a
check mark next to the current selection. The response depends entirely on how you im-
plement the delegated selection change method.

To set an object’s delegate, assign its delegate property (this is preferred) or use some
variation on the setDelegate: method. This instructs your application to redirect interac-
tion callbacks to the delegate.You let Xcode know that your object implements delegate
calls by adding a mention of the delegate protocol it implements in the class declaration.
This appears in angle brackets, to the right of the class inheritance. Listing 1-1 shows a
kind of uIviewController that implements delegate methods for UITableView views.
The MergedTableController class is, therefore, responsible for implementing all required
table delegate methods.

Xcode’s documentation exhaustively lists all standard delegate methods, both required
and optional. Open Help > Documentation (Command-Option-Shift-?) and search for
the delegate name, such as UITablevViewControllerDelegate. The documentation pro-
vides a list of instance methods that your delegate method can or must implement.

Delegation isn’t limited to Apple’s classes. It’s simple to add your own protocol declara-
tions to your classes and use them to define callback vocabularies. Listing 1-1 creates the
FTPHostDelegate protocol, which declares the ftpHost instance variable. When used, that
object must implement all three (required) methods declared in the protocol. Protocols are
an exciting and powerful part of Objective-C programming, letting you create client
classes that are guaranteed to support all the functionality required by the primary class.

Note

If your application is built around a central table view, use UITableViewController in-
stances to simplify table creation and use.

Listing 1-1 Defining and Adding Delegate Protocol Declarations to a Class Definition

@protocol FTPHostDelegate <NSObject>

- (void) percentDone: (NSString *) percent;
- (void) downloadDone: (id) sender;

- (void) uploadDone: (id) sender;

@end

@interface MergedTableController : UIViewController
<UITableViewDelegate,UITableViewDataSource>

UIView *contentView;
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Listing 1-1  Continued

UITableView *subView;
UIButton *button;
id <FTPHostDelegate> *ftpHost;
SEL finishedAction;
}
@end
Target-Action

Target-actions are a lower-level way of redirecting user interactions.You encounter these
almost exclusively for children of the UIControl class. With target-action, you tell the
control to contact a given object when a specific user event takes place. For example,
you’'d specify which object to contact when users press a button.

Here is a typical example. This snippet defines a UIBarButtonltem instance, a typical
buttonlike control used in iPhone toolbars. It sets the item’s target to self and the action to
@selector(trackNotifications:). When tapped, it triggers a call to the defining object send-
ing the setHelvetica: message:

UIBarButtonItem *helvItem = [[[UIBarButtonItem alloc]
initwithTitle:@"Helvetica" style:UIBarButtonItemStyleBordered
target:self action:@selector(setHelvetica:)] autorelease];

As you can see, the name of the method (setHelvetica:) is completely arbitrary. Target-
actions do not rely on an established method vocabulary the way delegates do. In use,
however, they work exactly the same way. The user does something, in this case presses a
button, and the target implements the selector to provide a meaningful response.

Whichever object defines this UIBarButtonItem instance must implement a
setHelvetica: method. If it does not, the program crashes at runtime with an undefined
method call error. Unlike delegates and their required protocols, there’s no guarantee that
setHelvetica: has been implemented at compile time. It’s up to the programmer to
make sure that the callback refers to an existing method.

Standard target-action pairs always pass either zero, one, or two arguments. These argu-
ments are the interaction object and a UIEvent object that represents the user’s input.Your se-
lector can choose to pass any or all of these. In this case, the selector uses one argument, the
UIBarButtonItem instance that was pressed. This self-reference, where the triggered object is
included with the call, enables you to build more general action code. Instead of building sep-
arate methods for setHelvetica:, setGeneva:, and setCourier:, you could create a single
setFontFace: method to update a font based on which button the user pressed.

Note

To build target-action into your own UIControl-style classes, add a target variable of type
id (any object class) and an action variable of type SEL (method selector). At runtime, use
performSelector: withObject: to send the method selector to the object. To use selec-
tors without parameters, for example, @selector(action), pass nil as the object.
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Notifications

In addition to delegates and target-actions, the iPhone uses yet another way to communi-
cate about user interactions between your model and your view—and about other events,
for that matter. Notifications enable objects in your application to talk among themselves,
as well as to talk to other applications on your system. By broadcasting information, notifi-
cations enable objects to send state messages: “I've changed,” “I've started doing some-
thing,” or “I've finished.”

Other objects might be listening to these broadcasts, or they might not. For your ob-
jects to “hear” a notification, they must register with a notification center and start listen-
ing for messages. The iPhone implements many kinds of notification centers. For App
Store development, only NsNotificationCenter is of general use.

The NSNotificationCenter class is the gold standard for in-application notification.
You can subscribe to any or all notifications with this kind of notification center and listen
as your objects talk to each other. The notifications are fully implemented and can carry
data as well as the notification name. This name + data implementation offers great flexi-
bility, and you can use this center to perform complex messaging.

It’s easy to subscribe to a notification center. Register your application delegate or,
more typically, your UIViewController as an observer.You supply an arbitrary selector to
be called when a notification arrives, in this case trackNotifications:.The method
takes one argument, an NSNotification. Ensure that your callback method hears all ap-
plication notifications by setting the name and object arguments to nil.

[[NSNotificationCenter defaultCenter] addObserver:self
selector:@selector(trackNotifications:) name:nil object:nil];

All notifications contain three data elements: the notification name, an associated object,
and a user information dictionary. If youre unsure what notifications UIKit objects in
your application produce, have your callback print out the name from all the notifications
it receives—for example, NSLog(@"% @", [notification name]).

The kinds of notification vary by the task you are performing. For example, notifications
when rotating an application include UIApplicationWillChangeStatusBarOrientation
Notification and UIDeviceOrientationDidChangeNotification.

Make sure you implement the trackNotifications: method (or another callback
method whose selector you supplied), which gets called in this case for all program notifi-
cations, regardless of name or object. Setting these to nil when listening acts as a wild card.

(void) trackNotifications: (NSNotification *) theNotification
{
CFShow([theNotification name]);
CFShow([theNotification object]);
CFShow ([ [theNotification userInfo] description]);
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Note

The recipes in this book use printf and CFShow as well as NSLog. Each debug feedback
method has its advantages and disadvantages. The former have the advantage of not print-
ing out the date and time, which results in cleaner output. How you choose to log informa-
tion is strictly a matter of taste. There are no wrong or right ways to put print statements
into your program. See Chapter 3 for more details about logging information.

Model
You're responsible for building all application semantics—the model portion of any MVC
app.You create the callback methods triggered by your application’s controller and provide
the required implementation of any delegate protocol. For relatively simple programs,
model details often are added to a UIViewController subclass. With more complex code,
avoid shoehorning that implementation into a UIViewController. Custom-built classes
can better help implement semantic details needed to support an application’s model.
There’s one place that the iPhone SDK gives you a hand with meaning, and that’s with
data sources. Data sources enable you to fill UIKit objects with custom content.

Data Sources

A data source refers to any object that supplies another object with on-demand data.
Some UI objects are containers without any native content. When you set another object
as its data source, by assigning its dataSource property (preferred) or via a call like
[uiobject setDataSource:applicationobject],you enable the Ul object (the view)
to query the data source (the model) for data such as table cells for a given UITableview.
Usually the data source pulls its data in from a file such as a local database, from a Web
service such as an XML feed, or from other scanned sources. UITableView and
UIPickerView are two of the few Cocoa Touch classes that support or require data
sources.

Data sources are like delegates in that you must implement their methods in another
object, typically the uITableViewController that owns the table. They differ in that they
create/supply objects rather than react to user interactions.

Listing 1-2 shows a typical data source method that returns a table cell for a given row.
Like other data source methods, it enables you to separate implementation semantics that
fill a given view from the Apple-supplied functionality that builds the view container.

Objects that implement data source protocols must declare themselves just as they
would with delegate protocols. Listing 1-1 showed a class declaration that supports both
delegate and data source protocols for UITableviews. Apple thoroughly documents data
source protocols.You find this documentation in Xcode’s Documentation window (Help
> Documentation).

Listing 1-2 Data Source Methods Fill Views with Meaningful Content

// Return a cell for the ith row, labeled with its number
- (UITablevViewCell *)tableView: (UITableView *)tableView
cellForRowAtIndexPath: (NSIndexPath *)indexPath
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Listing 1-2  Continued

UITableViewCell *cell = [tableView
dequeueReusableCellWithIdentifier:@"any-cell"];

if (!cell) {
cell = [[[UITableViewCell alloc] initWithFrame:CGRectZero

reuseldentifier:@"any-cell"] autorelease];

}

// Set up the cell

cell.text = [tableTitles objectAtIndex:[indexPath row]];

return cell;

The UIApplication Object
In theory, you'd imagine that the iPhone “model” component would center on the
UIApplication class. In practice, it does not, at least not in any MVC sense of the word
model. In the world of the Apple SDK, each program contains precisely one
UIApplication instance, which you can refer to via [UIApplication sharedInstance].
For the most part, unless you need to open a URL in Safari, recover the key window,
or adjust the look of the status bar, you can completely ignore UIApplication. Build your
program around a custom application delegate class that is responsible for setting things up
when the application launches and closing things down when the application terminates.
Otherwise, hand oft the remaining model duties to methods in your custom
UIViewController classes or to custom model classes.

Note

Use [[UIApplication sharedInstance] keyWindow] to locate your application’s main
window object.

Uncovering Data Source and Delegate Methods

In addition to monitoring notifications, message tracking can prove to be an invaluable
tool. Add the following snippet to your class definitions to track all the optional methods
that your class can respond to:

-(BOOL) respondsToSelector: (SEL)aSelector {
printf("SELECTOR: %s\n", [NSStringFromSelector (aSelector)

UTF8String]);
return [super respondsToSelector:aSelector];
}
Summary

This chapter introduced you to the iPhone SDK, the developer portal, and the iPhone
application.You saw how to choose a developer program and how to create provisions.
You explored typical iPhone applications, from projects and source files to the application
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end product and learned about design limitations that should influence your develop-
ment. Here are a few thoughts you may want to take away with you before leaving this
chapter:

Most developers end up choosing the $99/year standard iPhone developer pro-
gram. This is the best, most general program to sign up for as it allows you to test
on real devices and gives you access to the App Store.

There are significant differences between each iPhone and iPod touch platform.
Make sure your applications understand those differences to provide the best end-
user experience.

Developing for mobile platforms is not the same as developing for desktop systems.
Keep this cardinal rule in mind: Fingers big, screen small, attention span short.

The iPhone application bundle is much simpler and less structured than its Macin-
tosh brother although it shares many common features such as Info.plist files and
Iproj folders.

If you come from a Cocoa background, you’ll be prepared, if not overprepared, to
create iPhone applications. Familiarity with Objective-C and Cocoa best practices
will put you on a firm development footing.

If you're more comfortable using C++ than Objective C, Apple has made it possi-
ble to create hybrid projects that leverage your C++ expertise with a minimum of
Objective-C overhead.
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Building Your First Project

chapter introduces you to the basics of using these tools in your projects.You see

how to build a simple Hello World project, compile and test it in the simulator, and
then learn how to compile for and deploy to the device.You also discover some basic de-
bugging tools and walk through their use as well as pick up some tips about handy com-
piler directives. This chapter also looks at how to submit to App Store and distribute via
ad hoc. By the time you finish this chapter, you’ll have followed the application creation
progress from start to finish and learned valuable tricks along the way.

Xcode and Interface Builder help you craft applications for the iPhone SDK. This

Creating New Projects

If diving into SDK programming without a lifeline seems daunting, be reassured. Xcode
makes getting started as simple as possible. It provides preconfigured projects that you can
easily adapt while exploring the SDK. Since each of these projects is a fully working
skeleton, all you need to do is add a little custom functionality to make that app your own.

To get started, launch Xcode and choose File > New Project (Command-Shift-N).
The New Project template window (see Figure 2-1) opens, allowing you to select one of
these application styles to get started.

These six project styles are chosen to match the most common development patterns
for iPhone.Your choices are

= Navigation-based Application—Usually based around lists and tables, navigation
applications offer a series of selection choices, each choice sliding to a new screen.
The bar at the top of the screen ofters a Back button, letting you return to previous
screens. Apple’s Contacts application is a navigation-based application.

= OpenGL ES Application—When programming with OpenGL ES, all you need is
a view to draw into and a timer that offers an animation heartbeat. The OpenGL ES
template provides these elements, letting you build your OpenGL ES graphics on top.

= Tab Bar Application—Apple’s iPod and YouTube applications offer typical exam-
ples of Tab bar applications. In these applications, users can choose from a series of
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screens by tapping buttons in a bar at the bottom of the application. For example,
the YouTube application lets you choose from Featured videos, Most Viewed, Book-
marks, or the search pane.The Tab Bar Application template provides a skeleton that
you can grow to add panes and their contents.

Utility Application—Meant to be the simplest style of application, the Ultility
Application template creates a two-sided single-view presentation like the ones you
see in the Stocks and Weather application. The template provides a main view and a
flip view, which you can easily customize.

View-based Application—The View-based template provides a skeleton that
supports a single view. It provides a view controller to manage the view and an
empty XIB to populate that view with custom GUI elements. This is the template
you use later in this chapter to build your first Hello World application.

Window-based Application—The window-based application offers the same
template as the view-based one but without the view controller or view.You get an
application delegate and a window and that’s about it. One advantage of choosing
this template is that it’s relatively easy to strip out the Interface Builder elements
should you prefer to build your iPhone applications completely from scratch.

@ e e New Project

Choose a template for your new project:

u iPhone 05 E

Library Navigation-based OpenGL ES Tab Bar Application
Application Application

‘LJ Mac 05 X oe oe

Application

Audio Units |¢ . }

Automator Action X

Bundle Utility Application View-based window-based

Command Line Utility Application Application

Dynamic Library

Framewark

Java

Kernel Extension

Standard Apple Plug-ins Description This template provides a starting peint for an application that

Static Libra uses a tab bar. It provides a user interface configured with a tab
Y bar controller, and a view controller for the first tab bar item.

Other

(" Cancel ) E(Ehnnsera

Figure 2-1 The Xcode New Project template selection window.
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Note

Apple offers sample code and tutorials at the iPhone Reference Library. The library is lo-
cated at http://developer.apple.com/iphone/library/navigation/index.html; you must use
your developer credentials to access its contents. In addition to sample code, you'll find re-
lease notes, technical notes, Getting Started guides, Coding How-To’s, and more.

Building Hello World the Template Way

Xcode’s preconfigured template offers the easiest path to creating a Hello World-style
sample application. In the following steps, you create a new project, edit it to say Hello
World, and run it on the iPhone simulator. As you build your first Xcode project, you’ll
discover some of the key development pathways.

Create a New Project

With the iPhone SDK installed, launch Xcode. Close the Xcode news page; it’s the
window that says Welcome to Xcode and offers options like Create a new Xcode project.
This window continues to appear until you uncheck Show at Launch before closing.

Note

If you ever change your mind about hiding the window, you can find it again by choosing
Help > Welcome to Xcode.

To create the new project, choose File > New Project (Command-Shift-N). This opens
the template selection window shown previously in Figure 2-1. Notice that there are cur-
rently just two sets of iPhone templates (called Application and Library in the left-hand
column) available versus a dozen project styles available for the Macintosh.You can, in
fact, add new iPhone templates to Xcode, and you learn how to do so later in this chapter.
For now, choose Application if it has not already been selected for you.

Select View-based Application and click Choose. When Xcode prompts you to Save As,
name the project HelloWorld and save it to your Desktop with Save. A new HelloWorld
Xcode project window opens (see Figure 2-2). This project contains all the files you need
to design an application centered on a primary view.

The style of the project window depends on an Xcode setting. Choose Xcode > Pref-
erences (Command-,), select the General pane, and choose the layout from the pop-up.
The samples in this chapter use the All-In-One layout that combines operations to a sin-
gle window, as shown in Figure 2-2. Other options include Condensed, offering separate
windows for most tasks, and Default, which has a core project window and separate tool

windows.

Note

When creating new iPhone projects, some templates offer a Use Core Data for Storage
check box. These projects offer a skeleton that creates a Core Data stack for persistent
storage. See Chapter 19, “A Taste of Core Data,” for more details about Core Data.
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Figure 2-2  This brand-new HelloWorld project was created by choosing the View-based
Application template.

Review the Project Window

The default Xcode project window is normally divided into three parts as you can see in
Figure 2-2.These parts include the gray toolbar at top, the left-hand column, and the cen-
ter-right portion of the window. Each part has a role to play in managing your project.

At the top, the gray toolbar provides a number of useful tools. The toggle on the very
left (A) moves you between the project overview and the visual debugger. To its right, a
pop-up (B) sets your targets and configuration. These control the application you intend
to build and the way you intend to build it. The default iPhone templates provide two
configurations, Debug and Release, which you can see from the pop-up choices. These
configurations are actually a poor match for the realities of iPhone development, where
better choices would have been Debug (for in-house development), Ad Hoc (for ad hoc
distribution), and Distribution (for App Store release). Fortunately, the configurations are
editable, and you discover how to create better choices later in this chapter.

To the right of the Configuration pop-up is Action (C), a pop-up that offers typical
project functionality like adding new files and Reveal in Finder to locate those files on
your Macintosh. To the right of that, you see the Build and Go button (D). Click it to
compile your application and run it, whether on the device or in the simulator. The Info
button (E) when clicked opens a window that you can use to customize parts of your
project.




Building Hello World the Template Way

On the left side of the project window is the Groups and Files column (F).This col-
umn starts off with the source for your project. This list includes any files used to build the
application plus any other files you've added to the project. The folder system shown is
completely arbitrary.You can group with folders to organize your materials or skip the
folders entirely. Groups provide an elegant way to organize your code and resources inside
Xcode without touching the organization on the file system.

The Products folder (G), which is the last item in the folders list by default, contains
the item you intend to build. In this case, that is the HelloWorld.app application (H). It is
shown in red as it has not yet been built. Once built, it appears in black.

Below the first group of files is the Targets item (I). Click the gray disclosure triangle to
reveal the HelloWorld entry under Targets. Locating your target is important. Select it and
click the blue Info button at the top of the project window to open the Target “Hello
World” Info window. This Target Info window is going to become one of your most im-
portant tools. Remember this sequence: Open the Target disclosure triangle, select the tar-
get, and click Info.

To the right of the Groups and Files column is a tabbed area. At the top, are four op-
tions: Detail (J), Project Find (K), SCM Results (L), and Build (M). Although they’re
stacked together, these four pane options have difterent roles and yet they all provide criti-
cal project information.

= Detail lists and previews files in your project. It helps you find files and open them
to edit.

= Project Find searches through entire projects.You can match strings in files and
frameworks. It mirrors and expands upon the single-file Find pop-up you access via
Command-E

= SCM Results shows the status of your files relative to a Source Code Management
System. SCM systems track changes to your project both for single and multiple
programmers. Xcode integrates with SVIN, Perforce, or CVS, and displays the results
of your syncs. Unfortunately, there is no support for the git version control system
at this time.

= Build presents a results window for building your projects, showing any errors and
their details.

The Detail Pane

You’ll likely spend much of your time looking at the Detail pane (N), which is the default
selection for the project window. The pane lists all the files in your project. Here you find
all the individual elements listed by name. The Groups and Files column controls what
you see. Click the HelloWorld group at the very top of the column to see all the files at
once. Clicking on a group restricts the file list to just those files contained in that group.
The bottom pane (O) offers a preview of whichever element has been selected on the
top. It’s also a live editor, so any changes made in the bottom pane update the file in ques-
tion. Click main.m and the bottom immediately updates with the contents of that file. A
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resize bar (P) sits between the top file list and the bottom editor/preview. Use this to ad-
just the proportions between the two elements. If you do not want to see a preview, drag
the bar all the way down to the bottom.

Editor Windows

You will normally not want to edit your files in the tiny preview pane of the project win-
dow. Double-click any source file at the top, such as main.m, to open a stand-alone editor
window (see Figure 2-3).This source code window offers some of the same options as the
project window in the top gray bar. Below the top bar, it offers a standard Xcode source-
code editing window. Make any changes you need by editing the text in the window. Be
sure to regularly save your work using File > Save (Command-S).

8e0o [m| main.m =)
| Simulator - 3.0 | Debug M| N | < ) ﬁ' E

< | » | [# main.m:1 <MNo selected symbol> = -

A main.m
/¢ HelloWorld

A¢ Creoted by Erico Sodun on 4/24/89.
/¢ Copyright __MyCompanyMame__ 2889, 4ll rights reserved.
Finport LIKILAIKIE b
int main{int arge, char *argv[]) {
WShutoreleasePool * pool = [[M3AutoreleoseFool alloc] init];
int ret¥al = UlApplicationMain{aorges, argy, nil, nil);

[pool releasze];
return retVal;

Figure 2-3 An Xcode source code editing window.

Xcode provides full undo support for a single session.You can even undo past a previous
save so long as you do so within the same session. That is, you cannot close a project, re-
open it, and then revert changes made before the project was closed.

Note

To add line numbers to your source code editing windows, open Preferences (Xcode > Prefer-
ences, Command-,). Scroll over to the Text Editing pane, check Show line numbers (on the
left, under Display Options), click Apply, and then click OK.
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Review the Project

When Xcode creates your new project, it populates it with all the basic elements and
frameworks you need to build your first iPhone application. Items you see in this project
include the following:

» Foundation and Core Graphics frameworks—These essential frameworks en-
able you to build your iPhone applications using the same fundamental classes and
calls you are familiar with from the Macintosh.

» UIKit framework—This framework provides iPhone-specific user interface ele-
ments and is key to developing applications that can be seen and interacted with on
the iPhone screen.

= HelloWorld.app—Displayed in red, this placeholder is used to store your finished
application. Like on the Macintosh, iPhone applications are bundles and consist of
many items stored in a central folder.

» HelloWorld-Info.plist—This file describes your application to the iPhone’s system
and enables you to specify its executable, its application identifier, and other key fea-
tures. It works in the same way Info.plist files work on the Mac.

» MainWindow.xib—This Interface Builder file creates an unpopulated window.
You will not use this for this first walk-through.

= HelloWorldViewController.xib—This Interface Builder file builds the view that
displays in your first application.You edit this to customize how it looks.

» main.m, HelloWorldAppDelegate.h, HelloWorldAppDelegate.m,
HelloWorldViewController.h, and HelloWorldViewController.m—These
files contain a rough Objective-C skeleton that you can customize and expand to
create your application. Feel free to browse through the code, but you will not edit
these in this walk-through. Instead, you use the way that Xcode set them up and
limit your modifications to the view controller .xib.

Open the View Controller .xib

In the HelloWorld project window, locate the HelloWorldViewController.xib file. As you
read in Chapter 1, “Introducing the iPhone SDK,” .xib files store Interface Builder layouts.
Double-click the .xib file to launch Interface Builder so you can begin to edit the file.
This may take a few seconds as the program opens and loads data. Once launched, locate
the primary .xib window in Interface Builder shown in Figure 2-4.

The three icons in the .xib window represent three elements of the interface you’re
editing. To the very right is the View. The view is by default a member of the UIview class.
It contains the onscreen elements that you want to display in your application.

On the left, the File’s Owner represents the view controller. This is an abstract class, and
its icon is called a proxy because it plays a role in IB, but the object is not itself embedded
in the .xib archive.
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eno  HelloWorldViewController.xib =
oo CO
Rl = [m) (] Q
N m
File's Owner First Responder View

Figure 2-4  The Interface Builder window for a
view controller .xib

View controllers don’t have a visual presentation. They manage views, but they don’t dis-
play anything of their own. Each view controller has an instance variable called “view”
which is set to some UIView (in this case, the one at the right) that is responsible for pro-
viding the actual onscreen presentation. So in the case of view controllers, the File’s
Owner proxy represents the object that loads and owns the .xib.

You can discover this for yourself by opening an inspector window. Choose Tools >
Identity Inspector (Command-4). Click the File’s Owner object and look at its class in
the inspector. It is set to HelloWorldviewController. Then click the view object. Its class
is UIView.

To see how the two are connected, click the File’s Owner in the .xib window and then
choose Tools > Connections Inspector (Command-2).You see that there is one Outlet
listed. Outlet is IB-talk for instance variable. Move your mouse over the view-View listing
in the Connections Inspector and you see the view object in the .xib window highlight.
That’s because the view outlet for your view controller is already connected to that view.
Xcode prebuilt the file to work properly with the view.

The last icon, the one in the middle of Figure 2-4, is called First Responder. Like File’s
Owner, it’s a proxy object. It represents the onscreen object that is currently responding to
user touches. During the lifetime of an application, the first responder changes as users in-
teract with the screen. For example, imagine a form. As the user touches each text field in
that form, that field becomes active and assumes the first responder role.

Edit the View

To start customizing the view, double-click the view object in the .xib window. This
opens a new editor window (see Figure 2-5, left). By default, the view is empty. It’s up to
you to customize it and add some content.To do so, you rely on two tools: the Interface
Builder library and the inspector.
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Select the view editor by clicking on it and then choose Tools > Attributes Inspector
(Command-1). In the inspector, locate the Background swatch. Click on it and choose a
new color from the Colors palette. The View automatically updates the background color.
As you can see, the attributes inspector lets you adjust the properties of the currently se-
lected object, in this case the view that you are editing.

- View ST e Library
= Qbjects.| Classes  Media
w |l Gbary

=Y X 2=

.: | | E % 1 2 L..ihal
Tewt H - —_— :
O

Pravides view-management functivnality fur toolbars, navigation
bars, and application views, The UiewCaneredler elass also
supports modal views and rotating wiews when device orientation
changes.

Figure 2-5 An empty view editor window (left); the Interface
Builder Library (right).

Next, open the library by choosing Tools > Library (Command-Shift-L). The library (refer
to Figure 2-5, right) presents a list of all the prebuilt Cocoa Touch elements you can use in
your IB projects. These include both abstract elements like view controllers as well as vi-
sual components like buttons and sliders. Enter UlLabel in the search field at the bottom
of the library window. Drag the label from the middle pane, which is highlighted in
Figure 2-5 (right) and drop it onto your view. Alternatively double-click the label in the
middle pane.This automatically adds that item to your view. The bottom pane offers doc-
umentation of the selected class and you cannot drag from it.

Once dragged to the view, double-click the label and change the words from “Label”
to “Hello World.” You can also move the label around in the window to appeal to your
aesthetic sensibilities or set its location in the Size Inspector (Command-3). Once satisfied,
save your project with File > Save (Command-S). You have now customized your view
with this content.
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Run Your Application

Return to Xcode and to your project window. Choose Project > Set Active SDK >
iPhone Simulator (3.0). This tells Xcode to compile your project for the Macintosh-based
iPhone Simulator. Click Build and Go in the main project window and then wait as
Xcode gets to work. It takes a few seconds to finish compiling and then Xcode automati-
cally launches the simulator, installs your project, and runs it. Figure 2-6 shows the result,
the Hello World application running on the simulator.

-all Carrier = 10:31 AM

Hello World

Figure 2-6  The customized Hello World applica-
tion runs on the simulator.

Using the Simulator

The iPhone SDK Simulator makes it possible to test applications on the Macintosh using
many of the same actions a user would perform on an actual device. Because the Macin-

tosh is not a handheld touch-based unit, you must use menus, keyboard shortcuts, and the
mouse to approximate iPhone-style interactions. Table 2-1 shows how to perform these

tasks via the simulator.
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Table 2-1  Simulator Equivalents for iPhone Actions
Action Simulator Equivalent

Rotating the device Hardware > Rotate Left (Command-left arrow) and Hardware >
Rotate Right (Command-right arrow).

Shaking the device Hardware > Shake Gesture (Command-Control-Z). This simu-
lates a shake using a motion event but does not simulate
other accelerometer actions.

Pressing the Home Key Click the Home button on the Simulator screen or choose
Hardware > Home (Command-Shift-H).

Locking the device Hardware > Lock (Command-L).

Tapping and double- Click with the mouse, either a single- or double-click.

tapping

Tapping on the keyboard Click the virtual keyboard or type on the Mac keyboard.

Dragging, swiping, and Click, drag, and release with the mouse. The speed of the

flicking drag determines the action. For flicks, drag very quickly.

Pinching in or out Press and hold the Option key on your keyboard. When the
two dots appear, drag them toward each other or away from
each other.

Running out of memory Hardware > Simulate Memory Warning.

In-progress phone call (vi- Hardware > Toggle In-Call Status Bar. On the iPhone, you can

sual display only) run an application while on a phone call. The in-call bar ap-

pears at the top of the screen for the duration of the call.

Simulator: Behind the Scenes

Because the simulator runs on a Macintosh, Xcode compiles simulated applications for the
Intel chip.Your application basically runs natively on the Macintosh within the simulator
using a set of Intel-based frameworks that mirror the frameworks installed with the iPhone
OS onto actual units. The simulator versions of these frameworks are located in the Xcode
developer directory: /Developer/Platforms/iPhoneSimulator.platform/Developer/SDKs/
iPhoneSimulator3.0.sdk/System/Library.

You can find your applications in your home’s Library/Application Support folder.
They are stored in iPhone Simulator/User/Applications/. It’s helpful to visit this folder to
peek under the hood and see how applications get deployed to the iPhone.

Each application is stored in an individual sandbox. The name of the sandbox is ran-
dom, using a unique code (generated by CFUUIDCreateString()). Until OS 3.0, a sand-
box file usually accompanied the sandbox folder. It used the same name with a .sb
extension and stored the permissions associated with the file. Starting with 3.0, these sand-
box permissions files no longer seem to be used. In the past, you had to zip up both the
folder and the .sb file to share compiled simulator applications with others. Now you can
zip up just the folder and still be able to share between Macintoshes.
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Each sandbox name hides the application it’s hosting, so you must peek inside to see
what’s there. Inside you find the application bundle (HelloWorld.app, for example), a Doc-
uments folder, a Library folder, and a /tmp folder. While running, each application is lim-
ited to accessing these local folders. They cannot use the main user Library as applications
might on a Macintosh.

If you want to clean out your applications folder, you can delete files directly while the
simulator is not running. Alternatively, use the press-and-hold-until-it-jiggles interface on
the simulator that you're used to on the iPhone device itself. After pressing and holding
any icon for a few seconds, the application icons start to jiggle. Once in this edit mode,
you can move icons around or press the corner X icon to delete applications along with
their data. Press the Home button to exit edit mode.You can also delete all of the simula-
tor data by choosing iPhone Simulator > Reset Contents and Settings.

Although applications cannot access the user library folder, you can. If you want to edit
the simulator’s library, the files are stored in the iPhone Simulator/User/Library folder
in your home Application Support folder. Editing your library lets you test applications
that depend on the address book for example.You can load different address book sqlitedb
files into Library/AddressBook to test your source with just a few or many contacts.

Note

The iPhone Simulator and Mac OS X use separate clipboards. The simulator stores its own
clipboard data, which it gathers from the copy/paste features new to 3.0 firmware. Although
you can use Edit > Paste (Command-V) to paste text from the Macintosh into simulator appli-
cations, this does not affect the simulator’s onboard clipboard.

The Minimalist Hello World

While exploring the iPhone SDK, and in the spirit of Hello World, it helps to know how
to build parsimonious applications. That is, it helps know how to build an application
completely from scratch, without five source files and two interface files. So here is a
walk-through showing you exactly that, a very basic Hello World that mirrors the
UIViewController approach shown with the previous Hello World example but that
manages to do so with one file and no .xibs.

Start by creating a new project (File > New Project, Command-Shift-N) in Xcode.
Choose Window-based Application and save it as HelloWorld2 to your desktop. When the
project window opens, select the Classes folder from the left column and click backspace
to delete it. Choose Also Move to Trash when prompted. Next, delete MainWindow.xib.

Locate HelloWorld2-Info.plist (in the Resources folder) and double-click to open its
editor. The last line should read Main nib file base name. Select this line and delete it. Save
and close the file.

Open main.m and replace its contents with Listing 2-1. The source is included in
the sample code for this book (see the preface for details), so you don’t have to type it
in by hand.
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Listing 2-1  Reductionist main.m

#import <UIKit/UIKit.h>

@interface HelloWorldViewController : UIViewController
@end

@implementation HelloWorldViewController
- (void) loadview
UIView *contentView = [[UIView alloc] initWithFrame:
[[UIScreen mainScreen] applicationFramel];

contentView.backgroundColor = [UIColor lightGrayColor];

UILabel *label = [[UILabel alloc] initWithFrame:
CGRectMake (0.0f, 0.0f, 320.0f, 30.0f)];

label.text = @"Hello World";

label.center = contentView.center;

label.textAlignment = UITextAlignmentCenter;

label.backgroundColor = [UIColor clearColor];

[contentView addSubview:labell];
[label release];

self.view = contentView;
[contentView release];

}

@end

@interface HelloWorldAppDelegate : NSObject <UIApplicationDelegates
@end

@implementation HelloWorldAppDelegate
- (void)applicationDidFinishLaunching: (UIApplication *)application {
UIWindow *window = [[UIWindow alloc] initWithFrame:

[[UIScreen mainScreen] bounds]];

HelloWorldvViewController *hwvc;

hwve = [[HelloWorldViewController alloc] init];
[window addSubview:hwvc.view] ;

[window makeKeyAndVisible];

}

@end

int main(int argc, char *argv(])

{
NSAutoreleasePool * pool = [[NSAutoreleasePool alloc] init];
int retVal = UlApplicationMain(argc, argv, nil,
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Listing 2-1  Continued

@"HelloWorldAppDelegate") ;
[pool release];
return retVal;

So what does this application do? It builds a view, colors the background, and adds a label
that says “Hello World.” In other words, it does exactly what the first Hello World example
did, but it does so by hand, without using Interface Builder.

It starts in main.m by establishing the autorelease pool and calling
UIApplicationMain. From there, control passes to the application delegate, which is spec-
ified as the last argument of the call. This is a critical point for building a non-Interface
Builder project, and one that has snagged many a new iPhone developer.

The delegate, receiving an application did launch message, builds a new window and
creates a new instance of a custom view controller. It adds that controller’s view to the
window. The view controller waits for a request to load its view and when that request
comes in, it runs loadview, which builds the view and adds the Hello World text.

Building views by hand means using this loadview method to set up the primary view
and its children. This sample starts by creating a new view and telling it to fill the full
space available to the application. It then sets the background color, in this case to light
gray. Next, the sample builds a new instance of the UILabel class. Each of the label prop-
erties is set by hand.

In Interface Builder, the attributes inspector fills the same function. The inspector
shows the label properties, oftering interactive controls to choose settings like left, center,
or right alignment. Here, that alignment is set programmatically to the constant
UITextAlignmentCenter, the background color is set to clear, and the label programmati-
cally moved into place via its center property. In the end, both the by-hand and Interface
Builder approaches do the same thing, but here the programmer leverages specific knowl-
edge of the SDK APIs to produce a series of equivalent commands.

As with other examples in this book, this code does not provide a dealloc method for
the application delegate as it never gets called. The iPhone OS recovers all application
memory during the application tear-down. Technically, the view controller leaks. In prac-
tice, this isn’t a problem.

Browsing the SDK APls

The iPhone SDK APIs are fully documented and accessible from within Xcode. Choose
Help > Documentation (Command-Option-Shift-?) to open the Xcode Developer Doc-
umentation browser. Choose a documentation set from the top bar and search for
UILabel from the top-right. This brings you to the full uTLabel Class Reference (see
Figure 2-7) where you can find all the class methods, properties, and instance methods as
well as a general class overview.

Apple’s Xcode-based documentation is thorough and clear. With it you have instant ac-
cess to an entire SDK reference.You can look up anything you need without having to
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leave Xcode. When material goes out of date, a document subscription system lets you
download updates directly within Xcode.

8eno =] UlLabel Class Reference =
[ uiLabel & QUiLabel
Back/Forward Home Bookmarks Page Navigator Search
Prefix Exact | All DocSets ~ | AllLanguages ~
AR UlLabel Class Reference "} PDF
= T UlLabel » Table of Contents Jump To... « Previous | Next »
I-LAccess\ni\iw’ Programming Guide for iPhone OS UI Label Class Refe re nce m

Address Book Programming Guide for iPhane 05
Audio Host Time On iPhone OS

Core Data Tutarial for iPhone 0§ Inherits from UlView : UIResponder : NSObject
Crash Reporting for iPhane 05 Applicat
rash Reporting for iPhone pplications Conforms to NSCoding
Creating an iPhone Application NSCoding (UlView)
Exparting Mavies for iPod, Apple TV and iPhone NSObject (NSObject)
Getting Started with iPhone - i
How do | programmatically quit my iPhone . Framework /System/Library/Frameworks/ UIKit.framework
iPhone 2.1 API Diffs Availability Available in iPhone OS 2.0 and later.
¥ Full Text Declared in UlLabelh

Text

Ullabel Class Reference Related sample code iPhoneCoreDataRecipes

LocateMe
What Is Cocoa? SimpleNetworkStreams
UlLabel Class Reference Touches
LocateMe - /Classes/FlipsideViewController.h UlCatalog
Touches - /Classes/MyView.h
iPhoneCoreDataRecipes - {Classes /Temperat..
URLCache - [Classes/URLCacheAppDelegate.h
avTouch - /Classes/avTouchController.h
SeismicXML - /Classes /RootViewController.m o -
Photolocations - /Classes/EventDetailViewC.. verview
TaggedLocations - /Classes/EventTableView..
GKTank - /Classes /TankViewController.h Important: This is a preliminary document for an APl or technology in development.
UlCatalog - /PickerViewContraller.h Although this document has been reviewed for technical accuracy, it is not final.

Apple is supplying this information to help you plan for the adoption of the
technologies and programming interfaces described herein. This information is
subject to change, and software implemented according to this document should be
tested with final operating system software and final documentation, Newer versions
— iPhone ©S 3.1 Library » Topics + User Experience » Windows & Views » UlLabel Class Reference

iPhoneCoreDataRecipes - /Classes/MetricPic..

“

E

Figure 2-7  Apple offers complete developer documentation from within Xcode itself.

Interface Builder offers an extremely useful tool for developers at all expertise levels.
Relying on it for many developer tasks, such as hooking up instance variables and crafting
callbacks, may prove limiting. There is a lot more you can do in code that you cannot do
in IB. Xcode’s developer documentation helps you move past those limits and lets you fo-
cus your IB work on interface design, which is what the tool best offers. By understanding
the SDK at a deeper level, you can craft more nuanced and powerful applications.

Converting Interface Builder Files to Their Objective-C Equivalents

A handy open source utility by Adrian Kosmaczewski allows you to convert Interface
Builder files to Objective-C code. With it, you can extract all the layout information and
properties of your visual design and see how that would be coded by hand. nib2objc does
exactly what its name suggests. With it, you can generate converted code that takes into
account the class constructors, method calls, and more.
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Listing 2-2 shows the result of running nib2objc on the .xib file used in the first walk-
through. Compare it to the far simpler (and less thorough) by-hand version in Listing 2-1.
It performs more or less the same tasks. It creates a new view, then creates a new label, and
adds the label to the view. However, this conversion utility exposes all the underlying
properties, of which just a few were edited in Listing 2-1.

To peek at the original IB xml, open the .xib file in Text Edit.You can do so by issuing
open -e from the Terminal command line while in the HelloWorld project folder.

open -e HelloWorldViewController.xib

Note

nib2obj is hosted at http://github.com/akosma/nib2objc/tree/master and issued under a
general “Use this for good not evil” style of license.

Listing 2-2  HelloWorldViewController.xib after Conversion to Objective-C

UIView *view6 = [[UIView alloc] initWithFrame:CGRectMake (0.0, 0.0, 320.0, 460.0)];
viewé6.frame = CGRectMake (0.0, 0.0, 320.0, 460.0);
view6.alpha = 1.000;

view6.autoresizingMask = UIViewAutoresizingFlexibleWidth |
UIViewAutoresizingFlexibleHeight;

view6.backgroundColor = [UIColor colorWithRed:0.740 green:0.750 blue:0.638
alpha:1.000];

view6.clearsContextBeforeDrawing = NO;
viewé6.clipsToBounds = NO;

viewé6.contentMode = UIViewContentModeScaleToFill;
viewé6.hidden = NO;

view6.multipleTouchEnabled = NO;

view6.opaque = YES;

viewe.tag = 0;

view6.userInteractionEnabled = YES;

UILabel *view8 = [[UILabel alloc] initWithFrame:
CGRectMake (100.0, 188.0, 89.0, 21.0)];

view8.frame = CGRectMake(100.0, 188.0, 89.0, 21.0);

view8.adjustsFontSizeToFitWidth = YES;

view8.alpha = 1.000;

view8.autoresizingMask = UIViewAutoresizingFlexibleRightMargin |
UIViewAutoresizingFlexibleBottomMargin;

view8.baselineAdjustment = UIBaselineAdjustmentAlignCenters;
view8.clearsContextBeforeDrawing = YES;

view8.clipsToBounds = YES;

view8.contentMode = UIViewContentModeScaleToFill;
view8.enabled = YES;

view8.font = [UIFont fontWithName:@"Helvetica” size:17.000];
view8.hidden = NO;

view8.lineBreakMode = UILineBreakModeTailTruncation;
view8.minimumFontSize = 10.000;
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Listing 2-2  Continued

view8.multipleTouchEnabled = NO;

view8 .numberOfLines = 1;

view8.opaque = NO;

view8.shadowOffset = CGSizeMake (0.0, -1.0);

view8.tag = 0;

view8.text = @"Hello World”;

view8.textAlignment = UITextAlignmentLeft;

view8.textColor = [UIColor colorWithRed:0.000 green:0.000 blue:0.000 alpha:1.000];
view8.userInteractionEnabled = NO;

[viewé addSubview:view8];

Using the Debugger

Xcode’s integrated debugger provides a valuable tool for iPhone application development.
The following walk-through shows you where the debugger is and provides a simple
grounding for using it with your program. In these steps, you discover how to set break-
points and use the debugger console to inspect program details. These steps assume you
are working on the second, minimalist Hello World example just described and that the
project window is open and the main.m file displayed.

Set a Breakpoint

Locate the loadview method in the main.m file of your Hello World project. Click in the
leftmost Xcode window column, just to the left of the label.text assignment line. A
blue breakpoint indicator appears (see Figure 2-8).The dark blue color means the break-
point is active. Tap once to deactivate—the breakpoint turns light blue—and once more
to reactivate.You can remove breakpoints by dragging them offscreen and add them by
clicking in the column, next to any line of code.

Open the Debugger

Click the Project/Debug toggle in the project window to view the debugger. The debug-
ger provides a graphical front end for inspecting program objects, as well as a source win-

dow, and a log area with an interactive gdb shell. Locate the Activate/Deactivate button at
the top-right of the debugger and make sure that it is activated, that is, that the button says
“Deactivate.”

Run the Program

Make sure the breakpoint is dark blue and that the button at the top of the debugger says
“Deactivate” (which means that the breakpoint is active), and click Build and Go to run
the program in the simulator. The program automatically stops when it hits the breakpoint.
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The simulator window remains black and the debugger window updates to show the in-
teractive interface of Figure 2-9.

@implementotion HelloWor ldViewControl ler
- {void)loodyiew

UIView *contentMiew = [[UIView alloc] initWithFrame:[[UIScreen mainScreen] applicationFrame]];
content¥iew.backgroundColor = [UIColor lightGrayColor];

UlLabel *lobel = [[UILobel alloc] initWithFrome:CGRectMake(B.af, @.8F, 320.8F, 30.87)];
[ label.text = @"Hello World";

label .center = contentView.center;

label .backgroundColor = [UICalor clearColor];

lobel.textAlignment = UITextélignmentCenter;

[contentView addSubview:label];
[lobel release];

self.view = contentView;
[contentView release];

}
@end

@interfoce HelloWor ldAppDelegate : NSObject <UIApplicationDelegotes
@end

Figure 2-8 Blue breakpoint indicators appear in the leftmost Xcode window column.

|m| main.m - HelloWorld2

!Vanabla isummary
¥ label Oxd19540
-[UViewController view] P UlView {e}

1
2 -[HelloWorldAppDelegate applicationDidFinishLaunching'] p_size {3 (width=0, height=0) m
3 -[WApplication _performinitializationWithURL:sourceBundlelD:] P _text 0x0 nil
4 -[UlApplication _runWithURL:sourceBundlelD:] #_color Oxd1bb10
5 -[UlApplication handleEvent-withNewEvent:] - »_highlighted( 0x0 | -
6 -[UlApplication sendEvent:] wd b _shadowColo 0x0 [+
7 _llAnplicationHandleFyent b = fant Nxd737R0 b4
(= =) y<Tr.
A | v | [ main. + [ -loadview ¢ _i
' UIView *content¥iew = [[UI¥iew alloc] initWithFrame:[[UIScreen nainScresn] opplicationFrame]]; r
content\iew.backgroundColor = [UIColor lightGrayColor]; m

UILgbel *lobel = [[UILabel alloc] initWithFrome:CGRectMake(B.0f, .87, 320.8f, 38.87)];
[ lobel.text = @"Hello World";

lobel.center = content\iew.center;

labelbackgroundColor = [UIColor clearColor];

lobel.textAlignment = UITextAlignmentCenter;

el

[contentYiew addSubview:lobel];

W
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"show copying” to see the conditions.

There is absolutely no warranty for GDB. Type "show warranty" for details.

This GDB was configured as "ij86=apple=-darwin".sharedlibrary apply=-load-rules all

Attaching to process 9831.

Pending breakpoint 1 - ""main.m:13" resolwved

GNU gdb 6.3.50-20050815 (Apple version gdb-966) (Tue Mar 10 02:43:13 UTC 2009)

Copyright 2004 Free Software Foundation, Inc.

GDB is free software, covered by the GNU General Fublic License, and you are

welcome to change it and/or distribute copies of it under certain conditions.

Type "show copying” to see the conditions.

There is absolutely no warranty for GDB. Type "show warranty" for details.

This GDB was configured as "i3B6=-apple=-darwin".sharedlibrary apply=-load-rules all

Attaching to process 9848.

Pending breakpoint 1 - ""main.m:13" resolved

(gdb) L
GDB: Stopped at breakpaint 1 (hit count ; 1) - '~loadView - Line 13" @ Succeeded

kill

quit

The Debugger has exited with status 0.

[Session started at 2009=04=29 13:10:25 =0600.]
a
v

Figure 2-9 Xcode’s graphical debugger enables you to interactively inspect pro-
gram state. A command-line version of gdb runs concurrently in the console window,
as shown by the (gdb) prompt. A red arrow appears at the active breakpoint.
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Inspect the Label

Once stopped at the breakpoint, the interactive debugger and the gdb command line let
you inspect objects in your program. For this example, navigate down the variable chain;
the variable inspection pane appears at the top-right of the debugger window. Locate the
Locals list of variables by scrolling down slightly below the Arguments list. Inside, click
the disclosure triangle to the left of label to show the properties of the label object. No-
tice that text is labeled either nil or Invalid.

The gray Step Into button appears in the top toolbar of the window. Click it once.
The text assignment executes and the red arrow moves down by one line. The summary
of the label.text updates. It should now say Hello World.

Set Another Breakpoint

You can set additional breakpoints during a debugging session. For example, add a second
breakpoint just after the line that sets the text alignment to center.You can do this in the
middle pane; there’s no need to reopen the original source window. Once again click in
the leftmost column next to the line where you want to set the breakpoint.

Confirm that the current alignment is set to 0, the default value, by inspecting the la-
bel’s textLabelFlags. You may have to scroll down a little and resize the variable column.
Figure 2-10 shows the two breakpoints, the red arrow just after the assignment, and the
alignment value defaulting to 0.

With the new breakpoint set, click the green Continue button. HelloWorld resumes
execution until the next breakpoint, where it stops. The red arrow should now point to
the addsubview line, and the alignment flag updates from O to 1 as that code has now
run, changing the value for that variable.

Note
Remove breakpoints by dragging them out from the left column.

Going Text

The bottom pane of the debugging window offers text-based GNU debugger (gdb) out-
put that mirrors the results and data from the top two panes. For example, type backtrace
at the gdb prompt to view the same trace shown in the top-left pane. After stopping at
the second breakpoint, the backtrace should show that you are near line 19 in the source
from main.m.

This bottom section is also known as the console. In Xcode, choose Run, Console
(Command-Shift-R) to jump to the Xcode console. If the debugger is already open, the
cursor jumps to the bottom pane. This pane is where your printf, NSLog, and CFShow
messages are sent by default when running in tethered standard debug mode or when you
use the simulator.You can resize the console by adjusting the resize bar at its top. If you
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want, you can drag it all the way to the top.This provides a full-window text-based con-
sole when needed.

800 [m| main.m - HelloWorld2 =

gv

# | Thread-1% | Variable | Value | Summary
0 -[HelloWorldViewCantreller loadView] ¥ _textLabelFlags  {...} r
1 -[uviewController view] lineBreakMode 4
2 -[HelloWeorldAppDelegate applicationDidFinishLaunching:] highlighted o
3 -[UlApplication _performinitializationWithURL:sourceBundlelD:] autosizeTextTe 0
4 -[UlApplication _runWithURL:sourceBundlelD:] baselineAdjust 0 m
5 -[UlApplication handleEvent:withNewEvent:] - alignment o -
6 -[UlApplication sendEvent:] =4 enabled 1 il
7 _\anplicatinnHand|eFyent b4 wardRAunAing 1 X
| —) Jainl .
| > '|ﬁ|main.m.13 + M -loadview 3 _—_v_-_._C:_#_.

UI¥iew *contentView = [[UIView alloc] initWithFrame: [[UIScreen mainScreen] applicationFrome]];
contentView.bockgroundColor = [UIColor lightGrayColor]; m

UlLabel *label = [[UlLabel alloc] initWithFrame:CGRectMaoke(B.8f, @8.0f, 320.8f, 38.8f)];

label .text = @"Hello World";

label.center = contentView.center;

label.backgroundColor = [UIColor clearColor];

label .textAlignment = UITextAlignmentCenter; —

[contentView addSubview:lobel];

Figure 2-10 You can set additional breakpoints during the debugging session.

To test console logging, add a NSLog (@”Hello World!”) ; line to your code; place it after
the contentView release. Compile and run the application in the simulator. The log mes-
sage appears in the console pane. The console keeps a running log of messages regardless
of how many times you have tested your application.You can manually clear the log as
needed.

You don’t have to be running with gdb and the debugger console to see log messages.
Tethered iPhones automatically send their NSLog output to the Xcode organizer
(Window > Organizer > Device Name > Console). The Organizer console shows the out-
put created by NSLog. For example, when run on an iPhone, that NSLog command dis-
plays like the following. It shows the date and time, the program name and the NSLog
output (in this case, “Hello World!”).

Sun May 3 09:08:11 unknown HelloWorld2[2198] <Warning>: Hello World!

Moving the Clear Log Button

In the current version of the iPhone SDXK, the Clear Log button defaults to the very right
of the toolbar. Because of this, Clear Log does not appear when the window is sized too
small, as shown in Figure 2-10.You can access it by clicking the double-chevron at the top
right of the window. I find this default location too much of a pain as I use the button
constantly.

Fortunately, like most OS X toolbars, Xcode supports customization. To customize,
Control- or right-click the toolbar. Choose Customize Toolbar from the contextual
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pop-up. From here you can drag Clear Log to a better location so less important buttons
get sent to the chevron submenu and the Clear Log remains available at all times. To clear
the console log via the keyboard, type the extremely awkward Control-Option-Com-
mand-R key combo. Alternatively, use Xcode’s hotkey rebinding support. See the Key
Bindings pane in Xcode preferences (Command-,).

You can also automatically clear the console, although this can sometimes erase content
that you are still reviewing. Open Xcode Preferences (Xcode > Preferences, Command-,),
and then check Debugging > Auto Clear Debug Console. This erases the console each
time you execute the application.

Enabling Zombies

In the movies, a zombie is something dead that starts walking around. In Xcode vernacu-
lar, a zombie is an object that has been destroyed or released that you are still trying to
send messages to. During debugging, you can set a special mode called NSzZombieEnabled.
This debug mode lets you gather information about messages sent to invalid objects. Say,
for example, you create an instance variable called array. You set this and release it in the
application’s loadview method:

// Create and then release array

array = [[NSArray alloc] init];

[array releasel;

Should you attempt to access this object elsewhere in the program, the application will
crash. The debugger will fail with objc_msgSend and at best you can view a backtrace to
try to locate the error. Backtraces show a system stack, tracing the chain of messages that
led to the current error.

- (void) accessArray

{

CFShow ( [array self]);

}

NSZombieEnabled lets you locate the exact problem. In your project, select the Project
view (as opposed to the Debug view). Locate Executables in the project list and open the
disclosure triangle. Select your application, and click the blue Info button at the top tool-
bar. Click the Arguments tab and locate the Variables section at the bottom of the
Arguments pane. Click +, add NSZombieEnabled as the name (zombie, not zombies) and
YES as the value. Close the Executable Info window.

Now when you run the program, you receive a far more helpful message:

2009-05-03 13:20:31.014 HelloWorld[16603:20b] *** -[CFArray self]: message sent to
deallocated instance 0xd32590

This message lets you use the interactive debugger window to match the instance value
with the identity of the object; you’ll know exactly which object went zombie on you.To
disable zombies, delete the NSzZombieEnabled from the variables section of the Executable
Info. Make sure to do so before distributing the application.
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Note

In Xcode 3.2 and newer, you can also use Run > Run with Performance Tool > Instruments >
Zombies.

Memory Management

The iPhone does not offer garbage collection. It relies on a reference counted memory
management system. As a developer that means you must control when objects are created,
retained, and released from memory. Use too much memory and the iPhone warns your
application delegate and UIViewControllers. Delegates receive applicationDidReceive
=MemoryWarning: callbacks; view controllers get didReceiveMemoryWarning. Continue
to use too much memory and the iPhone will terminate your application, crashing your
user back to the SpringBoard. As Apple repeatedly points out, this is probably not the user
experience you intend for your user, and it will keep your application from being ac-
cepted into App Store.

You must carefully manage memory in your programs and release that memory during
low-memory conditions. Low memory is usually caused by one of two problems: leaks
that allocate memory blocks that can’t be accessed or reused and holding on to too much
data at once.

Note

In addition to retain and release, Objective-C offers autorelease memory management. Send-
ing autorelease to an object, typically at the time of its creation, says that you want it dis-
posed of automatically at some time in the future. The method that requests the object can
use the autoreleased object right away, and let it be disposed of at the end of the current
run loop, or it can retain the object for future use. Chapter 3, “Objective-C Boot Camp,” dis-
cusses memory management in further detail.

Leaks

Every object in Objective-C is created with an integer-based retain count. So long as that
retain count remains at one or higher, objects will not be deallocated. It is up to you as a
developer to implement strategies that ensure that objects get released at the time you will
no longer use them.

Every object built with alloc, new, or copy starts with a retain value of 1. Sending a
retain message to the object increases that count by one; sending release decreases the
count. (Assigning the object to a retained property also increases the count.) If you lose
access to an object without reducing the count to 0, that lost object creates a leak, that is,
memory that is allocated and cannot be recovered. The following code leaks an array:
NSArray *leakyarray = [[NSMutableArray alloc] init];
leakyarray = nil;



Recipe: Using Instruments to Detect Leaks

Caching

When you load too much data at once, you can also run short of memory. Holding on to
everything in your program when you are using memory-intense resources such as im-
ages, audio, or PDFs may cause problems. A strategy called caching lets you delay loads until
resources are actually needed and release that memory when the system needs it.

The simplest approach involves building a cache from a NSMutableDictionary object.
A basic object cache works like this. When queried, the cache checks to see whether the
requested object has already been loaded. If it has not, the cache sends out a load request
based on the object name. The object load method might retrieve data locally or from the
Web. Once loaded, it stores the new information in memory for quick recall.

This code here performs the first part of a cache’s duties. It delays loading new data
into memory until that data is specifically requested. (In real life, you probably want to
type your data and return objects of a particular class rather than use the generic id type.)

- (id) retrieveObjectNamed: (NSString *) someKey

{

id object = [self.myCache objectForKey:someKey] ;
if (lobject)

{

object = [self loadObjectNamed:someKey] ;
[self.myCache setObject:object forKey:someKey] ;

}

return object;

}

The second duty of a cache is to clear itself when the application encounters a low-
memory condition. With a dictionary-based cache, all you have to do is remove the ob-
jects.When the next retrieval request arrives, the cache can reload the requested object.

- (void) respondToMemoryWarning

{

[self.myCache removeAllObjects];

}

Combining the delayed loads with the memory-triggered clearing allows a cache to oper-
ate in a memory-friendly manner. Once objects are loaded into memory, they can be used
and reused without loading delays. However, when memory is tight, the cache does its
part to free up resources that are needed to keep the application running.

Recipe: Using Instruments to Detect Leaks

Instruments plays an important role in tuning your applications. It offers a suite of tools
that lets you monitor performance. Its leak detection lets you track, identify, and resolve
memory leaks within your program. Recipe 2-1 shows an application that creates two
kinds of leaks on demands: a string built by malloc () that is not balanced by free (), and
the NSarray example shown earlier in this chapter.
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To see Instruments in action, first load the sample project for Recipe 2-1. Choose Run
> Run with Performance Tool > Leaks in Xcode. This launches both Instruments and the
simulator. The application begins to run in the simulator and Instruments watches over its
progress.

Click either button in the application to leak memory. The string button leaks a 128-
byte malloc’ed block. The array button leaks a 32-byte NSArray. Memory leaks appear in
Instruments as an orange triangle. The size of the triangle indicates the size of the leak.

Be sure to click on the Leaks line to see the list of individual leaks as shown in Figure
2-11. By default, the ObjectAlloc line is selected. Each leak shows the amount of memory
leaked, the address at which the leak starts, and the kind of object leaked.

Instruments

@@@ B HelloWorld & “ ﬂ,‘.zur:?l[:”frf’:':‘ ®>

Stop Default Target

Instruments » v

>

e of [ T —

m - —
| N

R — el U |

Leaks : Hellowaorld Self %) Self Size|Address [ Leaked Object
v Leaks Configuration 80 128 Bytes 0xd376c0 GeneralBlock-128
# Automatic Leaks Checking 20 32 Bytes Oxd2abfo NSCFArray
[ Gather Leaked Memory Contents

v Sampling Options
sec Between Auto Detections:  10.0

Figure 2-11 Instruments tracks leaks created by memory that cannot be recovered.

To track details about where the leak occurred, open the Extended Detail pane (View >
Extended Detail, Command-E). Alternatively, click the detail button just to the left of the
words “Leaked Blocks” at the bottom of the Instruments window. Click any item in the
list of leaks. This opens a stack trace for that leak in the extended detail view, as shown in
Figure 2-12.

Here, you find a stack trace that connects the leak to its creation. As this screenshot
shows, the memory leak in question was allocated in leakCString after being malloc’ed.
Finding the genesis of the object can help you track down where the leak occurs during
its lifetime. Once discovered, hopefully you will be able to plug the leak and remove the
memory issue from your application.
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Extended Detail
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Figure 2-12 The stack trace in the Extended Detail view reveals where leaks occurred.

Recipe 2-1  Creating Programmatic Leaks

@implementation TestBedController

- (void) leakCString

{
char *leakystring = malloc(sizeof (char)*128);
leakystring = NULL;

- (void) leakArray

NSArray *leakyarray = [[NSMutableArray alloc] init];
leakyarray = nil;

- (void) viewDidLoad

// set up buttons

self.navigationController.navigationBar.tintColor =
COOKBOOK_PURPLE_COLOR;

self.navigationItem.rightBarButtonItem = BARBUTTON (@"Leak Array",
@selector (leakArray)) ;
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self.navigationItem.leftBarButtonItem = BARBUTTON (@"Leak String",
@selector (leakString)) ;

}

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’'ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 2, and open the project for this recipe.

Recipe: Using Instruments to Monitor Cached
Object Allocations

One feature of the simulator allows you to test how your application responds to low-
memory conditions. Selecting Hardware > Simulate Memory Warning sends calls to your
application delegate and view controllers, asking them to release unneeded memory. In-
struments, which lets you view memory allocations in real time, can monitor those re-
leases. It ensures that your application handles things properly when warnings occur. With
Instruments, you can test memory strategies like caches discussed earlier in this chapter.
Recipe 2-2 creates a basic image cache. Rather than retrieve data from the Web, this
image cache builds empty UIImage objects to simulate a real use case. When memory
warnings arrive, as shown in Figure 2-13, the cache responds by releasing its data.

.®@@ B HelloWorld

Stop Default Target
5

Instruments

0o:00:a0e | (@l
»

« Run 3 of 3

Inspection §

Instruments [z v

1%, Objectalloc i
& =

W —=————0——— Ik CACHE DEMO
ObjectAlloc Graph | Category Net Bytes #Net|  Overall B . .
¥ Allocation Lifespan ™+ All Allocations * 1092752 8626 41628 Application Did Receive Memory
@ All Objects Created [l GeneralBlock-16 61984 3874 Warning
© Created & Still Living [ GeneralBlock-32 36448 1139
¥ Call Tree [] CFstring 15440 530 *
o T O CPNumber 12704 794 O
O GeneralBlock-0 0 636
[ GeneralBlock-48 6768 141
[ CrArmay 1840 55
= O o . 14288 10

Figure 2-13 Instruments helps monitor object allocations, letting you test your release
strategies during memory warnings.

The stair-step pattern shown here represents three memory allocations created by pressing
the Consume button. After, the simulator issued a memory warning. In response, the cache
did its job by releasing the images it had stored. The memory then jumped back down to
its previous levels. Instruments lets you save your trace data, showing the application’s


http://github.com/erica/iphone-3.0-cookbook-

Recipe: Using Instruments to Monitor Cached Object Allocations

performance over time. Choose File > Save to create a new trace file. By comparing runs,
you can evaluate changes in performance and memory management between versions of
your application.

Some SDK objects are automatically cached and released as needed. The UIImage
imageNamed: method retrieves and caches images in this manner, although it has gained a
deserved reputation for not operating as smoothly as it should and retaining memory that
should rightly be released. Nibs used to build UIviewControllers are also cached, and
reload as necessary when controllers need to appear.

Note

As a general rule of thumb for the first two generations of iPhones, an application can use
up to about 20MB of memory before memory warnings occur and up to about 30MB until
the iPhone OS Kkills your application.

Recipe 2-2 Image Cache Demo

// Build an empty image

UIImage *buildImage(int imgsize)

{
UIGraphicsBeginImageContext (CGSizeMake (imgsize, imgsize));
UIImage *image = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;
return image;

@implementation ImageCache
@synthesize myCache;

- (id) init

{
if (! (self = [super init])) return self;
myCache = [[NSMutableDictionary alloc] init];

return self;

(UIImage *) loadObjectNamed: (NSString *) someKey

// This demo doesn’t actually use the key to retrieve
// data from the web or locally.

// It just returns another image to fill up memory
return buildImage (320) ;

- (UIImage *) retrieveObjectNamed: (NSString *) someKey
UIlmage *object = [self.myCache objectForKey:someKey] ;

if (lobject)

{
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object = [self loadObjectNamed:someKey] ;
[self.myCache setObject:object forKey:someKey] ;

}

return object;

}

// Clear the cache at a memory warning
- (void) respondToMemoryWarning

{

[self.myCache removeAllObjects];

}

- (void) dealloc

{

self.myCache = nil;
[super dealloc];

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 2 and open the project for this recipe.

Using the Clang Static Analyzer

The LLVM/Clang static analyzer automatically helps detect bugs in Objective-C pro-
grams. It’s a terrific tool for finding memory leaks and other issues. Starting with Xcode
version 3.2, you can run the analyzer directly from Xcode. Choose Build > Build and An-
alyze (Command-Shift-A). The interactive screen shown in Figure 2-14 guides you
through all suspected leaks and other potential problems.

Issues found by the static analyzer are not necessarily bugs. It’s possible to write valid
code that Clang identifies as incorrect. Always critically evaluate all reported issues before
making any changes to your code.

A stand-alone version of Clang can be used with legacy Xcode. Here are the steps you
can take to download, install, and use the static analyzer with your own projects:

1. Download a copy of the analyzer from http://clang-analyzer.llvm.org/. Unzip it
and rename the folder. I use the name “analyzer”; adapt the script in step 3 to match
your name.

2. Move the folder into place, typically into your home directory. I placed mine in
~/bin and the short shell script that follows uses this path.

3. I created and added the following script to ~/bin, naming it “clangit.” Again, use
your own judgment on placement and naming.
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rm -rf /tmp/scan-build*
rm -rf build
~/bin/analyzer/scan-build —view xcodebuild

4. Open an Xcode project, choose the Simulator | Debug configuration, and then
close Xcode.

5. From the command line, navigate to the project folder. Run the clangit script from
that folder. Once analyzed, the analyzer report opens automatically in your Web
browser.

800 [m| main.m: HelloWorld - Build Results =)

All Results (oD | By Issue | Issues Only ~

Build HelloWorld

Project HelloWorld | Configuration Debug
¥ 0 CompileXIB TestBedViewController.xib Al

£\ The ‘view' outlet of 'File's Owner' is connected to "View' but 'view' is no long...
¥ O Analyze main.m _..in .-\.-'Dlunw5fenca5adun,-'Desictop-"“-l’JSampleCcde 2

» % Potential leak of object allocated on line 220 and stored into "nav

» D Potential leak of object allocated on line 218 and stored into ‘window'

Build Succeeded 7/6/09 2:55 PM
= 1 warning, 2 analyzer results

< | » |[fmainm:222 3 -applicationDidFinishLawm X, ™, C, #, o
TR SELTsOVE = [[[TESLDEUVIEWLUNTIULIET dllUC] INIL] duLDrEle g
UINavigationController #nav = [[UINavigationController a'l.ll—
[window addSubview:nav.view];
| [window makeKeyAndVisible]; lhmliegk_nf_o_lyurdw_w
[} 3 Potential leak of object allocated on line 218 and stored into ‘window'

- (void) applicationWillTerminate: (UIApplication #*) applicati

[self.tbvc archiveInterfacel; // update the defaults on qu

-éend
- 0

int main(int argc, char =argv[]) i

{
| HEi!ﬁEEE EEiEEEE! % nonl = _[INSAutoreleasePonl a'l'lnr]) init Y
.

Build succeeded (1 warning, 2 analyzer results) @Succeeded 32 11

Figure 2-14 The Clang static analyzer creates bug reports for
source code and displays them in an Xcode feedback window.

Building for the iPhone

Building for and testing in the simulator takes you only so far. The end goal of iPhone de-
velopment is to create applications that run on actual devices. There are three ways to do

so: building for development, for distribution, and for ad hoc distribution. These three, re-
spectively, allow you to test locally on your device, to build for the App Store, and to build
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test and review versions of your applications that run on up to 100 registered devices.
Chapter 1 introduced mobile provisions and showed how to create these in the Apple
iPhone developer program portal. Now it’s time to put these to use and deploy a program
to the iPhone itself.

Install a Development Provision

At a minimum, a development provision is a prerequisite for iPhone deployment. So be-
fore going further, make sure you have created a wild-card dev provision and installed it
into Xcode by dragging the mobileprovision file onto the Xcode application icon. (Alter-
natively, drop the provision onto iTunes.) After doing so, quit and restart Xcode to ensure
that the provision is properly loaded and ready to use.

You may also want to review your keychain and ensure that the WWDR (Worldwide
Developer Relations) and your developer identity certificates are available for use. During
compilation, Xcode matches the provision against the keychain identity. These must match
or Xcode will be unable to finish compiling and signing your application. To check your
certificates, open Keychain Access (from /Applications/Utilities) and type “developer” in
the search box on the top right.You see, at a minimum, an Apple Worldwide Developer
Relations certifications Authority and one labeled iPhone Developer followed by your
(company) name.

Edit Your Application Identifier

Your project application identifier can be set in the Target Info window under the Proper-
ties tab. To find this, open the disclosure triangle next to Targets in the left-hand column
of your project window. Select the item inside. Its name matches the name of your proj-
ect. Click the big blue Info button at the top of the project window. This opens the Target
Info window with its five tabs. Click Properties, which is the fourth tab (see Figure 2-15).

8.0.0 Target “HelloWorld” Info

[ General  Build  Rules | Properties = Comments }

Executable: | ${EXECUTABLE_NAME]}

Identifier: com.yourcompany.S{PRODUCT_MAME:rfc1034identifier}

Type: APPL Creatar: | 7777

Icon File:

Version: 1.0

Principal Class:

Main Nib File: | MainWindow

Figure 2-15 The Properties tab reveals the current application identifier
settings.

Your wild-card development provision must match your actual application identifier. So if
you registered a wild-card application identifier of, say, com.sadun.™ and used that to
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generate your provisioning profile, your project’s application identifier must match the
registered identifier. You could use com.sadun.helloworld or com.sadun.testing, for exam-
ple, but not helloworld or com.mycompany.helloworld.

By default, Xcode sets the application identifier to com.yourcompany.productname,
where the product name is automatically filled in using the name you used to create your
project. Edit com.yourcompany without touching the Xcode variable, which starts with
the dollar sign, to match the values used in your wildcard identifier.

Note

You can change the default company name by editing the templates found at
/Developer/Platforms/iPhoneOS.platform/Developer/Library/Xcode/Project Templates/
Application or, better yet, by copying them and transforming them into custom templates.
This process is described later in this chapter.

Set Your Code Signing Identity

After setting your identifier, click on the Build tab and confirm that the Configuration
drop-down list at the top-left of the screen is set for the configuration type you want to
modify (Debug or Release). Scroll down to find the Code Signing Identity entry. Click
the triangle to disclose Any iPhone OS Device and click the pop-up to its right. This is
where you select the provisioning profile identity you use to sign your application.

As you start to accumulate provisions and identities, the list of options can become
long indeed. The sample shown in Figure 2-16 has been trimmed for narrative purposes.
Normally, it’s triple that size mostly due to third-party ad hoc provisions like the Polar
Bear Farm Beta Program one.

Build Active Architecture Only

| .
Valid Architectures Sopt Cade Sign

¥ EBuild Locations d Automatic Profile Selectors
Build Products Path iPhone Developer
Intermediate Build Files Path iPhone Distribution

Per-configuration Build Products Path
Per-configuration Intermediate Build Files Pa  Ea
Precompiled Headers Cache Path i

Sadun Ad Hoc

one Distribution: Erica Sadun

¥ Build Options d
Build Variants Sadun Wildcard Distribution
Debug Information Format iPhone Distribution: Erica Sadun

Enable OpenMP Support
Generate Profiling Code
Precompiled Header Uses Files From Build Di

My First Push App

profile doesn't ma Application Identifier 'com.sadun.HelloWorld'

Scan All Source Files for Includes Push Tast Provision Try 4
¥ Code Signing | profile ¢ V't match Application Identifier ‘com.sadun.HelloWorld'
Code Signing Entitlements
v Code Signing Identity Sadun Wildcard Development
Any iPhone OS Device v iPhone Developer: Erica Sadun

Code Signing Resource Rules Path
Other Code Signing Flags

¥ Compiler Version d
C/C++ Compiler Version

¥ Denlovment

Figure 2-16 Select a provisioning profile for your Code Signing Identity. To be used, provi-
sions must match the application identifier.
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You can see that there are items in black and items in gray. Gray items do not match the
project’s application identifier. They cannot be used to sign. In this example, these include
a couple of push notification provisions, which are tied to specific application IDs that
aren’t equal to the current com.sadun.HelloWorld identifier.

The black items include my three matching provisions: my normal ad hoc provision,
my wild-card distribution provision, and my wild-card development provision, which is
selected in the image. Each of these three is listed with a certificate identity, namely
iPhone Developer or iPhone Distribution followed by a colon, followed by my name.
These match both the identities stored in the keychain and the certificates used in the
portal to generate the provisions.

The two Automatic Profile Selectors automatically pick the first matching profile. This
works well for the Developer identity. I have only one. This works poorly for the Distrib-
ution identity, which matches first to my ad hoc profile, which I rarely use. In day-to-day
work, ignore the automatic profile selector and make sure you pick the item you actually
intend to use by inspecting both the certificate name and the profile identity just above
that name before choosing a profile.

Compile and Run the Hello World Application

Finally, it’s time to test Hello World on an actual iPhone or iPod touch. Connect a unit
that you will use for development. If this is your first time doing so, Xcode prompts you
to confirm that you want to use it for development. Go ahead and agree, understanding
that Apple always warns about possible dire consequences for doing so. First-time devel-
opers are sometimes scared that their device will be locked in some “development mode”;
in reality, I have heard of no long-lasting issues. Regardless, do your homework before
committing your device as a development unit. Read through the latest SDK release notes
for details.

Before you compile, you must tell Xcode to build for the iPhone’s ARM architecture
rather than the Macintosh’s Intel one. In the project window, choose iPhone Device as
your Active SDK (see Figure 2-17).Then, check the Active Executable setting. If you have
attached more than one development unit to your Macintosh, choose the one you want
to test on. A check mark appears next to the unit name that will be used.

Click the Build and Go button in the project window. Assuming you have followed the
directions earlier in this chapter properly, the Hello World project should compile without
error, copy over to the iPhone, and start running.

If the project warns you about the absence of an attached provisioned device, open the
Xcode Organizer window and verify that the dot next to your device is green. If this is
not the case, you may need to reboot your device or your computer.

Signing Compiled Applications
You can sign already compiled applications at the command line using a simple shell

script. This works for applications built for development. Signing applications directly
helps developers share applications outside of ad hoc channels.
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#! /bin/bash

export CODESIGN ALLOCATE=/Developer/Platforms/iPhoneOS.platform/Developer/usr/
bin/codesign allocate

codesign -f -s "iPhone Developer" $1.app

vice — ebu v&

¥ iPhone Device 3.0 (Base SDK)
iPhone Simulator 3.0

v Debug
Release
¥ iy HelloWorld

& HelloWorld - Elvio
v % HelloWorld - Bologna

¥ armvo

Figure 2-17 The Active Executable selection
chooses which device to use. Two development
units are connected to this Mac, with the Bologna
unit chosen.

If you use several iPhone Developer profiles in your keychain, you may need to adapt this
script so that it matches only one of those. Otherwise codesign complains about ambigu-
ous matching.

I personally used this approach to distribute test versions of the sample code from this
book. Using developer code-signing allowed me to skip the hassles of ad hoc distribution,
allowing me to rapidly turn around applications to an arbitrary audience.

From Xcode to Your iPhone: The Organizer
Interface

The Xcode Organizer helps manage your development units. Choose Window > Orga-
nizer (Control-Command-O). This window (see Figure 2-18) forms the control hub for
access between your development computer and your iPhone or iPod testbed. This win-
dow allows you to add and remove applications, view midtest console results, examine
crash logs, and snap screenshots of your unit while testing your application. Here’s a quick
rundown of the major features available to you through the Organizer.
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Figure 2-18 The Xcode-based iPhone Organizer window (Window > Organizer) provides a sin-
gle control hub for most of your application testing needs. Here, you can load firmware, install
and remove applications, read through crash logs, snap device-based screenshots, and more.

Projects and Sources List

Keep your current projects in easy reach by dragging them onto the Organizer.You can
drag in the entire project folder. Once added, double-click the project file to open that
project.You can add individual source files as well as complete projects. Use the Build,
Clean, Run, and Action options at the top of the Organizer window, to perform even
more development tasks directly from the Organizer.

In addition to storing files, the Projects and Sources list can be used for viewing the
contents of sandboxes. When you download sandbox data from a device with the Sum-
mary tab, Xcode automatically adds that folder to this list, where you can browse through
the file contents.

To remove items from this list, especially items that were added automatically and that
you didn’t choose to include, open the contextual pop-up. Right-click or control-click
any item and choose Remove from Organizer, and then click OK. Doing so does not af-
fect any files on your disk.You’re not deleting files; you're just omitting the listing in the
Projects and Sources list.
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Devices List

The Devices list shows the name and status of those devices you’ve authorized as develop-
ment platforms. The indicators to the right of each name show whether the device 1s at-
tached (green light) or not (red light). A gray light indicates a unit that has not been set
up for development or that it has been “ignored”—that is, removed from the active list.
An amber light appears when a device has just been attached. Should the light remain
amber-colored, you may have encountered a connection problem. This may be due to
1Tunes syncing, and the unit is not yet available, or there may be a problem connecting
with the onboard services, in which case a reboot of your iPhone usually resolves any
outstanding issues.

iPhone Development Tools

The items in this list offer Mac-based development resources. These include archival crash
logs (i.e., not tied to a particular device but offloaded to your system), a Provisioning Pro-
files manager, and a Software Images list that shows the firmware bundles currently avail-
able on your system. The profile manager is particularly useful as it shows which device
each profile is installed on, offers a profile identifier (so you can figure out which file in
~/Library/MobileDevice/Provisioning Profiles corresponds to which provision), and pro-
vides handy expiration date checks.

Summary Tab

The Summary tab tells you the name, capacity, serial number, and identifier of your
iPhone or iPod touch. Here is where you can provision your unit (that is, authorize it to
work with the projects you build in Xcode), add and remove applications, and load the
latest firmware.

Each developer license allows you to provision your personal or corporate
iPhones/iPod touches for testing. The Provisioning list shows a list of application provi-
sions available to your unit. The provision determines which applications may or may not
be run on the device. As a rule, only development and ad hoc distribution provisions are
listed here, which makes sense. Distribution provisions are used to sign applications for the
App Store, not for any specific device.

A list of installed applications appears at the bottom of the Summary tab. Use the —
button to remove applications. To install an application, drag it onto the list or use the +
button to browse for it. Make sure your application is compiled for the iPhone OS and
that the device is provisioned to run that application. The application will immediately
sync over. Applications installed from App Store are grayed out in the application list.

Open the disclosure triangle next to each application name to reveal the application
data associated with that application. To download the application data, click the down-
pointing arrow, choose a destination, and click Save. Xcode builds a dated folder and pop-
ulates it with the contents of the sandbox, namely the Documents, Library, and tmp
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directories. Xcode also adds the folder to the Projects and Sources list, where you can
browse the contents directly from the Organizer.

You can reverse this process and add edited sandboxes back to the device. Locate the
folder you created (use Reveal in Finder from the contextual pop-up in Projects and
Sources). Drop new items into any of the subfolders, and then drag the entire folder back
onto the application name at the bottom of the Summary pane. Xcode reads the new
items and instantly transfers them to the device. This is a great way to prepopulate your
Documents folder with test material.

Console Tab

Use the console to view system messages from your connected units. This screen shows
NSLog () calls as you’re running software on the tethered iPhone.You need not be using
Xcode’s debugger to do this. The console listens in to any application currently running
on the device.

In addition to the debugging messages you add to your iPhone applications, you also
see system notices, device information, and debugging calls from Apple’s system software.
It’s basically a text-based mess. Logged data also appears on the Xcode debugging console
(Run > Console) along with any printf output. Click Save Log As to write the console
contents out to disk.

Crash Logs Tab

Get direct access to your crash logs by selecting a particular crash (labeled with the iPhone
application name and the date and time of the crash) from the scrolling list. The crash de-
tails, including a stack trace, thread information, exception types, and so forth, appear in
the bottom pane.

In addition to crash logs that you generate yourself, you can also retrieve crash reports
from users from their home computer and from iTunes Connect. The iPhone automati-
cally syncs crash reports to computers when units back up to iTunes. These reports are
stored in different locations depending on the platform used to sync the device:

= Mac OS X—~/Library/Logs/CrashReporter/MobileDevice/ DeviceName

» Windows XP—C:\Documents and Settings\ UserName\Application Data\Apple
Computer\Logs\CrashR eporter\MobileDevice\ Device Name

= Windows Vista—C:\Users\ UserName\AppData\R oaming\Apple
Computer\Logs\CrashR eporter\MobileDevice\ DeviceName

iTunes Connect collects crash log data from your App Store users and makes it available to
you. Download reports by selecting Manage Your Applications > App Details > View
Crash Report for any application. There you find a list of the most frequent crash types
and Download Report buttons for each type.
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Copy reports into the Mac OS X crash reporter folder and they load directly into the
Organizer. Make sure to load them into the device folder for the currently selected de-
vice. The reports appear in IPHONE DEVELOPMENT > Crash Logs.

Once in the Organizer, Xcode uses the application binary and .dSYM file to replace
the hexadecimal addresses normally supplied by the report with function and method
names. This process is called symbolication.You don’t have to manually locate these items;
Xcode uses Spotlight and the application’s unique identifier (UUID) to locate the original
binary and .dSYM files so long as they exist somewhere in your home folder.

As with crash logs in the Organizer, the reports from users provide a stack trace that
you can load into Xcode to detect where errors occurred. The trace always appears in re-
verse chronological order, so the first items in the list were the last ones executed.

In addition to showing you where the application crashed, Crash Reports also tell you
why they crashed. The most common cause is EXC_BAD_ACCESS, which can be gen-
erated by accessing unmapped memory (KERN_INVALID_ADDRESS) or trying to
write to read-only memory (KERN_PROTECTION_FAILURE).

Other essential items in the crash report include the OS version of the crash and the
version of the application that crashed. Users do not always update software to the latest
release, so it’s important to distinguish which crashes arose from earlier, now potentially
fixed, versions.

Note
See Apple Technical Note TN2151 for more details about iPhone OS Crash Reporting.

Screenshot Tab

Snap your tethered iPhone’s screen by clicking the Capture button on the Screenshot tab.
The screenshot feature takes a picture of whatever is running on the iPhone, whether
your applications are open or not. So you can access shots of Apple’s built-in software and
any other applications running on the iPhone.

Once snapped, you can drag snapped images onto the desktop or save them as an open
project’s new Default.png image. Archival shots appear in a library on the left side of the
window. To delete a screenshot, select one and press the Delete key to permanently re-
move it.

Note

Screenshots are stored in your home Library/Application Support/Developer/Shared/
Xcode/Screenshots folder.

Using Compiler Directives

Xcode directives issue instructions to the compiler that can detect the platform and
firmware you’re building for. This lets you customize your application to safely take ad-
vantage of platform- or firmware-only features. Adding #if statements to your code lets
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you block or reveal functionality based on these options. To detect if your code is com-
piled for the simulator or for the iPhone, for example, use target defines:
TARGET IPHONE_SIMULATOR and TARGET OS_IPHONE.

#if TARGET IPHONE_SIMULATOR
Code specific to simulator
#else
Code specific to iPhone
#endif

The simple “OS 3 or later” version check lets you build OS-specific blocks. For example,
you might want to include code specific to the 3.0 MapKit within these blocks so a pro-
gram would still compile and run on 2.2.x devices. This approach lets you create version-
specific builds.Your program will not adapt on the go to changing device conditions; as
with the platform directive, this is a compile-time only check.
#ifdef _USE_OS_3_OR_LATER

#import <MapKit/MapKit.h>
#endif

Another approach involves checking the minimum OS version required to run the appli-
cation. For this, you can use any of the OS presets. This ensures that 3.0 code applies
strictly to apps compiled for 3.0 and later.

#if  IPHONE_OS_VERSION MIN REQUIRED < 30000
Pre-3.0 Code

#else
3.0 Code

#endif

The values for the OS versions use the following basic naming pattern, which will pre-
sumably continue from 3.1 on.These definitions were pulled from a global set of iPhone
defines. The next section shows you how to recover these for yourself.

#define _ IPHONE 2 0 20000

#define _ IPHONE 2 1 20100

#define  IPHONE 2 2 20200

#define _ IPHONE 3 0 30000

Recovering iPhone-Specific Definitions

Although directive-specific definitions are not secret, they are not exactly well known. To
check the current list of iPhone-specific defines, do the following. These steps dump a list
from Xcode during compilation that you can use as a ready reference.

1. Open the Target Info window for the Hello World iPhone project from earlier in
this chapter.

2. Add the following flags to the OTHER_CFLAGS in the Build tab:
-g3 -save-temps -dD.
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3. Build your project. It will compile with errors. Ignore these.

4. Open a Terminal shell and navigate to your project folder. Inside, you find a new
file: main.mi.

5. Issue the following command: grep -i iPhone main.mi | open -£.This searches
through the main.mi for all iPhone references and adds them to a new TextEdit
document. This list contains all the currently defined macro elements. Save the list
somewhere convenient.

6. Remove the custom flags from your project and save.You should now be able to re-
build without error.

Note

Platform-specific limitations like onboard camera or microphone access should also be ad-
dressed by your code. Read more about coding around these potential roadblocks in
Chapter 14, “Device Capabilities.”

Runtime Checks

Compiler directives allow you to build 2.x- and 3.x-specific versions of your applications.
They do not, however, provide a way to run code that adapts to the current firmware.

To sell your application to the greatest number of customers, do not build for any SDK
higher than your lowest desired customer. If your iPod customers are hesitant to pay for
upgrades to newer firmware, you can still sell software that uses an older firmware specifi-
cation so long as it has been thoroughly tested to run on newer firmware.

However, if you want to use more modern classes and calls, you either have to cut out
older firmware customers entirely or you need to develop applications that provide those
teatures while being compiled for earlier firmware. That means checking for compatibility
at runtime rather than compile time.

You can accomplish this in a number of ways. First, you can check against the system
running on the device, calling the firmware-appropriate methods. This sample does ex-
actly that. It produces compile-time warnings for a 2.x build, letting you know that table
cells may not respond to textLabel.This is not the preferred way of doing things. Apple
recommends that you check for functionality and availability, not against specific firmware
versions.

NSString *celltext = [[UIFont familyNames] objectAtIndex:
[indexPath row]];

if ([[[UIDevice currentDevice] systemVersion] hasPrefix:@"2."])
[cell setText:celltext];

else if ([[[UIDevice currentDevice] systemVersion] hasPrefix:@"3."])
[[cell textLabel] setText:celltext];

return cell;
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You can also test objects to see whether they respond to specific selectors. When 3.X
versions of the frameworks are available, objects will report that they respond to those
selectors, letting you call them without crashing the program. As with the previous
approach, this too generates compile-time warnings about unimplemented selectors.

NSString *celltext = [[UIFont familyNames] objectAtIndex:
[indexPath row]];

if (![cell respondsToSelector:@selector (textLabel)])
[cell setText:celltext];

else
[[cell textLabel] setText:celltext];

return cell;

To avoid those compile-time warnings, you can add 3.x specific interface declarations to
your 2.X source.

@interface UITableViewCell (SDK3)
- (UILabel *) textLabel;
@end

A Dbetter approach, however, is to set the Base SDK and Deployment targets for your proj-
ect. In Target Info > Build Settings, set Base SDK to the highest version of the OS you
want to target, namely some 3.x version. Set the iPhone OS Deployment Target to the
lowest OS version you intend to build for.

You can also use a variety of other workarounds like pulling the label out indirectly.
This code retrieves the label and sets its text.

UILabel *label = (UILabel *) [cell valueForKey:@"textLabel"];
if (label) [label setText:celltext];

You can access 3.x classes from a 2.x build by using NSClassFromString (). Test to see
whether the class returns nil. If not, the class is available for your use in the current
firmware. Link against any framework you might use, regardless of whether it is available
for the 2.x build.

Class MFMCVC = NSClassFromString(@"MFMailComposeViewController") ;
If (MFMVC) myMFMCViewController = [[MFMCVC alloc] init];

And if you really want to go hard core, you can build NsInvocation instances directly, as
discussed in Chapter 3.

Pragma Marks

Pragma marks organize your source code by adding bookmarks into the method list pop-
up button at the top of each Xcode window. This list shows all the methods and functions
available in the current document. Adding pragma marks lets you group related items to-

gether, as shown in Figure 2-19. By clicking on these labels from the drop-down list, you

can jump to a section of your file (for example, to tag utilities) as well as to a specific
method (such as -tagExists:).
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Figure 2-19 Use pragma marks to organize your method and func-
tion list.

To create a new bookmark, just add a simple pragma mark definition to your code.To
replicate the first group in Figure 2-20, for example, add:

#pragma mark view retrieval functions

You can also add a separation line with a special pragma mark call. Do not add any text af-
ter the hyphen or Xcode will add a normal bookmark, not a spacer.

#pragma mark -

The marks have no functionality and otherwise do not affect your code. They are simply
organizational tools that you choose to use or not.

Collapsing Methods

When you need to see more than one part of your code at once, Xcode lets you close and
open method groups. Place your mouse in the gutter directly to the left of any method. A
pair of disclosure triangles appears. Click a triangle and Xcode collapses the code for that
method, as shown in Figure 2-20.The ellipsis indicates the collapsed method. Click again
on the disclosure triangle, and Xcode reveals the collapsed code.
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int main{int arge, char *argv[])

Figure 2-20 Xcode lets you collapse individual methods and
functions. This allows you to see parts of your program that nor-
mally would not fit onscreen together.

Building for Distribution

Building for distribution means creating a version of your application that can be submit-
ted to Apple for sale in the App Store. Before you even think about building, know how
to clean up builds, how to create a distribution configuration, and how to find your built
product.You want to compile for the App Store with precision. Cleaning first, then com-
piling with a preset distribution configuration helps ensure that your application uploads
properly. Locating the built application lets you compress and submit the right file. The
following sections cover these skills and others needed for distribution compiles.

Creating and Editing Configurations

In Xcode, configurations store build settings. They act as a quick reference to the way you
want to have everything set up, so you can be ready to compile for your device or for the
App Store just by selecting a configuration. Standard Xcode projects offer Debug and Re-
lease configurations.You may want to create a few others, such as ones for regular or ad
hoc distribution.

Assuming you’ve been following along in this chapter, you have already set up the Hel-
loWorld project and edited its debug build settings. It uses your development wild-card
provision to sign the application. Instead of editing the build settings each time you want
to switch the signing provision, you can create a new configuration instead.

In the Project window;, select the HelloWorld group at the top of the Groups & Files
column. Click the blue Info button to open the Project Info window. This window contains
four tabs: General, Build, Configurations, and Comments. Open the Configurations tab.

Select the Debug configuration that you have already customized and click the Dupli-
cate button in the bottom-left of the window. Xcode creates a copy and opens a text
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entry field for its name, as shown in Figure 2-21. Edit the name from Debug copy to Dis-
tribution. For real world development, you may want to edit and/or duplicate the Release
configuration rather than the Debug one. This example uses Debug as it’s already cus-
tomized.

8.0 Project “HelloWorld2” Info
I General  Build | Configurations | Comments |
Edit configuration list:
Debug
Debug copy
Release
Duplicalel | R | | Delete
Command-line builds use: | Release FH ®

Figure 2-21  Use the Project Info configuration window to create new config-
urations so you can build with preset options such as signing identities.

Next, click the Build tab and choose the new Distribution option from the Configuration
pop-up. It’s important that you do so; otherwise, you’ll be editing whatever configuration
was last used. Locate the Code Signing Identity and set Any iPhone OS Device to your
wild-card distribution profile. When you have done so, close the Project Info window.

Following these steps adds a distribution configuration to your project, allowing you to
select it when you're ready to compile. Remember that you must create a separate config-
uration for each project. Configurations do not transfer from project to project and are
stored as part of each project’s settings.
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Clean Builds

Clean builds ensure that every part of your project is recompiled from scratch. Doing a
clean also ensures that your project build contains current versions of your project assets
including images and sounds.You can force a clean build by deleting the build folder in-
side your project folder and you can use Xcode’s built-in utility. Choose Build > Clean
(Command-Shift-K). As Figure 2-22 shows, Xcode prompts you to choose whether to
clean dependencies and precompiled headers as well. As a general rule, there’s no harm in
agreeing. Click Clean and wait as Xcode gets to work.

nOe [m| main.m - HelloWorld2 )
[Simulator - 3.0 | Debug 'J ".-:) i Q.- String Matching
Groups & Files | n
'& HE"DWNIHZ ] . Clean “Helloworld2" Target gde @ | A |0
B | | Other Sources s
» 3 R Cleaning will remove all derived products and files for the o
! ES0Urces P s l
— HelloWorld2" target and targets it depends on. Do you really T
» [ Framewarks want to clean this target? .
» | Products -
y@hmm EAISD Clean Dependencies ]
b-,zg HelloWaorld2 EAISD Remove Precompiled Headers - -
b < Executables v
( o
» /B Errors and Warnings Cancel L
» (4 Find Results
» L1 Bookmarks |
B S SCM

I Project Symbols

Figure 2-22  Xcode can thoroughly clean compiled artifacts from your project.

Apple recommends cleaning before compiling any application for App Store review, and
it’s a good habit to get into. I combine methods. I dispose of the build folder and then
clean out dependencies and precompiled headers. This produces a single product that is
easily located and won’t be confused with other build versions.

Compiling for the App Store

To build your application in compliance with the App Store’s submission policies, it must
be signed by a valid distribution provision profile using an active developer identity. If
you’ve properly set up a developer configuration, most of this is taken care of for you.
Here’s what's left.

= Select Device as the active SDK. I can't tell you how many people have attempted
to submit simulator builds to App Store only to be frustrated for hours before dis-
covering their error.

» Choose Distribution as the active configuration.You may want to open the Target

Info window and confirm that your application identifier and code signing identity
are set properly. Check that the Configuration at the top of the window is set to
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Active (Distribution) or Distribution. The Overview pop-up in the project window
should say Device | Distribution.

= Compile your application using Build > Compile (Command-K).Your application
should compile without errors. If not, reconsider your readiness to submit to the
App Store.

» Locate the compiled product. In the Groups & Files column, find the Products
group. Open it and right-click/Control-click your compiled application. It should
appear in black and not in red. Choose Reveal in Finder from the contextual pop-up.

= Use the Finder window to confirm that your build is located in a folder ending with
the name iphoneos. (Again, you cannot submit simulator builds to the App Store.)

= Right-click (Control-click) the application and compress it. You will submit the zip
file to the App Store through iTunes Connect.

If your application is larger than 10MB, use Apple’s OS X application loader utility to
submit your application to the App Store. This program is available for download through
iTunes Connect on the Managing Your Applications page. Scroll to the very bottom and
click Get Application Loader.

Debugging App Store Uploads

At times, it proves difficult to upload your application to the App Store.You log in to
iTunes Connect.You set up your application details and get ready to upload your binary,
but when you do, iTunes Connect rejects the binary. In a big pink message, the Web site
tells you your upload has failed. Do you have a real signature problem? Are your certifi-
cates invalid? Sometimes you do have a signature problem and sometimes you don’t. Here
are a few steps that can help. Some of these you've just read about in the previous section;
others are new. Make sure you go down the entire list until you’ve resolved your problem.

Start by visiting the program portal and make sure that your developer certificate is up
to date. It expires after a certain period of time (typically one year) and if you haven’t reis-
sued a new one, you cannot submit software to App Store. If your certificate has expired,
you need to request a new one and to build new provisioning profiles to match. For most
people experiencing the “pink upload of doom,” though, their certificates are already valid
and Xcode is properly configured.

Return to Xcode and check that you've set the active SDK to one of the device
choices, like Device - 3.0. Accidentally leaving the build settings set to Simulator can be a
big reason for the pink rejection. Next, make sure that you've chosen a build configura-
tion that uses your distribution (not your developer) certificate. Check this by double-
clicking on your target in the Groups & Files column on the left of the project window.
The Target Info window opens. Click the Build tab and review your Code Signing Iden-
tity. It should be iPhone Distribution: followed by your name or company name.

The top-left of your project window also confirms your settings and configuration. It
should read something like “Device | Distribution,” showing you the active SDK and the
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active configuration. If your settings are correct but you still aren’t getting that upload fin-
ished properly, clean your builds. Choose Build > Clean (Command-Shift-K) and click
Clean. Alternatively, you can manually trash the build folder in your Project from Finder.
Once you've cleaned, build again fresh.

Avoid spaces and special characters in the name of the zip archive you upload to
iTunes Connect.You cannot rename your app file but you can freely rename the zip
archive. Name issues can cause problems with some application uploads. So long as the
data inside the zip archive includes the proper application, the name of the zip file really
doesn’t matter.

If this does not produce an app that when zipped properly loads to iTunes Connect, do
this: Quit and relaunch Xcode. This one simple trick solves more signing problems and
“pink rejections of doom” than any other solution already mentioned. Quit, restart
Xcode, clean your build, rebuild, zip, and submit. For most developers, this final step is all
it takes to get past the invalid submission screen.

Assuming you are still having problems, download a copy of Apple’s OS X Application
Loader from iTunes Connect on the Manage Your Application page. Instead of uploading
directly, check the box that says Check Here to Upload Your Binary Later and use the
loader to submit the archive.

If you're still having trouble submitting to the App Store, consider compressing with a
third-party archiver or try copying the application to the desktop before zipping it up.
This sometimes solves the problem, creating an acceptable submission for an application
that is otherwise properly signed. Some files rejected by the iTunes Connect Web site may
be uploaded without error through the Application Loader.

Try launching Terminal and navigating to your compiled application. Run codesign -
vvv YourApplication.app, substituting the actual application name to see whether any
errors are reported about invalid signatures.

If you continue to have application submission problems even after walking through all
these steps, contact Apple. Send an e-mail to iTunes Connect (they do not have a public
phone) and explain your situation. Tell them that you’ve checked your certificates, that
they are all valid, and mention the steps you’ve already tried. They may be able to help fig-
ure out why you’re still getting pink-rejected when you try to submit your apps. For
everybody else, the checklist items you’ve already seen are probably enough to help you
move past your submission issues and get your app on the way to review.

Note

When renewing your developer and distribution certificates, you must reissue all your mobile
provisions. Throw away the old ones and create new ones with your updated developer iden-
tity. Make sure to remove the outdated certificates from your keychain when replacing them
with the new ones.
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Building for Ad Hoc Distribution

Apple allows you to distribute your applications outside the App Store via ad hoc distri-
bution. With ad hoc, you can send your applications to up to 100 registered devices and
run those applications using a special kind of mobile provision that allows the applications
to execute under the iPhone’s FairPlay restrictions. Ad hoc distribution is especially useful
for beta testing and for submitting review applications to news sites and magazines.

Register Devices

The ad hoc process starts with registering devices. Use the iPhone developer program
portal to add device identifiers (Program Portal, Devices) and names to your account. Re-
cover these identifiers from the iPhone directly (use the UIDevice calls from Chapter 9,
“Building and Using Controls”), from Xcode’s Organizer (copy the identifier from the
Summary tab), from iTunes (click on Serial Number in the iPhone’s Summary tab), from
System Profiler (select USB, iPhone, Serial Number), or via Ad Hoc Helper from iTunes.
Enter the identifier and a unique username.

Build the Ad Hoc Provision

If you have not done so already, build your Ad Hoc provision. To build a mobile provision,
select Program Portal > Provisioning > Distribution. Click Add Profile. Select Ad Hoc,
enter a profile name, your standard wildcard application identifier (for example,
com.yourname . *), and select the device or devices to deploy on. Don't forget to check
your identity and then click Submit and wait for Apple to build the new mobile provi-
sion. Download the provision file and drop it onto the Xcode application icon.You will
use it to build your application. You may want to restart Xcode after adding the provision.

Add an Entitlement File to Your Project

A special entitlement file is needed in ad hoc projects. (See Apple Technical Note
TN2242.) In Xcode, choose File > New File > Code Signing > Entitlements. Click
Next. Create a new entitlement called dist.plist. Click Finish. This creates a new file and
adds it to your project. The name of the entitlement file is arbitrary.

Locate the new entitlements file. The file contains a single property that you must edit.
Double-click to open it in an editor and uncheck get-task-allow (that is, set it to a
Boolean value of FALSE). Save your changes and close the file.

Add the Entitlement to Your Settings

After setting up your entitlement, you need to add it to your target settings. With the Ad
Hoc configuration selected, open the Target Info window. Make sure that the configura-
tion pop-up in the Target Info window also says Ad Hoc. If it does not, select it.

In the Build tab, choose your Ad Hoc provision for your Code Signing Identity.
Then, double-click Code Signing Entitlements. This pops up an interactive dialog. Click
+ and add the filename dist.plist to the Code Signing Entitlement (see Figure 2-23) and
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click OK. Alternatively, you can drag the entitlements file onto the Code Signing Enti-
tlements field.

OO Target “HelloWorld2” Info
Code Signing Entitlements [
Configuration:| distplisf D
Show:|
'Setting |
VAr(hilef_tuj l
Additiot |
Architec H
Base 5D
Build Ac
Valid Ar |
¥ Euild Loca !
Build Py Con |
Interme A
Per-configuration Build Products Path BuUildfAd Hoc-iphoneos
Per-configuration Intermediate Build Files Path  build/HelloWarld2.build/Ad Hoc-ipheneos
Precompiled Headers Cache Path Jvar[folders/Xo/XoLxWUISFtSplCoUpBV7DE+ ++T1/-Cach...
YEBuild Options

Figure 2-23 Add dist.plist as a new code signing entitlement for Ad Hoc dis-
tribution builds.

Build Your Ad Hoc Application

Now you're ready to build your application. Make sure your Code Signing Identity is set to
your ad hoc provision. Select Build > Build (Command-B).You can find the newly com-
piled product via the Products group in the project window. Right-click (Control-click) it
and choose Reveal in Finder. A Finder window opens, showing the compiled item.

Distribute a copy of this application, which you just compiled with the mobile ad hoc
provision, along with the provision itself that you downloaded from Apple.Your user can
drop the provision and the application into 1Tunes before syncing your application to his
or her iPhone. The application runs only on those phones you registered, providing a se-
cure way to distribute these apps directly to your user.

Adding Artwork to Ad Hoc Distributions

Normally, iTunes does not display artwork for ad hoc programs. By default, it shows a styl-
ized “A” instead. Fortunately, you can work around this. iPhone developer Malcolm Hall
taught me how to set up ad hoc applications so they display the proper image.

Create a folder in Finder and populate it with two items. The first is a 512x512 JPEG
image called iTunesArtwork. The second is a folder called Payload. Add the application
bundle (do not compress it) into the Payload subfolder. Then zip up the entire folder and
rename the zip file to Appname.ipa, where the name of the application matches the bundle
you included in the Payload subfolder.
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This IPA package (IPA stands for iPhone application) mimics the way that Apple provides
applications for iTunes. When iTunes sees the iTunesArtwork file, it uses it to create the
image seen in the Applications library.

Add the iTunesArtwork file without an explicit extension. If needed, remove any exist-
ing extension by renaming the file at the command line. Although the file needs to be in
JPEG format, it should not use the standard .jpg or .jpeg naming.

Note
When distributing ad hoc builds to Windows Vista clients, instruct users to unzip the IPA first

and then add the unzipped folder into iTunes. Vista apparently unzips the file incorrectly, re-
sulting in application verification errors.

Customizing Xcode Identities

By definition, Xcode builds the following header into all your source code. Each of the
items contained within the double chevrons is a variable and is set at the time the code
gets created. Your user and organization names are retrieved from your Address Book,
where they correspond to your personal contact information. The icon for this contact is
marked with “me”—as shown in Figure 2-24.

% . Erica Sadun

r“ Up To Ne Good, Inc.
e

Figure 2-24  In OS X’s address book, the contact
used for personalizing Xcode files is marked with a
“me” in the corner of the user’s icon.

* main.m
*  <<PROJECTNAME>>

* Created by <<FULLUSERNAME>> on <<DATE>>.
* Copyright (c) <<YEAR>> <<ORGANIZATIONNAME>>. All rights reserved.

*/

You can override these settings with a pair of defaults that you assign at the command
line. The following defaults command sets the organization and username to values dif-
ferent from those found in the address book. When used, these custom settings override
the address book entry.

defaults write com.apple.Xcode PBXCustomTemplateMacroDefinitions
‘{ORGANIZATIONNAME = "Apple, Inc." ; FULLUSERNAME = "Jonathan I.}'
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You can also update the Organization Name in the Project Info > General settings on a
project-by-project basis.

Unfortunately, the one string most iPhone developers want to override cannot be set
by defaults. The com.yourcompany identifier that appears in new projects is hard coded
into Xcode templates. If you want to change that identifier, you must edit Apple’s built-in
templates or, better yet, create copies of those templates and edit them in your own user
library.

Creating Custom Xcode Templates

When you create new projects in Xcode, the program lets you select a template. You can
choose from iPhone and Mac OS X options that let you craft your application from any
number of predesigned program skeletons. For the iPhone, these include view-based ap-
plications and applications built with OpenGL ES. On the Mac, you can build dynamic li-
braries, command-line utilities, and apps built with Cocoa, among many others.

Sometimes, though, you find yourself taking the same steps over and over to customize
your projects to your own particular in-house design including updating that company
identifier. Fortunately, Xcode lets you add user templates that you can precustomize so
you can always start your new projects off where you really need to begin, not just where
Apple left oft. Jay Abbott of TinyPlay.com first showed me how to do this. His instructions
involve making a copy of one of Apple’s templates, dragging it to a folder in your applica-
tion support library, and customizing it.

Apple stores its project templates in Xcode’s /Developer directory. iPhone project tem-
plates are found in /Developer/Platforms/iPhoneOS.platform/Developer/Library/
Xcode/Project Templates/Application. Each folder in that directory corresponds to a
single template.

Overriding com.yourcompany

Replacing com.yourcompany is one of the simplest patches you can make. To start, copy
the entire Application folder from the developer templates to your desktop. Search each
folder for instances of com.yourcompany inside Info.plist files and edit them to match the
actual identifier for your wild-card provisions. Make sure you look in subfolders in the
templates to locate all Info.plist files. Use caution when editing and avoid changing any of
the normal formatting information.

Once patched, locate the Library/Application Support/Developer/Shared/Xcode
folder in your home directory. Create a Project Templates folder there and move the Ap-
plication folder from the Desktop into that folder. When you next launch Xcode, it adds a
new User Templates section and lists your version of the Application templates there, as
shown in Figure 2-25.

Selecting a template from User Templates rather than from iPhone OS loads your cus-
tomized version, complete with the patched Info.plist. When you create new projects this
way, you ensure that the application identifier has been preset to match your provisions.
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OO New Project
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Figure 2-25 Xcode lets you create new projects from custom User
Templates. These templates are stored in your home library folder in a special
Xcode directory.

Building Other Templates

There’s a lot more you can do with custom templates than just editing a single string.
Think of user templates as a jumping off point for any project development you can think
of.You can add custom images like your company logo or often-used classes. Any materi-
als added to a template become available to Xcode to clone into new projects. If you find
yourself repeating the same customization tasks again and again with Apple’s templates, a
custom template will save you those steps. Custom templates can save you a lot of work.
By carefully going through the project initialization process once, you can build on that
well-executed start for all your projects.

Survey the existing templates. Copy whichever template best matches your goal onto
your desktop. Adapt the folder by editing, trimming, and/or augmenting the files within.
You need to update the project in Xcode to set it up.You might add Distribution and ad
hoc configurations including your ad hoc entitlement file. Avoid setting provisioning pro-
files in the Target Info window, however. Once a template hard codes a signing identity, it
becomes difficult to switch to other configurations. Perform however many edits you need.

Make sure that the template actually compiles and, if working with iPhone source, that
it runs properly in the simulator. Save your work and then delete the build folder. Also
delete the user-specific files in the xcodeproj subdirectory that contain your username.
(You need to delete these files again should you ever reedit your project.)
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Decide on a group name for your new template such as My Custom Templates. This
name refers to the group that owns the template rather than the template itself. This cor-
responds to the Application group used for Apple’s templates. Drag your edited template
into the new group folder. Rename the template folder meaningfully. The name of the
folder corresponds to the name of the template shown in Xcode.

To finish, update the template description in the TemplateInfo.plist in the xcodeproj
folder and, optionally, change the images in the TemplateIcons.icns file. Xcode ships with
an icon editor that lets you paste art into ICNS files if you want. Otherwise, the icon de-
faults to the standard image used by the template you copied.

After following these steps, you’ll have created custom templates that you can use in
Xcode to start new projects.You can share these templates with others by zipping up their
folders. It’s probably best to zip starting at the template group level and then drop them
into Project Templates folders.

One More Thing: Viewing Side-by-Side Code

When building new classes, it helps to open the header file and the method file right next
to each other. Rather than flipping back and forth between two separate windows, Xcode
offers a nifty trick that lets you edit both together. To accomplish this, start by opening the
.m file in a standard editor.

Locate the top-right corner of the edit area, just under the Ungrouped and Project
buttons. There, you see several icons in the corner. The corner is shaped like a lock and
just underneath it is a bifurcated square. Hover your mouse over that square and confirm
that the tool tip says Click to Split the Editor View.

Press the Option key and with the key pressed, click that square. The Option-click
combination creates a vertical split rather than the default horizontal split normally intro-
duced by the button. Once split, notice the new button that appears under the split but-
ton. It’s a merge button, and when you're ready to do so, clicking it returns the window to
a single unsplit display. For now, leave the display split.

Next, move your mouse up and to the left of the lock corner square. The tool tip for
this button should read Go to Counterpart. This is used to switch between .h and .m
views. Click it. (Alternatively, press Command-Option-Up Arrow.) After doing so, the
screen updates, as shown in Figure 2-26, to display both the .m (at the left) and .h (at the
right) versions of a class definition file in a single editor. This provides you with both items
in a single window, making it simple to refer back and forth.

If you need to, you can resize the window and reapportion the two panes. The resize
bar occurs just to the right of the scrollbar for the left-hand view. It’s hard to see at first,
but when you move your mouse onto the right spot, the cursor updates to the double-
arrowed resizer. Click and drag to perform the resize.

Note

Command-double-click on any class or method to automatically load the associated
header file.
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Figure 2-26  Xcode lets you edit header and method class sources in a single window.

Summary

This chapter covered a lot of ground. From start to finish, you saw how to create, com-
pile, and debug Xcode projects.You were introduced to most of the major Xcode com-
ponents that you’ll use on a day-to-day basis, and you read about many of the different
ways you can produce and run iPhone projects. Here are some thoughts to take away
from this chapter.

= Although Xcode provides easy-to-use templates, think of them as a jumping oft
point not an endpoint.You can customize and edit projects however you want, and,
as you read in this chapter, you can turn those edited projects into new templates.

» Interface Builder makes it really easy to lay out views. Although technically, you're
producing the same method calls and property assignments as if you'd designed by
hand, IB’s elegant GUI transforms those design tasks into the visual domain, which
is a welcome place for many developers.

= Learning to navigate through Xcode’s in-program reference documentation is an
essential part of becoming an iPhone developer. No one can keep all that informa-
tion in his or her head. The more you master the documentation interface, the bet-
ter you’ll be at finding the class, method, or property you need to move forward.

= Everything changes. Subscribe to iPhone OS documentation in Xcode and ensure
that your documentation remains as up-to-date as possible.
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= Xcode’ built-in debugger and Instruments tools help you fix bugs faster than try-
ing to figure out everything by hand. The tools may seem complex at first but are
well worth mastering for day-to-day development.

= Get to know and love the Organizer pane. It gives you critical feedback for know-
ing which devices are connected and what state they are in. And the other tools, in-
cluding the screenshot utility and the console, just add to its power.

= Configurations help prevent repetitive work. Once set, a configuration lets you
choose how to compile and sign your application with a minimum of further effort.
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language for both the iPhone and for Mac OS X. It offers a powerful object-

oriented language that lets you build applications that leverage Apple’s Cocoa
and Cocoa Touch frameworks. In this chapter, you learn basic Objective-C skills that help
you get started with iPhone programming.You learn about interfaces, methods, proper-
ties, memory management, and more. To round things out, this chapter takes you beyond
Objective-C into Cocoa to show you the core classes you’ll use in day-to-day program-
ming and offers you concrete examples of how these classes work.

M ost iPhone development centers on Objective-C. It is the standard programming

The Objective-C Programming Language

Objective-C is a strict superset of ANSI C. C is a compiled, procedural programming lan-
guage developed in the early 1970s at AT&T. Objective-C, which was developed by Brad
J. Cox, adds object-oriented features to C, blending C language constructs with concepts
that originated in Smalltalk-80. Smalltalk 1s one of the earliest and best-known object-
oriented languages, which was developed at Xerox PARC. Cox layered Smalltalk’s object
and message passing system on top of standard C to create his new language. This allowed
programmers to continue using familiar C-language development while accessing object-
based features from within that language. In the late 1980s, Objective-C was adopted as
the primary development language for the NeXTStep operating system by Steve Jobs’s
startup computer company NeXT. NeXTStep became both the spiritual and literal
ancestor of OS X.The current version of Objective-C is 2.0, which was released in
October 2007 along with OS X Leopard.

Object-oriented programming brings features to the table that are missing in standard
C. Objects refer to data structures that are associated with a preset list of function calls.
Every object in Objective-C has instance variables, which are the fields of the data struc-
ture, and methods, which are the function calls the object can execute. Object-oriented
code uses these objects and methods to introduce programming abstractions that increase

code readability and reliability.
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Object-oriented programming lets you build reusable code units that can be decou-
pled from the normal flow of procedural development. Instead of relying on process flow,
object-oriented programs are developed around smart data structures provided by objects
and their methods. Cocoa Touch on the iPhone and Cocoa on Mac OS X offer a massive
library of these smart objects. Objective-C unlocks that library and lets you build on Ap-
ple’s toolbox to create effective, powerful applications with a minimum of effort and code.

Note

The iPhone’s Cocoa Touch class names that start with NS, such as NSString and

NSArray, hearken back to NeXT. NS stands for NeXTStep, the operating system that ran on
NeXT computers.

Classes and Objects

Objects are the heart of object-oriented programming.You define objects by building
classes, which act as object creation templates. In Objective-C, a class definition specifies
how to build new objects that belong to the class. So to create a “widget” object, you de-
fine the Widget class and then use that class to create new objects on demand.

Each class lists its instance variables and methods in a public header file using the stan-
dard C .h convention. For example, you might define a car object like the one shown in
Listing 3-1.The Car.h header file shown here contains the interface that declares how a
Car object is structured. Note that all classes in Objective-C should be capitalized.

Listing 3-1 Declaring the Car Interface (Car.h)

#import <Foundation/Foundation.h>
@interface Car : NSObject

int year;

NSString *make;

NSString *model;

- (void) setMake: (NSString *) aMake andModel: (NSString *) aModel
andYear: (int) aYear;

- (void) printCarInfo;

- (int) year;

@end

In Objective-C, the @ symbol is used to indicate certain keywords. The two items shown
here (einterface and @end) delineate the start and end of the class interface definition.
This class definition describes an object with three instance variables: year, make, and
model. These three items are declared between the braces at the start of the interface.

The year instance variable is declared as an integer (using int). Make and model are
strings, specifically instances of NSString. Objective-C uses this object-based class for the
most part rather than the byte-based C strings defined with char *.As you see through-
out this book, Nsstring offers far more power than C strings. With this class, you can find
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out a string’s length, search for and replace substrings, reverse strings, retrieve file exten-
sions, and more. These features are all built into the base Cocoa Touch object library.

This class definition also declares three public methods. The first is called
setMake:andModel :andYear:.This entire three-part declaration, including the colons, is
the name of that single method. That’s because Objective-C places parameters inside the
method name. In C, you'd use a function like setProperties (char *cl, char *c2,
int 1i).Objective-C’s approach, although heftier than the C approach, provides much
more clarity and self~documentation.You don’t have to guess what c1, c2, and i mean
because their use is declared directly within the name:

[myCar setMake:cl andModel:c2 andYear:i];

The three methods are typed as void, void, and int.As in C, these refer to the type of
data returned by the method. The first two do not return data, the third returns an integer.
In C, the equivalent function declaration to the second and third method would be void
printCarInfo() and int year() ;.

Using Objective-C’s method-name-interspersed-with-arguments approach can feel
odd to new programmers but quickly becomes a much-loved feature. There’s no need to
guess which argument to pass when the method name itself tells you what items go
where. In Objective-C, method names are also interchangeably called selectors. You see this
a lot in iPhone programming, especially when you use calls to performselector:, which
lets you send messages to objects at runtime.

Notice that this header file uses #import to load headers rather than #include. Im-
porting headers in Objective-C automatically skips files that have already been added.
This lets you add duplicate #import directives to your various source files without any
penalties.

Note

The code for this example, and all the examples in this chapter, is found in the sample code
for this book. See the Preface for details about downloading the book sample code from the
Internet.

Creating Objects

To create an object, you tell Objective-C to allocate the memory needed for the object
and return a pointer to that object. Because Objective-C is an object-oriented language,
its syntax looks a little different from regular C. Instead of just calling functions, you ask an
object to do something. This takes the form of two elements within square brackets, the
object receiving the message followed by the message itself, [object message].

Here, the source code sends the message alloc to the car class, and then sends the
message init to the newly allocated car object. This nesting is typical in Objective-C.

Car *myCar = [[Car alloc] init];
The “allocate followed by init” pattern you see here represents the most common way to

instantiate a new object. The class car performs the alloc method. It allocates a new
block of memory sufficient to store all the instance variables listed in the class definition,
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zeroes out any instance variables, and returns a pointer. The newly allocated block is called
an instance and represents a single object in memory.

Some classes, like views, use specialized initializers such as initwWithFrame:.You can
write custom ones like initWithMake: andModel: andYear:.The pattern of allocation
followed by initialization to create new objects holds universally. You create the object in
memory and then you preset any critical instance variables.

Memory Allocation

In this example, the memory allocated is 16 bytes in size. Notice that both make and
model are pointers, as indicated by the asterisk. In Objective-C, object variables point to
the object itself. The pointer is 4 bytes in size. So sizeof (myCar) returns 4. The object
consists of two 4-byte pointers, one integer, plus one additional field that does not derive
from the car class.

That extra field is from the Nsobject class. Notice NSObject at the right of the colon
next to the word Car in the class definition of Listing 3-1. Nsobject is the parent class of
Car, and car inherits all instance variables and methods from this parent. That means that
Car is a type of NSObject and any memory allocation needed by NSobject instances is in-
herited by the car definition. So that’s where the extra 4 bytes come from.

The final size of the allocated object is 16 bytes in total. That size includes two 4-byte
NSString pointers, one 4-byte int, and one 4-byte allocation inherited from NSObject.
You can easily print out the size of objects using C’s sizeof function.This code uses stan-
dard C printf statements to send text information to the console. print f commands
work just as well in Objective-C as they do in ANSI C.

NSObject *object = [[NSObject alloc] init];
Car *myCar = [[Car alloc] init];

// This returns 4, the size of an object pointer
printf ("object pointer: %d\n", sizeof (object));

// This returns 4, the size of an NSObject object
printf ("object itself: %d\n", sizeof (*object));

// This returns 4, again the size of an object pointer
printf ("myCar pointer: %d\n", sizeof (myCar));

// This returns 16, the size of a Car object
printf ("myCar object: %d\n", sizeof (*myCar));

Releasing Memory

In C, you allocate memory with malloc () or a related call and free that memory with
free (). In Objective-C, you allocate memory with alloc and free it with release. (In
Objective-C, you can also allocate memory a few other ways, such as by copying other
objects.)
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[object release];
[myCar release];

As discussed in Chapter 2, “Building Your First Project,” releasing memory is a little more
complicated than in standard C.That’s because Objective-C uses a reference-counted
memory system. Each object in memory has a retain count associated with it.You can see
that retain count by sending retainCount to the object. Every object is created with a re-
tain count of 1. Sending release reduces that retain count by one. When the retain count
for an object reaches zero, it is released into the general memory pool.

Car *myCar = [[Car alloc] init];

// The retain count is 1 after creation
printf ("The retain count is %d\n", [myCar retainCount]) ;

// This reduces the retain count to 0
[myCar release];

// This causes an error. The object has already been freed
printf ("Retain count is now %d\n", [myCar retainCount]) ;

Sending messages to freed objects will crash your application. When the second printf
executes, the retainCount message is sent to the already-freed mycar. This creates a mem-
ory access violation, terminating the program.

The retain count is 1

objc[10754] : FREED(id): message retainCount sent to freed
object=0xdle520

There is no garbage collection on the iPhone. As a developer, you must manage your ob-
jects. Keep them around for the span of their use and free their memory when you are
finished. R ead more about basic memory management strategies later in this chapter.

Methods, Messages, and Selectors

In standard C, you'd perform two function calls to allocate and initialize data. Here is how
that might look, in contrast to Objective-C’s [[Car alloc] init] statement.

Car *myCar = malloc (sizeof (Car));
init (myCar) ;

Objective-C doesn’t use function_name (argument) syntax. Instead, you send messages to
objects using square brackets. Messages tell the object to perform a method. It is the ob-
ject’s responsibility to implement that method and produce a result. The first item within
the brackets is the receiver of the message, the second item is a method name, and possibly
some arguments to that method that together define the message you want sent. In C, you
might write

printCarInfo (myCar) ;
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but in Objective-C, you say:

[myCar printCarInfol];

Despite the difference in syntax, methods are basically functions that operate on objects.
They are typed using the same types available in standard C. Unlike function calls,
Objective-C places limits on who can implement and call methods. Methods belong to
classes. And the class interface defines which of these are declared to the outside world.

Dynamic Typing

Objective-C uses dynamic typing in addition to static typing. Static typing restricts a vari-
able declaration to a specific class at compile time. With dynamic typing, the runtime sys-
tem, not the compiler, takes responsibility for asking objects what methods they can
perform and what class they belong to. That means you can choose what messages to send
and which objects to send them to as the program runs. This is a powerful feature, one
that is normally identified with interpreted systems like Lisp. You can choose an object,
programmatically build a message, and send the message to the object all without knowing
which object will be picked and what message will be sent at compile time.

With power, of course, comes responsibility. You can only send messages to objects that
actually implement the method described by that selector (unless that class can handle
messages that don’t have implementations by implementing Objective-C invocation for-
warding, which is discussed at the end of this chapter). Sending printCarInfo to an array
object, for example, causes a runtime error and crashes the program. Arrays do not define
that method. Only objects that implement a given method can respond to the message
properly and execute the code that was requested.

2009-05-08 09:04:31.978 HelloWorld[419:20b] *** -[NSCFArray printCarInfo]:
wunrecognized selector sent to instance 0xdl4e80

2009-05-08 09:04:31.980 HelloWorld[419:20b] *** Terminating app due to uncaught
wmexception 'NSInvalidArgumentException’, reason: '*x* - [NSCFArray
wprintCarInfo] : unrecognized selector sent to instance 0xdl4e80'

During compilation, Objective-C performs object message checks using static typing. The
array definition in Figure 3-1 is declared statically, telling the compiler that the object in
question is of type (NSArray *).When the compiler finds objects that may not be able to
respond to the requested methods, it issues warnings.

A¢ Uncomment this to bomb by sending a messoge to on object

A7 thot does not implement that selector|

MNSarroy #*array = [NSArroy arroy];

[array printCarinfo]; £ "NSArray' may not respend to '-printCarlnfo’

Figure 3-1 Xcode’s Objective-C issues warnings when it finds a
method that does not appear to be implemented by the receiver.
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These warnings do not make the compilation fail, and it’s possible that this code could
run without error if NSArray implemented printCarInfo and did not declare that imple-
mentation in its published interface. Since NSArray does not, in fact, implement this
method, running this code produces the actual runtime crash shown previously.
Objective-C’s dynamic typing means you can point to the same kind of object in sev-
eral different ways. Although array was declared as a statically typed (NSarray *) object,
that object uses the same internal object data structures as an object declared as id. The id
type can point to any object, regardless of class, and is equivalent to (NsObject *).This
following assignment is valid and does not generate any warnings at compile time.

NSArray *array = [NSArray arrayl;
// This assignment is valid
id untypedvariable = array;

To further demonstrate, consider a mutable array. The NSMutableArray class is a subclass
of NSArray. The mutable version offers arrays that you can change and edit. Creating and
typing a mutable array but assigning it to an array pointer compiles without error. Al-
though anotherarray is statically typed as NSArray, creating it in this way produces an
object at runtime that contains all the instance variables and behaviors of the mutable ar-
ray class.

NSArray *anotherArray = [NSMutableArray array];
// This mutable-only method call is valid but
// produces a compile-time warning
[anotherArray addObject:@"Hello World"];

What produces a warning here is not the creation and assignment. It’s the use. Sending
addObject: to anotherArray uses our knowledge that the array is, in fact, mutable de-
spite the fact that it is statically typed as (NSArray *).That’s something the compiler does
not understand. This use generates a compile-time warning, namely ““NSArray’ may not
respond to ‘~addObject:” At runtime, however, the code works without error.

While assigning a child class object to a pointer of a parent class generally works at
runtime, it’s far more dangerous to go the other way. A mutable array is a kind of array. It
can receive all the messages that arrays do. Not every array, on the other hand, is mutable.
Sending the addobject : message to a regular array is lethal. Doing so bombs at runtime,
as arrays do not implement that method.

NSArray *standardArray = [NSArray arrayl;
NSMutableArray *mutableArray;

// This line produces a warning
mutableArray = standardArray;

// This will bomb at run-time
[mutableArray addObject:@"Hello World"];

The code seen here produces just one warning, at the line where the standard array object is
assigned to the mutable array pointer, namely “assignment from distinct Objective-C type.”
Parent-to-child assignments do not generate this warning. Child-to-parent assignments do.
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So do assignments between completely unrelated classes. Do not ignore this warning; fix
your code. Otherwise, you're setting yourself up for a runtime crash. Because Objective-C is
a compiled language that uses dynamic typing, it does not perform many of the runtime
checks that interpreted object-oriented languages do.

Note

In Xcode, you can set the compiler to treat warnings as errors by setting the
GCC_TREAT_WARNINGS_AS_ERRORS flag in the Project Info > Build > User-Defined panel.
Because Objective-C is so dynamic, the compiler cannot catch every problem that might
crash at runtime the way static language compilers can. So pay special attention to warnings
and try to eliminate them.

Inheriting Methods

As with data, objects inherit method implementations as well as instance variables. A car
is a kind of NSObject, so it can respond to all the messages that an NSObject responds to.
That’s why myCar can be allocated and initialized with alloc and init.These methods
are defined by Nsobject. Therefore, they can be used by any instance of car, which is de-
rived from the NSobject class.

Similarly, NSMutableArray instances are a kind of NSArray. All array methods can be
used by mutable arrays, their child class.You can count the items in the array, pull an ob-
ject out by its index number, and so forth.

A child class may override a parent’s method implementation, but it can’t negate that
the method exists. Child classes always inherit the full behavior and state package of their
parents.

Declaring Methods

As Listing 3-1 showed, a class interface defines the instance variables and methods that a
new class adds to its parent class. This interface is normally placed into a header file,
which is named with a .h extension. The interface from Listing 3-1 declared three meth-
ods, namely

- (void) setMake: (NSString *) aMake andModel: (NSString *) aModel
andYear: (int) aYear;

- (void) printCarInfo;

- (int) year;

These three methods, respectively, return void, void, and int. Notice the dash that starts
the method declaration. It indicates that the methods are implemented by object in-
stances. For example, you call [myCar year] and not [Car year].The latter sends a mes-
sage to the car class rather than an actual car object. A discussion about class methods
(indicated by “+” rather than “-”) follows later in this section.

As mentioned earlier, methods calls can be complex. The following invocation sends a

method request with three parameters. The parameters are interspersed inside the method
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invocation. The name for the method, that is, its selector, is setMake: andModel :
andyear:.The three colons indicate where parameters should be inserted. The types for
each parameter are specified in the interface after the colons, namely (NSString *),
NSString *),and (int).As this method returns void, the results are not assigned to a
variable.

[myCar setMake:@"Ford" andModel:@"Prefect" andYear:1946];

Implementing Methods

Together, a method file and a header file pair store all the information needed to imple-
ment a class and announce it to the rest of an application. The implementation section of a
class definition provides the code that implements functionality. This source is usually
placed in a .m (m is for “method”) file.

Listing 3-2 shows the implementation for the Car class example. It codes all three
methods declared in the header file from Listing 3-1 and adds a fourth. This extra method
redefines init.The Car version of init sets the make and model of the car to nil, which
is the NULL pointer for Objective-C objects. It also initializes the year of the car to
1901.

The special variable self refers to the object that is implementing the method. That
object is also called the receiver, that is, the object that receives the message. This variable
is made available by the underlying Objective-C runtime system. In this case, self refers to
the current instance of the Car class. Calling [self message] tells Objective-C to send a
message to the object that is currently executing the method.

Several things are notable about the init method seen here. First, the method returns a
value, which is typed to (id).As mentioned earlier in this chapter, the id type is more or
less equivalent to (NSobject *),although it’s theoretically slightly more generic than
that. It can point to any object of any class (including Class objects themselves).You return
results the same way you would in C, using return.The goal of init is to return a prop-
erly initialized version of the receiver via return self.

Second, the method calls [super init].This tells Objective-C to send a message
to a different implementation, namely the one defined in the object’s superclass. The
superclass of Car is NSObject, as shown in Listing 3-1.This call says “please perform
the initialization that is normally done by my parent class before I add my custom
behavior.”

Finally, notice the check for if (!self).In rare instances, memory issues arise. In such
a case, the call to [super init] returns nil. If so, this init method returns before setting
any instance variables. Since a nil object does not point to allocated memory, you cannot
access instance variables within nil.

As for the other methods, they use year, make, and model as if they were locally de-
clared variables. As instance variables, they are defined within the context of the current
object and can be set and read as shown in this example. The UTF8String method that is
sent to the make and model instance variables converts these NSString objects into C
strings, which can be printed using the %s format specifier.
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Note

You can send any message to nil, for example, [nil anyMethod]. The result of doing so is,
in turn, nil. (Or, more accurately, O casted as nil.) In other words, there is no effect. This be-
havior lets you nest method invocations with a failsafe should any of the individual methods
fail and return nil. If you were to run out of memory during an allocation with [ [Car alloc]
init], the init message would be sent to nil, allowing the entire alloc/init request to
return nil in turn.

Listing 3-2 The Car Class Implementation (Car.m)

#import "Car.h"

@implementation Car

- (id) init

{
self = [super init];
if (!self) return nil;

make = nil;
model = nil;
year = 1901;

return self;

- (void) setMake: (NSString *) aMake andModel: (NSString *) aModel
andYear: (int) aYear

make = [NSString stringWithString:aMake];
model = [NSString stringWithString:aModel] ;
year = aYear;

- (void) printCarInfo

if (!make) return;
if (!model) return;

printf ("Car Info\n");

"Make: %s\n", [make UTF8String]);
"Model: %s\n", [model UTF8String]);
printf ("Year: %d\n", year);

printf

(
(
printf (
(

- (int) year

{

return year;

}

@end
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Class Methods

Class methods are defined using a plus (+) prefix rather than a hyphen (). They are de-
clared and implemented in the same way as instance methods. For example, you might
add the following method declaration to your interface:

+ (NSString *) motto;

and code it up in your implementation:

+ (NSString *) motto

{

return (@"Ford Prefects are Mostly Harmless");

}

Class methods difter from instance methods in that they generally cannot use state. That is,
they have no access to instance variables because those elements are only created when
objects are allocated from memory.

So why use class methods at all? The answer is threefold. First, class methods produce
results without having to instantiate an actual object. This motto method produces a hard-
coded result that does not depend on access to variables. Convenience methods like this
often have a better place as classes rather than instance methods.

You might imagine a class that handles geometric operations. The class could imple-
ment a conversion between radians and angles without needing an instance, for example,
[GeometryClass convertAngleToRadians:theta];.Simple C functions declared in
header files also provide a good match to this need.

The second reason is that class methods can hide a singleton. Singletons refer to stati-
cally allocated instances. The iPhone SDK is full of these. For example, [UIApplication
sharedApplication] returns a pointer to the singleton object that is your application.
[UIDevice currentDevice] retrieves an object representing the hardware platform
you're working on.

Combining a class method with a singleton lets you access that static instance anywhere
in your application.You don’t need a pointer to the object or an instance variable that
stores it. The class method pulls that object’s reference for you and returns it on
demand.

Third, class methods tie into memory management schemes. Consider allocating a new
NSArray.You do so via [ [NSArray alloc] init], or you can use [NSArray arrayl.
This latter class method returns an array object that has been initialized and set for autore-
lease. As you read about later in this chapter, Apple has provided a standard about class
methods that create objects. They always return those objects to you already autoreleased.
Because of that, this class method pattern is a fundamental part of the standard iPhone
Mmemory management system.

Fast Enumeration

Fast enumeration was introduced in Objective-C 2.0 and offers a simple and elegant way
to enumerate through collections like arrays and sets. It adds a for-loop that iterates
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through the collection using concise for/in syntax. The enumeration is very efficient,
running quickly. It is also safe. Attempts to modify the collection as it’s being enumerated
raise a runtime exception.
NSArray *colors = [NSArray arrayWithObjects:

@"Black", @"Silver", @"Gray", nill;
for (NSString *color in colors)

printf ("Consider buying a %s car", [color UTF8String]);

Note

Use caution when using methods like arrayWithObjects: or
dictionaryWithKeysAndValues: as being unnecessarily error-prone. Developers often
use these methods with instance variables without first checking that these values are
non-nil.

Class Hierarchy

In Objective-C, each new class is derived from an already-existing class. The car class de-
scribed in Listings 3-1 and 3-2 is formed from NSObject, the root class of the Objective-
C class tree. Each subclass adds or modifies state and behavior that it inherits from its
parent, also called its superclass. The car class adds several instance variables and methods
to the vanilla NSObject it inherits.

Figure 3-2 shows some of the classes found on the iPhone and how they relate to each
other in the class hierarchy. Strings and arrays descend from NSObject as does the
UIResponder class. UIResponder is the ancestor of all onscreen iPhone elements.Views,
labels, text fields, and sliders are children, grandchildren, or other descendants of
UIResponder and NSObject.

Every class other than NSobject descends from other classes. UITextField is a kind of
UIControl, which is in turn a kind of UIView, which is a UIResponder, which is an
NsObject. Building into this object hierarchy 1s what Objective-C is all about. Child
classes can

= Add new instance variables that are not allocated by their parent, also called the
superclass. The car class adds three: the make and model strings, and the year
integer.

» Add new methods that are not defined by the parent. car defines several new meth-
ods, letting you set the values of the instance variables and print out a report about
the car.

» Override methods that the parents have already defined. The car class’s init

method overrides NsObject’s version. When sent an init message, a car object runs
its version, not NSObject’s. At the same time, the code for init makes sure to call
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NSObject’s init method via [super init].Referencing a parent’s implementa-
tion, while extending that implementation, is a core part of the Objective-C design

philosophy.
NSObject
NSArray NSString UIResponder
I
UlView

|

UlLabel UlControl
I

UlTextField UlSlider

Figure 3-2  All Cocoa Touch classes are descended from NSObject, the root
of the class hierarchy tree.

Logging Information

Now that you’ve read the basics about classes and objects, it’s important to understand
how to log information about them. In addition to print£, Objective-C offers a funda-
mental logging function called NsLog. This function works like printf and uses a similar
format string, but it outputs to stderr instead of stdout. NSLog also uses an NSString
format string rather than a C string one.

NSStrings are declared differently than C strings. They are prepended with the @ (at)
symbol. A typical NSString looks @ “like this”; the equivalent C string looks “like this”,
omitting the @.Whereas C strings refer to a pointer to a string of bytes, NSStrings are
objects.You can manipulate a C string by changing the values stored in each byte.
NSStrings are immutable; you cannot access the bytes to edit them, and the actual string
data is not stored within the object.

// This is 12 bytes of addressable memory
printf ("$d\n", sizeof ("Hello World"));

103



104

Chapter 3 Objective-C Boot Camp

// This 4-byte object points to non-addressable memory
NSString *string = @"Hello World";
printf ("$d\n", sizeof (*string));

In addition to using the standard C format specifiers, NSLog introduces an object specifier,
3@, which lets you print objects. This allows you to transform

printf ("Make: %s\n", [make UTF8String]);
into
NSLog (@"Make: %@", make);

Table 3-1 shows some of the most common format specifiers. This is far from an exhaus-
tive list, so consult Apple’s String Programming Guide for Cocoa for more details.

Table 3-1 Common String Format Specifiers

Specifier Meaning

o°

@ Objective-C object using the description or descriptionWithLocale:
results

The “%” literal character

Signed integer (32-bit)

Unsigned integer (32-bit)

Floating-point (64-bit)

Floating-point printed using exponential (scientific) notation (64-bit)
Unsigned char (8-bit)

Unicode char (16-bit)

Null-terminated char array (string, 8-bit)

o d° o o° o° o° o°
[@ ¢! [0 Hh c Q. oe

o°
n

Null-terminated Unicode char array (16-bit)

o
n

Pointer address using lowercase hex output, with a leading Ox

o
o)

Lowercase unsigned hex (32-bit)

o
»

I
b

Uppercase unsigned hex (32-bit)

Notice that NSLog does not require a hard-coded return character. It automatically ap-
pends a new line when used. What’s more it adds a time stamp to every log, so the results
of the NSLog invocation shown previously look something like this:

2009-05-07 14:19:08.792 HelloWorld[11197:20b] Make: Ford

Nearly every object converts itself into a string via the description message. NSLog uses
description to show the contents of objects formatted with $@.This returns an NSString
with a textual description of the receiver object.You can describe objects outside of NSLog
by sending them the same description method. This is particularly handy for use with
printf and fprintf, which cannot otherwise print objects.
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fprintf (stderr, "%s\n", [[myCar description] UTF8String]) ;

Another useful logging function is called cFshow (). It takes one argument, an object, and
prints out a snapshot description of that object to stderr.

CFShow (make) ;

Like NSLog, CFShow sends description to the objects it displays. Unlike NSLog, however,
cFshow does not clutter your debugging console with time stamps, so it appeals to anyone
who prefers to skip that extra information. cFshow doesn’t require format strings, which
simplifies adding them to code, but they can only be used with objects.You cannot
CFShow an integer or float.

Properties

Properties expose class variables and methods to outside use through what are called
accessor methods, that is, methods that access information. Using properties might sound re-
dundant. After all, the class definition shown in Listing 3-1 already announces public meth-
ods. So why use properties? It turns out that there are advantages to using properties over
hand-built methods, not the least of which are dot notation and memory management.

Dot Notation

Dot notation allows you to access object information without using brackets. Instead of
calling [myCar year] to recover the year instance variable, you use myCar.year. While
this may look as if you're directly accessing the year instance variable, you’re not. Proper-
ties always invoke methods. These in turn can access an object’s data. So you're not, strictly
speaking, breaking an object’s encapsulation as properties rely on these methods to bring
data outside the object.

Due to method hiding, properties simplify the look and layout of your code. For exam-
ple, you can access properties to set a table’s cell text via

myTableViewCell.textLabel.text = @"Hello World";

rather than the more cumbersome

[ [myTableViewCell textLabel] setText:@"Hello World"];

The property version of the code is more readable and ultimately easier to maintain.

Properties and Memory Management

Properties simplify memory management.You can create properties that automatically re-
tain instance variables for the lifetime of your objects and release them when you set those
variables to nil. Setting a retained property ensures that memory will not be released until
you say so.

The arrayWithObjects: method normally returns an autoreleased object, whose
memory is deallocated at the end of the event loop cycle. (See Chapter 1, “Introducing
the iPhone SDK,” for details about autorelease pools. A deeper discussion about memory
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management follows later in this chapter.) Assigning the array to a retained property
means that the array will stick around indefinitely.

self.colors = [NSArray arrayWithObjects:
@"Gray", @"Silver", @"Black"];

When you're done using the array and want to release its memory, set the property to nil.
This approach works because Objective-C knows how to synthesize accessor methods,
creating properly managed ways to change the value of an instance variable.You're not re-
ally setting a variable to nil.You're actually telling Objective-C to run a method that re-
leases any previously set object and then sets the instance variable to nil. All this happens
behind the scenes. From a coding point of view, it simply looks as if you’re assigning a
variable to nil.

self.colors = nil;

As a rule, do not send release directly to retained properties, that is, [self.colors
release].This does not affect the colors instance variable assignment, which now points
to memory that is likely deallocated. When you next assign an object to the retained prop-
erty, the memory pointed to by self.colors will receive an additional release message, likely
causing a crash due to a double-free exception.

Creating Properties

There are two basic styles of properties, readwrite and readonly. Read-write properties,
which are the default, let you modify the values you access; read-only properties do not.
The two kinds of accessor methods you must provide are called setters and getters.

Setters set information; getters retrieve information.You can define these with arbitrary
method names or you can use the standard Objective-C conventions: The name of the in-
stance variable retrieves the object, while the name prefixed with set, sets it. Objective-C
can even synthesize these methods for you. For example, if you declare a property such as
the Car class’s year in your class interface as such

@property int year;

and then synthesize it in your class implementation with

@synthesize year;

you can read and set the instance variable with no further coding. Objective-C builds two

methods that get the current value (that is, [myCar year]) and sets the current value (that
is, [myCar setYear:1962]) and adds the two dot notation shortcuts:

myCar.year = 1962;

NSLog (@"%d", myCar.year);

To build a read-only property, declare it in your interface using the readonly attribute.
Read-only properties use getters without setters. For example, here’s a property that re-
turns a formatted text string with car information:

@property (readonly) NSString *carInfo;
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Although Objective-C can synthesize read-only properties, you can also build the getter
method by hand and add it to your Class implementation. This method returns a descrip-
tion of the car via stringWithFormat :, which uses a format string a la sprintf to create
a new string.

- (NSString *) carInfo

{

if (!self.make) return @"";

if (!self.model) return @"";

return [NSString stringWithFormat:
@"Car Info\nMake: %@nYear: % %d",
self.make, self.model, self.year];

}

This method now becomes available for use via dot notation, for example,
CFShow (myCar.carInfo) ;.

If you choose to synthesize a getter for a read-only property, you should use care in
your code. Inside your implementation file, make sure you assign the instance variable for
that property without dot notation. Imagine that you declared model as a read-only prop-
erty.You could assign model with

model = @"Prefect";

but not with

self.model = @"Prefect";

The latter use attempts to call setModel :, which is not defined for a read-only property.

Creating Custom Getters and Setters

Although Objective-C automatically builds methods when you @synthesize properties,
you may skip the synthesis.You can create those methods yourself. For example, you could
build methods as simple as these. Notice the capitalization of the second word in the set
method. By convention, Objective-C expects setters to use a method named
setInstance: where the first letter of the instance variable name is capitalized.

- (int) year

{

return year;

- (void) setYear: (int) aYear

{

year = aYear;

}
When building your own setters and getters, you might add some basic memory manage-
ment. The following methods retain new items and release previous values.

- (NSString *) model

{
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return model;

- (void) setModel: (NSString *) newModel

{

if (newModel != model) ({
[model release];
model = [newModel retain];
}
}
Note

In the remote case that newModel is somehow a child of model, calling [model releasel
may free the memory of new model. For that reason, a more complete setter method retains
newModel before calling [model releasel].

Or you could go even further by building more complicated routines that generate side
effects upon assignment and retrieval. For example, you might keep a count of the number
of times the value has been retrieved or changed, or send in-app notifications to other ob-
jects. The Objective-C compiler remains happy so long as it finds, for any property, a get-
ter (typically named the same as the property name) and a setter (usually setName: where
name is the name of the property). What’s more, you can bypass any Objective-C naming
conventions by specifying setter and getter names in the property declaration. This decla-
ration creates a new Boolean property called forsale and declares a custom getter/setter
pair. As always, you add any property declarations to the class interface.

@property (getter=isForSale, setter=setSalable:) BOOL forSale;

Then synthesize the methods as normal in the class implementation. The implementation
is typically stored in the .m file that accompanies the .h header file.

@synthesize forSale;

Using this approach creates both the normal setter and getter via dot notation plus the
two custom methods, isForSale and setSalable:. Oddly, while you can use dot nota-
tion to assign and retrieve forSale, you cannot use the equivalent methods, and you can-
not use the customized setter in dot notation. Here is how the usage breaks down.

Car *myCar = [Car car];

// You can use the synthesized setter and getter of course
[myCar setSalable:YES];
printf ("The car %s for sale\n",

myCar.isForSale ? "is" : "is not");

// The normal getter and setter still work in dot notation
myCar.forSale = NO;
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printf ("The car %s for sale\n",
myCar.forSale ? "is" : "is not");

// But not the method versions.

// These produce run-time errors

// [myCar setForSale:YES];

// printf ("The car %s for sale\n",

// [myCar forSale] ? "is" : "is not");

// You cannot use the customized setter via dot notation.
// This produces a compile-time error
// myCar.setSalable = YES;

Property Attributes

In addition to readwrite and readonly attributes, you can specify whether a property is
retained and/or atomic. The default behavior for properties is assign. Assignment acts ex-
actly as if you’d assigned a value to an instance variable. There’s no special retain/release
behavior associated with the property, but by making it a property you expose the variable
outside the class via dot notation. A property that’s declared

@property NSString *make;

uses the assign behavior.

Setting the property’s attribute to retain does two things. First, it retains the passed
object upon assignment. Second, it releases the previous value before a new assignment is
made. Using the retain attribute introduces the memory management advantages dis-
cussed in the previous section. To create a retained property, add the attribute between
parentheses in the declaration:

@property (retain) NSString *make;
A third attribute called copy sends a copy message to the passed object, retains it, and
releases any previous value.

@property (copy) NSString *make;

You can also retain the object as you assign it.

myCar.make = @"Ford";
[myCar.make retain];

When you develop in a multithreaded environment, you want to use atomic methods.
Xcode synthesizes atomic methods to automatically lock objects before they are accessed
or modified and unlock them after. This ensures that setting or retrieving an object’s value
is performed fully regardless of concurrent threads. There is no atomic keyword. All meth-
ods are synthesized atomically by default.You can, however, state the opposite, allowing
Objective-C to create accessors that are nonatomic.

@property (nonatomic, retain) NSString *make;

109



110

Chapter 3 Objective-C Boot Camp

Marking your properties nonatomic does speed up access, but you might run into prob-
lems should two competing threads attempt to modify the same property at once. Atomic
properties, with their lock/unlock behavior, ensure that an object update completes from
start to finish before that property is released to another read or change.

Simple Memory Management

Memory management comes down to two simple rules. At creation, every object has a re-
tain count of one. At release, every object has a retain count of zero. It is up to you as a
developer to manage an object’s retention over its lifetime. You should ensure that it moves
from start to finish without being prematurely released and guarantee that it does finally
get released when it is time to do so. Complicating matters is Objective-C’s autorelease
pool. If some objects are autoreleased and others must be released manually, how do you
best control your objects? Here’s a quick and dirty guide to getting your memory man-
agement right.

Creating Objects

Any time you create an object using the alloc/init pattern, you build it with a retain count
of one. It doesn’t matter which class you use or what object you build, alloc/init produces
a +1 count.

id myObject = [[SomeClass alloc] init];

For locally scoped variables, if you do not release the object before the end of a method,
the object leaks.Your reference to that memory goes away, but the memory itself remains
allocated. The retain count remains at +1.

- (void) leakyMethod

{
// This is leaky
NSArray *array = [[NSArray alloc] init];

}

The proper way to use an alloc/init pattern is to create, use, and then release. Releasing
brings the retain count down to 0. When the method ends, the object is deallocated.

- (void) properMethod

{
NSArray *array = [[NSArray alloc] init];
// use the array here
[array releasel;

}

Autorelease objects do not require an explicit release statement for locally scoped vari-
ables. (In fact, avoid doing so to prevent double-free errors that will crash your program.)
Sending the autorelease message to an object marks it for autorelease. When the auto-
release pool drains at the end of each event loop, it sends release to all the objects it owns.
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- (void) anotherProperMethod

{

NSArray *array = [[[NSArray alloc] init] autorelease];
// This won’t crash the way release would

printf ("Retain count is %d\n", [array retainCount]) ;
// use the array here

}

By convention, all class object-creation methods return an autoreleased object. The
NsArray class method array returns a newly initialized array that is already set for auto-
release. The object can be used throughout the method, and its release is handled when
the autorelease pool drains.

- (void) yetAnotherProperMethod

{

NSArray *array = [NSArray arrayl;
// use the array here

}

At the end of this method, the autoreleased array can return to the general memory pool.

Creating Autoreleased Objects

As a rule, whenever you ask another method to create an object, it’s good programming
practice to return that object autoreleased. Doing so consistently lets you follow a simple
rule: “If I didn’t allocate it, then it was built and returned to me as an autorelease object.”

- (Car *) fetchACar

{
Car *myCar = [[Car alloc] init];

return [myCar autoreleasel];

}

This holds especially true for class methods. By convention all class methods that create
new objects return autorelease objects. These are generally referred to as convenience
methods. Any object that you yourself allocate is not set as autorelease unless you specify
it yourself.

// This is not autoreleased
Car *carl = [[Car alloc] init];

// This is autoreleased
Car *car2 = [[[Car alloc] init] autorelease];

// By convention, this *should* be an autoreleased object
Car *car3 = [Car car];

To create a convenience method at the class level, make sure to define the class with the +
prefix instead of - and return the object after sending autorelease to it.
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+ (Car *) car

{

return [[[Car alloc] init] autorelease];

Autorelease Object Lifetime
So how long can you use an autorelease object? What guarantees do you have? The hard
and fast rule is that the object is yours until the next item in the event loop gets
processed. The event loop is triggered by user touches, by button presses, by “time passed”
events, and so forth. In human reckoning these times are impossibly short; in the iPhone’s
processor frame of reference, they’re quite large. As a more general rule, you can assume
that an autoreleased object should persist throughout the duration of your method call.
Once you return from a method, guarantees go out the window. When you need to
use an array beyond the scope of a single method or for extended periods of time (for ex-
ample, you might start a custom run-loop within a method, prolonging how long that
method endures), the rules change. You must retain autorelease objects to increase their
count and prevent them from getting deallocated when the pool drains; when the auto-
release pool calls release on their memory, they’ll maintain a count of at least +1.

Note

Avoid assigning properties to themselves, for example, myCar.colors = myCar.colors.
The release-then-retain behavior of properties may cause the object to deallocate before it
can be reassigned and re-retained.

Retaining Autorelease Objects

You can send retain to autorelease objects just like any other object. Retaining objects
set to autorelease allows them to persist beyond a single method. Once retained, an auto-
release object is just as subject to memory leaks as one that you created using alloc/1init.
For example, retaining an object that’s scoped to a local variable might leak, as shown here.

- (void)anotherLeakyMethod

{

// After returning, you lose the local reference to
// array and cannot release.

NSArray *array = [NSArray array];

[array retain];

}

Upon creation, array has a retain count of +1. Sending retain to the object brings that
retain count up to +2. When the method ends and the autorelease pool drains, the object
receives a single release message; the count returns to +1. From there, the object is
stuck. It cannot be deallocated with a +1 count and with no reference left to point to the
object, it cannot be sent the final release message it needs to finish its life cycle. This is
why it’s critical to build references to retained objects.
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By creating a reference, you can both use a retained object through its lifetime and be
able to release it when you’re done. Set references via an instance variable (preferred) or a
static variable defined within your class implementation. If you want to keep things simple
and reliable, use retained properties built from those instance variables. The next section
shows you how retained properties work and demonstrates why they provide a solution of
choice for developers.

Retained Properties

Retained properties hold onto data that you assign to them and properly relinquish that
data when you set a new value. Because of this, they tie in seamlessly to basic memory man-
agement. Here’s how you create and use retained properties in your iPhone applications.

First, declare your retained property in the class interface by including the retain key-
word between parentheses.

@property (retain) NSArray *colors;

Then synthesize the property methods in your implementation.

@synthesize colors;

When given the @esynthesize directive, Objective-C automatically builds routines that
manage the retained property. The routines automatically retain an object when you assign
it to the property. That behavior holds regardless of whether the object is set as auto-
release. When you reassign the property, the previous value is automatically released.

Assigning Values to Retained Properties

‘When working with retained properties, you need to be aware of two patterns of assign-
ment. These patterns depend on whether you’re assigning an autorelease object. For au-
torelease style objects, use a simple single assignment. This assignment sets the colors
property to the new array and retains it.

myCar.colors = [NSArray arrayWithObjects:
@"Black", @"Silver", @"Gray", nill;

The array is created and returned as an autorelease object with a count of +1.The assign-
ment to the retained colors property brings the count to +2. Once the current event
loop ends, the autorelease pool sends release to the array, and the count drops back to +1.

For normal (nonautorelease) objects, release the object after assigning it. Upon cre-
ation, the retain count for a normally allocated object is +1. Assigning the object to a re-
tained property increases that count to +2. Releasing the object returns the count to +1.
// Non-autorelease object. Retain count is +1 at creation

NSArray *array = [[NSArray alloc]
initWithObjects:@"Black", @"Silver", @"Gray", nil];

// Count rises to +2 via assignment to a retained property
myCar.colors = array;
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// Now release to get that retain count back to +1
[array releasel;

You often see this pattern of create, assign, release in iPhone development.You might use
it when assigning a newly allocated view to a view controller object. For example:
UIView *mainView = [[UIView alloc] initWithFrame:aFrame];

self.view = mainView;

[mainView release] ;

These three steps move the object’s retain count from +1 to +2 and back to +1.

A final count of +1 guarantees you that can use an object indefinitely. At the same
time, you’re assured that the object deallocates properly when the property is set to a new
value and release is called on its prior value. That release brings the count down from +1
to 0, and the object automatically deallocates.

Reassigning a Retained Property

When you're done using a retained property, regardless of the approach used to create that
object, set the property to nil or to another object. This sends a release message to the pre-
viously assigned object.

myCar.colors=nil;

If the colors property had been set to an array, as just shown, that array would automati-
cally be sent a release message. Since each pattern of assignment produced a +1 retained
object, this reassignment would bring that retain count down from +1 to 0.The object’s
life would be over.

Avoiding Assignment Pitfalls

Within a class implementation, it’s handy to use properties to take advantage of this mem-
ory management behavior. To take advantage of this, avoid using instance variables di-
rectly. Direct assignment like this won'’t retain the array or release any previous value. This
is a common pitfall for new iPhone developers. Remember the dot notation when access-
ing the instance variables.

colors = [NSArray arrayWithObjects:
@"Black", @"Silver", @"Gray", nil];

This same caution holds true for properties defined as assign. Note the following behav-
ior carefully. Although both

@property NSArray *colors;

and

@property (assign) NSArray *colors;

allow you to use dot notation, assignment via these properties does not retain or release

objects. Assign properties expose the colors instance variable to the outside world, but
they do not provide the same memory management that retain properties do.
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Note

As a general rule of thumb, Apple recommends you avoid using properties in your init func-
tions. Instead, use instance variables directly.

High Retain Counts

Retain counts that go and stay above +1 do not necessarily mean you’ve done anything
wrong. Consider the following code segment. It creates a view and starts adding it to ar-
rays. This raises the retain count from +1 up to +4.

// On creation, view has a retain count of +1;
UlView *view = [[[UIView alloc] init] autorelease];
printf ("Count: %d\n", [view retainCount]) ;

// Adding it to an array increases that retain count to +2
NSArray *arrayl = [NSArray arrayWithObject:view];
printf ("Count: %d\n", [view retainCount]) ;

// Another array, retain count goes to +3
NSArray *array2 = [NSArray arrayWithObject:view];
printf ("Count: %d\n", [view retainCount]) ;

// BAnd another +4
NSArray *array3 = [NSArray arrayWithObject:view];
printf ("Count: %d\n", [view retainCount]) ;

Notice that each array was created using a class convenience method and returns an au-
toreleased object. The view is set as autorelease, too. Some collection classes like NSArray
automatically retain objects when you add them into an array and release them when ei-
ther the object is removed (mutable objects only) or when the collection is released. This
code has no leaks because every one of the four objects is set to properly release itself and
its children when the autorelease pool drains.

When release is sent to the three arrays, each one releases the view, bringing the count
down from +4 to +1.The final release, sent to the object, brings the count from +1 down
to 0, allowing the view to deallocate when this method finishes: no leaks, no further re-
tains, no problems.

Other Ways to Create Objects

You've seen how to use alloc to allocate memory. Objective-C offers other ways to build
new objects.You can discover these by browsing class documentation as the methods vary
by class and framework. As a rule of thumb, if you build an object using any method
whose name includes alloc, new, create, or copy, you maintain responsibility for releas-
ing the object. Unlike class convenience methods, methods that include these words gen-
erally do not return autoreleased objects.
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Sending a copy message to an object, for example, duplicates it. Copy returns an object
with a retain count of +1 and no assignment to the autorelease pool. Use copy when you
want to duplicate and make changes to an object while preserving the original. Note that
for the most part, Objective-C produces shallow copies of collections like arrays and dic-
tionaries. It copies the structure of the collection, and maintains the addresses for each
pointer, but does not perform a deep copy of the items stored within.

C-Style Object Allocations

As a superset of C, Objective-C programs for the iPhone often use APIs with C-style
object-creation and management. Core Foundation (CF) is a Cocoa Touch framework
with C-based function calls. When working with CF objects in Objective-C, you build
objects with cFAllocators and often use the CFRelease () function to release object
memory.

There are, however, no simple rules. As the following code shows, you may end up us-
ing free (), CFRelease (), and custom methods like cGContextRelease () all in the same
scope, side-by-side with standard Objective-C class convenience methods like
imageWithCGImage:.The function used to create the context object used here is
CGBitmapContextCreate () and like most Core Foundation function calls, it does not re-
turn an autoreleased object. This code snippet builds a UIImage, the iPhone class that
stores image data.

UIImage *buildImage (int imgsize)
{
// Create context with allocated bits
CGContextRef context =
MyCreateBitmapContext (imgsize, imgsize);
CGImageRef myRef =
CGBitmapContextCreateImage (context) ;
free (CGBitmapContextGetData (context)) ;
CGContextRelease (context) ;
UlImage *img = [UIImage imageWithCGImage:myRef];
CFRelease (myRef) ;
return img;

Carbon and Core Foundation

Working with Core Foundation comes up often enough that you should be aware

of its existence and be prepared to encounter its constructs, specifically as regards to its

frameworks. Frameworks are libraries of classes that you can utilize in your application.
Table 3-2 explains the key terms involved. To summarize the issue, early OS X used

a C-based framework called Core Foundation to provide a transitional system for
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developing applications that could run on both Classic Mac systems as well as Mac OS X.
Although Core Foundation uses object-oriented extensions to C, its functions and con-
structs are all C-based, not Objective-C-based.

Table 3-2 Key OS X Development Terms
Term Definition

Foundation The core classes for Objective-C programming, offering all the fundamental
data types and services needed for Cocoa and Cocoa Touch. A section at the
end of this chapter introduces some of the most important Foundation
classes you'll use in your applications.

Core A library of C-based classes that are based on Foundation APIs but that are
Foundation implemented in C. Core Foundation uses object-oriented data but is not built
using the Objective-C classes.

Carbon An early set of libraries provided by Apple that use a procedural API. Carbon
offered event handling support, a graphics library, and many more frame-
works. Some Carbon APIs live on through Core Foundation. Carbon was intro-
duced for the Classic Mac OS, first appearing in Mac OS 8.1.

Cocoa Apple’s collection of frameworks, APIs, and runtimes that make up the mod-
ern Mac OS X runtime system. Frameworks are primarily written in Objective-
C although some continue to use C/C++.

Cocoa Cocoa’s equivalent for the iPhone OS, where the frameworks are tuned for

Touch the touch-based mobile iPhone user experience. Some iPhone frameworks
such as Core Audio and Open GL are considered to reside outside Cocoa
Touch.

Toll Free A method of Cocoa/Carbon integration. Toll Free Bridging refers to sets of in-

Bridging terchangeable data types. For example, Cocoa’s Foundation (NSString *)

object can be used interchangeably with Carbon’s Core Foundation’s
CFStringRef. Bridging connects the C-based Core Foundation with the
Objective-C Foundation world.

Core Foundation technology lives on through Cocoa.You can and will encounter C-style
Core Foundation when programming iPhone applications using Objective-C.The
specifics of Core Foundation programming fall outside the scope of this chapter, however,
and are best explored separately from learning how to program in Objective-C.

Deallocating Objects

The iPhone uses reference-count managed Objective-C. On the iPhone, there’s no
garbage collection and little likelihood there ever will be. Every object cleans up after it-
self. So what does that mean in practical terms? Here’s a quick rundown of how you end
an object’s life, cleaning up its instance variables and preparing it for deallocation.
Instance variables must release retained objects before deallocation.You as the devel-
oper must ensure that those objects return to a retain count of 0 before the parent object
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is itself released. To do this, you implement dealloc, a method automatically called by the
runtime system when an object is about to be released. If you use a class with object in-
stance variables (i.e., not just floats, ints, and Bools), you probably need to implement a
deallocation method. The basic dealloc method structure looks like this:

- (void) dealloc

{

// Class-based clean-up
clean up my own instance variables here

// Clean up superclass
[super dealloc]

}

The method you write should work in two stages. First, clean up any instance variables
from your class. Then ask your superclass to perform its cleanup routine. The special super
keyword refers to the superclass of the object that is running the dealloc method. How
you clean up depends on whether your instance variables are automatically retained.
You’ve read about creating objects, building references to those objects, and ensuring
that the objects’ retain counts stay at +1 after creation. Now, you see the final step of the
object’s lifetime, namely reducing that count back to 0 so the objects can be deallocated.

Retained Properties

In the case of retained properties, set those properties to nil using dot notation assignment.
This calls the custom setter method synthesized by Objective-C and releases any prior ob-
ject the property has been set to. Assuming that prior object had a retain count of +1, this
release brings the count to 0.

self.make = nil;

Variables

‘When using plain (nonproperty) instance variables or assign style properties, send release
at deallocation time. Say, for example, you’ve defined an instance variable called salesman.
It might be set at any time during the lifetime of your object. The assignment of salesman
might look like this:

// release any previous value
[salesman release];

// make the new assignment. Retain count is +1
salesman = [[SomeClass alloc] init];

This assignment style means that salesman could point to an object with a +1 retain count
at any time during the object’s lifetime. Therefore in your dealloc method, you must re-
lease any object currently assigned to salesman, setting the count to 0.

[salesman release];
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A Sample Deallocation Method

Keeping with an expanded car class that uses retained properties for make, model, and
colors, and that has a simple instance variable for salesman, the final deallocation method
would look like this. The integer year and the Boolean forSale instance variables are not
objects and do not need to be managed this way.

- (void) dealloc

{

self.make = nil;
self.model = nil;
self.colors = nil;
[salesman release];
[super dealloc];

}

Setting a retain count upper limit proves key to making Objective-C memory manage-
ment work. Few objects should continue to have a retain count greater than +1 after their
creation and assignment. By guaranteeing a limit, your final releases in dealloc are assured
to bring those counts down to 0.

Cleaning Up Other Matters

The dealloc method offers a perfect place to clean up shop. For example, you might
need to dispose of an Audio Toolbox sound or perform other maintenance tasks before
the class is released. These tasks almost always relate to legacy Core Foundation, Core
Graphics, Core Audio, or similar C-style frameworks.

if (snd) AudioServicesDisposeSystemSoundID (snd) ;

Think of dealloc as your last chance to tidy up loose ends before your object goes away
forever. Whether this involves shutting down open sockets, closing file pointers, or releas-
ing resources, use this method to make sure your code returns state as close to pristine as

possible.

Crafting Singletons

The Ulapplication and UIDevice classes let you access information about the currently
running application and the device hardware it is running on.They do so by offering sin-
gletons, that is, a sole instance of a class in the current process. For example,
[UIApplication sharedApplication] returns a singleton that can report information
about the delegate it uses, whether the application supports shake-to-edit features, what
windows are defined by the program, and so forth.

Most singleton objects act as control centers. They coordinate services, provide key in-
formation, and direct external access, among other functionality. If you have a need for
centralized functionality, like a manager that accesses a Web service, a singleton approach
ensures that all parts of your application coordinate with the same central manager.
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Building a singleton takes very little code.You define a static shared instance inside the
class implementation and add a class method pointing to that instance. In this snippet,
which is taken from the tagging example of Chapter 6, “Assembling Views and Anima-
tions,” the instance is built the first time it is requested.

@implementation ViewIndexer
static ViewIndexer *sharedInstance = nil;

+(ViewIndexer *) sharedInstance {
if (IsharedInstance)
sharedInstance = [[self alloc] init];
return sharedInstance;

// Class behavior defined here

@end

To use this singleton, call [ViewIndexer sharedInstance].This returns the shared object
and lets you access any behavior that the singleton provides.You can prevent any class
from creating a second instance by overriding allocWithzone:. (For most uses this is
paranoid overkill.) The @synchronized () directive used here prevents this code from be-
ing executed by more than one thread at a time.

+ (id)allocWithZone: (NSZone *)zone

{

@synchronized (self) {
if (sharedInstance == nil) {
sharedInstance = [super allocWithZone:zonel ;
return sharedInstance;

}

return nil;

Categories (Extending Classes)

Objective-C’s built-in capability to expand already-existing classes is one of its most pow-
erful features. This behavioral expansion is called a cafegory. Categories extend class func-
tionality without subclassing.You choose a descriptive expansion name, build a header, and
then implement the functionality in a method file. Categories add methods to existing
classes even if you did not define that class in the first place and do not have the source
code for that class.

To build a category, you declare a new interface. Specify the category name (it’s arbi-
trary) within parentheses, as you see here. List any new public methods and properties and
save the header file. This Orientation category expands the UIDevice class, which is the



Categories (Extending Classes)

SDK class responsible for reporting device characteristics including orientation, battery
level, and the proximity sensor state. This interface adds a single property to UIDevice, re-
turning a read-only Boolean value. The new isLandscape property reports back whether
the device is currently using a landscape orientation.

@interface UIDevice (Orientation)

@property (nonatomic, readonly) BOOL isLandscape;

@end

You cannot add new instance variables to a category interface as you could when
subclassing. You are instead expanding a class’s behavior, as shown in the source code of
Listing 3-3.The code implements the landscape check by looking at the standard
UlDevice orientation property.
You might use the new property like this.
NSLog (@"The device orientation is%$@landscape",
[UIDevice currentDevice] .isLandscape ? @" " : @" not ");
Here, the landscape orientation check integrates seamlessly into the SDK-provided
UIDevice class via a property that did not exist prior to expanding the class. Just FYI,
uikit does offer device orientation macros (UIDeviceOrientationIsPortrait and
UIDeviceOrientationIsLandscape), but you must pass these an orientation value, which
you have to poll from the device.

Note

In addition to adding new behavior to existing classes, categories also let you group related
methods into separate files for classes you build yourself. For large, complex classes, this
helps increase maintainability and simplifies the management of individual source files.
Please note that when you add a category method that duplicates an existing method
signature, the Objective-C runtime uses your implementation and overrides the original.

Listing 3-3  Building an Orientation Category for the UlDevice Class

@interface UIDevice (Orientation)
@property (nonatomic, readonly) BOOL isLandscape;
@end

@implementation UIDevice (Orientation)
- (BOOL) isLandscape

{

return (self.orientation == UlIDeviceOrientationLandscapeleft) ||
(self.orientation == UIDeviceOrientationLandscapeRight) ;

@end
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Protocols

Chapter 1 introduced the notion of delegates. Delegates implement details that cannot be
determined when a class is first defined. For example, a table knows how to display rows
of cells, but it can’t know what to do when a cell is tapped. The meaning of a tapped row
changes with whatever application implements that table. A tap might open another
screen, or send a message to a Web server, or perform any other imaginable result. Delega-
tion lets the table communicate with a smart object that is responsible for handling those
taps but whose behavior is written at a completely separate time from when the table class
itself is created.

Delegation basically provides a language that mediates contact between an object and
its handler. A table tells its delegate “I have been tapped,”“I have scrolled,” and other status
messages. The delegate then decides how to respond to these messages, producing updates
based on its particular application semantics.

Data sources operate the same way, but instead of mediating action responses, data
sources provide data on demand. A table asks its data source, “What information should I
put into cell 1 and cell 22" The data source responds with the requested information. Like
delegation, data sourcing lets the table place requests to an object that is built to under-
stand those demands.

In Objective-C, both delegation and data sourcing are produced by a system called
protocols. Protocols define a priori how one class can communicate with another. They
contain a list of methods that are defined outside any class. Some of these methods are re-
quired. Others are optional. Any class that implements the required methods is said to
conform to the protocol.

Defining a Protocol

Imagine, if you would, a jack-in-the box toy. This is a small box with a handle. When you
turn the crank, music plays. Sometimes a puppet (called the “jack”) jumps out of the box.
Now imagine implementing that toy (or a rough approximation) in Objective-C.The toy
provides one action, turning the crank, and there are two possible outcomes: the music or
the jack.

Now consider designing a programmatic client for that toy. It could respond to the
outcomes, perhaps, by gradually increasing a boredom count when more music plays or
reacting with surprise when the jack finally bounces out. From an Objective-C point of
view, your client needs to implement two responses: one for music, another for the jack.
Here’s a client protocol you might build.

@protocol JackClient <NSObject>
- (void) musicDidPlay;

- (void) jackDidAppear;

@end

This protocol declares that to be a client of the toy, you must respond to music playing
and the jack jumping out of the box. Listing these methods inside an eprotocol container
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defines the protocol. All the methods listed here are required unless you specifically de-
clare them as @eoptional, as you read about in the next sections.

Incorporating a Protocol

Next, imagine designing a class for the toy itself. It offers one action, turning the crank,
and requires a second object that implements the protocol, in this case called client. This
class interface specifies that the client needs to be some kind of object (id) that conforms
to the JackClient protocol (<JackClient>). Beyond that, the class does not know at de-
sign time what kind of object will provide these services.

@interface JackInTheBox : NSObject

{

id <JackClient> client;

}

- (void) turnTheCrank;

@property (retain) id <JackClient> client;
@end
Adding Callbacks

Callbacks connect the toy class to its client. Since the client must conform to the Jack-
Client protocol, you can send jackDidAppear and musicDidPlay messages to the object
and they will compile without error. The protocol ensures that the client implements
these methods. In this code, the callback method is selected randomly. The music plays ap-
proximately nine out of every ten calls, sending musicDidPlay to the client.

- (void) turnTheCrank

{

// You need a client to respond to the crank
if (!self.client) return;

// Randomly respond to the crank turn
int action = random() % 10;
if (action < 1)
[self.client jackDidAppear] ;
else
[self.client musicDidPlay];

Declaring Optional Callbacks

Protocols include two kinds of callbacks, required and optional. By default, callbacks are
required. A class that conforms to the protocol must implement those methods or they
produce a compiler warning.You can use the @required and @optional keywords to de-
clare a protocol to be of one form or the other. Any methods listed after an erequired
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keyword are required; after an eoptional keyword, they are optional.Your protocol can
grow complex accordingly.

@protocol JackClient <NSObjects>

- (void) musicDidPlay; // required
@required

- (void) jackDidAppear; // also required
@optional

- (void) nothingDidHappen; // optional
@end

In practice, using more than a single @optional keyword is overkill. The same protocol
can be declared more simply. When you don'’t use any optional items, skip the keyword
entirely. Notice the <NSobjects declaration here. It’s required to effectively implement
optional protocols. It says that a JackClient object conforms to and will be a kind of
NSObject.

@protocol JackClient <NSObject>
- (void) musicDidPlay;

- (void) jackDidAppear;
@optional

- (void) nothingDidHappen;

@end

Implementing Optional Callbacks

Optional methods let the client choose whether to implement a given protocol method.
They reduce the implementation burden on whoever writes that client but add a little ex-
tra work to the class that hosts the protocol definition. When you are unsure whether a
class does or does not implement a method, you must test before you send a message. For-
tunately, Objective-C and the Nsobject class make it easy to do so.
// optional client method
if ([self.client respondsToSelector: @selector (nothingDidHappen)])

[self.client nothingDidHappen] ;

NSObject provides a respondsToSelector: method, which returns a Boolean YES if
the object implements the method or NO otherwise. By declaring the client with
<NSObject >, you tell the compiler that the client can handle this method, allowing you to
check the client for conformance before sending the message.

Conforming to a Protocol

Classes include protocol conformance in interface declarations. A view controller that im-
plements the JackClient protocol announces it between angle brackets. A class might con-
form to several protocols. Combine these within the brackets, separating protocol names
with commas.
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@interface TestBedViewController :
UIViewController <JackClient>

JackInTheBox *jack;

}
@property (retain) JackInTheBox *jack;
@end

Declaring the JackClient protocol lets you assign the host’s client property. The following
code compiles without error because the class for self was declared in conformance with

JackClient.

self.jack = [JackInTheBox jack];
self.jack.client = self;

Had you omitted the protocol declaration in your interface, this assignment would pro-
duce an error at compile time.

Once you include that protocol between the angle brackets, you must implement all re-
quired methods in your class. Omitting any of them produces the kind of compile-time
warnings shown in Figure 3-3.The compiler tells you which method is missing and what
protocol that method belongs to.

@end Incomplete implementation of class ‘TestBedViewController’
Method definition for '~jackDidAppear’ not found
Ginterfoce TestBedappDelegate : NSObjsct <Iapplicationelegates Methad definition for -musicDidPlay’ not found
Bend Class TestBedViewController' does not fully implement the JackClient' protocol

@implementation TestBeddppDe leqate

Figure 3-3  You must implement all required methods to conform to a
protocol. Objective-C warns about incomplete implementations.

The majority of protocol methods in the iPhone SDK are optional. Both required and
optional methods are detailed exhaustively in the developer documentation. Note that
protocols are documented separately from the classes they support. For example, Xcode
documentation provides three distinct UI'TableView reference pages: one for the
UITableView class, one for the UlTableViewDelegate protocol, and another for the

Ul TableViewDataSource protocol.

Foundation Classes

If you're new to Objective-C, there are a few key classes you absolutely need to be famil-
iar with before moving forward. These include strings, numbers, and collections, and they
provide critical application building blocks. The Nsstring class, for example, provides the
workhorse for nearly all text manipulation in Objective-C. However it, like other funda-
mental classes, is not defined in Objective-C itself. It is part of the Foundation framework,
which offers nearly all the core utility classes you use on a day-to-day basis.

Foundation provides over a dozen kinds of object families and hundreds of object
classes. These range from value objects that store numbers and dates, to strings that store
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character data, and collections that store other objects, to classes that access the file system
and retrieve data from URLs. Foundation is often referred to (slightly inaccurately) as
Cocoa. (Cocoa and its iPhone equivalent Cocoa Touch actually include all the frameworks
for OS X programming.) To master Foundation is to master Objective-C programming,
and thorough coverage of the subject demands an entire book of its own.

As this section cannot offer an exhaustive introduction to Foundation classes, you're
about to be introduced to a quick and dirty survival overview. Here are the classes you
need to know about and the absolutely rock-core ways to get started using them.You find
extensive code snippets that showcase each of the classes to give you a jumping-oft point
if, admittedly, not a mastery of the classes involved.

Strings

Cocoa strings store character data, just as their cousins the (char *) C strings do. They
are, however, objects and not byte arrays. Unlike C, the core NSString class is immutable
in Cocoa.That is, you can use strings to build other strings, but you can’t edit the strings
you already own. String constants are delineated by quote marks and the @ character.
Here is a typical string constant, which is assigned to a string variable.

NSString *myString = @"A string constant";

Building Strings

You can build strings using formats, much as you would using sprintf. If youre comfort-
able creating printf statements, your knowledge transfers directly to string formats. Use
the $@ format specifier to include objects in your strings. String format specifiers are
thoroughly documented in the Cocoa String Programming Guide, available via Xcode’s
documentation window (Command-Option-?). The most common formats are listed in
Table 3-1.

NSString *myString = [NSString stringWithFormat:
@"The number is %d", 5];

To create new strings, you can append strings together. This call outputs “The number is
5227.1t creates a new instance built from other strings.

NSLog (@"%@", [myString stringByAppendingString:@"22"]);

Appending formats provides even more flexibility.You specify the format string and the
components that build up the result.

NSLog (@"%@", [myString stringByAppendingFormat:@"%d", 22]);

Length and Indexed Characters

Every string can report its length (via length) and produce an indexed character on de-
mand (via characterAtIndex:).The two calls shown here output 15 and e, respectively,
based on the previous @*“The number is 5” string. Cocoa characters use the unichar
type, which store Unicode-style characters.
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NSLog (@"%d", myString.length) ;
printf ("$c", [myString characterAtIndex:2]);

Converting to and from C Strings

The realities of normal C programming often crop up despite working in Objective-C.
Being able to move back and forth between C strings and Cocoa strings is an important
skill. Convert an NSString to a C string either by sending UTF8String or
cStringUsingEncoding:.These are equivalent, producing the same C-based bytes.
printf ("$s\n", [myString UTF8String]);

printf ("$s\n", [myString cStringUsingEncoding: NSUTF8StringEncoding]) ;

You can also go the other way and transform a C string into an NSString by using
stringWithCString: encoding:.The samples here use UTF-8 encoding, but Objective-
C supports a large range of options, including ASCII, Japanese, Latin, Windows-CP1251,
and so forth.

NSLog (@"%@", [NSString stringWithCString:”Hello World”
encoding: NSUTF8StringEncoding]) ;

Writing Strings to and Reading Strings from Files
Writing to and reading strings from the local file system offers a handy way to save and
retrieve data. This snippet shows how to write a string to a file.

NSString *myString = @"Hello World";
NSError *error;

NSString *path = [NSHomeDirectory ()
stringByAppendingPathComponent :@"Documents/file.txt"];

if (! [myString writeToFile:path atomically:YES
encoding:NSUTF8StringEncoding error:é&error])

NSLog (@"Error writing to file: %@", [error localizedDescription]);
return;

}

NSLog (@"String successfully written to file");

The path for the file is NSHomeDirectory(), a function that returns a string with a path
pointing to the application sandbox. Notice the special append method that properly ap-
pends the Documents/file.txt subpath.

In Cocoa, most file access routines offer an atomic option. When you set the atomically
parameter to YES, the iPhone writes the file to a temporary auxiliary and then renames it
into place. Using an atomic write ensures that the file avoids corruption.

The request shown here returns a Boolean, namely YES if the string was written, or
NO if it was not. Should the write request fail, this snippet logs the error using a lan-
guage-localized description. It uses an instance of the NSError class to store that error in-
formation and sends the localizedDescription selector to convert the information into
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a human-readable form. Whenever iPhone methods return errors, use this approach to de-
termine which error was generated.

Reading a string from a file follows a similar form but does not return the same
Boolean result. Instead, check to see whether the returned string is nil, and if so display
the error that was returned.

NSString *inString = [NSString stringWithContentsOfFile:path
encoding:NSUTF8StringEncoding error:&error] ;

if (!inString)

{

NSLog (@"Error reading from file % %@", [path lastPathComponent],
)

i

[error localizedDescription]
return;

}

NSLog (@"String successfully read from file");
NSLog (@"%@", inString) ;

Accessing Substrings

Cocoa offers a number of ways to extract substrings from strings. Here’s a quick review of
some typical approaches. As you'd expect, string manipulation is a large part of any flexible
API, and Cocoa offers many more routines and classes to parse and interpret strings than
the few listed here. This quick NSString summary skips any discussion of NSScanner,
NSXMLParser, and so forth.

Converting Strings to Arrays

You can convert a string into an array by separating its components across some repeated
boundary. This sample chops the string into individual words by splitting around spaces.
The spaces are discarded, leaving an array that contains each number word.

NSString *myString = @"One Two Three Four Five Six Seven'";

NSArray *wordArray = [myString componentsSeparatedByString: e" "];

NSLog (@"%@", wordArray) ;

Requesting Indexed Substrings

You can request a substring from the start of a string to a particular index, or from an in-
dex to the end of the string. These two examples return @*“One Two” and @ Two Three
Four Five Six Seven”, respectively, using the to and from versions of the indexed substring
request. As with standard C, array and string indices start at O.

NSString *subl = [myString substringToIndex:7];
NSLog (@"%@", subl);

NSString *sub2 = [myString substringFromIndex:4];
NSLog (@"%@", sub2) ;
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Generating Substrings from Ranges

Ranges let you specify exactly where your substring should start and stop. This snippet re-
turns @ “Tw”, starting at character 4 and extending 2 characters in length. NSRange pro-
vides a structure that defines a section within a series.You use ranges with indexed items
like strings and arrays.

NSRange r;

r.location = 4;

r.length = 2;

NSString *sub3 = [myString substringWithRange:r];

NSLog (@"%@", sub3);

Search and Replace with Strings
With Cocoa, you can easily search a string for a substring. Searches return a range, which
contain both a location and a length. Always check the range location. The location
NSNotFound means the search failed. This returns a range location of 18, with a length of 4.
NSRange searchRange = [myString rangeOfString:@"Five"];
if (searchRange.location != NSNotFound)

NSLog (@"Range location: %d, length: %d", searchRange.location, searchRange.length);

Once you've found a range, you can replace a subrange with a new string. The replace-
ment string does not need to be the same length as the original, thus the result string may
be longer or shorter than the string you started with.

NSLog (@"$@", [myString stringByReplacingCharactersInRange:
searchRange withString: @"New String"]);

A more general approach lets you replace all occurrences of a given string. This snippet
produces @ “One * Two * Three * Four * Five * Six * Seven” by swapping out each
space for a space-asterisk-space pattern.

NSString *replaced = [myString stringByReplacingOccurrencesOfString:
@" " withString: e" * "];
NSLog (@"%@", replaced);

Changing Case

Cocoa provides three simple methods that change a string’s case. Here, these three examples
produce a string all in uppercase, all in lowercase, and one where every word is capitalized
(“Hello World. How Do You Do?”). Because Cocoa supports case-insensitive comparisons,
you rarely need to apply case conversions when testing strings against each other.

NSString *myString = @"Hello world. How do you do?";
NSLog (@"%@", [myString uppercaseString]) ;

NSLog (@"%@", [myString lowercaseStringl) ;

NSLog (@"%$@", [myString capitalizedString]) ;
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Testing Strings

The iPhone offers many ways to compare and test strings. The three simplest check for
string equality and match against the string prefix (the characters that start the string) and
suffix (those that end it). More complex comparisons use NSComparisonResult constants
to indicate how items are ordered compared with each other.

NSString *sl = @"Hello World";

NSString *s2 = @"Hello Mom";

NSLog (@"%@ %@ %@", sl, [sl isEqualToString:s2] ?
@"equals" : @"differs from", s2);

NSLog (@"%@ %@ %@", sl, [sl hasPrefix:@"Hello"] ?
@"starts with" : @"does not start with", @"Hello");

NSLog (@"%@ %@ %@", sl, [sl hasSuffix:@"Hello"] ?
@"ends with" : @"does not end with", @"Hello");

Extracting Numbers from Strings

Convert strings into numbers by using a value method. These examples return 3, 1,
3.141592, and 3.141592, respectively.

NSString *sl = @"3.141592";

NSLog (@"%d", [sl intValue]);
NSLog (@"%d", [sl boolValuel);
NSLog (@"$f", [sl floatValuel);
NSLog (@"%f", [sl doubleValuel);

Mutable Strings

The NSMutableString class is a subclass of NSstring. It offers you a way to work with
strings whose contents can be modified. Once instantiated, you can append new contents
to the string, allowing you to grow results before returning from a method. This sample
displays “Hello World. The results are in now.”

NSMutableString *myString = [NSMutableString stringWithString:
@"Hello World. "];

[myString appendFormat:@"The results are %@ now.", @"in"];

NSLog (@"%@", myString) ;

Numbers and Dates

Foundation offers a large family of value classes. Among these are numbers and dates. Un-
like standard C floats, integers, and so forth, these elements are all objects. They can be al-
located and released, and used in collections like arrays, dictionaries, and sets. The
following examples show numbers and dates in action, providing a basic overview of these
classes.
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Working with Numbers
The NsNumber class lets you treat numbers as objects.You can create new NSNumber in-
stances using a variety of convenience methods, namely numberWwithInt:,
numberWithFloat :, numberWithBool:, and so forth. Once set, you extract those values
via intValue, floatValue, boolValue, and so on, and use normal C-based math to per-
form your calculations.

You are not limited to extracting the same data type an object was set with.You can set
a float and extract the integer value, for example. Numbers can also convert themselves
into strings.

NSNumber *number = [NSNumber numberWithFloat:3.141592];
NSLog (@"%d", [number intValuel);
NSLog (@"%@", [number stringValue]) ;

One of the biggest reasons for using NSNumber objects rather than ints, floats, and so forth,
is that you can use them with Cocoa routines and classes. For example, you cannot set a
user default (that is, a preference value) to, say, the integer 23, as in ““You have used this
program 23 times.”You can, however, store an object [NSNumber numberWithInt:23] and
later recover the integer value from that object to produce the same user message.

Note
The NSDecimalNumber class provides a handy object-oriented wrapper for base-10 arithmetic.

Working with Dates
As with standard C and time(), NSDate objects use the number of seconds since an epoch,
that is a standardized universal time reference, to represent the current date. The iPhone
epoch was at midnight on January 1, 2001.The standard Unix epoch took place at mid-
night on January 1, 1970.

Each NSTimeInterval represents a span of time in seconds, stored with subsecond
floating-point precision. The following code shows how to create a new date object using
the current time and how to use an interval to reference some time in the future (or past).

// current time
NSDate *date = [NSDate date];

// time 10 seconds from now
date = [NSDate dateWithTimeIntervalSinceNow:10.0f];

You can compare dates by setting or checking the time interval between them. This snip-
pet forces the application to sleep until 5 seconds into the future and then compares the
date to the one stored in date.

// Sleep 5 seconds and check the time interval
[NSThread sleepUntilDate: [NSDate dateWithTimeIntervalSinceNow:5.0f]];
NSLog (@"Slept %f seconds", [[NSDate date] timelIntervalSinceDate:date]);

The standard description method for dates returns a somewhat human-readable string,
showing the current date and time.
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// Show the date
NSLog (@"%@" [date description]);

To convert dates into fully formatted strings rather than just using the default description,
use an instance of NSDateFormatter.You specify the format (for example,YY for two-
digit years, and YYYY for four-digit years) using the object’s date format property. A full
list of format specifiers is oftered in the built-in Xcode documentation. In addition to
producing formatted output, this class can also be used to read preformatted dates from
strings, although that is left as an exercise for the reader.

// Produce a formatted string representing the current date

NSDateFormatter *formatter = [[[NSDateFormatter alloc] init]
autorelease] ;

formatter.dateFormat = @"MM/dd/YY HH:mm:ss";

NSString *timestamp = [formatter stringFromDate: [NSDate datel];

NSLog (@"%@", timestamp) ;

Timers

When working with time, you may need to request that some action occur in the future.
Cocoa offers an easy-to-use timer that triggers at an interval you specify; use the NSTimer
class. The timer shown here triggers after one second and repeats until the timer is disabled.

[NSTimer scheduledTimerWithTimeInterval: 1.0f target: self
selector: @selector (handleTimer:) userInfo: nil repeats: YES];

Each time the timer activates, it calls its target sending the selector message it was initial-
ized with. The callback method takes one argument (notice the single colon), which is the
timer itself. To disable a timer, send it the invalidate message; this releases the timer ob-
ject and removes it from the current runloop.

- (void) handleTimer: (NSTimer *) timer

{

printf ("Timer count: %d\n", count++);
if (count > 3)

{

[timer invalidate];
printf ("Timer disabled\n");

Recovering Information from Index Paths

The NSIndexPath class is used with iPhone tables. It stores the section and row number
for a user selection, that is, when a user taps on the table. When provided with index paths,
you can recover these numbers via the myIndexPath.row and myIndexPath.section
properties. Learn more about this class and its use in Chapter 11, “Creating and Managing
Table Views.”
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Collections

The iPhone primarily uses three kinds of collections: arrays, dictionaries, and sets. Arrays
act like C arrays. They provide an indexed list of objects, which you can recover by speci-
fying which index to look at. Dictionaries, in contrast, store values that you can look up
by keys. For example, you might store a dictionary of ages, where Dad’s age is the
NSNumber 57, and a child’s age is the NSNumber 15. Sets offer an unordered group of
objects and are usually used on the iPhone in connection with recovering user touches
from the screen. Each of these classes offers regular and mutable versions, just as the
NSString class does.

Building and Accessing Arrays

Create arrays using the arrayWithobjects: convenience method, which returns an au-
toreleased array. When calling this method, list any objects you want added to the array
and finish the list with nil. (If you do not include nil in your list, you’ll experience a run-
time crash.) You can add any kind of object to an array, including other arrays and diction-
aries. This sample showcases the creation of a three-item array.

NSArray *array = [NSArray arrayWithObjects:@"One", @"Two", @"Three", nil];

The count property returns the number of objects in an array. Arrays are indexed starting
with 0, up to one less than the count. Attempting to access [array objectAtIndex:
array.count] causes an “index beyond bounds” exception and crashes. So always use care
when retrieving objects, making sure not to cross either the upper or lower boundary for
the array.

NSLog (@"%d", array.count);
NSLog (@"%@", [array objectAtIndex:0]);

Mutable arrays are editable. The mutable form of NSArray is NSMutableArray. With mu-
table arrays, you can add and remove objects at will. This snippet copies the previous array
into a new mutable one and then edits the array by adding one object and removing
another one. This returns an array of [@“One”, @ “Two”, @‘Four].

NSMutableArray *marray = [NSMutableArray arrayWithArray:array];

[marray addObject:@"Four"];

[marray removeObjectAtIndex:2];

NSLog (@"%@", marray) ;

Whether or not you’re working with mutable arrays, you can always combine arrays to
form a new version containing the components from each. No checks are done about du-
plicates. This code produces a six-item array including one, two, and three from the origi-
nal array, and one, two, and four, from the mutable array.

NSLog (@"%@", [array arrayByAddingObjectsFromArray:marray]) ;
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Checking Arrays

You can test whether an array contains an object and recover the index of a given object.
This code searches for the first occurrence of “Four” and returns the index for that object.
The test in the if statement ensures that at least one occurrence exists.

if ([marray containsObject:@"Four"])
NSLog (@"The index is %d",
[marray indexOfObject:@"Four"]);

Converting Arrays into Strings

As with other objects, sending description to an array returns an NSString that de-
scribes an array. In addition, you can use componentsJoinedByString to transform an
NSArray into a string. The following code returns @“One Two Three”.

NSArray *array = [NSArray arrayWithObjects:@"One", @"Two", @"Three", nil];
NSLog (@"%@", [array componentsJoinedByString:@" "]);

Building and Accessing Dictionaries

NSDictionary objects store keys and values, enabling you to look up objects using strings.
The mutable version of dictionaries, NSMutableDictionary, lets you modify these dic-
tionaries by adding and removing elements on demand. In iPhone programming, you use
the mutable class more often the static one, so these examples showcase mutable versions.

Creating Dictionaries

Use the dictionary convenience method to create a new mutable dictionary, as shown
here. This returns a new initialized dictionary that you can start to edit. Populate the dic-
tionary using setObject: forKey:.

NSMutableDictionary *dict = [NSMutableDictionary dictionaryl];

[dict setObject:@"1" forKey:@"A"];

[dict setObject:@"2" forKey:@"B"];

[dict setObject:@"3" forKey:@"C"];

NSLog (@"%@", [dict description]);

Searching Dictionaries

Searching the dictionary means querying the dictionary by key name. Use objectForKey:
to find the object that matches a given key. When a key is not found, the dictionary returns
nil. This returns @"1" and nil.

NSLog (@"%@", [dict objectForKey:@"A"]);
NSLog (@"%@", [dict objectForKey:@"F"]);

Replacing Objects
When you set a new object for the same key, Cocoa replaces the original object in the

ER)

dictionary. This code replaces “3” with “foo” for the key “C”.
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[dict setObject:@"foo" forKey:@"C"];
NSLog (@"%@", [dict objectForKey:@"C"]);

Removing Objects

You can also remove objects from dictionaries. This snippet removes the object associated
with the “B” key. Once removed, both the key and the object no longer appear in the
dictionary.

[dict removeObjectForKey:@"B"];

Listing Keys

Dictionaries can report the number of entries they store plus they can provide an array of
all the keys currently in use. This key list lets you know what keys have already been used.
It lets you test against the list before adding an item to the dictionary, avoiding overwrit-
ing an existing key/object pair.

NSLog (@"The dictionary has %d objects", [dict count]);

NSLog (@"%@", [dict allKeys]);

Accessing Set Objects

Sets store unordered collections of objects.You encounter sets almost exclusively when
working with the iPhone’s multitouch screen. The UTview class receives finger movement
updates that deliver touches as an NSset.To work with touches, you almost always issue
allobjects and work with the array that gets returned. Once converted, use standard ar-
ray calls to list, query, and iterate through the touches.

Memory Management with Collections

Arrays, sets and dictionaries automatically retain objects when they are added and release
those objects when they are removed from the collection. Releases are also sent when the
collection is deallocated. Collections do not copy objects. Instead, they rely on retain
counts to hold onto objects and use them as needed.

Writing Out Collections to File
Both arrays and dictionaries can store themselves into files using writeToFile:
atomically: methods so long as the types within the collections belong to the set of
NSData, NSDate, NSNumber, NSString, NSArray, and NSDictionary. Pass &K:padlasthe
first argument, and a Boolean as the second. As when saving strings, the second argument
determines whether the file is first stored to a temporary auxiliary and then renamed. The
method returns a Boolean value:YES if the file was saved, NO if not. Storing arrays and
dictionaries create standard property lists files.
NSString *path = [NSHomeDirectory ()
stringByAppendingPathComponent : @"Documents/ArraySample.txt"] ;
if ([array writeToFile:path atomically:YES])

NSLog (@"File was written successfully");
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To recover an array or dictionary from file, use the convenience methods
arrayWithContentsOfFile: and dictionaryWithContentsOfFile:. If the
methods return nil, the file could not be read.

NSArray *newArray = [NSArray arrayWithContentsOfFile:path];
NSLog (@"%@", newArray) ;

Building URLs
NSURL objects point to resources. These resources can refer to both local files and to URLs
on the Web. Create url objects by passing a string to class convenience functions. Separate
functions have been set up to interpret each kind of URL. Once built, however, NSURL
objects are interchangeable. Cocoa does not care if the resource is local or points to an
object only available via the Net. This code demonstrates building URLs of each type,
path, and Web.
NSString *path = [NSHomeDirectory ()

stringByAppendingPathComponent :@"Documents/foo.txt"] ;
NSURL *urll = [NSURL fileURLWithPath:path];
NSLog (@"3@", urll);

NSString *urlpath = @"http://ericasadun.com";
NSURL *url2 = [NSURL URLWithString:urlpath];
NSLog (@"%d characters read",
[ [NSString stringWithContentsOfURL:url2] length]);

Working with NSData

If Nsstring objects are analogous to zero-terminated C strings, then NSData objects cor-
respond to buffers. Nspata provides data objects that store and manage bytes. Often, you
fill Nspata with the contents of a file or URL. The data returned can report its length, let-
ting you know how many bytes were retrieved. This snippet retrieves the contents of a
URL and prints the number of bytes that were read.

NSData *data = [NSData dataWithContentsOfURL:url2];
NSLog (@"%d", [data lengthl]);

To access the core byte bufter that underlies an NSData object, use bytes. This returns a
(const void *) pointer to actual data.

As with many other Cocoa objects, you can use the standard NSData version of the
class or its mutable child, NSMutableData. Most Cocoa programs that access the Web, par-
ticularly those that perform asynchronous downloads, pull in a bit of data at a time. For
those cases, NSMutableData objects prove useful.You can keep growing mutable data by
issuing appendData: to add the new information as it is received.

File Management
The iPhone’s file manager is a singleton provided by the NSFileManager class. It can list
the contents of folders to determine what files are found and perform basic file system
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tasks. The following snippet retrieves a file list from two folders. First it looks in the sand-
box’s Documents folder and then inside the application bundle itself.

NSFileManager *fm = [NSFileManager defaultManager];

// List the files in the sandbox Documents folder
NSString *path = [NSHomeDirectory() stringByAppendingPathComponent:@"Documents"];
NSLog (@"%@", [fm directoryContentsAtPath:path]);

// List the files in the application bundle
path = [[NSBundle mainBundle] bundlePath];
NSLog (@"%@", [fm directoryContentsAtPath:path]);

Note the use here of NsBundle. It lets you find the application bundle and pass its path to
the file manager.You can also use NSBundle to retrieve the path for any item included in
your app bundle. (You cannot, however, write to the application bundle at any time.) This
code returns the path to the application’s Default.png image. Note that the file and exten-
sion names are separated and that each is case sensitive.

NSBundle *mb = [NSBundle mainBundle] ;
NSLog (@"%@", [mb pathForResource:@"Default" ofType:@"png"]) ;

The file manager ofters a full suite of file-specific management. It can move, copy, and re-
move files as well as query the system for file traits and ownership. Here are some exam-
ples of the simpler routines you may use in your applications.

// Create a file

NSString *docspath = [NSHomeDirectory ()
stringByAppendingPathComponent : @"Documents"] ;

NSString *filepath = [NSHomeDirectory ()
stringByAppendingPathComponent :@"Documents/testfile"];

NSArray *array = [@"One Two Three" componentsSeparatedByString:@" "];

[array writeToFile:filepath atomically:YES];

NSLog (@"$@", [fm directoryContentsAtPath:docspathl]);

// Copy the file

NSString *copypath = [NSHomeDirectory ()
stringByAppendingPathComponent :@"Documents/copied"] ;

if (![fm copyItemAtPath:filepath toPath:copypath error:&error])

{
NSLog (@"Copy Error: %$@", [error localizedDescription]);
return;

}

NSLog (@"%@", [fm directoryContentsAtPathdocspath]) ;

// Move the file

NSString *newpath = [NSHomeDirectory ()
stringByAppendingPathComponent :@"Documents/renamed"] ;

if (! [fm moveItemAtPath:filepath toPath:newpath error:&error])
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NSLog (@"Move Error: %$@", [error localizedDescription]);

return;

}

NSLog (@"%@", [fm directoryContentsAtPath:docspathl]) ;

// Remove a file

if (! [fm removeItemAtPath:copypath error:&error])

{
NSLog (@"Remove Error: %@", [error localizedDescription]);
return;

}

NSLog (@"%$@", [fm directoryContentsAtPath:docspath]) ;

Note

As another convenient file trick, use tildes in path names, for example, “~/Library/Prefer-
ences/foo.plist” and apply the NSString method stringByExpandingTildeInPath.

One More Thing: Message Forwarding

Although Objective-C does not provide true multiple-inheritance, it offers a work-
around that lets objects respond to messages that are implemented in other classes. If you
want your object to respond to another class’s messages, you can add message forwarding
to your applications and gain access to that object’s methods.

Normally, sending an unrecognized message produces a runtime error, causing an ap-
plication to crash. But before the crash happens, the iPhone’s runtime system gives each
object a second chance to handle a message. Catching that message lets you redirect it to
an object that understands and can respond to that message.

Consider the Car example used throughout this chapter. The carInfo property intro-
duced midway through these examples returns a string that describes the car’s make,
model, and year. Now imagine if a car instance could respond to NSString messages by
passing them to that property. Send length to a car object and instead of crashing, the
object would return the length of the carInfo string. Send stringByAppendingString:
and the object adds that string to the property string. It would be as if the car class inher-
ited (or at least borrowed) the complete suite of string behavior.

Objective-C provides this functionality through a process called message forwarding.
When you send a message to an object that cannot handle that selector, the selector gets
forwarded to a forwardInvocation: method. The object sent with this message, namely
an NSInvocation instance stores the original selector and arguments that were requested.
You can override forwardInvocation: and send that message on to another object.



One More Thing: Message Forwarding

Implementing Message Forwarding

To add message forwarding to your program, you must override two methods, namely,
methodSignatureForSelector: and forwardInvocation:.The former creates a valid
method signature for messages implemented by another class. The latter forwards the se-
lector to an object that actually implements that message.

Building a Method Signature

This first method returns a method signature for the requested selector. For this example,
a Car Instance cannot properly create a signature for a selector implemented by another
class, in this case NSString. Adding a check for a malformed signature (i.e., returning nil)
gives this method the opportunity to iterate through each pseudo-inheritance and at-
tempt to build a valid result. This example draws methods from just one other class via

self.carInfo

- (NSMethodSignature*) methodSignatureForSelector: (SEL)selector

{

// Check if car can handle the message
NSMethodSignature* signature = [super
methodSignatureForSelector:selector] ;

// If not, can the car info string handle the message?
if (!signature)
signature = [self.carInfo methodSignatureForSelector:selector];

return signature;

Forwarding

The second method you need to override is forwardInvocation:.This method only
gets called when an object has been unable to handle a message. This method gives the
object a second chance, allowing it to redirect that message. The method checks to see
whether the self.carInfo string responds to the selector. If it does respond, it tells the
invocation to invoke itself using that object as its receiver.

- (void) forwardInvocation: (NSInvocation *)invocation

{

SEL selector = [invocation selector];
if ([self.carInfo respondsToSelector:selector])

printf (" [forwarding from %s to %$s] ", [[[self class] description]
UTF8String], [[NSString description] UTF8String]);

[invocation invokeWithTarget:self.carInfo];
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Using Forwarded Messages

Calling nonclass messages like UTF8String and length produces compile-time warnings,

which you can ignore. The code shown in Figure 3-4 causes two compiler warnings. The
code, however, compiles and (more importantly) runs without error. As the figure shows,

you can send a car instance methods that are defined by the class itself and also those im-
plemented by NSString.

AT FayCar = [Cor oot
myCar.nake = @'Ford";
myCar.node| = @'Prefect”;
myCar.year = 1942;

/7 Thess two lines create warnings, which you can ignors
printf("Sending string nethods to the myCor Instance:in');

print? ("UTFEString: %'n', [nyCar UTFEString]); ‘Car’ may not respond to “-UTF8String’ a
printf{'string Length: %dwn’, [hyCar length]); ‘Car’ may not respond to *length' S|

/¢ This doss not create a warning because it's not checked at compile tine
NSString #string = [myCar perfor (stri i ing:) withObject:a' Extra String' ]
printf("Appended: %s'n', [string UTFBString]);

/4 Thiz is 0 normal Car method but it still works
print?("\hornal Car instance methodsin');
printf("Vear: %dwn", [myCar year]);
printf("Hodel: #sin’, [[myCar model] UTF8String]);

/¢ Bonus methods
printf (" \nBonus methods:in");

printf("nyCar % o kind of HSStringin’, [myCar isKindOfCloss:[NSString class]] 7 "i=" @ "is not")
printf("nyCar % to lengthin', [myCar respondsToSelector:@selector(length)] 7 "responds" : "dossn 't respond')

Figure 3-4 The compiler issues warnings for forwarded methods, but the code
runs without error.

House Cleaning

Although invocation forwarding mimics multiple inheritance, NSObject never confuses
the two. Methods like respondsToSelector: and isKindofClass: only look at the inher-
itance hierarchy and not at the forwarding change.

A couple of optional methods allow your class to better express its message compli-
ance to other classes. R eimplementing respondsToSelector: and isKindOfClass: lets
other classes query your class. In return, the class announces that it responds to all string
methods (in addition to its own) and that it is a “kind of” string, further emphasizing the
pseudo-multiple inheritance approach.

// Extend selector compliance
- (BOOL) respondsToSelector: (SEL)aSelector
{
// Car class can handle the message
if ( [super respondsToSelector:aSelector]
return YES;

// CarInfo string can handle the message
if ([self.carInfo respondsToSelector:aSelector])
return YES;



Summary

// Otherwise...
return NO;

// Allow posing as class
- (BOOL) isKindOfClass: (Class)aClass

{

// Check for Car
if (aClass == [Car class]) return YES;
if ([super isKindOfClass:aClass]) return YES;

// Check for NSString
if ([self.carInfo isKindOfClass:aClass]) return YES;

return NO;

Supereasy Forwarding

The method signature/forward invocation pair of methods provides a robust and ap-
proved way to add forwarding to your classes. A simpler approach is also available on the
iPhone, which you can use at your own risk.You can replace both those methods with
this single one, which does all the same work with less coding.

- (id) forwardingTargetForSelector: (SEL)sel

{
if ([self.carInfo respondsToSelector:sel]) return self.carInfo;
return nil;

Summary

This chapter provided an abridged, high-octane introduction to Objective-C and
Foundation. In it, you read about the way that Objective-C extends C and provides sup-
port for object-oriented programming.You discovered properties and memory manage-
ment and were subjected to a speedy review of the most important Foundation classes. So
what can you take away from this chapter? Here are a few final thoughts.

= The sample code for this chapter contains all the examples used throughout this in-
troduction. Try testing this material directly in Xcode. Mess around with the mate-
rial, add your own samples, or expand the ones you've been given. Hands-on offers
the best way to gain critical skills you need for iPhone development.
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= Learning Objective-C and Cocoa takes more than just a chapter. If you're serious

about learning iPhone programming, and these concepts are new to you, consider
seeking out single-topic books that are dedicated to introducing these technologies
to developers new to the platform. Consider Aaron Hillegass’s Cocoa Programming
for Mac OS X, 3rd Edition, or Stephen Kochan’s Programming in Objective-C 2.0,
2nd Edition, or Fritz Anderson’s Xcode 3 Unleashed.

This chapter mentioned Core Foundation and Carbon but did not delve into these
technologies in any depth.You can and will experience C-based APIs on the
iPhone, particularly when you work with the address book, with Quartz 2-D
graphics, and with Core Audio, among other frameworks. Each of these specific
topic areas are documented exhaustively at Apple’s developer Web site, complete
with sample code. A strong grounding in C (and sometimes C++) programming
will help you work through the specific implementation details.



A

Designing Interfaces

he iPhone SDK helps you craft user interfaces. This chapter introduces the visual

classes you’ll work with and discusses their roles in the interface design process.

You read about controllers that work with these visual classes and discover how
they handle tasks like device reorientation. Then you move on to solutions for laying out
and customizing interfaces.You learn about hybrid solutions that rely both on IB-created
interfaces and Objective-C-centered ones. By the time you finish this chapter, you’ll have
discovered many approaches that you can apply to your own application design.

UlView and UlWindow

Nearly everything that appears on the iPhone’s screen is a child of the uTview class.Views
act like little canvases that you can draw on with colors, pictures, and buttons.You can
drag them around the screen.You can resize them.You can layer them.Views provide the
basic component of user interfaces.

The iPhone rule goes like this: one window, many views. If you keep that idea in mind,
the iPhone interface design scenario simplifies. Metaphorically speaking, UIwindow is the
TV set, and uIviews are the actors on your favorite show. They can move around the
screen, appear, and disappear, and may change the way they look and behave over time.

The TV set, on the other hand, normally stays still. It has a set screen size that doesn’t
change even if the virtual world you see through it is practically unlimited. You may even
own several TVs in the same household (just like you can create several UIWindow in-
stances in the same application), but you can watch just one at a time.

UIViews are user interface building blocks. They provide visual elements that are
shown onscreen and invite user interaction. Every iPhone user interface is built from
UIviews displayed within one UIwindow, which is a specialized kind of uIview. The win-
dow acts a container; it is the root of the display hierarchy. It holds all the visible applica-
tion components within itself.

Beyond uview and UIwindow, you find a wealth of specialized views, such as
UIImageView and UITextView, that allow you to build your interfaces from predesigned
components. This section provides a rundown of those views. The Interface Builder
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library makes these views available to you, allowing you to place them in your application
interfaces to build your GUIs.

Note
The Ul at the beginning of certain classes (like UIVview) stands for User Interface.

Views That Display Data

One of the most important things that a view can do is provide a visual representation of
data. In Cocoa Touch, the following classes show information onscreen.

= The UITextView class presents passages of text to your users and/or allows them to
type in their own text using the keyboard.You choose whether to set the view text
as editable. Text views use a single font with a single text size throughout.

= UILabel instances present short, read-only text views. As the name implies, this class
is used to statically label items on your screen.You choose the color, font size, and
font face for your labels by setting view properties. The words “Fahrenheit” and
“Celsius” shown in Figure 4-8, later in the chapter, are created by uILabels.

= UIImageViews show pictures.You load them with uUIImage objects, which are in-
stances of an abstract image storing class. Once loaded, you specify the view’s
location and size. The UIImageView automatically scales its contents to fit those
bounds. A special feature of this class allows you to load a sequence of images rather
than a single picture and animate them on demand.

= When you want to display HTML, PDFs, or other advanced Web content, the
UIWebView class provides all the functionality you need. UIwebView instances offer a
powerhouse of display capabilities, allowing you to present nearly any data type sup-
ported by the built-in Safari browser. These views offer simple Web browsing with a
built-in history, essentially giving you a canned, usable Safari-style object you can
insert into your programs. Sometimes developers use UIWebView instances to pres-
ent blocks of stylized text. As a bonus, these support zoom and scroll with no addi-
tional work.

= MKMapViews (MK stands for Map Kit) embed maps into your applications. Users can
view map information and interact with the map contents, much as they would
with the Maps application. This class, which was introduced in the 3.0 SDK, lets you
annotate the map with custom information using the MKAnnotationview and
MKPinAnnotationview classes.

= UIScrollview instances allow you to present content that is larger than the normal
size of an application window. Users can scroll through that content to view it all,
using horizontal and/or vertical scrolling. Scroll views support zooming, so you can
use standard iPhone pinch and spread gestures to resize content.



UlView and UIWindow

Views for Making Choices

The iPhone offers two core classes that offer choices to users. The UIalertview class pro-
duces those blue pop-up windows you’ve seen in many applications. You choose the mes-
sage and customize their buttons to ask users questions. For example, you might ask a user
to confirm or cancel an action in your program. In addition to questions, you can present
information. By offering just one button (typically “Okay”), alert views provide a simple
way to show text to users.

The second choice-based class is UIActionSheet, which offers menus that scroll up
from the bottom of the screen. Action sheets display a message and present buttons for the
user to choose from. Although these sheets look different from alert views, functionally
they perform in a similar manner. As a rule, use action sheets when you have a number of
options to choose from and alert views when you are presenting just two or three choices
at most.

Both these presentations are modal. They require users to make a selection before
proceeding. For this reason, it’s polite to offer a cancel option among the other
choices.

Controls

Controls are onscreen objects that transform user touches into callback triggers. They may
also provide numeric or text values consumed by your application. Controls include but-
tons, switches, and sliders, among others. They correspond closely to the same kinds of
control classes used in desktop programming. Here’s a quick rundown of the major classes
provided by Cocoa Touch and what each control offers:

» UIButton instances provide onscreen buttons. Users can push them to trigger a call-
back via target/action programming.You specify how the button looks, the text it
displays, and how the button triggers. The most typical trigger used is “touch up in-
side,” where the user touch ends inside the button’s bounds. If it seems strange to
trigger with touch up rather than touch down, consider that the de facto standard
on the iPhone allows users to cancel a button press by sliding their finger away from
the button before lifting it.

In Interface Builder, buttons are called Round Rect Buttons. In IB, you also en-
counter buttons that look like views and act like views but are not, in fact, views.
Bar button items (UIBarButtonItem) store the properties of toolbar and navigation
bar buttons but are not buttons themselves. The bars use these descriptions to

build themselves; the actual button views are not generally accessible to you as a
developer.

Note

In Interface Builder, you can search the view library by class name (e.g., UIButton) or by
IB’s description (e.g., round or button).
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s The UISegmentedControl offers a row of equally sized buttons that act like the
old-fashioned radio buttons in a car, namely that only one button can be selected at
a time.You can present these buttons as images or text. An option (called “momen-
tary”) lets you replace the radio-button behavior with a style that prevents the but-
tons from showing which button was last selected.

= In Cocoa Touch, the urswitch class provides a simple binary control. This class pres-
ents On/Off choices and looks like a standard light switch you'd see on a wall.

s The urslider class lets users choose a value from a specified range by sliding an in-
dicator along a horizontal bar. The indicator (called the “thumb”) represents the
current setting for the control. The value is set by the thumb’s relative placement.
The iPhone’s onscreen volume slider in the iPod/Music application represents a
typical slider instance.

= Page controls let users move between pages, usually as part of a UIScrollview im-
plementation. The UIPageControl class offers a series of small dots (like the ones
you see on the iPhone’s home page) showing the current page and letting users
navigate to the next or previous pages.

= UITextFields are a kind of control that let you enter text. These fields offer just a
single line for input and are meant to solicit short text items (like usernames and
passwords) from users. Figure 4-8, later in the chapter, includes two text fields.

Tables and Pickers

Tables present a scrolling list of choices. The uITableview class provides the most com-
monly used table style, which you see, for example, in the Contacts,YouTube, and
iPod/Music applications. Tables offer rows of information (provided by the
UITableviewcCell class), which users scroll through and can select.

The urPickerview class offers a kind of table, where users can select choices by scroll-
ing individual wheels. A specialized version of this class is the UIDatePicker, which
comes preloaded with date- and time-specific behavior and is used extensively in the Cal-
endar and Clock applications.

Bars

The iPhone offers four kinds of bar-style views. Bars are compact views (typically shorter
than 50 pixels in height) that extend from one side of the screen to the other. The most
commonly used view is the UINavigationBar (see Figure 4-2, later in the chapter), which
is presented on top of many interfaces to provide navigation state. As a developer, you
almost never work directly with class instances. Instead, the view is generated and man-
aged by UINavigationController instances, which you read about in chapter sections
that follow this one.

Tab bars offer the kinds of choices you see at the bottom of the YouTube and
iPod/Music applications, like Featured, Most Viewed, Albums, and Podcasts. Later in the
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chapter, Figure 4-3 (top) shows a typical UITabBar instance. Search bars (UISearchBar)
add a text-based view meant to be shown on the top navigation bar of a table, as used in
the Contacts application. As with navigation bars, you normally work through
UITabBarControllers and UISearchDisplayControllers instead of building and man-
aging the view directly.

Of all the iPhone bars, only the UIToolbar class is meant for direct use. It provides a
series of buttons similar to segmented controls but with a different look (see Figure 4-3,
bottom). Toolbars are limited to a momentary highlighting style. The role of toolbars is to
provide a vocabulary of actions that act on the current view. The toolbar used in the Mail
application allows you to delete messages or to reply to messages. Toolbars present mono-
chrome images on each button.

If your design ideas include tab bars and toolbars, take the time to read Apple’s Human
Interface Guidelines, available as part of the standard iPhone documentation library. Apple
regularly rejects applications that use bars in a manner inconsistent with these guidelines.

Note

As with bar button Items, navigation items appear in Interface Builder and can be placed in
your projects as you would place views. Like their cousins, navigation items are not views
themselves. They store information about what items go on navigation bars and are used to
build the bar that does appear.

Progress and Activity

Cocoa Touch provides two classes meant to communicate an ongoing activity to the user.
The UIActivityIndicatorView offers a spinning-style wheel, which is shown during an
ongoing task. The wheel tells the user that the task may finish at some point, but it does
not determine when that time will end. When you want to communicate progress to a
user, use the UIProgressview class. Instances offer a bar that fills from left to right, indi-
cating how far a task has progressed.

UlViewControllers

On the 1Phone, view controllers centralize certain kinds of view management. They pro-
vide practical utility by linking views into the pragmatic reality of your device.View con-
trollers handle reorientation events such as when users tip the iPhone on its side to
landscape mode and navigation issues such as when users need to move their attention
from view to view.

View controllers aren’t views. They are abstract classes with no visual representation;
only views offer visual canvases. Instead, they help your views live in a larger application
design environment. Do not set a frame the way you would with a normal uIview.
UIViews use initWithFrame:;UIViewControllers use init.

The iPhone SDK offers many view controller classes. These classes range from the
general to the specific. In a way, specialized controllers are both a blessing and a curse. On
the positive side, they introduce enormous functionality, essentially with no additional
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programming burden. On the downside, theyre so specialized that they often hide core
features that developers might prefer to work with.

For example, there’s no simple camera access class. You must work through the
UIImagePickerController class to snap photos.This class with its prebuilt GUI is elegant
and well designed, but it denies developers direct access to the camera and to custom user
interfaces that they might prefer to build.You cannot pull live data from the camera and
store it to a time-lapse database. Instead, your user must shoot the image, agree that the
image is what he or she wanted, and then pass the control back to your application.

Here’s a quick guide to some of the view controllers you’ll encounter while building
your iPhone application interfaces.

UlViewController

UIViewController is the parent class for view controllers and the one you use to manage
your primary views. It’s the workhorse of view controllers.You may spend a large part of
your time customizing this one class. The basic UIviewController class manages each
primary view’s lifetime from start to finish and takes into account the changes that the
view must react to along the way.

For example, UIviewControllers handle reorientation tasks, letting you program for
both landscape and portrait orientation. UIviewControllers decide whether to change
their orientation when a user tilts the iPhone, and specify how that orientation change
occurs. They do this via instance methods like shouldautorotateToInterface
=Orientation:. Without a view controller, your interface won’t support automatic ori-
entation updates. Many developers have found it difficult trying to rotate UIviews directly
without the help of a view controller class.

UIViewController instances are responsible for setting up how a view looks and what
subviews it displays. Often they rely on loading that information from .xib files. A variety
of instance methods such as loadview and viewDidLoad let you add behavior while or af-
ter a view sets up.

Reacting to views being displayed or dismissed is another job that view controllers
handle. These are the realities of belonging to a larger application. Methods like
viewDidAppear: and viewWillDisappear: let you finish any bookkeeping associated
with your view management. You might preload data in anticipation of being presented or
clean up memory that won't be used when the view is not onscreen.

Each of the tasks mentioned here specifies how a view fits into an enveloping applica-
tion and works on a particular device. The UIViewController mediates between views
and these external demands, allowing the view to change itself to meet these needs.

UlNavigationController

As the name suggests, navigation controllers allow you to navigate up and down through
tree-based view hierarchies. They create the solid-colored navigation bars that appear at the
top of many standard iPhone applications.You see navigation controllers in use whenever
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you drill through some sort of hierarchy, whether using the Contacts application or the
on-iPhone App Store. Both of these applications are built using navigation controllers.

Navigation controllers let you push new views into place and automatically generate
“back” buttons showing the title of the calling view controller. All navigation controllers
use a “root” view controller to establish the top of their navigation tree, letting those back
buttons lead you back to a primary view. Navigation controllers and their trees are dis-
cussed in greater detail later in this chapter.

Handing off responsibility to a navigation controller lets you focus your design work
on creating individual view controller screens.You don’t have to worry about specific
navigation details other than telling the navigation controller which view to move to
next. The history stack and the navigation buttons are handled for you. Chapter 5,
“Working with View Controllers,” discusses navigation controllers in further detail and
offers recipes for their use.

UlTabBarController

Parallel views are like stations on a radio. A tab bar helps users select which
UIViewController to “tune in to,” without there being a specific navigation hierarchy.
You see this best in applications like YouTube and iPod, where users choose whether to
see a “Top 257 list or decide between viewing albums or playlists. Each parallel world op-
erates independently, and each can have its own navigation hierarchy. You build the view
controller or navigation controller that inhabits each tab, and Cocoa Touch handles the
multiple-view details.

For example, when tab bar instances oftfer more than five view controller choices at a
time, users can customize them through the More > Edit screen. The More > Edit screen
lets users drag their favorite controllers down to the button bar at the bottom of the
screen. No extra programming is involved. You gain editable tabs for free. All you have to
do is request them via the customizableviewControllers property. See Chapter 5 to
read more about implementing tab bar-based applications and setting the images that
adorn each button.

Table Controllers

Table view controllers simplify using tables in your iPhone projects. The
UITableViewController class provides a standard already-connected UITableview in-
stance and automatically sets delegation and data sources to point to itself. All you have to
do is supply those delegate and data source methods to fill up the table with data and re-
act to user taps. UITablevViewController is discussed at length in Chapter 11, “Creating
and Managing Table Views.”

The search display controller is a kind of table view but one that offers a built-in
search bar via uSearchBar. With it, you allow users to search data that is provided by an-
other view controller, called its contents controller. As users update the search information,
the contents controller adjusts its data source to include only those items that match the
search query.
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It may seem odd to force another controller to perform that work, but in practice, it
works out very neatly. The contents controller is almost always a table view controller,
which displays the search controller on demand. The search then weeds through the origi-
nal table’s data and shows a subset of that information until the search is dismissed.

The NSFetchedResultsController also provides a kind of table-based controller. Al-
though strictly speaking, not a view controller, this class helps populate a UITableView
with objects fetched from a Core Data store. See Chapter 19,“A Taste of Core Data,” for
an example that shows this class in action.

Address Book Controllers

The Address Book user interface framework (AddressBookUI.framework) provides several
view controllers that let you select a person from your address book, view his or her de-
tails, and add a new person or modify an existing person’s entry. These view controllers tie
into the C-based ABAddressBook framework, which provides functions that query and
update the iPhone’s built-in address book. Chapter 18, “Connecting to the Address Book,”
discusses the Address Book and its UI controllers in greater detail.

UlimagePickerController

This utility controller allows users to select images from onboard albums or to snap a photo
or shoot video using the iPhone camera. With it, you gain full access to most of the organi-
zational features made available to users via the Camera and Photos applications. In truth,
there are not two separate applications. There is just one application that poses as those two
utilities, just as the single controller offers access to both camera and photo selection features.

‘When selecting pictures, Apple has added an advanced image-selection interface. Users
can navigate up and down the photo album hierarchy until they find the image they want
to use. The picker automatically handles access to the onboard photo album leaving you
little more to do than decide how to use the picture it picks.

The photo/video interface is equally impressive. The controller even lets the users op-
tionally orient and zoom an image before finishing, providing user-defined “edits” on the
picture they snap. Full discussions of this class, including how-to’s for both the selection
and camera versions, appear in Chapter 7, “Working with Images,” and Chapter 15,
“Audio, Video, and MediaKit.”

Mail Composition

The MFMailComposeViewController lets you create mail messages that users can cus-
tomize from directly in your program. Although the iPhone has long supported mailto:
URLs to send mail messages, this new class introduced in the 3.0 SDK offers far more
control over mail contents and attachments. What’s more, users can continue working
within your program without being forced to leave to access the Mail application.

The mail composition controller is simple to use and is used in Chapter 7 to mail pho-
tographs. It is part of the MessageUI framework; the MF prefix apparently stands for Mes-
sage Framework.
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GKPeerPickerController

The GameKit peer picker provides a standard GUI for discovering and connecting to
other iPhones. It offers a slick interface listing other iPhones that are available and can be
linked to. Although this controller is part of GameXKit, its technology is readily adaptable to
nongame uses including file transfer, messaging, and so forth.

You can configure the picker to select whether to use Bluetooth or Internet connec-
tions. When presented to the user, only the supported connections appear. Note that users
cannot control that choice themselves using this interface.

Read more about using the peer picker controller in Chapter 12, “Making Connec-
tions with GameKit and Bonjour.”

Media Player Controllers

The Media Player framework offers several controllers that allow you to choose and play
music and movies. The MPMediaPickerController provides a media-selection GUI that
allows users to choose music, podcasts, and audio books.You choose which media to pres-
ent, and you can play back that media via an MPMusicPlayerController instance.

When your user needs to watch a movie or listen to audio, an
MPMoviePlayerController instance does the trick. Just supply it with a path to the media
resource and push the controller into view. The controller provides a Done button for the
user or automatically returns a delegate call when playback finishes.

If you want to read more about picking and playing back media, refer to Chapter 15.

View Desigh Geometry

The iPhone hardware is not theoretically limited to a 320-by-480 display. Design your ap-
plications as resolution-independently as possible. That having been said, certain facts of
geometry play a role in the design of current generation iPhone applications, particularly
when you need to hand specs to a graphic designer to take to Photoshop.

Here is a rundown of the onscreen elements whose geometry can mostly be counted
on to stay set when building your interfaces. Try not to rely on these sizes where possible,
but rather design around them while keeping their proportions and aspect ratios in
mind.

Keep in mind that future iPhone models and related iPhone OS devices may not use
the same screen size or shape. All the measurements in this section apply specifically to the
first five members of the iPhone OS family, all of which use a 320x480 screen: the first
generation iPhone, the iPhone 3G/3G S, and the various generations of iPod touch.

Status Bar

The status bar at the very top of the iPhone screen shows the time, connectivity, battery
status, and carrier (iPhones) or model (iPods) of the unit.This bar is 20 pixels in height for
normal use. It zooms to 40 pixels high during phone calls or when displaying messages;
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note that double-height status bars appear to be a portrait-only feature. Unfortunately the
SDK does not offer any public hooks into the message display system so you can’t display
your own messages. You can see these 40-pixel colorful status displays when you pause a
Voice Memo recording, use Nike+, or tether the iPhone on 3G or later units.

Figure 4-1 shows the status bar for portrait, landscape, and 40-pixel-high message
modes.You can hide the status bar from your users, but doing so at a minimum eliminates
their access to seeing the time and battery information unless you supply that information
elsewhere in your application’s user interface.You can set the status bar to display in gray,
black, or translucent black. The latter allows the view behind it to bleed through to better
coordinate colors with your application.

_aill Carrier = 8:47 AM [
[-utl Carrier = 2:29 PM =
il Carrier < 2:48 PM [

Touch to return to call

No Service = 4:53 PM =
Recording Paused 00:39

Figure 4-1 The status bar is normally 20 pixels high,
regardless of whether the iPhone is using portrait or
landscape orientation. At times the status bar zooms to
40 pixels in height to indicate ongoing system operations
like a phone call or a paused recording.

If you’d rather free up those 20 pixels of screen space for other use, you can hide the status
bar entirely. Use this UIApplication call: [UIApplication sharedApplication]
setStatusBarHidden:YES animated:NO].Alternatively, set the UIStatusBarHidden key
to <true/> in your application Info.plist file.

With the status bar displayed, your application has 320x460 pixels to work with in por-
trait mode, and 480x300 pixels in landscape mode for the standard iPhone. These numbers
change depending on whatever other elements you add into the interface such as naviga-
tion bars, tab bars, and so forth. And as already mentioned, the standard iPhone pixel di-
mensions may change over time as Apple releases new models and new related
touch-based products that run iPhone OS.

The status bar plays a role in both landscape and portrait orientations, adjusting to fit
as needed. To run your application in landscape-only mode, set the status bar orientation
to landscape. Do this even if you plan to hide the status bar (that is, [ [UIApplication
sharedApplication] setStatusBarOrientation: UIInterfaceOrientation
LandscapeRight ]). Alternatively, set UIInterfaceOrientation in your Info.plist to the
string UIInterfaceOrientationLandscapeLeft or UIInterfaeOrientationLandscapeRight.
These options force windows to display side to side and produce a proper landscape key-

board.



View Design Geometry

Note

Use Hardware > Toggle In Call Status Bar to test your interfaces in the simulator using the
40-pixel-high status bar.

Navigation Bars, Toolbars, and Tab Bars

By default, uINavigationBar objects (see Figure 4-2) are 44 pixels in height in portrait
mode and 32 pixels high in landscape. They stretch from one side of the screen to the
other, so their full dimensions are 320x44 pixels and 480x32 pixels.

_
I —

Button Sample Right

Button Sample

Figure 4-2  Navigation bars stretch from one side of the
screen to the other. Their height is fixed at 44 pixels for
portrait mode and 32 pixels for landscape on the stan-

dard iPhone. The rarely used prompt feature shown in the

bottom two images zoom the bar to 74 pixels high.

Navigation bars offer a seldom-used “prompt” mode that extends the height by 30 pixels.
In portrait mode, the bar occupies 320x74 pixels and in landscape, 480x74, using a
44 pixel high navigation bar rather than the normal 32 pixel high version.

Note

To add a prompt to a navigation bar, edit the view controller’s navigation item, that is,
self.navigationItem.prompt = @”Please click a button now”;.

Tab bars are 48 pixels high in both orientations, 320x48 pixels and 480x48 pixels. Accord-
ing to Apple, the individual items on tab bars should be designed with a minimum 44x44
hit region to provide sufficient space for users to tap. That corresponds to individual art of
about 30x30 pixels.

Figure 4-3 shows a typical tab bar and its near-cousin class, the toolbar. Toolbars use the
same 44 pixel spacing as navigation bars but, like tab bars, they’re meant to be displayed at
the bottom of the screen.
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=

iPocket

Figure 4-3 Tab bars are 48 pixels high for
320x480-pixel iPhone units (top). Toolbars use the
same 44-pixel spacing as navigation bars.

These two Ul elements aren’t generally meant for landscape mode use.You can see this with
both the iPod and YouTube applications. These apps swap out a toolbar-based portrait view for
a completely separate landscape presentation: Coverflow for iPod, movies for YouTube.

Between status bars, navigation bars, tab bars, and toolbars, you need to apply some basic
math to calculate the remaining proportions available to background design. A typical appli-
cation with a navigation bar and status bar leaves a central area of 320x416 for portrait dis-
play and 480x268 for landscape. Using tab bars or toolbars effectively diminishes the available
height by another 48 or 44 pixels and the resulting proportions change accordingly.

Keyboards and Pickers

The standard iPhone keyboard uses 320x216 pixels for landscape presentation and
480x162 for portrait. Figure 4-4 shows the keyboard in its default configuration in both
its orientations. When a text element becomes active in your application, the keyboard
displays over any elements at the bottom of the screen leaving a shortened space at the top
for interaction. Complex keyboard layouts may use even more onscreen room.

a|w|e|R|T|vfuli]o|P]
Als|o|Fla|H]| K|t
< HEB0000 =
.2123 m return

return

Figure 4-4  Both the portrait and landscape keyboards
occupy a large part of the iPhone screen. Design your ap-
plications accordingly.
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As a rule, resize your main view when the keyboard displays. When you have several on-
screen elements to edit, a shortened scrolling view works best. This lets your users access
all possible areas by scrolling and won'’t leave text fields or text views hidden behind the
keyboard. Change the background view’s frame, shortening it by 216 or 162 pixels, de-
pending on orientation.

Make sure you provide a way for the user to dismiss the keyboard, by pressing the Re-
turn key or tapping a Done button, to make sure you can return to your normal display.
Don’t leave users caught with the keyboard displayed. See Chapter 9, “Building and Using
Controls,” for a discussion about dismissing keyboards for more details.

Note

Both the UIPickerView and UIDatePicker use the same geometry as the standard Key-
board. uIswitches default to 94 by 28 pixels, and UISegmentedControls are typically 44
pixels high in their standard text-based form.

Text Fields

When working with UITextField instances, allocate at least 30 pixels in height. This al-
lows users enough room to enter text using the default font size without clipping.

The UlScreen Class

The UIscreen object acts as a stand-in for the iPhone’s physical screen, which you can ac-
cess via [UIScreen mainScreen].This object maps standard window layout boundaries
into pixel space. It takes into account any toolbars, status bars, and navigation bars in use.

To recover the size of the entire screen, use[ [UIScreen mainScreen] bounds].This
returns a rectangle defining the full pixel size of the iPhone’s screen. As mentioned earlier
in this chapter, the iPhone screen may not always be 320x480 pixels in size should Apple
introduce new units.

Another method call returns the central application space. Call [ [UIScreen
mainScreen] applicationFrame] to query this value. On a first or second generation
unit, for an application that uses a status bar and a navigation bar, this might return a size
of 320x416 pixels, taking into account the 20-pixel status bar and 44-pixel navigation bar.

Use these numbers to calculate the available space on your iPhone screen and lay out
your application views when not using Interface Builder.

Building Interfaces

There’s more than one way to build an interface. With the iPhone SDK, you can build a
GUI by hand using Objective-C, or you can lay it out visually in Interface Builder. When
coding, you programmatically specify where each element appears onscreen and how it
behaves. With Interface Builder, you lay out those same elements using a visual editor.

155



156

Chapter 4 Designing Interfaces

Both approaches offer benefits. As a developer, it’s up to you to decide how to balance
these benefits.

In the end, both technologies take you to the same place. The code used in Objective-
C corresponds directly to the layout used in Interface Builder, and the callback behavior
set up in Interface Builder produces identical results to those designed in Objective-C.

Yes, the implementation details differ. A hand-built version uses loadview to create the
main view and add its interface elements. In contrast, an xib-based view controller fin-
ishes setting itself up in viewDidLoad after loading the prebuilt interface from a .xib file.
Cocoa Touch supports both these approaches, plus you can use a hybrid approach, loading
xib files via direct Objective-C commands.

The next few sections show you various ways to use these tools. You walk through a
full IB approach and then a full Xcode one. After, you’ll find two further hybrid solu-
tions. All four of these walk-throughs produce identical end products offering identical
functionality.

Walk-Through: Building a Temperature Converter
with IB

Interface Builder, with its interactive GUI layout tools, helps lay out visual content. It
makes it possible for you to add interactive controls, moving them around the screen by
hand to design custom interfaces. This first example creates a classic Fahrenheit to Celsius
converter using absolutely standard Xcode/IB design templates. The interface is laid out
entirely in Interface Builder with a minimum of coding in Xcode.

Note

Make sure that you have worked through the Hello World examples in Chapter 2, “Building
Your First Project,” so you have a starting off point for understanding Xcode and Interface
Builder. The samples in this chapter go into greater depth but assume you've already
learned some of the basic vocabulary for using these tools.

Create a New Project

Launch Xcode and create a new project. Choose File > New Project > iPhone OS > Ap-
plication > Navigation-based Application and click Choose. Name it HelloWorld and save
it to your Desktop. Once created, a new project window opens in Xcode. This new proj-
ect contains two .xib files, MainWindow.xib and R ootViewController.xib, as well as
classes for your application delegate and the root view controller.

Any time you use a navigation-style project, you must assign it a root view controller.
This is the view controller that lives at the top of the navigation tree. All other view con-
trollers branch out from this one. The name of the .xib file and its class reflect this design
necessity.
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Add Media

Before moving forward, you need to add some basic media to the project. Copy the
icon.png and Default.png artwork—they’re in the sample code folder—to the project by
dropping them into the Resources group in the Groups & Files column. Make sure to
check Copy Items into Destination Group’s Folder (If Needed) before clicking Add.

Note

When you use a single asset in multiple projects, you can add that file without copying. This
maintains a single source version that you can update, and its changes are reflected in each
of the projects that use it. On the downside, if you remove the file from any project, you
might accidentally delete the original, which can affect multiple projects.

These two items provide the image used for the application icon on the iPhone’s Spring-
Board (icon.png) and the image displayed as the application launches (Default.png). Each
application you build should contain art for these. The roles of these two items are dis-
cussed in further detail in Chapter 1, “Introducing the iPhone SDK.”

Next, add cover320x416.png in the same manner and add it to the Resources group.
This file provides a backsplash image, which you use in this project. The art is sized for a
portrait-style interface that uses a status bar and a navigation bar.

Interface Builder

Locate MainWindow.xib and double-click it to open the file in Interface Builder. Bring
the MainWindow.xib window to the front. It is listed in the Windows menu if you have
trouble finding it. Here, you find five items, as shown in Figure 4-5.The first two, File’s
Owner and First Responder, you saw in Chapter 2. The others, a Hello World application
delegate (labeled Hello World A...), the Window, and the navigation controller (labeled
Navigation Co...) are new.

800 # MainWindow.xib =
oo ‘a 3
Q

Mod

=
< @ ®

File's Owner First Responder Hello World A...

—

d

Window Navigation Co...

Figure 4-5 The standard MainWindow.xib compo-
nents generated by Xcode’s Navigation Application.
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The identity inspector (Command-4) lets you explore the classes for each object. Click on
each object with the inspector open.The File’s Owner is a UIApplication instance, and
its delegate is the Hello World application delegate. This matches the design pattern previ-
ously discussed in Chapter 1.

The Window is a UIwindow instance. The window provides a full-screen view that
owns all application views once they are added.You will not work with this instance di-
rectly because it has already been set up to show the view contents defined by the naviga-
tion controller.

The role of the navigation controller is a little tricky. That’s because it provides a navi-
gation bar showing an optional title and maybe some buttons while another class provides
the actual interface elements below the bar. Every uINavigationController must be ini-
tialized with a single root view controller. That view controller provides the view that fills
the rest of the screen. Navigation controllers are discussed in greater detail later in this
chapter.

Double-click the navigation controller object and an editor window opens, as shown
in Figure 4-6.As you can see from this screenshot, the MainWindow .xib does not define
the root directly. Instead, it loads that view from RootViewController.xib, the second .xib
file that was created when you built the Navigation Application template.

™ ™ 7 Navigation Controller

=

View
Loaded From "RootViewController"

Figure 4-6 The Navigation Controller loads its
root view controller from a secondary .xib file.
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In theory, loading that view controller from a secondary file lets you design compo-
nents orthogonally, designing the view separately from the window and navigation bar. (In
reality, this is not a universally loved feature of Interface Builder.) Open the Attributes
Inspector (Command-1). Here you see the pop-up that lets you choose a .xib to set
as the root view controller. Do not change the selection, as you have no other
UlViewController .xib items to choose from.

Edit the Navigation Bar

Return to the editor shown in Figure 4-6, and make the following changes. First
double-click the middle of the blue bar and type the word “Converter.” This adds a
title to your navigation bar. Second, drag a bar button item from the library (Tools >
Library, Command-Shift-L) onto the right side of the bar. Double-click and change
the word “Item” to “Convert.” Figure 4-7 shows the bar after performing these
actions.

M O 7 Navigation Controller

Figure 4-7  You can edit the navigation controller
bar directly and add buttons to it.

Replace the Main View

When using standard templates, sometimes Apple doesn’t quite deliver what you really
need.To see this problem in action, open RootViewController.xib in Interface Builder.
This file includes a File’s Owner, a First Responder, and a Table View. Xcode’s default
Navigation Application project assumes you will use a table view controller, but this walk-
through requires a UIviewController instead. Quit IB.Youre about to replace the table-
based controller with a view-based one.

In Xcode, select RootViewController.xib, RootViewController.h, and RootViewCon-
troller.m. Delete these files by pressing Delete on your keyboard. Choose Also Move to
Trash. This eliminates the table-based defaults you started with.

Choose File > New (Command-N) > iPhone OS > Cocoa Touch Class > UlIView-
Controller subclass. Check With XIB for User Interface and click Next. Name the file
RootViewController.m, check Also Create RootView Controller.h, set the location to
your main project folder, and click Finish. This builds a new view-based version of the
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three RootViewController files you need for the project: the .xib file, the .h header file,
and the .m implementation file. At this point, you may want to drag the new class files
into the Classes group and the new .xib file into the Resources group.

Note
| use navigation controller-based projects often enough that | created my own template

rather than fix up the table-based version each time. Directions for building your own Xcode
user templates appear in Chapter 2.

Enable Simulated Elements

Locate the new RootViewController.xib file and double-click it to open it in IB. In
Interface Builder, double-click View. This opens the view editor, which starts as basically
a blank view, possibly with a status bar. Before going any further, you need to add a
simulated element; this ensures that the design space matches the components that show
onscreen.

Open the attributes inspector (Command-1). The status bar should already be selected
as Gray. If it is not, go ahead and do so.Then choose Top Bar > Navigation Bar. This adds
a basic navigation bar placeholder to the view. Leave the bottom bar unselected. These
simulated elements block off parts of the screen, limiting your design space to the remain-
ing area.

Create an Image Backdrop

Drag an image view into the editor. It automatically zooms to fill all available space in the
view below the navigation bar. Let the image view automatically snap into place and
completely cover that below-bar area.

In the attributes inspector, locate the Image drop-down. Choose cover320x416.png.
This drop-down lists all available art from your Xcode project. (To add more images, drop
them into the project in Xcode.) After selecting the png image, the editor’s image view
updates to show the art you chose.

Remaining in the attributes inspector, check Interaction > User Interaction Enabled.
This is a vital step, allowing users to interact with any subviews. Whenever you use an im-
age backdrop, always be sure to enable interactions. This little “gotcha” frequently snags
developers who forget.

Add Labels and Views

Drag two text fields and two labels into the view from the library. Set up these elements
to roughly match the layout in Figure 4-8. Then double-click the labels and edit the text,
labeling the top one Fahrenheit and the bottom Celsius.
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Fahrenheit _ )

Celsius ) :

Figure 4-8 Lay out your text fields and labels to
match this design.

It’s important to specify how you want each text field to interact with users. Among other
features, you can choose which keyboard to display, whether a prompt appears in the text
box, whether words are autocorrected, autocapitalized, and so forth.

Select the top text field. In the attributes inspector, choose Text Input Traits > Key-
board > Numbers & Punctuation. This ensures that a numeric keyboard is presented
when the user taps the top field.

Select the bottom field. Uncheck Control > Content > Enabled. The bottom field
shows results and should not be editable by users.

Note

As you add more elements to your Interface Builder view, it becomes difficult to select the

correct one by clicking on it. One handy tip is to Control+Shift+click on any view in an Inter-
face Builder edit window to display a list of all views stacked at that point. You can choose
an item from that list to select it.

Test the Interface

Save your changes and return to Xcode. Choose Project > Set Active SDK > iPhone
Simulator, and then Run > Run to compile the project as-is and run it in the simulator.
While running, make sure that the top field opens a numbers-based keyboard and that the
bottom field cannot be edited.You can click on the Convert button, but it does not do
anything yet. So long as your project can be compiled, you can always check your current
progress in the simulator and/or on a device.

Although you can test an interface directly in Interface Builder (use File > Simulate In-
terface, Command-R), the IB implementation is far less reliable than actual Xcode testing.
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Add Outlets and an Action

Outlets and actions play important roles in Interface Builder design. Outlets connect inter-
faces to objects; they essentially act as instance variable stand-ins. Actions are methods that
your IB-created interfaces can invoke. They specify target/action pairs, sending callbacks from
control views to objects. For this project you need to create two outlets and one action.

Return to Interface Builder and open the Library > Classes pane. Type RootViewCon-
troller into the search field at the bottom of the pane. Then tap on RootViewController in
the search results and click the Outlets tab. Add two outlets by clicking the + button. Name
them fieldl and field2. By default, the outlets are typed to id. Edit each type to change
id to uITextField. Typing limits how outlets can connect to view objects. When typed to
UITextField, the outlets can connect to the two fields you placed in the view but not, for
example, to the labels.

Next, add an action, again using +. Edit the default action name to convert:, making
sure to add the colon. Figure 4-9 shows the Library pane after making these changes.

8.0.0, Library 800 Library

[ Objects [ Classes-| Media | [ Objects | Classes.| Media |

("1l Library ] ([l Library ]

() RootViewController () RootViewController

m RootViewController m RootViewController
| UIviewContraller X ¥ UviewController

Lineage = Definitions | Outlets | Actions | Lineage Definitions  Outlets | Aninnsj

Outlet & Type Action A Type
RootViewController.xib RootViewController.xib

field1 UlTextField convert id

field2 UlTextField

+ +

¥ ) @ RostviewController % ) Q, RoatviewController

Figure 4-9 Use the Library’s Classes pane to add outlets and actions to
your classes.

Interface Builder can generate class files from the action and outlet changes you made.
Save the project, select File’s Owner, and choose File > Write Class Files. Keep the file-
name as RootViewController (no extensions) and save into your main folder, not the
Classes subfolder. When you re-created RootViewController, both the .xib file and the
class files were added to the main project folder. Click Replace to replace those files.
Take note that this action could cause data loss if you've already customized the
RootViewController class and then use IB to overwrite those changes.
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Note

Interface Builder can read class header files from Xcode (File > Read Class Files), or you can
drop header files into your IB document. This lets you add instances of custom classes and
assign objects to those classes with the identity inspector. If your .xib file “forgets” which
class the file owner belongs to (usually indicated by a warning about the view outlet being
connected but no longer defined), just reimport the custom view controller class header.

Inspect the New Class Header

Return to Xcode and open RootViewController.h. The newly generated class interface
includes the outlets and action you defined in IB. Both fieldl and field2 are typed, as
you requested, as UITextField instances and they are declared using the 1Boutlet key-
word. This keyword specifies that the instance variable will be set to match an IB element
when the view controller loads. The single convert action is typed to IBAction, which is
basically the same as (void).

@interface RootViewController : UIViewController {
IBOutlet UITextField *fieldl;
IBOutlet UITextField *field2;

}

- (IBAction)convert: (id)sender;
@end

Although you have now defined these two outlets and the action in your
RootViewController class, you have not made any assignments that would connect these
to elements in your view object. It’s time to do so.

Add Your Connections

Return to IB, select File’s Owner, and open the connections inspector (Command-2).
This inspector (shown in Figure 4-10) lists each available outlet and action. The empty
circles on the right show that the three elements you added have not yet been assigned.

® T O Root View Controller Connections
= o |l o | o

¥ Outlets

field1 @)

field2 @)

searchDisplayController O
(view —{® View ®
¥ Received Actions

convert: @)
¥ Referencing Outlets

New Referencing Outlet O

Figure 4-10 Empty circles indicate outlets and
actions that have yet to be connected to real world
objects.
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Drag from the field1 circle to the top text field. Then drag from the field2 circle to the
bottom text field. These connections define the real objects that each IBOutlet refers to.
Save your work.

Open MainWindow.xib. Double-click Navigation Controller to open the editor win-
dow shown in Figure 4-6. While holding down the Control key, drag from the Convert
button to the view in the middle. The Control-drag shortcut creates connections in the
same way as dragging from the circles shown in Figure 4-10. When the central view turns
slightly darker, release the mouse. A Sent Actions pop-up appears, as shown in Figure 4-
11. Select convert:, the only available action currently defined by the RootViewCon-
troller. Save.

™ O 7+ Navigation Controller

E

~

0 erter Convert

Loaded From *

Figure 4-11 Dragging from the bar button item
to the central view allows you to connect the button
action to a method defined by the view’s view
controller.

Note

Control-click (right-click) objects to open a pop-up showing many of the same details that nor-
mally display in the connections inspector.

It may seem counterintuitive to connect a button’s action to a view, when the actual
method being called is defined by the view’s view controller and not by the view itself. It
may also seem odd to connect a button in one .xib file to an object that’s defined in an-
other. These are, unfortunately, Interface Builder quirks that must be lived with.
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Capture Purple

The design for this project specifies a navigation bar that is tinted to match the art in the
backsplash. To make this happen, you must capture the right shade of purple. Return to
RootViewController.xib and open the View editor, which displays the
cover320x416.png art.

Open the Color Inspector (Font > Show Colors). Click the magnifying glass and drag
it over to the purple bar in the View art and click. This measures the purple from that
view and sets it as the current color for the color inspector.

Close RootViewController.xib and return to MainWindow.xib. In the project win-
dow, locate the view-mode options at the top-left of the window, above the File’s Owner
icon. Click the middle of these three view mode buttons. The window switches from icon
display to a list.

Open the disclosure triangle to the left of Navigation Controller and select Navigation
Bar, as shown in Figure 4-12.

®00o 7 MainWindow.xib =)
L] Q ]
| ViewMode W  SeachPeld
Name | Type
File's Owner UlApplication
@ First Responder UlResponder
§ | Helle World App Delegate HelloWorldAppDelegate
| Window Uiwindow
w & Navigation Controller UlNavigationController
» () Root View Controller (... RootViewController

Figure 4-12  To edit the navigation bar’s tint
color, you must navigate down to items not directly
available in the editor window.

With Navigation Bar selected, open the attributes inspector (Command-1). Make sure the
View from RootViewController.xib is visible onscreen. Drag the purple you sampled
from the top bar of the Colors palette into the tint well of the attributes inspector. Save
the file and close MainWindow.xib.

Defining the Conversion Method

Your project is now fully laid out and wired. The outlets are connected to the text field,
the button to the convert: action.That action, however, does not yet do anything. Re-
turn to Xcode and open RootViewController.m.The method is still just a skeleton that
does nothing.

@implementation RootViewController
- (IBAction) convert: (id) sender ({
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}
@end

For this project, the method should recover any text typed into the top field, convert it to
a float value, and then transform it from a Fahrenheit value to a Celsius one. The resulting
value gets placed into the second field. The following method does exactly that. What's
more, it dismisses the keyboard after performing the conversion by calling
resignFirstResponder. Add this full method to your code, and save.

- (IBAction) convert: (id) sender

{
float invalue = [[fieldl text] floatValue];
float outvalue = (invalue - 32.0f) * 5.0f / 9.0f;
[field2 setText:[NSString stringWithFormat:@7%3.2f”, outvalue]];
[field2 resignFirstResponder];
}

Run the Application

Now that you have fully edited your project, once again, run the program with Run >
Run.The program now converts Fahrenheit values into Celsius. Test with values of 32 (0
Celsius), 98.6 (37 Celsius), and 212 (100 Celsius).

Walk-Through: Building a Converter Interface by
Hand

Anything that can be designed in Interface Builder can be implemented directly using
Objective-C and Cocoa Touch. The code in Listing 4-1 duplicates the sample project you
just built. Instead of loading an interface from a .xib file, it manually lays out the elements
in the loadview method.

The code takes the same approach in doing so. First after creating a background view
(corresponding to View in the IB project), it adds an image view on top. The image
view uses the same art (cover320x416.png) and, as in IB, has its userInteractionEnabled
flag set to YES.

Next, it adds two labels and two text fields. It sets the label texts to Fahrenheit and
Celsius, tells the first field to use a numbers and punctuation keyboard, and disables the
second. The locations and sizes for these items use view frames derived from the previous
walk-through.

To finish the layout, the code tints the navigation bar purple and adds a Convert but-
ton. The button uses the same convert: callback as the IB project and calls the same code.
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Listing 4-1 Code-Based Temperature Converter

#import <UIKit/UIKit.h>

#define COOKBOOK_PURPLE_COLOR [UIColor colorWithRed:0.20392f w»
green:0.19607f blue:0.61176f alpha:1.0f]
#define BARBUTTON(TITLE, SELECTOR) [[[UIBarButtonItem alloc]=

initwWwithTitle:TITLE style:UIBarButtonItemStylePlain target:self action:SELECTOR]w=
autorelease]

@interface HelloWorldController : UIViewController {
UITextField *fieldl;
UITextField *field2;

}

-(void) convert: (id)sender;

@end

@implementation HelloWorldController

(void) convert: (id) sender

{
float invalue = [[fieldl text] floatValue];
float outvalue = (invalue - 32.0f) * 5.0f / 9.0f;
[field2 setText:[NSString stringWithFormat:@"%$3.2f", outvalue]];
[fieldl resignFirstResponder];
}
- (void)loadview
{

UIView *contentView = [[UIView alloc] initWithFrame:
[[UIScreen mainScreen] applicationFrame]];

self.view = contentView;

contentView.backgroundColor = [UIColor whiteColor];

[contentView release];

UIImageView *iv = [[UIImageView alloc] initWithImage:
[UIImage imageNamed:@"cover320x416.png"]];

[self.view addSubview:iv];

iv.userInteractionEnabled = YES;

fieldl = [[UITextField alloc] initWithFrame:
CGRectMake(185.0, 31.0, 97.0, 31.0)];
fieldl.borderStyle = UITextBorderStyleRoundedRect;
fieldl.keyboardType = UIKeyboardTypeNumbersAndPunctuation;
fieldl.contentVerticalAlignment =
UIControlContentVerticalAlignmentCenter;

field2 = [[UITextField alloc] initWithFrame:
CGRectMake(185.0, 97.0, 97.0, 31.0)];
field2.borderStyle = UITextBorderStyleRoundedRect;
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Listing 4-1  Continued

field2.enabled = NO;
field2.contentVerticalAlignment =
UIControlContentVerticalAlignmentCenter;

UILabel *labell = [[UILabel alloc] initWithFrame:
CGRectMake(95.0, 34.0, 82.0, 21.0)];

labell.text = @"Fahrenheit”;

labell.textAlignment = UITextAlignmentLeft;

labell.textColor = [UIColor colorWithRed:0.000 green:0.000
blue:0.000 alpha:1.000];

labell.backgroundColor = [UIColor clearColor];

UILabel *label2 = [[UILabel alloc] initWithFrame:CGRectMake(121.0,
102.0, 56.0, 21.0)];

label2.text = @"Celsius";

label2.textAlignment = UITextAlignmentLeft;

label2.textColor = [UIColor colorWithRed:0.000 green:0.000
blue:0.000 alpha:1.000];

label2.backgroundColor = [UIColor clearColor];

[iv addSubview:fieldl];
[iv addSubview:field2];
[iv addSubview:labell];
[iv addSubview:label2];

[fieldl release];
[field2 release];
[labell release];
[label2 release];

[iv release];

self.title = @"Converter";
self.navigationItem.rightBarButtonItem = BARBUTTON(@"Convert",
@selector(convert:));
self.navigationController.navigationBar.tintColor =
COOKBOOK_PURPLE_COLOR;
}
@end

@interface TestBedAppDelegate : NSObject <UIApplicationDelegate>
@end

@implementation TestBedAppDelegate
- (void)applicationDidFinishLaunching: (UIApplication *)application {
UIWindow *window = [[UIWindow alloc] initWithFrame:
[[UIScreen mainScreen] bounds]];
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Listing 4-1  Continued

UINavigationController *nav = [[UINavigationController alloc]
initWithRootViewController:[[HelloWorldController alloc]
init]];

[window addSubview:nav.view];
[window makeKeyAndVisible];

}
@end

int main(int argc, char *argv[])

{
NSAutoreleasePool * pool = [[NSAutoreleasePool alloc] init];
int retval = UIApplicationMain(argc, argv, nil,
@"TestBedAppDelegate");
[pool release];
return retval;
}

Putting the Project Together

Building this project means adapting one of Xcode’s built-in templates. Start by selecting
File > New Project (Command-Shift-N) > iPhone OS > Application > Window-based
Application. Click Choose. Name the new project HelloWorld2 and save it to the Desktop.

This template-based project demands a little file bookkeeping. Delete
MainWindow.xib, and choose Also Move to Trash. Next, open HelloWorld-Info.plist. Lo-
cate the line that says “Main nib file base name”. Delete this and save your change. This
removes the project’s dependency on an xib-based interface.

Similarly, locate the Classes group. Delete this group including the two source files
contained within. Choose Also Move to Trash. This removes the code associated with the
original .xib file, leaving you free to introduce your own code.

As with the previous walk-through Copy in the three image files from the sample
code: icon.png, Default.png, and cover320x416.png. Make sure to check Copy Items into
Destination Group’s Folder (If Needed) before clicking Add. Move these files to the Re-
sources group in your project.

To finish, open the main.m file, paste in the code from Listing 4-1 (it’s in the sample code
folder), compile the project and run it in the simulator. What you’ll find is an application that
both looks and acts identical to the IB version. Instead of loading the interface from a .xib
file, this version creates it programmatically in the view controller class implementation.

Walk-Through: Creating a Hybrid Converter

One of the great things about Cocoa Touch is that you don’t have to program entirely by
hand or entirely using Interface Builder.You can leverage IB’s visual layout and combine it
with Xcode-based programming for a better, hybrid solution. This combines the static
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loading of .xib files provided by IB with a more reusable programmatic dynamic loading
approach.You can use one of two approaches. Either create entire IB-centered
UIViewController-based classes or code your own view controller class and load an IB-
designed uIview. This walk-through shows you the former; the next walk-through de-
scribes the latter.

Whenever Xcode finds a .xib file whose name matches a class derived from
UIViewController, it automatically loads that .xib when initializing an instance. For ex-
ample, say you create a new navigation controller and initialize its root view controller as
follows:

UINavigationController *nav = [[UINavigationController alloc]
= initWithRootViewController:[[RootViewController alloc] init]];

When a file named RootViewController.xib is included in the project, Xcode uses that
.xib to set up the view controller’s view. The actual name of the view controller class does
not matter. What matters is that that name has a matching .xib file. This walk-through uses
this behavior to initialize an interface.

Clean Up a Basic Template

As with the previous project, you need to adapt a built-in template to get started. Select
File > New Project (Command-Shift-N) > iPhone OS > Application > Window-based
Application. Click Choose. Name the new project HelloWorld3 and save it to the Desktop.

Delete MainWindow.xib, and choose Also Move to Trash. Open HelloWorld-Info.plist.
Locate the line that says “Main nib file base name”. Delete this and save your change. In
the project window, locate the Classses group and delete it, including the two source files
contained within. Choose Also Move to Trash.

Finally, copy in the three image files from the sample code: icon.png, Default.png, and
cover320x416.png. Make sure to check Copy Items into Destination Group’s Folder (If
Needed) before clicking Add. Move these files to the Resources group in your project.

Add a New View Controller Class with .xib

In Xcode, choose File > New (Command-IN) > iPhone OS > Cocoa Touch Class >
UlViewController subclass. Check With XIB for User Interface and click Next. Name
the file RootViewController.m, check Also Create RootView Controller.h, set the loca-
tion to your main project folder, and click Finish.

The class name is arbitrary. I use RootViewController here because it describes the
role of the view controller, and it matches the name used in the previous walk-throughs.

Design the Interface

As you did with the first walk-through, locate the new RootViewController.xib file and
double-click it to open it in IB. In Interface Builder, double-click View to open the view
editor, and then perform the following steps:

1. With View selected, open the attributes inspector (Command-1), and choose Top
Bar > Navigation Bar.



Walk-Through: Creating a Hybrid Converter

2. Drag an image view into the editor. Let it snap to fill the view below the naviga-
tion bar.

3. In the attributes inspector, set the Image drop-down to Choose cover320x416.png.
Also check Interaction > User Interaction Enabled.

4. Drag two text fields and two labels into the view from the library. As before, set up
these elements to roughly match the layout in Figure 4-8.

5. Select the top text field. In the attributes inspector, choose Text Input Traits > Key-
board > Numbers & Punctuation.

6. Select the bottom field. Uncheck Control > Content > Enabled.

7. Open the Library (Command-Shift-L). Search for and select the RootViewCon-
troller class and then click Outlets. Add two outlets by clicking the + button. Name
them fieldl and field2. Edit each type to change id to UITextField.

8. Click Actions and add an action, again using +. Edit the default action name to
convert:, making sure to add the colon.

9. Open the connections inspector (Command-2). Drag from the field1 circle to the
top text field. Then drag from the field2 circle to the bottom text field.

10. Save the project with your changes.

11. Select File’s Owner, and choose File > Write Class Files. Keep the file name as
RootViewController (no extensions) and save into your main folder. Agree to re-
place the existing files.

12. Close the RootViewController.xib file and return to Xcode.

Edit the View Controller Implementation

In Xcode, open RootViewController.m and replace the contents of that file with this
code. This code adds the convert: method used in the previous two walk-throughs but
also adds a new method called viewbidLoad. This method is called after the .xib loads
and gives the view controller a chance to finish any initialization details. Here it sets the
title (“Converter”), adds the navigation bar’s bar button item (“convert”), sets its callback
(convert:), and tints the bar purple.

#import "RootViewController.h"

#define COOKBOOK_PURPLE COLOR [UIColor colorWithRed:0.20392f

wgreen:0.19607f blue:0.61176f alpha:1.0f]

#define BARBUTTON(TITLE, SELECTOR) [[[UIBarButtonItem alloc] initWithTitle:TITLE
wstyle:UIBarButtonItemStylePlain target:self action:SELECTOR] autorelease]
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@implementation RootViewController
- (IBAction) convert: (id) sender

{
float invalue = [[fieldl text] floatValue];
float outvalue = (invalue - 32.0f) * 5.0f / 9.0f;
[field2 setText:[NSString stringWithFormat:@"%$3.2f", outvalue]];
[fieldl resignFirstResponder];
}
- (void) viewDidLoad
{
self.title = @"Converter";
self.navigationItem.rightBarButtonItem = BARBUTTON(@"Convert",
@selector(convert:));
self.navigationController.navigationBar.tintColor =
COOKBOOK_PURPLE_COLOR;
}
@end

Edit main.m

As a final step edit main.m, replacing its contents with the following. This code sets up
the main window and navigation controller, and assigns a new instance of
RootViewController as the navigation controller’s root view controller.

#import <UIKit/UIKit.h>
#import "RootViewController.h"

@interface HelloWorldAppDelegate : NSObject <UIApplicationDelegate>
@end

@implementation HelloWorldAppDelegate
- (void)applicationDidFinishLaunching: (UIApplication *)application {
UIWindow *window = [[UIWindow alloc] initWithFrame:
[[UIScreen mainScreen] bounds]];
UINavigationController *nav = [[UINavigationController alloc]
initWithRootViewController:[[RootViewController alloc] init]];
[window addSubview:nav.view];
[window makeKeyAndVisible];

}
@end

int main(int argc, char *argv[])
{
NSAutoreleasePool * pool = [[NSAutoreleasePool alloc] init];
int retval = UIApplicationMain(argc, argv, nil,
@"HelloWorldAppDelegate");
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[pool release];
return retvVal;

Run the Application

Now that you have fully edited your project, once again, run the program with Run >
Run.The compiled application loads its interface from the .xib file. Once loaded, it final-
izes the details regarding the navigation bar, its button, its title, and its tint. The applica-
tion’s look and behavior remains identical to those built in the previous walk-throughs.

Walk-Through: Loading .xib Files Directly from Code

Cocoa Touch lets you recover objects from any .xib file by calling loadNibNamed:
owner: options:.This returns an array of objects initialized from the .xib bundle, which
you can then grab and use in your program. In this walk-through, you use this feature to
load an IB-designed interface from an otherwise hand-built application. To get started,
copy the project from the second walk-through, the one built entirely by code.You adapt
this hand-built code to use a xib-designed view.

The view you use is from the first project. Copy the RootViewController.xib file from
that project and add it into your new project folder. This .xib file contains the original lay-
out, with the image view backsplash, the two text fields, and so on. Rename the file to
mainview.xib. This renaming is important because you need to use a .xib file whose name
does not match the name of the primary view controller class. If you forget, the applica-
tion attempts to load that view causing all kinds of runtime misery.

Open the project in Xcode and drop the copied mainview.xib file from the folder into
the project.You can leave the Copy check box checked although it is not needed here; the
file is already in the folder. Click Add.

Clean Up the .xib

Open mainview.xib in Interface Builder. Here you perform a few maintenance tasks that
allow the .xib file to load properly from loadview, and allow you to access subviews that
normally would be assigned to IBoutlet instance variables.

Tagging views assigns numbers to them. All view classes provide a tag field. Tags are in-
tegers that you can utilize to identify view instances.You choose what number to use. Se-
lect the top text field, open the attributes inspector (Command-1), and edit the View >
Tag field to 101. (You may have to scroll down to find this field.) Select the bottom field
and edit its tag field to 102. Once tagged, you can retrieve views from a parent view by
calling viewWwithTag:.

Remove any previous connections set up in Interface Builder. Select the File’s Owner
and open the connections inspector (Command-2). Delete all the connections (there are
three) by clicking the small X on each. Save and close the .xib file. This ensures that your
application does not attempt to make any outlet or action connections at compile time.
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Update loadView

Open main.m and replace the loadview method with the following code. This code loads
a view from a .xib file and assigns it as the main view for the view controller. This ap-
proach relies on the fact that there is just one actual view object in that .xib. For this .xib
that 1s the main UIView that is named View in Interface Builder. Neither the File’s Owner
nor First Responder is a view.

- (void)loadview

{
self.view = [[[NSBundle mainBundle] loadNibNamed:@"mainview"
owner:self options:NULL] lastObject];
fieldl = (UITextField *)[self.view viewWithTag:101];
field2 = (UITextField *)[self.view viewWithTag:102];
self.title = @"Converter";
self.navigationItem.rightBarButtonItem = BARBUTTON(@"Convert",
@selector(convert:));
self.navigationController.navigationBar.tintColor =
COOKBOOK_PURPLE_COLOR;
}

More complicated .xib files may include several view objects. When loading views
from .xibs, you may want to use tagging and class confirmation to check which object is
which, ensuring you retrieve the correct object from the returned array.

Note

The order of the items in the .xib file array mirrors the order of the items in Interface
Builder’s project window. Since this .xib contains exactly one top-level item, the code could
just as easily use objectAtIndex:0 as lastObject.

Objects from a .xib file are created with a retain count of 1 and autoreleased. When load-
ing items directly from a .xib file, you must retain any objects from within the returned
array that you need to stick around. Using the self.view setter automatically retains a
view. Be aware that the default memory warning logic for view controllers relies on re-
leasing and setting to nil all views that are not displayed at that moment. This eftectively
disposes any .xib files from memory.

Designing for Rotation

On the iPhone, device orientation changes are a fact of life. How you decide your appli-
cation should respond to those changes presents a common design challenge. Do you re-
size onscreen elements, letting them grow and shrink in place like Safari does? Do you
move them to new locations to accommodate the different view proportions? Or do you
present an entirely different view, like the YouTube and iPod/Music apps do? Each of
these choices presents a possible design solution. The one you pick depends on your appli-
cation’s needs and the visual elements in play.
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The following sections explore these design approaches.You learn about autosizing and
manual view placement as well as view swapping approaches. Apple has indicated it will
eventually support separate landscape and portrait views in the SDK. At the time of writ-
ing, this functionality has not yet been implemented.

Enabling Reorientation

UIViewController instances decide whether to respond to iPhone orientation by imple-
menting the optional shouldAutorotateToInterfaceOrientation: method. This
method returns either YES or NO, depending on whether you want to support autorota-
tion to a given orientation. To allow autorotation to all possible orientations, simply re-
turn YES.

- (BOOL)shouldAutorotateToInterfaceOrientation:
(UIInterfaceOrientation)interfaceOrientation

return YES;

}

Possible iPhone orientations passed to this method include

= UIDeviceOrientationUnknown

® UIDeviceOrientationPortrait

= UIDeviceOrientationPortraitUpsideDown

m UIDeviceOrientationLandscapelLeft

= UIDeviceOrientationLandscapeRight

®» UIDeviceOrientationFaceUp

= UIDeviceOrientationFaceDown
Of these orientations, only the portrait and landscape varieties influence how a view au-
torotates. If your application is portrait only or landscape only, it might allow flipping be-

tween the two available orientations. This code uses the logical OR symbol “| | to
combine tests into a single return value.

- (BOOL)shouldAutorotateToInterfaceOrientation:
(UIInterfaceOrientation) interfaceOrientation

{
return ((interfaceOrientation == UIDeviceOrientationPortrait) ||
(interfaceOrientation ==
UIDeviceOrientationPortraitUpsideDown))
}

When returning YES, the view controller uses several flags to determine how the autoro-
tation takes place. For example, you might want to stretch subviews both horizontally and
vertically.
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contentView.autoresizesSubviews = YES;
contentView.autoresizingMask = (UIViewAutoresizingFlexibleWidth |
UIViewAutoresizingFlexibleHeight);

These flags correspond exactly to settings made available in Interface Builder’s size inspec-
tor (Command-3), which is discussed in the next section.

Autosizing

When you tilt the iPhone on its side in Safari, the browser view adjusts its proportions to
match the new orientation. It does this through autosizing. Autosizing adds rules to a view
telling it how to reshape itself. It can stretch, stay the same size, and/or be pinned a certain
distance from the edge of its parent. These properties can be set by hand in code or in In-
terface Builder’ size inspector (Command-3), which is shown in Figure 4-13.

Autosizin

I
“C3

Figure 4-13 Interface Builder’s Autosizing pane
sets a view’s autoresizingMask.

This pane adjusts a view’s autosizing rules. The control consists of an inner square with
two double-arrowed lines and an outer square with four blunt-ended lines. Each item can
be set or unset via a click. When enabled, they appear in bright red; when disabled they
are dim red in color.

The four outer lines are called struts. They establish a fixed distance between a view and
its parent’s edge. Imagine setting a view at 40 pixels from the top and left of the super-
view. Enabling the top and left struts (as shown in Figure 4-13) fixes that view at that po-
sition. It basically pins the view in place. When you use a right or bottom strut, those
distances are also maintained. The view must either move or resize to stay the same pixel
distance from those sides.

The two inner lines are called springs. They control how a view resizes itself. The sam-
ple shown in Figure 4-13 has its horizontal spring set, allowing the view to resize hori-
zontally in proportion to the parent view’s size.

To allow a view to float, that is, to set it as both unpinned and without automatic resiz-
ing, unset all six struts and springs. This option is only available for subviews. The primary
view defined in Interface Builder must be set with both springs on.

If you prefer to set these traits by hand, the two properties involved are
autoresizesSubviews, a Boolean value that determines whether the view provides sub-
view resizing, and autoresizingMask, an integer composed of the following flags, which
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= UIViewAutoresizingNone means the view does not resize.

» UIViewAutoresizingFlexibleLeftMargin,

UIViewAutoresizingFlexibleRightMargin,

UIViewAutoresizingFlexibleTopMargin, and

UIViewAutoresizingFlexibleBottomMargin allow a view to resize by expanding
or shrinking in the direction of a given margin without affecting the size of any
items inside. These correspond to the four struts of Interface Builder’s Autosizing
pane (refer to Figure 4-13) but act in the opposite way. In IB, struts fix the margins;

the flags allow flexible resizing along those margins.

= UIViewAutoresizingFlexibleWidth and UIViewAutoresizingFlexibleHeight
control whether a view shrinks or expands along with a view. These correspond di-
rectly with Interface Builder’s springs. Springs allow flexible resizing, as do these flags.

Autosizing Example

Consider the view shown in Figure 4-14. It consists of one main view and three subviews,
namely the title, a white background splash, and a small piece of art. These subviews repre-
sent three typical scenarios you’ll encounter while designing applications. The title wants
to stay in the same place and maintain its size regardless of orientation. The white splash
needs to stretch or shrink to match its parent’s geometry, and the butterfly art should float

within its parent.

® 00  View al 000 View Size
= » [ o]l o]0
¥ View Size
Butterfly

P . [ Frame =
X 200 Y 71
W: | 280 H:| 370
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ofmj o
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|

Figure 4-14  Setting view autosizing in Interface Builder.
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The autosizing behavior of each subview is set in the size inspector (Command-3). The
title requires only a single strut at the top. The splash needs to resize while maintaining its
distance from each edge. Setting all six struts and springs (shown in Figure 4-14) produces
this result. The art subview uses the opposite setting, with none of the six struts or springs
in use.

Test the view in its opposite orientation by clicking the small curved arrow at the top-
right of the view editor window. In Figure 4-14, this arrow appears just above the battery
indicator in the simulated status bar. Figure 4-15 shows the landscape version of this view
using these settings. Switching between portrait and landscape presentation helps preview
how your autoresizing choices work.

ML) < View 5

Butterfly

N

Figure 4-15 This is the landscape version of the view
shown in Figure 4-14 using the described autosizing
choices. Click the arrow at the right of the title bar to

rotate the view in Interface Builder.

Note
The iPhone loads the last saved .xib orientation on launch. Make sure to return to the por-
trait view before saving your .xib file.

Evaluating the Autosize Option

Some iPhone classes work well with autosizing. Some do not. Large presentation-based
views provide the best results. Web views and text views autosize well. Their content eas-
ily adapts to the change in view shape.

Small controls, especially text fields, fare more poorly. These views are not naturally
elastic. Moving from landscape to portrait, or portrait to landscape, often leaves either too
much room or not enough room to accommodate the previous layout. For these views
you might place each item in a custom position rather than depend on autosizing. That’s
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not to say that autosize solutions cannot work for simple layouts just that as a general rule
more complex views with many subviews do not always lend themselves to autosizing.

Image views are another class that doesn’t work well with autosizing. Most pictures
need to maintain their original aspect ratios. A 320x480 image shown originally in por-
trait orientation must shrink to 213x320 for landscape. That leaves you with just 45% of
the portrait size. Consider swapping out art to a landscape-appropriate version rather than
trying to stretch or resize portrait-based originals.

When working with autosizing, always take the keyboard into account. If your main
view does not scroll or provide provisions for moving its views into accessible places, a
keyboard may hide some of the views it’s trying to service. Test your interfaces as you de-
sign them, both with Interface Builder’s flip button and in the simulator, to ensure that all
elements remain well placed and accessible.

Moving Views

If autosizing provides a practically no-work solution to orientation changes, moving
views ofters a fix with higher-bookkeeping responsibilities. The idea works like this.
After a view controller finishes its orientation, it calls the delegate method
didRotateFromInterfaceOrientation:.You can implement a method that manually
moves each view into place, producing the kinds of results seen in Figure 4-16. As you
can see, this approach quickly gets tedious, especially when you are dealing with more
than four subviews at a time.

.ull Carrier = 10:24 AM = all Carrier = 10:23 AM =
Converter Convert Converter Convert
Fahrenheit Celsius Fahrenheit
Celsius

Figure 4-16 Moving views allows you to adjust layouts after orientation changes.
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- (void)didRotateFromInterfaceOrientation:
(UIInterfaceOrientation) fromInterfaceOrientation

{
UIInterfaceOrientation orientation = [[UIDevice currentDevice]
orientation];
UILabel *flabel = (UILabel *) [self.view viewWithTag:11];
UILabel *clabel = (UILabel *) [self.view viewWithTag:12];
UITextField *ffield = (UITextField *) [self.view viewWithTag:101];
UITextField *cfield = (UITextField *) [self.view viewWithTag:102];
switch (orientation)
{
case UIInterfaceOrientationLandscapeLeft:
case UIInterfaceOrientationLandscapeRight:
{
flabel.center = CGPointMake(61,114);
clabel.center = CGPointMake (321, 114);
ffield.center = CGPointMake (184, 116);
cfield.center = CGPointMake (418, 116);
break;
}
case UIInterfaceOrientationPortrait:
case UIInterfaceOrientationPortraitUpsideDown:
{
flabel.center = CGPointMake(113, 121);
clabel.center = CGPointMake (139, 160);
ffield.center = CGPointMake (236, 123);
cfield.center = CGPointMake (236, 162);
break;
}
default:
break;
}
}

The big advantage of this moving-subviews approach over presenting two separate views
is that you maintain access to your original subviews. Any instance variables in your view
controller that point, say, to a text field, continue to do so regardless of where that field is
placed onscreen. The data structure of your view controller remains unchanged and inde-
pendent of location, which is very model-view-controller compliant.

Moving Views by Mimicking Templates
There’s a much simpler way to accomplish the same movement with less work. In Inter-

face Builder, duplicate your primary view twice. Edit those two copies to create landscape
and portrait versions using the same view elements. Since the views were copied from the
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original, all the subviews retain their original tags. Figure 4-17 shows what those views
might look like.

 Portrait el
| ==]
Converter Convert
Fahrenheit
Celsius
® O 0O~ HelloWorldViewController.xib —
oo C )
FEl = m) (i) a
m + Landscape 5
N

Converter Convert

File's Owner First Responder View

Celsius

Landscape Portrait

Figure 4-17 Duplicating views in Interface Builder creates templates for moving
subviews.

This example continues to use your original view and subviews after orientation changes.

(Please note that allSubviews() is defined in Recipe 6-2,“Subview Utility Functions.”)

What you do is use those extra two views as templates to determine where to place each

subview.You move objects into position based on matching the template. This approach
introduces two enormous advantages.You don’t hard-code locations, and you can adjust
the layouts in Interface Builder as needed.

- (void)didRotateFromInterfaceOrientation:
(UIInterfaceOrientation) fromInterfaceOrientation

UIView *template = nil;
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switch ([[UIDevice currentDevice] orientation])
{
case UIInterfaceOrientationLandscapeLeft:
case UIInterfaceOrientationLandscapeRight:
{
template = landscapeTemplate;
break;
}
case UIInterfaceOrientationPortrait:
case UIInterfaceOrientationPortraitUpsideDown:

{
template = portraitTemplate;
break;

}

default:
break;

if (!template) return;

for (UIView *eachView in allSubviews(template))

{

int tag = eachView.tag;

if (tag < 10) continue;

printf(“About to move view %d\n”, tag);

[self.view viewWithTag:tag].frame = eachView.frame;
}

}

Here are a few points about this approach:

= This code ignores untagged views and tags with a value under 10. Apple rarely tags
views, but when it does so, it uses small numbers like 1, 2, and 3. Make sure to tag
your views starting with numbers from 10 and up.

= This example uses two instance variables (portraitTemplate and
landscapeTemplate) to provide immediate access to the templates. These are de-
fined as IBoutlets in the view controller header file and are connected via Inter-
face Builder. When the .xib loads, these two outlets are automatically set.

= If you decide to edit your portrait layout, do so in your original view in Interface
Builder. Discard the previous Portrait view and replace it with a copy of your ed-
ited View. Reconnect the outlet from the File’s Owner to the new Portrait view.
This ensures that your portrait and primary views remain identical in the .xib file.
Unfortunately, you cannot just use the main view as your portrait template. Once
rotated, it loses all memory of the proper portrait view positions.
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. .
Swapping Views

The iPod/Music application does not attempt to restructure its table when you flip the
iPhone into landscape. Instead it displays an entirely different view, namely a Coverflow
presentation of albums. To create your own swap, add two views into your view con-
troller’s .xib, one portrait and one landscape. Assign IBOutlets to each and, to start, set
your view controller’s view property to the portrait version.

In your view controller implementation, make sure to set the autoresizesSubviews
flag for each primary view to No.This ensures that the view appears exactly as you laid it
out in Interface Builder. (If you want, you can amuse yourself by commenting out those
lines and performing a few flips in the simulator. The results are often startling.)
@implementation HelloWorldviewController

- (void)viewDidLoad
{
self.view.frame = [[UIScreen mainScreen] applicationFrame];
landscapeView.autoresizesSubviews = NO;
portraitView.autoresizesSubviews = NO;

}

‘When the view rotates to landscape or portrait, switch self.view to point to the proper
view. This code first checks for landscape and then uses else if and checks for portrait
orientations. This guards against matching unknown orientations and face up/face down
ones to the portrait view.

- (BOOL)shouldAutorotateToInterfaceOrientation:
(UIInterfaceOrientation) interfaceOrientation

{
if ((interfaceOrientation == UIInterfaceOrientationLandscapeLeft)
|| (interfaceOrientation == UIInterfaceOrientationLandscapeRight))
self.view = landscapeView;
else if ((interfaceOrientation == UIInterfaceOrientationPortrait)

|| (interfaceOrientation == UIInterfaceOrientationPortraitUpsideDown))
self.view = portraitView;
return YES;

}
@end

When run, this code responds to interface changes by reassigning the view controller’s
view property either to the landscape or the portrait version based on the new
orientation.
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One More Thing: A Half Dozen Great Interface
Builder Tips

It never hurts to have a few extra tricks up your sleeve when developing with Interface
Builder and Xcode. Here are six favorite IB tricks that I use on a regular basis:

= Selecting from stacked views—Figure 4-12 showed you how to drill down into
Interface Builder’s object hierarchy to reveal subviews. Another way to find and se-
lect subviews is by Control-Shift-clicking a view. This exposes all the views layered
at that point (see Figure 4-18) and lets you select whichever item you want, regard-
less of whether it is the top view.

8,0,0 -+ Portrait ="l
=
Converter Convert
Fahrenheit
k Portrait
. - UlView (ID: 27)
Celsius

Purple Splash
UlView (IC

White Splash
Ulview (ID: 29)

Fahrenheit Text Field

UlTextField (D

Figure 4-18  Shift-Control-click a view to pop up a view-
selection dialog.

» Naming views—Give your views names like the ones used in Figure 4-18 in the
identity inspector (Command-4). Edit the Interface Builder Identity > Name field.

» Pulling in media—Interface Builder’ library offers a Media tab, listing the media
currently available in your Xcode project (see Figure 4-19, left). You can drag art-
work from there and drop it onto a view. Interface Builder automatically creates a
new UIImageView instance, adding the art (as a UIImage) to that view.

» Adding custom guides—Interface Builder offers the same kind of layout guides
used in programs like Photoshop. Use the Layout menu to add horizontal and
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Figure 4-19 You can drag media from the Library into your IB projects (left). Custom guides
add attraction points for laying out views (right).

vertical guides. As Figure 4-19 (right) shows, IB provides live position feedback as
you drag the guide into place, offering pixel-precise placement.

= Moving objects—When moving subviews, the arrow keys move you one pixel in
any direction. Hold down the Shift key to move by 5 pixels at a time.

= Show object layout—Hold down the option key and hover the mouse over any
object to reveal the pixel-accurate layout information shown in Figure 4-20.

Figure 4-20 Holding the option key while moving the mouse over
views reveals how each view is placed in the view container.
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Summary

This chapter introduced the basics of iPhone interface design.You discovered not one but
four ways to build interfaces: using Interface Builder, using Xcode, and blending the two
approaches.You saw reorientation in action and learned about different ways to update
your views to live in both portrait and landscape worlds.

Before moving on to the next chapter, here are a few points to consider about laying
out interfaces:

» Interface Builder excels at laying out the content of UIView instances. Use its tools
to connect those instances to the view controllers in your program and use Inter-
face Builder to refine WYSIWY G-style interfaces like the temperature converter
example covered in this chapter.

» Know when Interface Builder isn’t the right solution. When you’re building tab
bars and navigation controllers with minimal window design (such as for table-
based or text-based applications), you don’t especially need IB’s view layout tools.
‘When skipping IB, make sure to delete the .xib file from your project and remove
the Main NIB Window key from Info.plist. Also edit your main.m file to substitute
the application delegate class name for the fourth UIApplicationMain() argument.
Failing to do so produces an application that shows a black screen and provides no
further interaction.

= Some views work beautifully under multiple orientations. Some do not. Don't feel
that you must provide a landscape version of your application that exactly matches
either the look or the functionality of the portrait one.

= Always, always save your work in Interface Builder. Until you do so, your project

will not be updated with the current version of your .xib files.

= There’s no “right” way to design and implement portrait and landscape layouts.
Choose the approach that works best for your needs and provides the best experi-
ence for your users.
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Working with View Controllers

IViewControllers handle view management for many iPhone applications. In the

previous chapter you saw how to build view controller-based applications using

Xcode and Interface Builder. Now it’s time to dive into more advanced view
controller-based classes and learn how to apply them to real-world situations. In this
chapter you discover how to build simple menus, create view navigation trees, design tab
bar-based applications, and more. This chapter offers hands-on recipes for working with a
variety of controller classes.

Developing with Navigation Controllers

The UINavigationController class provides all the high-calorie goodness of a
UINavigationBar-based interface with minimal navigation-specific programming. Navi-
gation controllers let users move smoothly between views (or, more accurately, view con-
trollers) using built-in animation. They provide history control for free without any
programming effort. Navigation controllers automatically handle Back button functional-
ity. The titles of each parent view controller appear as Back buttons, letting users “pop the
stack,” so to speak, without any further programming eftort.

And if that weren’t enough, the navigation controller also offers a simple menu bar.
You can add buttons—or even more complicated controls—into the bar to build actions
into your application. Between these three features of navigation, history, and menus, nav-
igation controllers build a lot of wow into a simple-to-program package.

The following recipes introduce these core navigation controller features, from build-
ing menus to building a history stack. In these examples, you see how to use the
UINavigationController class to create a variety of novel and useful interfaces.

Setting Up a Navigation Controller

Whether you plan to use a navigation controller to simplify moving between views—its
intended use—or use it as a convenient menu button holder you should understand how
the navigation controller works. At their simplest level, navigation controllers manage
view controller stacks.
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Every navigation controller owns a root view controller. This controller forms the base
of the stack.You can programmatically push other controllers onto the stack. This extends
the navigation breadcrumb trail and automatically builds a Back button each time a new
view controller gets pushed.

Tap one of these Back buttons to pop controllers off the stack. Users can pop back un-
til reaching the root. Then you can go no further. The root is the root, and you cannot
pop beyond that root.

This stack-based design lingers even when you plan to use just one view controller.
You might want to leverage the UINavigationController’s built-in navigation bar to
build a two-button menu, for example. This would disregard any navigational advantage
of the stack.You still need to set that one controller as the root via
initWithRootViewController:.

You can use Interface Builder and Xcode templates to build navigation-based inter-
faces, as introduced in Chapter 4, “Designing Interfaces,” or you can create those same in-
terfaces by hand.The easiest way to do so is by building your navigation controller in the
applicationDidFinishLaunching: method that gets called at the start of your applica-
tion run. Here, you set up the window, create the navigation controller, and assign its root.
- (void)applicationDidFinishLaunching: (UIApplication *)application {

UIWindow *window = [[UIWindow alloc] initWithFrame:
[[UIScreen mainScreen] bounds]];

UINavigationController *nav = [[UINavigationController alloc]
initWithRootViewController:[[HelloWorldController alloc]
init]];

[window addSubview:nav.view];
[window makeKeyAndVisible];

}

This is one of the few places you don'’t really have to worry about memory management
and leaky calls. An application delegate’s dealloc method is never called at application
termination, so while you can assign the window and the navigation controller to in-
stance variables and use those variables in a deallocation method, it doesn’t really matter if
you’d rather not do so.

Pushing and Popping View Controllers

Add new items onto the navigation stack by pushing a new controller with
pushviewController: animated:.Send this call to the navigation controller that owns a
UIviewController.This is normally called on self.navigationController. When
pushed, the new controller slides onscreen from the right (assuming you set animated to
YES). A left-pointing Back button appears, leading you one step back on the stack.The
Back button uses the title of the previous view controller.

There are many reasons you'd push a new view. Typically, these involve navigating to
subviews like detail views or drilling down a file structure.You can push controllers onto
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the navigation controller stack after your user taps a button, a table item, or a disclosure
ACCEsSOry.

Perform push requests and navigation bar customization (like setting up a bar’s right-
hand button) inside UIviewController subclasses. As a rule, there’s no reason or need to
ever subclass UINavigationController.And, for the most part, you need never access the
navigation controller directly. The two exceptions to this rule include managing the navi-
gation bar’s buttons and when you change the bar’s look.

You might change a bar style or its tint color by accessing the navigationBar prop-
erty directly.
self.navigationController.navigationBar.barStyle =

UIBarStyleBlackTranslucent;

To add a new button you modify your navigationItem, which provides an abstract class
that describes the content shown on the navigation bar. To remove a button, assign the
item to nil.

self.navigationItem.rightBarButtonItem = [[[UIBarButtonItem alloc]
initWithTitle:@"Action" style:UIBarButtonItemStylePlain target:self
action:@selector(performAction:)] autorelease];

The Navigation Item Class

The objects that populate the navigation bar are put into place using the
UINavigationItem class, which is an abstract class that stores information about those
objects. Navigation item properties include the left and right bar button items, the title
shown on the bar, the view used to show the title, and any Back button used to navigate
back from the current view.

This class basically enables you to attach buttons, text, and other Ul objects into three
key locations: the left, the center, and the right of the navigation bar. Typically, this works
out to be a regular button on the right, some text (usually the UIViewController’s title)
in the middle, and a Back-styled button on the left. But you're not limited to that layout.
You can add custom controls to any of these three locations You can build navigation bars
with search fields, segment controls, toolbars, pictures, and more.

You've already seen how to add custom bar button items to the left and right of a nav-
igation item. Adding a custom view to the title is just as simple. Instead of adding a con-
trol, assign a view. This code adds a custom UILabel, but this could be a UTImageview, a
UISwitch, or anything else.

self.navigationItem.titleView = [[[UILabel alloc]
initWithFrame:CGRectMake(0.0f,0.0f, 120.0f, 36.0f)] autorelease];

The simplest way to customize the actual title is to use the title property of the child

view controller rather than the navigation item.

self.title = @"Hello";
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When you want the title to automatically reflect the name of the running application,
here is a little trick you can use. This returns the short display name defined in the
bundle’s Info.plist file.

self.title = [[[NSBundle mainBundle] infoDictionary]
objectForKey:@"CFBundleName" ];

Modal Presentation

‘With normal navigation controllers, you push your way along views, stopping occasion-
ally to pop back to previous views. That approach assumes that you’re drilling your way
up and down a set of data that matches the tree-based view structure you’re using.
Modal presentation offers another way to show a view controller. After sending the
presentModalViewController: animated: message,a new view controller slides up
into the screen and takes control until it’s dismissed with dismissModalviewController
=Animated:.This enables you to add special-purpose dialogs into your applications that
go beyond alert views.

Typically, modal controllers are used to pick data such as contacts from the Address
Book or photos from the Library, but you can use modal controllers in any setting where
it makes sense to perform a task that lies outside the normal scope of the active view
controller.

You can present a modal dialog in any of three ways, controlled by the
modalTransitionStyle property of the presented view controller. The standard,
UIModalTransitionStyleCoverVertical,slides the modal view up and over the current
view controller. When dismissed it slides back down. UIModalTransitionStyleFlip
wHorizontal performs a back-to-front flip from right-to-left. It looks as if you're reveal-
ing the back side of the currently presented view. When dismissed, it flips back left-to-
right. The final style is UIModalTransitionStyleCrossDissolve. It fades the new view
in over the previous one. On dismissal, it fades back to the original view.

Utility Function

Some of the recipes in this book use this showAlert ()macro/function combination. This
function acts as a visual version of NSLog( ), and it displays a message and information
about where the call originated. This function can be called using the same parameters as
NSLog, complete with format string and arguments. For space considerations, this alert
code is not listed in individual recipes. Invoking the alert code is shown in Figure 5-1,
which follows later in this chapter.

#define showAlert(format, ...) myShowAlert(_ LINE , (char *)_ FUNCTION_ ,
=format, ## VA ARGS_ )

// Simple Alert Utility
void myShowAlert(int line, char *functname, id formatstring,...)
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va_list arglist;

if (!formatstring) return;

va_start(arglist, formatstring);

id outstring = [[[NSString alloc] initWithFormat:formatstring
arguments:arglist] autorelease];

va_end(arglist);

NSString *filename = [[NSString stringWithCString: FILE_ ]
lastPathComponent];

NSString *debugInfo = [NSString stringWithFormat:@"$@:%d\n%s",
filename, line, functname];

UIAlertView *av = [[[UIAlertView alloc] initWithTitle:outstring
message:debugInfo delegate:nil
cancelButtonTitle:@"OK"otherButtonTitles:nil] autorelease];

[av show];

You pressed the right button

main.m:
-[TestBedViewController
rightAction:]

P —————
(6],4

Figure 5-1 Create a basic two-button menu for
iPhone applications by adding custom buttons to a
UINavigationController-based interface.
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Recipe: Building a Simple Two-ltem Menu

Although many applications demand serious user interfaces, sometimes you don’t need
complexity. A simple one- or two-button menu can accomplish a lot. Use these steps to
create a hand-built interface for simple utilities:

1. Create a UIViewController subclass that you use to populate your primary inter-
action space.

2. Allocate a navigation controller and assign an instance of your custom view con-
troller to its root view.

3. In the custom view controller, create one or two buttons and add them to the
view’s navigation item.

4. Build the callback routines that get triggered when a user taps a button.

Recipe 5-1 demonstrates these steps. It creates a simple view controller called
TestBedViewController and assigns it as the root view for a UINavigationController.
In the loadview method, two buttons populate the left and right custom slots for the
view’s navigation item. When tapped, these show an alert, indicating which button was
pressed. This recipe is not feature rich, but it provides an easy-to-build two-item menu.
Figure 5-1 shows the interface in action.

This code uses a handy bar button creation macro. When passed a title and a selector,
this macro returns a properly initialized autoreleased bar button item ready to be assigned
to a navigation item.

#define BARBUTTON(TITLE, SELECTOR) [[[UIBarButtonItem alloc] initWithTitle:
=»TITLE style:UIBarButtonItemStylePlain target:self action:SELECTOR] autorelease]

If you’re looking for more complexity than two items can offer, consider having the but-
tons trigger UTActionSheet menus. Action sheets, which are discussed in Chapter 10,
“Alerting Users,” let users select actions from a short list of options (usually between two
and five options, although longer scrolling sheets are possible) and can be seen in use in
the Photos and Mail applications for sharing and filing data.

Note

You can add images instead of text to the UIBarButtonItem instances used in your navi-
gation bar. Use initWithImage: style: target: action: instead of the text-based
initializer.

Recipe 5-1 Creating a Two-ltem Menu Using a Navigation Controller

@implementation TestBedViewController
- (void) rightAction: (id) sender
{
showAlert(@"You pressed the right button");
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Recipe 5-1 Continued

- (void) leftAction: (id) sender

{
showAlert(@"You pressed the left button");

}

- (void) loadview

{
self.view = [[[NSBundle mainBundle] loadNibNamed:@"mainview"

owner:self options:nil] lastObject];
self.navigationItem.rightBarButtonItem =
BARBUTTON(@"Right",@selector (rightAction:));

self.navigationItem.leftBarButtonItem = BARBUTTON(@"Left",selector(leftAction:));

}

@end

@implementation TestBedAppDelegate
- (void)applicationDidFinishLaunching: (UIApplication *)application

{
UIWindow *window = [[UIWindow alloc]
initWithFrame:[[UIScreen mainScreen] bounds]];
UINavigationController *nav = [[UINavigationController alloc]
initWithRootViewController:[[TestBedViewController alloc] init]];
[window addSubview:nav.view];
[window makeKeyAndVisible];
}
@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 5 and open the project for this recipe.

Recipe: Adding a Segmented Control

The preceding recipe showed how to use the two available button slots in your navigation
bar to build mini menus. Recipe 5-2 expands on that idea by introducing a six-item
UISegmentedControl and adding it to a navigation bar’s custom title view, as shown in
Figure 5-2.When tapped, each item updates the main view with its number.

The key thing to pay attention to in this recipe is the momentary attribute assigned to
the segmented control. This transforms the interface from a radio button style into an ac-
tual menu of options, where items can be selected independently and more than once. So
after tapping item three, for example, you can tap it again. That’s an important behavior for
menu interaction.
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Figure 5-2 Adding a segmented control to the
custom title view allows you to build a multi-item
menu. Notice that no items remain highlighted
even after an action takes place. (In this case, the
One button was pressed.)

Unlike Recipe 5-1, all items in the segmented control trigger the same action (in this
case, segmentAction:). Determine which action to take by querying the control for its
selectedSegmentIndex and use that value to create the needed behavior. This recipe up-
dates a central text label. You might want to choose difterent options based on the seg-
ment picked.

Note
If you want to test this code with the momentary property disabled, set the

selectedSegmentIndex property to match the initial data displayed. In this case, segment
0 corresponds to the displayed number 1.

Segmented controls use styles to specify how they should display. The sample here, shown in
Figure 5-2, uses a bar style. It is designed for use with bars, as it is in this example. The other
two styles (UISegmentedControlStyleBordered and UISegmentedControlStylePlain)
offer larger, more metallic-looking presentations. Of these three styles, only
UISegmentedControlStyleBar can respond to the tintColor changes used in this recipe.
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Recipe 5-2 Adding a Segmented Control to the Navigation Bar

-(void) segmentAction: (UISegmentedControl *) sender
{
// Update the label with the segment number
UILabel *label = (UILabel *)[self.view viewWithTag:101];
[label setText:[NSString stringWithFormat:
@"%0d", sender.selectedSegmentIndex + 1]];

- (void) loadview
{
self.view = [[[NSBundle mainBundle] loadNibNamed:@"mainview"
downer:self options:nil] lastObject];

// Create the segmented control

NSArray *buttonNames = [NSArray arrayWithObjects:@"One", @"Two",
@"Three", @"Four", @"Five", @"Six", nil];

UISegmentedControl* segmentedControl = [[UISegmentedControl alloc]
initWithItems:buttonNames];

segmentedControl.segmentedControlStyle =
UISegmentedControlStyleBar;

segmentedControl.momentary = YES;

@selector (segmentAction:[segmentedControl addTarget:self action:)
forControlEvents:UIControlEventValueChanged];

// Add it to the navigation bar
self.navigationItem.titleView = segmentedControl;
[segmentedControl release];

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 5 and open the project for this recipe.

Recipe: Navigating Between View Controllers

In addition to providing menus, navigation controllers do the job they are designed to do:
managing hierarchy as you navigate between views. Recipe 5-3 introduces the navigation
controller as an actual navigation controller, pushing views on the stack.

These views consist of the same number-display stand-ins you’ve seen in earlier
recipes. An instance variable stores the current depth number, which is used to show the
current level and decide whether to display a further push option. The maximum depth
here is 6. In real use, you'd use more meaningful view controllers or contents. This sample
demonstrates things at their simplest level.

The navigation controller automatically creates the Level 2 Back button shown in
Figure 5-3 (left) as an effect of pushing the new Level 3 controller onto the stack. The
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rightmost button (Push 4) triggers navigation to the next controller by calling
pushViewController: animated:.When pushed, the next Back button reads Level 3, as
shown in Figure 5-3 (right).

.aill Carrier = 12:14 PM = .uall Carrier = 1:21 PM

Level 2 Level 3 Push 4 Level 3 Level 4

Figure 5-3 The navigation controller automatically creates properly labeled
Back buttons. After selecting the Push 4 button in the left interface, the naviga-
tion controller pushes the Level 4 view controller and creates the Level 3 Back

button in the right interface.

Back buttons pop the controller stack for you.You do not need to program any popping
behavior yourself. Note that Back buttons are automatically created for pushed view con-
trollers but not for the root controller itself, as it is not applicable.

Recipe 5-3 Drilling Through Views with UINavigationController

@interface TestBedViewController : UIViewController

{

int depth;
}
@end

@implementation TestBedViewController
- (id) initWithDepth: (int) theDepth
{

self = [super init];
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Recipe 5-3 Continued

if (self) depth = theDepth;
return self;

}
- (void) push
{
TestBedViewController *tbvc = [[[TestBedViewController alloc]
initWithDepth: (depth + 1)] autorelease];
[self.navigationController pushViewController:tbvc animated:YES];
}
- (void) loadview
{
self.view = [[[NSBundle mainBundle] loadNibNamed:@"mainview"
owner:self options:nil] lastObject];
NSString *valueString = [NSString stringWithFormat:@"%d", depth];
NSString *nextString = [NSString stringWithFormat:@"Push %d",
depth + 1];
// set the title
self.title = [@"Level " stringByAppendingString:valueString];
// Set the main label
((UILabel *)[self.view viewWithTag:101]).text = valueString;
// Add the "next" bar button item. Max depth is 6
if (depth < 6) self.navigationItem.rightBarButtonItem =
BARBUTTON (nextString, @selector(push));
}
@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 5 and open the project for this recipe.

Recipe: Using Creative Popping Options
Although you usually want to pop to the previous view controller upon hitting the Back
button, be aware that there are times you want to pop the entire stack instead. For exam-
ple, you might have just given an interactive quiz, or a museum visitor might have finished
his walking tour. For these cases, it makes little sense to move back up a long complex tree
a screen at a time. Instead, use popToRootViewControllerAnimated:.This empties the
stack, popping all view controllers except the root, updating the display accordingly.

To pop back to a specific controller other than the root, use popToviewController:
animated:.This pops the stack until the top view matches the view controller specified.
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To pop back just one item, as if the user had tapped the back button, use
popViewControllerAnimated:.

Loading a View Controller Array

You can create and assign an array of UIViewController objects to a UINavigationCon-
troller’s viewControllers property. The array represents the current controller stack.The
top (that is, active) view controller occupies the last position (n -1) in the array; the root
object lives at index 0.

There are various reasons you might want to set the array property. Controller arrays
help restore previous states after quitting and then returning to an application. You might
store a state list to user defaults and then re-create the same array on launch, returning
your user to the same place in the controller hierarchy that he or she left from.

Arrays are also handy when jumping within a conceptual tree. For example, you might
be navigating directories and then need to jump through a symbolic link to somewhere
else. By setting the entire array, you avoid the detail work of popping and then pushing
the stack.

Pushing Momentary Views

Every now and then, I run into developers who want to be able to push UIViewCon-
trollers that do not remain in the navigation controller stack. For example, you might start
at view 1, push on view 2, and then push on view 3 while letting the Back button from
view 3 link back to the first view.

This situation comes up more often than you might imagine. The most common rea-
son is that you're introducing the action that will take place in the third view with the
second. Typically, the second screen contains instructions, general “read me” content, or a
visual splash. These are meant to display once and then be gone from the user experience
and yet, you want the navigation controller experience to remain as standard as possible.
To make this work, the Back button needs to ignore the second, temporary view.

Recipe 5-4 demonstrates how to do this. When the second view is ready to transition
to the third, the navigation controller goes ahead and performs the push.This creates the
proper animation for the viewer, from view two to view three. Then, without animation,
the code pops the last two views, leaving the stack at view one.To finish, the code per-
forms a delayed animated push, adding view three behind view one, creating the proper
“back” button.

Although the main view animation properly shows a push from view two to view
three, be aware that the navigation bar animation shows a push from root to Level 3. This
should not be enough to get your application booted from the App Store for violating
human interaction guidelines but you might want to use smart interface design to mini-
mize visual discontinuities.
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Recipe 5-4 Pushing Momentary Views

- (void) doPush: (id) nc

{

// With the stack back at view 1, push on view #depth+l
[nc pushViewController:[[TestBedViewController alloc]
initWithDepth:depth+1] animated:YES];

- (void) push

{

if (depth < 2)

{

[self.navigationController
pushViewController:[[TestBedViewController alloc]
initWithDepth:depth+1l] animated:YES];

return;

}

// Push from current view to view #depth+l, showing the animation

[self.navigationController
pushViewController:[[TestBedViewController alloc]
initWithDepth:depth+1l] animated:YES];

// Get ready to push from view #1 to view #depth+l
[self performSelector:@selector(doPush:)
withObject:self.navigationController afterDelay:0.05f];

// Pop off view #depth+l and then view #depth
[[self.navigationController topViewController] autorelease];
[self.navigationController popViewControllerAnimated:NO];
[[self.navigationController topViewController] autorelease];
[self.navigationController popViewControllerAnimated:NO];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 5 and open the project for this recipe.

Recipe: Presenting a Custom Modal Information
View

Modal view controllers slide onscreen without being part of your standard view controller

stack. Modal views are useful for picking data or presenting information, tasks that might

not match well to your normal hierarchy. Any view controller or navigation controller can

present a modal controller:
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[self presentModalViewController:[[[InfoViewController alloc] init]
autorelease] animated:YES];

The controller that is presented can be either a view controller or navigation controller.
Either way, it helps to provide a Done button to allow the user to dismiss the controller.
Figure 5-4 shows a modal presentation built around a UIViewController instance. The
navigation bar at the top of the view was added via a UINavigationBar instance, making
this view especially easy to construct in Interface Builder.

.ull Carrier = 1:11 PM =

Lorem ipsum dolor sit amet,
consectetur adipiscing elit. Praesent
placerat tincidunt lectus, id adipiscing
enim congue sit amet. Ut scelerisque
faucibus vehicula. Curabitur imperdiet
gravida blandit. Quisque hendrerit,
lectus at fristique hendrerit, nunc tortor
sodales justo, nec dignissim nibh ligula
at lorem. Sed in posuere leo. Morbi
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semper vel, aliquam a sapien.

Figure 5-4  This modal view is built using
UlViewController with a UINavigationBar.

Normally, a navigation controller-based view requires two .xib files and extra work, as
shown in the Chapter 4 walk-throughs that built a navigation-based interface. Using the
bar directly avoided the hassle and provided an elegant solution that mimics the normal
look of a UINavigationController presentation.

Recipe 5-5 shows the two key pieces for this presentation. The presentation is done in
the main view controller, with the presentation style set by a segmented control. The
InfoviewController, that is, the class that was presented, handles dismissal. Its Done but-
ton was connected via IB to the doneReading method. This method asks the view con-
troller’s parent to dismiss the modally presented view controller.
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Recipe 5-5 Presenting and Dismissing a Modal Controller

// Presenting the controller
- (void) info
{
int segment = [ (UISegmentedControl *)self.navigationItem.titleView
selectedSegmentIndex];
int styles[3] = {UIModalTransitionStyleCoverVertical,
UIModalTransitionStyleCrossDissolve,
UIModalTransitionStyleFlipHorizontal};
InfoviewController *ivec = [[[InfoViewController alloc] init]
autorelease];
ivc.modalTransitionStyle = styles[segment];
[self presentModalViewController:ivc animated:YES];

And...

// Dismissing the controller
- (IBAction) doneReading
{
[[self parentViewController]
dismissModalViewControllerAnimated:YES];

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 5 and open the project for this recipe.

Recipe: Tab Bars

The uITabBarController class allows users to move between multiple view controllers
and to customize the bar at the bottom of the screen. This is best seen in the YouTube and
iPod applications. Both offer one-tap access to different views, and both offer a More but-
ton leading to user selection and editing of the bottom bar.

With tab bars, you don’t push views the way you do with navigation bars. Instead, you
assemble a collection of controllers (they can individually be utviewControllers,
UINavigationControllers, or any other kind of view controllers) and add them into a
tab bar by setting the bar’s viewControllers property. It really is that simple. Cocoa
Touch does all the rest of the work for you. Set allowsCustomizing to YES to enable user
reordering of the bar.

Recipe 5-6 creates 11 simple view controllers of the BrightnessController class.
This class uses a UIView embedded into mainview.xib and sets its background to a speci-
fied gray level, in this case from 0% to 100% in steps of 10%. Figure 5-5 (left) shows the
interface in its default mode, with the first four items and a More button displayed.
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Reorder these tabs by selecting the More option and then tapping Edit. This opens the
Configure panel shown in Figure 5-5 (right). These 11 view controllers are the options a
user can navigate through and select from.

.uall Carrier = 2:32 PM .uall Carrier = 2:49 PM =

Figure 5-5 Tab bar controllers allow users to pick view controllers from a bar
at the bottom of the screen (left side of the figure) and to customize the bar
from a list of available view controllers (right side of the figure).

Notice that this recipe adds those 11 controllers twice. The first time assigns them to the
list of view controllers available to the user:

tbarController.viewControllers = controllers;

The second time specifies that the user can select from the entire list when interactively
customizing the bottom tab bar:

tbarController.customizableViewControllers = controllers;

The second line is optional, the first mandatory. After setting up the view controllers, you
can add all or some to the customizable list. If you don't, you still can see the extra view
controllers using the More button, but users won't be able to include them in the main
tab bar on demand.

Tab art appears inverted in color on the More screen. According to Apple, this is the
expected and proper behavior. They have no plans to change this. It does provide an inter-
esting view contrast when your 100% white swatch appears as pure black on that screen.

Note that this recipe uses a convenience class called Graphicsutilities, which I cre-
ated for this book. This and other goodies are looked at in detail in later chapters.
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Recipe 5-6 Creating a Tab View Controller

@implementation BrightnessController
- (UIImage*) buildSwatch: (float) tint
{
CGContextRef context = [GraphicsUtilities
newBitmapContextWithWidth:30 andHeight:30];
[GraphicsUtilities addRoundedRect:
CGRectMake(0.0f, 0.0f, 30.0f, 30.0f) toContext:context
withWidth:4.0f andHeight:4.0f];
CGFloat gray[4] = {tint, tint, tint, 1.0f};
CGContextSetFillColor (context, gray);
CGContextFillPath(context);

CGImageRef myRef = CGBitmapContextCreateImage (context);
free(CGBitmapContextGetData(context));
CGContextRelease(context);

UIImage *img = [UIImage imageWithCGImage:myRef];
CFRelease(myRef);

return img;

- (BrightnessController *) initWithBrightness: (int) aBrightness
{
self = [super init];
brightness = aBrightness;
self.title = [NSString stringWithFormat:@"$d%$%", brightness * 10];
[self.tabBarItem initWithTitle:self.title image:[self
buildSwatch: (((float)brightness) / 10.0f)] tag:0];
return self;

}
- (void) loadView
{
self.view = [[[NSBundle mainBundle] loadNibNamed:@"mainview"
owner:self options:nil] lastObject];
UIView *bigSwatch = [self.view viewWithTag:101];
bigSwatch.backgroundColor = [UIColor colorWithWhite:
(brightness / 10.0f) alpha:1.0£f];
}
@end

@interface TestBedAppDelegate : NSObject <UIApplicationDelegate,
UITabBarControllerDelegate>
@end

@implementation TestBedAppDelegate
- (void)applicationDidFinishLaunching: (UIApplication *)application {
NSMutableArray *controllers = [NSMutableArray array];
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Recipe 5-6 Continued

for (int i = 0; i <= 10; i++)

{
BrightnessController *bControl = [[BrightnessController alloc]
initWithBrightness:i];
UINavigationController *nav = [[UINavigationController alloc]
initWithRootViewController:bControl];
nav.navigationBar.barStyle = UIBarStyleBlackTranslucent;
[bControl release];
[controllers addObject:nav];
[nav release];
}
// Create the toolbar and add the view controllers
UITabBarController *tbarController = [[UITabBarController alloc]
init];

tbarController.viewControllers = controllers;
tbarController.customizableViewControllers = controllers;
tbarController.delegate = self;

// Set up the window
UIWindow *window = [[UIWindow alloc] initWithFrame:[[UIScreen
mainScreen] bounds]];
[window addSubview:tbarController.view];
[window makeKeyAndVisible];
}
@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 5 and open the project for this recipe.

Recipe: Remembering Tab State

On the iPhone, persistence 1s golden. When starting or resuming your application from
termination or interruption, always return users to a state that closely matches where they
left off. This lets your users pick up with whatever tasks they were involved with and pro-
vides a user interface that matches the previous session. Recipe 5-7 introduces an example
of doing exactly that.

This recipe stores both the current tab order and the currently selected tab, and does so
whenever those items are updated. When a user launches the application, the code
searches for previous settings and applies them when they are found.

The approach used here depends on two delegate methods. The first, tabBarController:
didEndCustomizingViewControllers: provides the current array of view controllers
after the user has customized them with the More > Edit screen. This code snags their
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titles (10%, 20%, and so on) and uses that information to relate a name to each view
controller.

The second delegate method is tabBarController: didSelectViewController:.
The tab bar controller sends this method each time a user selects a new tab. By capturing
the selectedIndex, this code stores the controller number relative to the current array.

Setting these values depends on using the iPhone’s built-in user defaults system,
NSUserDefaults.This preferences system works very much as a large mutable dictionary.
You can set values for keys using setObject: forKey:

[[NSUserDefaults standardUserDefaults] setObject:titles
forKey:@"tabOrder"];

and retrieve them with objectForKey:.

NSArray *titles = [[NSUserDefaults standardUserDefaults]
objectForKey:@"tabOrder"];

Always make sure to synchronize your settings as shown in this code to ensure that the
defaults dictionary matches your changes. If you do not synchronize, the defaults will not
get set until the program terminates. If you do synchronize, your changes are updated im-
mediately. Any other parts of your application that rely on checking these settings will
then be guaranteed to access the latest values.

When the application launches, it checks for previous settings for the last selected tab
order and selected tab. If it finds them, it uses these to set up the tabs and select a tab to
make active. Since the titles contain the information about what brightness value to show,
this code converts the stored title from text to a number and divides that number by ten
to send to the initialization function.

Most applications aren’t based on such a simple numeric system. Should you use titles
to store your tab bar order, make sure you name your view controllers meaningfully and
in a way that lets you match a view controller with the tab ordering.

Note

You could also store an array of the view tags as NSNumbers or, better yet, use the
NSKeyedArchiver class that is introduced in Chapter 8, “Gestures and Touches.” Keyed
archiving lets you rebuild views using state information that you store on termination.

Recipe 5-7 Storing Tab State to User Defaults

@implementation TestBedAppDelegate

- (void)tabBarController: (UITabBarController *)tabBarController
didEndCustomizingViewControllers: (NSArray *)viewControllers changed:(BOOL)changed

{
// Store the titles from the tabs in order
NSMutableArray *titles = [NSMutableArray array];
for (UIViewController *vc in viewControllers) [titles
addObject:vc.title];
[ [NSUserDefaults standardUserDefaults] setObject:titles
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Recipe 5-7 Continued

forKey:@”tabOrder”];
[ [NSUserDefaults standardUserDefaults] synchronize];

- (void)tabBarController: (UITabBarController *)tabBarController
didSelectViewController: (UIViewController *)viewController

// Update the currently selected tab number

NSNumber *tabNumber = [NSNumber numberWithInt:[tabBarController
selectedIndex]];

[[NSUserDefaults standardUserDefaults] setObject:tabNumber
forKey:@"selectedTab"];

[ [NSUserDefaults standardUserDefaults] synchronize];

(void)applicationDidFinishLaunching: (UIApplication *)application {
NSMutableArray *controllers = [NSMutableArray array];
NSArray *titles = [[NSUserDefaults standardUserDefaults]
objectForKey:@"tabOrder"];

if (titles)

{
// titles retrieved from user defaults
for (NSString *theTitle in titles)

{
BrightnessController *bControl = [[BrightnessController
alloc] initWithBrightness:([theTitle intValue] / 10)];
UINavigationController *nav = [[UINavigationController
alloc] initWithRootViewController:bControl];
nav.navigationBar.barStyle = UIBarStyleBlackTranslucent;
[bControl release];
[controllers addObject:nav];
[nav release];
}
} else {

// generate all new controllers
for (int 1 = 0; i <= 10; i++)

{
BrightnessController *bControl = [[BrightnessController
alloc] initWithBrightness:i];
UINavigationController *nav = [[UINavigationController

alloc] initWithRootViewController:bControl];
nav.navigationBar.barStyle = UIBarStyleBlackTranslucent;
[bControl release];
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Recipe 5-7 Continued

[controllers addObject:nav];
[nav release];

}
}
// Create the toolbar and add the view controllers
UITabBarController *tbarController = [[UITabBarController alloc]
init];

tbarController.viewControllers = controllers;
tbarController.customizableViewControllers = controllers;
tbarController.delegate = self;

NSNumber *tabNumber = [[NSUserDefaults standardUserDefaults]
objectForKey:@"selectedTab"];

if (tabNumber)
tbarController.selectedIndex = [tabNumber intValue];

// Set up the window

UIWindow *window = [[UIWindow alloc] initWithFrame:[[UIScreen
mainScreen] bounds]];

[window addSubview:tbarController.view];

[window makeKeyAndVisible];

}
@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 5 and open the project for this recipe.

One More Thing: Interface Builder and Tab Bar
Controllers

Xcode offers an easy to customize Tab Bar Application template that gets you started
building tab-bar-based GUIs in Interface Builder. The tab bar controller’s attribute in-
spector lets you add new tabs, as shown in Figure 5-6. Click the + button. The class col-
umn lets you select what kind of view controller you’re working with, namely View
Controller, Table View Controller, Navigation Controller, or Image Picker Controller.

You’ll likely want to create a new view controller class for each tab. Create your class
(and its associated .xib file) in Xcode and then choose the .xib from within Interface
Builder. Tap any of the black tabs in the MainWindow .xib, and tap the gray View presen-
tation. Select the .xib from the attributes inspector (Command-1).The first tab comes
prepopulated with a view (as shown in Figure 5-6), but all the other tabs require a .xib to
be assigned to them.
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Figure 5-6 Interface Builder provides tools for laying out tab bar con-
trollers but offers few advantages for building what is essentially a logj-
cal and not a visual class.

To add art to the tabs in IB, drag 20x20 png images from the Library > Media pane onto
each tab button. The Media pane lists the images you have added to your Xcode project.
Design your images using a transparent background and a white foreground.

While Interface Builder ofters a friendly way to lay out individual views, you may find
yourself forgoing it for tab bars and navigation bars. These classes provide what can be
argued is more of a logical construct than a visual presentation. After all, you cannot drag
the tab bar or the navigation bar around the screen and any customizations can easily be
done in code.

Further, once you start taking advantage of the delegate callbacks that are leveraged
directly from code, the IB overhead may no longer be worth the trouble. IB works best
with view design. Its support for navigation controllers and tab bar controllers is rela-
tively weak.

Summary

This chapter showed the UIViewController, UINavigationController, and
UITabBarController classes in action.You learned how to use them to handle view pres-
entation and user navigation. With these classes, you discovered how to expand virtual
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interaction space and create multipage interfaces as demanded by applications. Before
moving on to the next chapter, here are a few points to consider about view controllers:

= Use navigation trees to build hierarchical interfaces. They work well for looking at
file structures or building a settings tree. When you think “disclosure view” or
“preferences,” consider pushing a new controller onto a navigation stack.

= Don't be afraid to use conventional Ul elements in unconventional ways so long as
you respect the overall Apple human interface guidelines. Parts of this chapter cov-
ered innovative uses for the UINavigationController that didn’t involve any navi-
gation. The tools are there for the using.

= Be persistent. Let your users return to the same GUI state that they last left from.
NSUserDefaults provides a built-in system for storing information between appli-
cation runs. Use these defaults to re-create the prior interface state.

= Interface Builder works best for visual layout. Many developers use it for designing
views but give it a pass when building navigation controllers and tab bar con-
trollers.
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Assembling Views and
Animations

IView and its subclasses populate the iPhone’s screen. This chapter introduces views
U from the ground up.You learn how to build, inspect, and break down view hierar-

chies and understand how views work together.You discover the role geometry
plays in creating and placing views into your interface, and you read about animating
views so they move and transform onscreen. This chapter covers everything you need to

know to work with views from the lowest levels up.

View Hierarchies

A tree-based hierarchy orders what you see on your iPhone screen. Starting with the
main window, views are laid out in a specifically hierarchical way. All views may have
children, called subviews. Each view, including the window, owns an ordered list of these
subviews.Views might own many subviews; they might own none.Your application deter-
mines how views are laid out and who owns whom.

Subviews display onscreen in order, always from back to front. This works something
like a stack of animation cells—those transparent sheets used to create cartoons. Only the
parts of the sheets that have been painted show through. The clear parts allow any visual
elements behind that sheet to be seen.Views too can have clear and painted parts, and can
be layered to build a complex presentation.

Figure 6-1 shows a little of the layering used in a typical window. Here the window
owns a UINavigationController-based hierarchy The elements layer together. The win-
dow (represented by the empty, rightmost element) owns a navigation bar, which in turn
owns two subview buttons (one left and one right). The window also owns a table with
its own subviews. These items stack together to build the GUIL.

Listing 6-1 shows the actual view hierarchy of the window in Figure 6-1.The tree
starts at the top UIWindow and shows the classes for each of the child views. If you trace
your way down the tree, you can see the navigation bar (at level 2) with its two buttons
(each at level 3) and the table view (level 4) with its two cells (each at level 5). Some of
the items in this listing are private classes, automatically added by the SDK when laying
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out views. For example, the UlLayoutContainerview is never used directly by develop-
ers. It’s part of the SDK’s uIWindow implementation.

New To Do Edit
Pick Up Milk ©
Call Anna ©

Figure 6-1 Subview hierarchies combine to build complex GUIs.

The only parts missing from this listing are the dozen or so line separators for the table,
omitted for space considerations. Each separator is actually a UITableviewSeparatorView
instance. They belong to the UITableview and would normally display at a depth of 5.

Listing 6-1 To Do List View Hierarchy

[ 0] UIWindow
--[ 1] UILayoutContainerView

----[ 2] UlINavigationTransitionView
—————— [ 3] UIViewControllerWrapperView
________ [ 4] UITableView

.......... [ 5] UITableViewCell
____________ [ 6] UIView
______________ [ 7] UILabel
____________ [ 6] UIButton
______________ [ 7] UIlmageView
____________ [ 6] UIView

.......... [ 5] UITableViewCell
____________ [ 6] UIView
______________ [ 7] UILabel
____________ [ 6] UIButton
______________ [ 7] UIlmageView
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Listing 6-1 Continued

____________ [ 6] UIView
__________ [ 5] UIImageView
__________ [ 5] UIlmageView

----[ 2] UlINavigationBar

—————— [ 3] UINavigationItemView
—————— [ 3] UINavigationButton
________ [ 4] UIlmageView
________ [ 4] UIButtonLabel
------ [ 3] UINavigationButton
,,,,,,,, [ 4] UIlmageView
________ [ 4] UIButtonLabel

Recipe: Recovering a View Hierarchy Tree

Each view knows both its parent ([aview superview]) and its children ([aview
subviews]). Build a view tree like the one shown in Listing 6-1 by recursively walking
through a view’s subviews. Recipe 6-1 does exactly that. It builds a visual tree by noting
the class of each view and increasing the indentation level every time it moves down from
a parent view to its children. The results are stored into a mutable string and returned
from the calling method.

The code shown in Recipe 6-1 was used to create the tree shown in Listing 6-1.The
same interface and recipe appear as part of the sample code that accompanies this book.
You can use this routine to duplicate the results of Listing 6-1, or you can copy it to other
applications to view their hierarchies.

Recipe 6-1 Extracting a View Hierarchy Tree

// Recursively travel down the view tree, increasing the
// indentation level for children

- (void) dumpView: (UIView *) aView atIndent: (int) indent
into: (NSMutableString *) outstring

for (int 1 = 0; 1 < indent; i++)
[outstring appendString:@”"—"];
[outstring appendFormat:@” [$2d] %@\n”, indent,
[[aVview class] description]];
for (UIView *view in [aView subviews])
[self dumpView:view atIndent:indent + 1 into:outstring];

// Start the tree recursion at level 0 with the root view

- (NSString *) displayViews: (UIView *) aView

{
NSMutableString *outstring = [[NSMutableString alloc] init];
[self dumpView:aView atIndent:0 into:outstring];
return [outstring autorelease];
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Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

. . .
Recipe: Querying Subviews

Views store arrays of their children. Retrieve this array by calling [aView subviews].
Onscreen, the child views are always drawn after the parent, in the order that they appear
in the subviews array. These views draw in order from back to front, and the subviews
array mirrors that drawing pattern.Views that appear later in the array are drawn after
views that appear earlier.

The subviews method returns just those views that are immediate children of a given
view. At times, you may want to retrieve a more exhaustive list of subviews including the
children’s children. Recipe 6-2 introduces allSubviews (), a simple recursive function
that returns a full list of descendants for any view. Call this function with view.window to
return a complete set of views appearing in the UTWindow that hosts that view. This list
proves useful when you want to search for a particular view, like a specific slider or button.

Although it is not typical, iPhone applications may include several windows, each of
which can contain many views. Recover an exhaustive list of all application views by iter-
ating through each available window.The allapplicationSubviews () function in
Recipe 6-2 does exactly that. A call to [ [UIApplication sharedApplication]
windows] returns the array of application windows. The function iterates through these,
adding their subviews to the collection.

In addition to knowing its subviews, each view knows the window it belongs to. The
view’s window property points to the window that owns it. Recipe 6-2 also includes a
simple function called pathToview () that returns an array of superviews, from the win-
dow down to the view in question. It does this by calling superview repeatedly until ar-
riving at that window.

Views can also check their superview ancestry in another way. The
isDescendantOfView: method determines whether a view lives within another view,
even if that view is not its direct superview. This method returns a simple Boolean value.
YES means the view descends from the view passed as a parameter to the method.

Recipe 6-2 Subview Utility Functions

// Return an exhaustive descent of the view's subviews

NSArray *allSubviews (UIView *aView)

NSArray *results = [aView subviews];
for (UIView *eachView in [aView subviews])

{

NSArray *riz = allSubviews (eachView) ;
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Recipe 6-2 Continued

if (riz) results = [results arrayByAddingObjectsFromArray:riz];

}

return results;

// Return all views throughout the application

NSArray *allApplicationViews ()

{
NSArray *results = [[UIApplication sharedApplication] windows];
for (UIWindow *window in [[UIApplication sharedApplication]

windows])

NSArray *riz = allSubviews (window) ;
if (riz) results = [results arrayByAddingObjectsFromArray:
riz];
}

return results;

// Return an array of parent views from the window down to the view
NSArray *pathToView (UIView *aView)
NSMutableArray *array = [NSMutableArray arrayWithObject:aView];
UlView *view = aView;
UIWindow *window = aView.window;
while (view != window)
view = [view superview];
[array insertObject:view atIndex:0];

}

return array;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Managing Subviews

The vtview class offers numerous methods that help build and manage views. These meth-
ods let you add, order, remove, and query the view hierarchy. Since this hierarchy controls
what you see onscreen, updating the way that views relate to each other changes what you
see on the iPhone. Here are some approaches for typical view-management tasks.
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Adding Subviews

Call [parentview addsubview:child] to add new subviews to a parent. Newly added
subviews are always placed frontmost on your screen; the iPhone adds them on top of any
existing views. To insert a subview into the view hierarchy at a particular location other
than the front, the SDK offers a trio of utility methods:

» insertSubview:atIndex:
= insertSubview:aboveSubview:

» insertSubview:belowSubview:

These methods control where view insertion happens. That insertion can remain relative
to another view, or it can move into a specific index of the subviews array. The above and
below methods add subviews in front of or behind a given child. Insertion pushes other
views forward and does not replace any views that are already there.

Reordering and Removing Subviews

Applications often need to reorder and remove views as users interact with the screen. The
iPhone SDK offers several easy ways to do this, allowing you to change the view order
and contents.

= Use [parentView exchangeSubviewAtIndex:i withSubviewAtIndex:j] to ex-
change the positions of two views.

= Move subviews to the front or back using bringSubviewToFront : and

sendSubviewToBack.

= To remove a subview from its parent, call [childView removeFromSuperview].If
the child view had been onscreen, it disappears. Removing a child from the super-
view calls a release on the subview, allowing its memory to be freed if its retain
count has returned to zero.

When you reorder, add, or remove views, the screen automatically redraws to show the
new view presentation.

View Callbacks

When the view hierarchy changes, callbacks can be sent to the views in question. The
iPhone SDK ofters six callback methods. These callbacks may help your application keep
track of views that are moving and changing parents.

= didaddsubview: is sent to a view after a successful invocation of addSubview: lets
subclasses of UTView perform additional actions when new views are added.

» didMoveToSuperview: informs views that they’ve been re-parented to a new super-
view. The view may want to respond to that new parent in some way. When the
view was removed from its superview, the new parent is nil.

= willMoveToSuperview: is sent before the move occurs.
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= didMoveToWindow: provides the callback equivalent of didMoveToSuperview but
when the view moves to a new Window hierarchy instead of to just a new superview.

» willMoveToWindow: is, again, sent before the move occurs.

= willRemoveSubview: informs the parent view that the child view is about to be
removed.

Recipe: Tagging and Retrieving Views

The iPhone SDK offers a built-in search feature that lets you recover views by tagging
them. Tags are just numbers, usually positive integers, that identify a view. Assign them us-
ing the view’s tag property, for example, myview.tag = 101.In Interface Builder, you can
set a view’s tag in the attributes inspector. As Figure 6-2 shows, you specify the tag in the
View section.

¥ View
Mode [ Scale To Fill A
Alpha —_—0 1oo| [2)
Tag 101
Drawing ["] Opague ["] Hidden
a Clear Context Before Drawing
™ Clip Subviews
a Autoresize Subviews

Figure 6-2 Set the tag for any view in Interface
Builder’s attributes inspector.

Tags are completely arbitrary. The only “reserved” tag is 0, which is the default property
setting for all newly created views. It’s up to you to decide how you want to tag your
views and which values to use.You can tag any instance that is a child of UTView, includ-
ing windows and controls. So if you have many onscreen buttons and switches, adding tags
helps tell them apart when users trigger them.You can add a simple switch statement to
your callback methods that looks at the tag and determines how to react.

Apple rarely tags subviews. The only instance I have ever found of their view tagging
has been in UIAlertViews where the buttons use tags of 1, 2, and so forth. (I’'m half con-
vinced they left this tagging in there as a mistake.) If you worry about conflicting with
Apple tags, start your numbering at 10 or 100, or some other number higher than any
value Apple might use.

Using Tags to Find Views

Tags let you avoid passing user interface elements around your program by making them
directly accessible from any parent view. The viewWithTag: method recovers a tagged
view from a child hierarchy. The search is recursive, so the tagged item need not be an im-
mediate child of the view in question.You can search from the window with [window
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viewWithTag:101] and find a view that is several branches down the hierarchy tree.
When more than one view uses the same tag, viewWithTag: returns the first item it finds.

The problem with viewWithTag: is that it returns a UIview object. This means you of-
ten have to cast it to the proper type before you can use it. Say you want to retrieve a label
and set its text.

UlLabel *label = (UILabel *) [self.view.window viewWithTag:101];
label.text = @”Hello World”;

It would be far easier to use a call that returned an already typed object and then be able
to use that object right away, as these calls do:

- (IBAction)updateTime: (id)sender

{

// set the label to the current time
[self.view.window labelWithTag:LABEL_TAG] .text =
[ [NSDate date] description];

- (IBAction)updateSwitch: (id)sender

// toggle the switch from its current setting
UISwitch *s = [self.view.window switchWithTag:SWITCH_TAG];
[s setOn:!s.isOn];

}

Recipe 6-3 extends the behavior of UTview to introduce a new category, TagExtensions.
This category adds just two typed tag methods, for UTLabel and UISwitch.The sample
code for this book extends this to include a full suite of typed tag utilities. The additional
classes were omitted for space considerations; they follow the same pattern of casting from
viewWithTag:.Access the full collection by including the UIView-TagExtensions files in
your projects.

Recipe 6-3 Recovering Tagged Views with Properly Cast Objects

@interface UIView (TagExtensions)

- (UILabel *) labelWithTag: (NSInteger) aTag;

- (UISwitch *) switchWithTag: (NSInteger) aTag;
@end

@implementation UIView (TagExtensions)
- (UILabel *) labelWithTag: (NSInteger) aTag

{

return (UILabel *) [self viewWithTag:aTag];

- (UISwitch *) switchWithTag: (NSInteger) aTag
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Recipe 6-3 Continued

return (UISwitch *) [self viewWithTag:aTag];

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Recipe: Naming Views

Although tagging offers a thorough approach to identifying views, some developers may
prefer to work with names rather than numbers. Using names adds an extra level of mean-
ing to your view identification schemes. Instead of referring to “the view with a tag of
101,” a switch named “Ignition Switch” describes its role and adds a level of self~-docu-
mentation missing from a plain number.

// Toggle switch

UISwitch *s = [self.view switchNamed:@”Ignition Switch”];
[s setOn:!s.isOn];

It’s relatively easy to design a class that associates strings with view tags. This custom class
needs to store a dictionary that matches names with tags, allowing views to register and
unregister those names. Recipe 6-4 shows how to build that view name manager, which
uses a singleton instance ([ViewIndexer sharedInstancel]) to store its tag and name
dictionary.

The class demands unique names. If a view name is already registered, a new registra-
tion request will fail. If a view was already registered under another name, a second regis-
tration request will unregister the first name. There are ways to fool this of course. If you
change a view’s tag and then register it again, the indexer has no way of knowing that the
view had been previously registered. So if you decide to use this approach, set your tags in
Interface Builder or let the registration process automatically tag the view but otherwise
leave the tags be.

If you build your views by hand, register them at the same point you create them and
add them into your overall view hierarchy. When using an IB-defined view, register your
names in viewDidLoad using the tag numbers you set in the attributes inspector.

- (void) viewDidLoad

{

[[self.view viewWithTag:LABEL TAG] registerName:@"my label”];
[[self.view viewWithTag:SWITCH TAG] registerName:@”my switch”];

}

Recipe 6-4 hides the view indexer class from public view. It wraps its calls inside a UIView
category for name extensions. This allows you to register, retrieve, and unregister views
without using ViewIndexer directly. For reasons of space, the recipe omits typed name
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retrievals like 1abelNamed: and textFieldNamed:, but these are included in the sample
code for the chapter.

Recipe 6-4 Creating a View Name Manager

@interface ViewIndexer : NSObject {

NSMutableDictionary *tagdict;

NSInteger count;
@property (nonatomic, retain) NSMutableDictionary *tagdict;
@end

@implementation ViewIndexer
@synthesize tagdict;

static ViewIndexer *sharedInstance = nil;

+(ViewIndexer *) sharedInstance {
if (!sharedInstance) sharedInstance = [[self alloc] init];
return sharedInstance;

- (id) 1init

{
if (!(self = [super init])) return self;
self.tagdict = [NSMutableDictionary dictionaryl];
count = 10000;
return self;

- (void) dealloc

{
self.tagdict = nil;
[super dealloc];

// Pull a new number and increase the count
- (NSInteger) pullNumber

{

return count++;

// Check to see if name exists in dictionary
- (BOOL) nameExists: (NSString *) aName

{

return [self.tagdict objectForKey:aName] != nil;
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// Pull out first matching name for tag

- (NSString *) nameForTag: (NSInteger) aTag

{
NSNumber *tag = [NSNumber numberWithInt:aTag];
NSArray *names = [self.tagdict allKeysForObject:tag];
if (!names) return nil;
if ([names count] == 0) return nil;
return [names objectAtIndex:0];

// Return the tag for a registered name. 0 if not found
- (NSInteger) tagForName: (NSString *)aName
{
NSNumber *tag = [self.tagdict objectForKey:aNamel] ;
if (!tag) return 0;
return [tag intValuel];

// Unregistering reverts tag to 0
- (BOOL) unregisterName: (NSString *) aName forView: (UIView *) aView

{

NSNumber *tag = [self.tagdict objectForKey:aName] ;

// tag not found
if (!tag) return NO;

// tag does not match registered name
if (aview.tag != [tag intValuel]) return NO;

aView.tag = 0;
[self.tagdict removeObjectForKey:aName] ;
return YES;

// Register a new name. Names will not re-register. (Unregister first,
// please). If a view is already registered, it is unregistered and
// re-registered
- (NSInteger) registerName: (NSString *)aName forView: (UIView *) aView
{

// You cannot re-register an existing name

if ([[ViewIndexer sharedInstance] nameExists:aName]) return 0;

// Check to see if the view is named already. If so, unregister.
NSString *currentName = [self nameForTag:aView.tag];
if (currentName) [self unregisterName:currentName forView:aView];
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Recipe 6-4 Continued

// Register the existing tag or pull a new tag if aView.tag is 0

if (laview.tag) aView.tag = [[ViewIndexer sharedInstance]
pullNumber] ;

[self.tagdict setObject: [NSNumber numberWithInt:aView.tag]
forKey: aName];

return aView.tag;

}

@end
@implementation UIView (NameExtensions)

- (NSInteger) registerName: (NSString *) aName

{

return [[ViewIndexer sharedInstance] registerName: aName
forvView: self];

- (BOOL) unregisterName: (NSString *) aName

return [[ViewIndexer sharedInstance] unregisterName: aName
forview:self];

- (UIView *) viewNamed: (NSString *) aName

{

NSInteger tag = [[ViewIndexer sharedInstance] tagForName: aName];
return [self viewWithTag: tagl;

}

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

View Geometry

As you’d expect, geometry plays an important role when working with views. Geometry
defines where each view appears onscreen, what its size is, and how it is oriented. The
UIView class provides two built-in properties that define these aspects.

Every view uses a frame to define its boundaries. The frame specifies the outline of the
view: its location, width, and height. If you change a view’s frame, the view updates to
match the new frame. Use a bigger width and the view stretches. Use a new location and
the view moves. The view’s frame delineates each view’s onscreen outline.View sizes are
not limited to the screen size. A view can be smaller than the screen or larger. It can also
be smaller or larger than its parent.
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View Geometry

Views also use a transform property that sets the view’s orientation and any geometric
transformations that have been applied to it. For example, a view might be stretched or
squashed by applying a transform, or it might be rotated away from vertical. Together the
frame and transform fully define a view’s geometry.

Frames

Frame rectangles use a cGRect structure, which is defined as part of the Core Graphics
framework as its CG prefix suggests. A CGRect is made up of an origin (a CGPoint, x and
y) and a size (a CGSize, width and height). When you create views, you normally allocate
them and initialize them with a frame, for example:

CGRect rect = CGRectMake(0.0f, 0.0f, 320.0f, 416.0f);
myView = [[UIView alloc] initWithFrame: rect];

The cGRectMake function creates a new rectangle using four parameters, the origin’s x
and y locations, the width of the rectangle, and its height. In addition to cGRectMake,
there are several other convenience functions you may want to be aware of that help you
work with rectangles and frames.

» NSStringFromCGRect (aCGRect) converts a CGRect structure to a formatted string.
This function makes it easy to log a view’s frame when you'’re debugging.

» CGRectFromString(aString) recovers a rectangle from its string representation. It
proves useful when you’ve stored a view’s frame as a string in user defaults and want
to convert that string back to a cGRect.

" CGRectInset (aRect, xinset, yinset) enables you to create a smaller or larger
rectangle that’s centered on the same point as the source rectangle. Use a positive in-
set for smaller rectangles, negative for larger ones.

» CGRectIntersectsRect (rectl, rect2) lets you know whether rectangle struc-
tures intersect. Use this function to know when two rectangular onscreen objects
overlap.

" CGRectCreateDictionaryRepresentation(aRect) transforms a rectangle structure
into a standard CFDictionaryRef, also known (via the magic of toll-free bridging)
as (NSDictionary *) instances.Transform the dictionary back to a rectangle by us-
Ing CGRectMakeWithDictionaryRepresentation(aDict, aRect).

= CGRectZero is a rectangle constant located at (0, 0) whose width and height are
zero.You can use this constant when you’re required to create a frame but are still
unsure what that frame size or location will be at the time of creation.

The cGRect structure is made up of two substructures: CGPoint, which defines the rectan-
gle’s origin, and cGsize, which defines its bounds. Points refer to locations defined with x
and y coordinates; sizes have width and height. Use cePointMake (x, y) to create points.
CGSizeMake (width, height) creates sizes. Although these two structures appear to be
the same (two floating-point values), the iPhone SDK differentiates between them. Points
refer to locations. Sizes refer to extents.You cannot set myFrame .origin to a size.
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As with rectangles, you can convert them to and from strings:
NSStringFromCGPoint (), NSStringFromCGSize (), CGSizeFromString (), and
CGPointFromString () perform these functions.You can also transform points and sizes to
and from dictionaries.

Transforms

The iPhone supports standard affine transformations as part of its Core Graphics imple-
mentation. Affine transforms allow points in one coordinate system to transform into an-
other coordinate system. These functions are widely used in both 2D and 3D animations.
The version used in the iPhone SDK uses a 3-by-3 matrix to define UIview transforms,
making it a 2D-only solution. With affine transforms, you can scale, translate, and rotate
your views in real time.You do so by setting the view’s transform property, for example:
float angle = theta * (PI / 100);

CGAffineTransform transform = CGAffineTransformMakeRotation (angle) ;
myView.transform = transform;

The transform is always applied with respect to the view’s center. So when you apply a
rotation like this, the view rotates around its center. If you need to rotate around another
point, you must first translate the view, then rotate, and then return from that translation.

To revert any changes, set the transform property to the identity transform. This re-
stores the view back to the last settings for its frame.

myView.transform = CGAffineTransformIdentity;

Coordinate Systems

Views live in two worlds. Their frames are defined in the coordinate system of their par-
ents. Their bounds and subviews are defined in their own coordinate system. The iPhone
SDK offers several utilities that allow you move between these coordinate systems so long
as the views involved live within the same UIWindow. To convert a point from another
view into your own coordinate system, use convertPoint: fromvView:, for example:

myPoint = [myView convertPoint:somePoint fromView:otherView] ;

If the original point indicated the location of some object, the new point retains that loca-
tion but gives the coordinates with respect to myview’s origin. To go the other way, use
convertPoint: toView: to transform a point into another view’s coordinate system.
Similarly, convertRect: toView: and convertRect: fromview: work with CGRect
structures rather than cGPoint ones.

Recipe: Working with View Frames

When you change a view’s frame, you update its size (i.e., its width and height) and its lo-
cation. For example, you might move a frame as follows. This code creates a subview lo-
cated at (0,0) and then moves it down 30 pixels to (0,30).
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CGRect initialRect = CGRectMake(0.0f, 0.0f, 320.0f, 50.0f);
myView = [[UIView alloc] initWithFrame:initialRect];
[topView addSubview:myView] ;

myView.frame = CGRectMake(0.0f, 30.0f, 320.0f, 50.0f);

This approach is fairly uncommon. The iPhone SDK does not expect you to move a view
by changing its frame. Instead, it provides you with a way to update a view’s position. The
preferred way to do this is by setting the view’s center. Center is a built-in view property,
which you can access directly:

myView.center = CGPointMake (160.0f, 55.0f);

Although you'd expect the SDK to offer a way to move a view by updating its origin, no
such option exists. It’s easy enough to build your own class extension. Retrieve the view
frame, set the origin to the requested point, and then update the frame with change. This
snippet creates a new origin property letting you retrieve and change the view’s origin.
@interface UIView (ViewFrameGeometry)

@property CGPoint origin;

@end

@implementation UIView (ViewFrameGeometry)
- (CGPoint) origin

{

return self.frame.origin;

- (void) setOrigin: (CGPoint) aPoint

{

CGRect newframe = self.frame;
newframe.origin = aPoint;
self.frame = newframe;

}

@end

When you move a view, you don’t need to worry about things such as rectangular sections
that have been exposed or hidden. The iPhone takes care of the redrawing. This lets you
treat your views like tangible objects and delegate rendering issues to Cocoa Touch.

Adjusting Sizes

A view’s frame and bounds control its size. Frames, as you've already seen, define the loca-
tion of a view in its parent’s coordinate system. If the frame’s origin is set to (0, 30), the
view appears in the superview flush with the left side of the view and offset 30 pixels
from the top. Bounds define a view within its own coordinate system. That means the ori-
gin for a view’s bounds, that is, myView.bounds, is always (0,0), and its size matches its
normal extent, that is, the frame’s size property.
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Change a view’s size onscreen by adjusting either its frame or its bounds. In practical
terms, you’re updating the size component of those structures. As with moving origins, it’s
simple to create your own utility method to do this directly.

- (void) setSize: (CGSize) aSize

{

CGRect newframe = self.frame;
newframe.size = aSize;
self.frame = newframe;

}

When a view’s size changes, the view itself updates live onscreen. Depending how the ele-
ments within the view are defined and the class of the view itself, subviews may shrink to
fit or they may get cropped. There’s no single rule that covers all circumstances. Interface
Builder’s size inspector offers interactive resizing options that define how subviews re-
spond to changes in a superview’s frame. See Chapter 4, “Designing Interfaces,” for more
details about laying out items in Interface Builder.

Sometimes, you need to resize a view before adding it to a new parent. For example,
you might have an image view to place into an alert. To fit that view into place without
changing its aspect ratio, you might use a method like this to ensure that both the height
and width scale appropriately.

- (void) fitInSize: (CGSize) aSize
{

CGFloat scale;

CGRect newframe = self.frame;

if (newframe.size.height > aSize.height)

{
scale = aSize.height / newframe.size.height;
newframe.size.width *= scale;
newframe.size.height *= scale;

if (newframe.size.width >= aSize.width)

scale = aSize.width / newframe.size.width;
newframe.size.width *= scale;
newframe.size.height *= scale;

self.frame = newframe;
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CGRects and Centers

As you've seen, UIViews use CGRect structures composed of an origin and a size to de-
fine their frames. This structure contains no references to a center point. At the same time,
UlViews depend on their center property to update a view’s position when you move a
view to a new point. Unfortunately Core Graphics doesn’t use centers as a primary rec-
tangle concept. As far as centers are concerned, Core Graphics’ built-in utilities are limited
to recovering a rectangle’s midpoint along the X- or Y-axis.

You can bridge this gap by constructing functions that coordinate between the origin-
based CGRect struct and center-based UIview objects. This function retrieves the center
from a rectangle by building a point from the X- and Y- midpoints. It takes one argument,
a rectangle, and returns its center point.

CGPoint CGRectGetCenter (CGRect rect)

{
CGPoint pt;
pt.x = CGRectGetMidX (rect) ;
pt.y = CGRectGetMidY (rect) ;
return pt;

}

Moving a rectangle by its center point is another function that may prove helpful, and one
that mimics the way UIViews work. Say you need to move a view to a new position but
need to keep it inside its parent’s frame. To test before you move, you'd use a function like
this to offset the view frame to a new center.You could then test that offset frame against
the parent (use CGRectContainsRect ()) and ensure that the view won't stray outside its
container.

CGRect CGRectMoveToCenter (CGRect rect, CGPoint center)

{

CGRect newrect = CGRectZero;

newrect.origin.x = center.x-CGRectGetMidX (rect) ;
newrect.origin.y = center.y-CGRectGetMidY (rect) ;
newrect.size = rect.size;

return newrect;

Other Utility Methods

As you've seen, it’s convenient to expose a view’s origin and size in parallel to its center,
allowing you to work more natively with Core Graphics calls.You can build on this idea
to expose other properties of the view including its width and height, as well as basic
geometry like its left, right, top, and bottom points.

In some ways, this breaks Apple’s design philosophy. This exposes items that normally
fall into structures without reflecting the structures. At the same time, it can be argued that
these elements are true view properties. They reflect fundamental view characteristics and
deserve to be exposed as properties.
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Recipe 6-5 provides a full view frame utility category for UIView, letting you make the
choice of whether to use these properties.

Recipe 6-5 UlView Frame Geometry Category

@interface UIView (ViewFrameGeometry)
@property CGPoint origin;

@property CGSize size;

@property (readonly) CGPoint bottomLeft;
@property (readonly) CGPoint bottomRight;
@property (readonly) CGPoint topRight;
@property CGFloat height;

@property CGFloat width;

@property CGFloat top;

@property CGFloat left;

@property CGFloat bottom;

@property CGFloat right;

- (void) moveBy: (CGPoint) delta;

- (void) scaleBy: (CGFloat) scaleFactor;
- (void) fitInSize: (CGSize) aSize;

@end

@implementation UIView (ViewGeometry)
// Retrieve and set the origin
- (CGPoint) origin

{

return self.frame.origin;

- (void) setOrigin: (CGPoint) aPoint
CGRect newframe = self.frame;
newframe.origin = aPoint;
self.frame = newframe;

// Retrieve and set the size
- (CGSize) size

{

return self.frame.size;

- (void) setSize: (CGSize) aSize
CGRect newframe = self.frame;
newframe.size = aSize;
self.frame = newframe;
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// Query other frame locations

{

(CGPoint) bottomRight

CGFloat x = self.frame.origin.x + self.frame
CGFloat y = self.frame.origin.y + self.frame
return CGPointMake (x, V) ;

(CGPoint) bottomLeft
CGFloat x = self.frame.origin.x;
CGFloat y = self.frame.origin.y + self.frame
return CGPointMake (x, y);
(CGPoint) topRight
CGFloat x = self.frame.origin.x + self.frame

CGFloat y = self.frame.origin.y;
return CGPointMake (x, V) ;

.size

.size.

.size.

.size.

// Retrieve and set height, width, top, bottom, left,

{

(CGFloat) height

return self.frame.size.height;

(void) setHeight: (CGFloat) newheight
CGRect newframe = self.frame;
newframe.size.height = newheight;
self.frame = newframe;

(CGFloat) width

return self.frame.size.width;

(void) setWidth: (CGFloat) newwidth

CGRect newframe = self.frame;
newframe.size.width = newwidth;

.width;

height;

height;

width;

right

229



230

Chapter 6 Assembling Views and Animations

Recipe 6-5 Continued

self.frame = newframe;

(CGFloat) top

return self.frame.origin.y;

(void) setTop: (CGFloat) newtop
CGRect newframe = self.frame;
newframe.origin.y = newtop;
self.frame = newframe;

(CGFloat) left

return self.frame.origin.x;

(void) setLeft: (CGFloat) newleft
CGRect newframe = self.frame;
newframe.origin.x = newleft;
self.frame = newframe;

(CGFloat) bottom

return self.frame.origin.y + self.frame.size.height;

(void) setBottom: (CGFloat) newbottom
CGRect newframe = self.frame;

newframe.origin.y = newbottom - self.frame.size.height;
self.frame = newframe;

(CGFloat) right

return self.frame.origin.x + self.frame.size.width;

(void) setRight: (CGFloat) newright

CGFloat delta = newright - (self.frame.origin.x + self.frame.size

.width) ;
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Recipe 6-5 Continued

CGRect newframe = self.frame;
newframe.origin.x += delta;
self.frame = newframe;

}

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Recipe: Randomly Moving a Bounded View

When you move a view to a random point, you must take into account several things. Of-
ten a view must fit entirely within its parent’s view container so there aren’t parts of the
view clipped off.You may also want to add a boundary to that container so the view does
not quite touch the parent’s edge at any time. Finally, if you’re working with out-of-the-
box SDK versions of the UIView class, you need to work with random centers, not ran-
dom positions, as discussed earlier in this chapter. Just picking a point somewhere in the
parent view fails some or all of these qualifications.

Recipe 6-6 approaches this problem by creating a series of insets. It uses the
UIEdgeInset structure to define the boundaries for the view. This structure contains
four inset values, corresponding to the amount to inset a rectangle at its top, left, bottom,
and right.

typedef struct {
CGFloat top, left, bottom, right;
} UIEdgelInsets;

This method uses the UIEdgeInsetsInsetRect () function to narrow a CGRect rectangle
to create an inner container, which is called innerRect in this method.

It then narrows the container even further. It insets that rectangle by half the child’s
height and width. This leaves enough room around any point in the subrectangle to allow
the placement of the child view, guaranteeing that the view can do so without overlap-
ping the inner bounded rectangle. Select any point in that subrectangle to return a valid
center for the child view.

Recipe 6-6 Randomly Moving a Bounded View

- (CGPoint) randomCenterInView: (UIView *) aView withInsets: (UIEdgeInsets) insets
{
// Move in by the inset amount and then by size of the subview
CGRect innerRect = UIEdgeInsetsInsetRect ([aView bounds], insets);
CGRect subRect = CGRectInset (innerRect,
self.frame.size.width / 2.0f, self.frame.size.height / 2.0f);
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Recipe 6-6 Continued

// Return a random point
(int) floor (subRect.size.width))

float rx = (float) (random() ;
(int) floor (subRect.size.height)) ;

<
g
>

<

float ry = (float) (random()
return CGPointMake (rx + subRect.origin.x, ry + subRect.origin.y);

- (CGPoint) randomCenterInView: (UIView *) aView
withInset: (float) inset

UIEdgelInsets insets = UIEdgelInsetsMake (inset, inset, inset, inset);
return [self randomCenterInView:aView withInsets:insets];

- (void) moveToRandomLocationInView: (UIView *) aView {
self.center = [self randomCenterInView:aView withInset:5];

return;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Recipe: Transforming Views

Affine transforms enable you to change an object’s geometry by mapping that object from
one view coordinate system into another. The iPhone SDK fully supports standard affine
2D transforms. With them, you can scale, translate, rotate, and skew your views however
your heart desires and your application demands.

Transforms are defined in Core Graphics and consist of calls such as
CGAffineTransformMakeRotation and CGAffineTransformScale.These build and mod-
ify the 3-by-3 transform matrices. Once built, use UIView’s setTransform call to apply
2D affine transformations to UIView objects.

Recipe 6-7 demonstrates how to build and apply an affine transform of a uUIview.To
create the sample, I kept things simple. I build an NSTimer that ticks every 1/30th of a sec-
ond. On ticking, it rotates a view by 1% of pi and scales over a cosine curve. I use the co-
sine’s absolute value for two reasons. It keeps the view visible at all times, and it provides a
nice bounce effect when the scaling changes direction. This produces a rotating bounce
animation.

This is one of those samples that it’s best to build and view as you read through the
code.You are better able to see how the handleTimer: method correlates to the visual ef-
tects you're looking at.
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Note

This recipe uses the standard C math library, which provides both the cosine function and
the M_PI constant.

Recipe 6-7 Example of an Affine Transform of a UIView

#import <math.h>

#define BARBUTTON (TITLE, SELECTOR) [[[UIBarButtonItem alloc]
winitWithTitle:TITLE style:UIBarButtonItemStylePlain target:self action:SELECTOR]
=autorelease]

@interface TestBedViewController : UIViewController
NSTimer *timer;
int theta;

}

@end

@implementation TestBedViewController
- (void) move: (NSTimer *) aTimer
{
// Rotate each iteration by 1% of PI
CGFloat angle = theta * (M_PI / 100.0f);
CGAffineTransform transform = CGAffineTransformMakeRotation (angle) ;

// Theta ranges between 0% and 199% of PI, i.e. between 0 and 2*PI
theta = (theta + 1) % 200;

// For fun, scale by the absolute value of the cosine
float degree = cos(angle);

if (degree < 0.0) degree *= -1.0f;

degree += 0.5f;

// Create add scaling to the rotation transform
CGAffineTransform scaled = CGAffineTransformScale (transform,
degree, degree) ;

// Bpply the affine transform
[[self.view viewWithTag:999] setTransform:scaled];

- (void) start: (id) sender

{
// The timer is automatically retained by the runloop
// You can start and stop it without being the owner
// or messing with its retain count.
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Recipe 6-7 Continued

timer = [NSTimer scheduledTimerWithTimeInterval:0.03f target:self
@selector (move:selector:) userInfo:nil repeats:YES];

[self move:nil];

self.navigationItem.rightBarButtonItem = BARBUTTON (@”Stop”,
@selector(stop:));

- (void) stop: (id) sender

[timer invalidate];

timer = nil;

self.navigationItem.rightBarButtonItem = BARBUTTON (@”Start”,
@selector (start:)) ;

- (void) viewDidLoad

self.navigationItem.rightBarButtonItem = BARBUTTON (@”Start”,
@selector (start:));

UIImageView *imgView = [[UIImageView alloc] initWithImage: [UIImage
imageNamed:@"BflyCircle.png”]];

imgView.tag = 999;

imgView.center = CGPointMake (160.0f, 143.0f);

[self.view addSubview:imgView] ;

[imgView releasel];

timer = nil;
theta 0;

}

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Centering Landscape Views

Use the same affine transform approach to center landscape-oriented views. This snippet
creates a 480-by-320 pixel view, centers it at [160, 240] (using portrait view coordinates),
and then rotates it into place. Half of pi corresponds to 90 degrees, creating a landscape-
right rotation. Centering keeps the entire view onscreen. All subviews, including text
fields, labels, switches, and so on rotate into place along with the parent view.
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Display and Interaction Traits

#define PI 3.141592f

- (void) loadview

{

contentView = [[UIView alloc] initWithFrame:

CGRectMake (0.0f, 0.0f, 480.0f, 320.0f)1;
[contentView setCenter:CGPointMake (160.0f, 240.0f)];
[contentView setBackgroundColor: [UIColor blackColor]];
[contentView setTransform:CGAffineTransformMakeRotation (PI/2.0f)];
self.view = contentView;
[contentView release] ;

}

For the most part, it’s far easier using UIViewControllers to work with reorientation
events than manually rotating and presenting views. Additionally, manual view rotation
does not change the status bar orientation nor the keyboard orientation. Chapter 4 dis-
cusses view controllers and reorientation in depth.

Display and Interaction Traits

In addition to physical screen layout, the UTView class provides properties that control how
your view appears onscreen and whether users can interact with it. Every view uses a
translucency factor (alpha) that ranges between opaque and transparent. Adjust this by is-
suing [myView setAlpha:value], where the alpha values falls between 0.0 (fully transpar-
ent) and 1.0 (fully opaque).This is a great way to hide views and to fade them in and out
onscreen.

You can assign a color to the background of any view. [myView setBackgroundColor:
[UIColor redColor]] colors your view red, for example. This property affects different
view classes in different ways depending on whether those views contain subviews that
block the background. Create a transparent background by setting the view’s background
color to clear (i.e. [UIColor clearColor]).

Every view, however, offers a background color property regardless of whether you can
see the background. Using bright, contrasting background colors 1s great way to visually
see the true extents of views. When you’re new to iPhone development, coloring in views
offers a concrete sense of what is and is not onscreen and where each component is
located.

The userInteractionEnabled property controls whether users can touch and interact
with a given view. For most views, this property defaults to YEs. For UIImageview, it de-
faults to no, which can cause a lot of grief among beginning developers. They often place
a UIImageView as their backsplash and don’t understand why their switches, text entry
fields, and buttons do not work. Make sure to enable the property for any view that needs
to accept touches, whether for itself or for its subviews, which may include buttons,
switches, pickers, and other controls. If you're experiencing trouble with items that seem
unresponsive to touch, you should check the userInteractionEnabled property value
for that item and for its parents.
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Disable this property for any display-only view you layer over your interaction area. To
show a noninteractive clock via a transparent full-screen view, unset interaction. This al-
lows touches to pass through the view and fall below to the actual interaction area of your
application.

UlView Animations

UIView animation provides one of the odd but lovely perks of working with the iPhone as
a development platform. It enables you to slow down changes when updating views, pro-
ducing smooth animated results that enhance the user experience. Best of all, this all oc-
curs without you having to do much work.

UIView animations are perfect for building a visual bridge between a view’s current and
changed states. With them, you emphasize visual change and create an animation that links
those changes together. Animatable changes include the following:

= Changes in location—Moving a view around the screen

= Changes in size—Updating the view’s frame and bounds

= Changes in stretching—Updating the view’s content stretch regions
= Changes in transparency—Altering the view’s alpha value

= Changes in states—Hidden versus showing

= Changes in view order—Altering which view is in front

= Changes in rotation—Or any other affine transforms that you apply to a view

Building UlView Animation Blocks

UIView animations work as blocks, that is, a complete transaction that progresses at once.
Start the block by issuing beginAnimations:context:. End the block with
commitAnimations. Send these class methods to UIView and not to individual views. In
the block between these two calls, you define the way the animation works and perform
the actual view updates. The animation controls you’ll use are as follows:

» beginAnimations:context—Marks the start of the animation block.

» setAnimationCurve—Defines the way the animation accelerates and deceler-
ates. Use ease-in/ease-out (UIViewAnimationCurveEaseInout) unless you have
some compelling reason to select another curve. The other curve types are ease in
(accelerate into the animation), linear (no animation acceleration), and ease out (ac-
celerate out of the animation). Ease-in/ease-out provides the most natural-feeling
animation style.

» setAnimationDuration—Specifies the length of the animation, in seconds.
This is really the cool bit.You can stretch out the animation for as long as you need
it to run. Be aware of straining your user’s patience and keep your animations below
a second or two in length. As a point of reference, the keyboard animation, when it
slides on or offscreen, lasts 0.3 seconds.

= commitAnimations—Marks the end of the animation block.



Recipe: Fading a View In and Out

Sandwich your actual view change commands after setting up the animation details and
before ending the animation.

CGContextRef context = UIGraphicsGetCurrentContext () ;

[UIView beginAnimations:nil context:context];

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;

[UIView setAnimationDuration:1.0];

// View changes go here
[contentView setAlpha:0.0f];

[UIView commitAnimations] ;

This snippet shows UIView animations in action by setting an animation curve and the
animation duration (here, one second). The actual change being animated is a transparency
update. The alpha value of the content view goes to zero, turning it invisible. Instead of
the view simply disappearing, this animation block slows down the change and fades it
out of sight. Notice the call to UIGraphicsGetCurrentContext (), which returns the
graphics context at the top of the current view stack. A graphics context provides a virtual
connection between your abstract drawing calls and the actual pixels on your screen (or
within an image). As a rule, you can pass nil for this argument without ill effect in the
latest SDKs.

Animation Callbacks

View animations can notify an optional delegate about state changes, namely that an ani-
mation has started or ended. This proves helpful when you need to catch the end of an
animation to start the next animation in a sequence. To set the delegate, use
setAnimationDelegate:,ﬁ)rexanqﬂe:

[UIView setAnimationDelegate:self];

To set up an end-of-animation callback, supply the selector sent to the delegate.

[UIView setAnimationDidStopSelector:@selector (animationDidStop:finished:context:)];

You see animation callbacks in action later in this chapter in Recipe 6-9, which animates
a view swap.

Recipe: Fading a View In and Out

At times, you want to add information to your screen that overlays your view but does
not of itself do anything. For example, you might show a top scores list or some instruc-
tions or provide a context-sensitive tooltip. Recipe 6-8 demonstrates how to use a UIView
animation block to fade a view into and out of sight. This recipe follows the most basic
animation approach. It creates a surrounding view animation block and then adds the sin-
gle line of code that sets the alpha property.
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One thing this recipe does not do is wait for the animation to finish. The change in the
bar button item gets called as soon as the animations are committed, nearly a second be-
fore they end. If you tap the Fade In/Fade Out button quickly (you may want to slow the
animation duration to see this better), you discover that the new animation starts up, re-
placing the old one, creating a visual discontinuity.

To address this, you might want to add a call to UIView with setAnimationBegins
wFromCurrentState:, setting the argument to YEs. This tells the iPhone to use the
current state of the ongoing animation to start the next animation, avoiding that jump.

Recipe 6-8 Animating Transparency Changes to a View’s Alpha Property

@implementation TestBedViewController

- (void) fadeOut: (id) sender

{
CGContextRef context = UIGraphicsGetCurrentContext () ;
[UIView beginAnimations:nil context:context];
[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;
[UIView setAnimationDuration:1.0];
[[self.view viewWithTag:999] setAlpha:0.0f];
[UIView commitAnimations];

self.navigationItem.rightBarButtonItem =
BARBUTTON (@”Fade In”,@selector(fadeIn:));

- (void) fadeIn: (id) sender

{
CGContextRef context = UIGraphicsGetCurrentContext () ;
[UIView beginAnimations:nil context:context];
[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;
[UIView setAnimationDuration:1.0];
[[self.view viewWithTag:999] setAlpha:1.0f];
[UIView commitAnimations];

self.navigationItem.rightBarButtonItem =
BARBUTTON (@”Fade Out”,@selector (fadeOut:));

- (void) viewDidLoad

{

self.navigationItem.rightBarButtonItem =
BARBUTTON (@”Fade Out”,@selector (fadeOut:));

@end




Recipe: Swapping Views

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Recipe: Swapping Views

The UIview animation block doesn’t limit you to a single change. Recipe 6-9 combines
size transformations with transparency changes to create a more compelling animation. It
does this by adding several directives at once to the animation block. This recipe performs
five actions at a time. It zooms and fades one view into place while zooming out and fad-
ing away another and then exchanges the two in the subview array list.

Notice how the viewDidLoad method prepares the back object for animation by
shrinking it and making it transparent. When the swap: method first executes, that view
will be ready to appear and zoom to size.

Unlike Recipe 6-8, this recipe does wait for the animation to finish by providing a del-
egate and a simplified callback that ignores the parameters of the default callback
invocation (animationDidStop:finished:context:). This code hides the bar button
after it is pressed and does not return it to view until the animation completes.

Recipe 6-9 Combining Multiple View Changes in Animation Blocks

- (void) animationFinished: (id) sender
{
self.navigationItem.rightBarButtonItem =
BARBUTTON (@"Swap" , @selector (swap:) ) ;

- (void) swap: (id) sender
self.navigationItem.rightBarButtonItem = nil;

UIView *frontObject = [[self.view subviews] objectAtIndex:2];
UIView *backObject = [[self.view subviews] objectAtIndex:1];

CGContextRef context = UIGraphicsGetCurrentContext () ;
[UIView beginAnimations:nil context:context];

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;
[UIView setAnimationDuration:1.0];

frontObject.alpha = 0.0f;

backObject.alpha = 1.0f;

frontObject.transform = CGAffineTransformMakeScale(0.25f, 0.25f);
backObject.transform = CGAffineTransformIdentity;

[self.view exchangeSubviewAtIndex:1 withSubviewAtIndex:2];
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Recipe 6-9 Continued

[UIView setAnimationDelegate:self];
[UIView setAnimationDidStopSelector:@selector (animationFinished:)];
[UIView commitAnimations];

- (void) viewDidLoad

{
UIView *backObject = [self.view viewWithTag:998];
backObject.transform = CGAffineTransformMakeScale(0.25f, 0.25f);
backObject.alpha = 0.0f;

self.navigationItem.rightBarButtonItem = BARBUTTON (@”Swap”, @selector (swap:)) ;

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Recipe: Flipping Views

Transitions extend UIView animation blocks to add even more visual flair. Two transitions—
UIViewAnimationTransitionFlipFromLeft and UIViewAnimationTransitionFlip
wFromRight—do just what their names suggest.You can flip views left or flip views right
like the Weather and Stocks applications do. Recipe 6-10 demonstrates how to do this.

First, you add the transition as a block parameter. Use setAnimationTransition: to
assign the transition to the enclosing UIview animation block. Second, rearrange the view
order while inside the block.This is best done with exchangeSubviewAtIndex:
wwithSubviewAtIndex:. Recipe 6-10 creates a simple flip view using these techniques.

‘What this code does not show you is how to set up your views. UIKit’s flip transition
more or less expects a black background to work with. And the transition needs to be per-
formed on a parent view while exchanging that parent’s two subviews. Figure 6-3 reveals
the view structure used with this recipe.

Here, you see a black and white backdrop, both using the same frame. The white back-
drop contains the two child views, again using identical frames. When the flip occurs, the
white backdrop “turns around,” as shown in Figure 6-4, to reveal the second child view.

Do not confuse the uIview animation blocks with the Core Animation CATransition
class. Unfortunately, you cannot assign a CATransition to your UIView animation.To use
a CATransition, you must apply it to a UIView’s layer, which is discussed next.
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Recipe: Flipping Views

Recipe 6-10 Using Transitions with UlView Animation Blocks

@interface FlipView : UIImageView
@end

@implementation FlipView
- (void) touchesEnded: (NSSet*)touches withEvent: (UIEvent*)event

// Start Animation Block
CGContextRef context = UIGraphicsGetCurrentContext () ;
[UIView beginAnimations:nil context:context];
[UIView setAnimationTransition:
UIViewAnimationTransitionFlipFromLeft
forView: [self superview] cache:YES];
[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut];
[UIView setAnimationDuration:1.0];
// Animations
[[self superview] exchangeSubviewAtIndex:0 withSubviewAtIndex:1];
// Commit Animation Block
[UIView commitAnimations];
@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

# TestBedViewController.xib

| Type
File's Owner TestBedViewController
@ First Responder UlResponder
v View Ulview
Primary Backsplash UllmageView
¥ || White Backdrop Ulview
Maroon Butterfly UllmageView
Purple Butterfly UllmageView

Figure 6-3  Use two backdrops when building a
flip transition.
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_all Gestore = 2:07 PM

Left Right

Figure 6-4 Create a black backdrop when using
flip transition animations.

Recipe: Using Core Animation Transitions

In addition to UIView animations, the iPhone supports Core Animation as part of its
QuartzCore framework.The Core Animation API offers highly flexible animation solu-
tions for your iPhone applications. Specifically, it offers built-in transitions that offer the
same kind of view-to-view changes you’ve been reading about in the previous recipe.

Core Animation Transitions expand your UIView animation vocabulary with just a few
small differences in implementation. CATransitions work on layers rather than on views.
Layers are the Core Animation rendering surfaces associated with each urview. When
working with Core Animation, you apply CATransitions to a view’s default layer ([myview
layer]) rather than the view itself.

With these transitions, you don’t set your parameters through UIview the way you do
with UIView animation.You create a Core Animation object, set its parameters, and then
add the parameterized transition to the layer.

CATransition *animation = [CATransition animation];
animation.delegate = self;

animation.duration = 1.0f;

animation.timingFunction = UIViewAnimationCurveEaseInOut;
animation.type = kCATransitionMoveln;

animation.subtype = kCATransitionFromTop;

// Perform some kind of view exchange or removal here

[myView.layer addAnimation:animation forKey:@"move in"];



Recipe: Using Core Animation Transitions

Animations use both a fype and a subtype. The type specifies the kind of transition used.
The subtype sets its direction. Together the type and subtype tell how the views should act
when you apply the animation to them.

Core Animation Transitions are distinct from the UIViewAnimationTransitions dis-
cussed in previous recipes. Cocoa Touch offers four types of Core Animation transitions,
which are highlighted in Recipe 6-11.These available types include cross fades, pushes
(one view pushes another offscreen), reveals (one view slides oft another), and covers (one
view slides onto another). The last three types enable you to specify the direction of mo-
tion for the transition using their subtypes. For obvious reasons, cross fades do not have a
direction and they do not use subtypes.

Because Core Animation is part of the QuartzCore framework, you must add the
Quartz Core framework to your project and import <QuartzCore/QuartzCore.hs> into
your code when using these features.

Note

Apple’s Core Animation features 2D and 3D routines built around Objective-C classes. These
classes provide graphics rendering and animation for your iPhone and Macintosh applica-
tions. Core Animation avoids many low-level development details associated with, for exam-
ple, direct OpenGL while retaining the simplicity of working with hierarchical views.

Recipe 6-11 Animating Transitions with Core Animation

- (void) animate: (id) sender
{
// Set up the animation
CATransition *animation = [CATransition animation] ;
animation.delegate = self;
animation.duration = 1.0f;
animation.timingFunction = UIViewAnimationCurveEaseInOut;

switch ([(UISegmentedControl *)self.navigationItem.titleView
selectedSegmentIndex])

case 0:
animation.type = kCATransitionFade;
break;

case 1:
animation.type = kCATransitionMovelIn;
break;

case 2:
animation.type = kCATransitionPush;
break;
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Recipe 6-11 Continued

case 3:

animation.type = kCATransitionReveal;
default:

break;

if (isLeft)

animation.subtype = kCATransitionFromRight;
else

animation.subtype = kCATransitionFromLeft;

// Perform the animation
UIView *whitebg = [self.view viewWithTag:10];

NSInteger purple = [[whitebg subviews] indexOfObject: [whitebg
viewWithTag:99]11];
NSInteger white = [[whitebg subviews] indexOfObject: [whitebg

viewWithTag:100]];
[whitebg exchangeSubviewAtIndex:purple withSubviewAtIndex:white];
[[whitebg layer] addAnimation:animation forKey:@”animation”];

// Allow or disallow user interaction (otherwise you can
// touch “through” the cover view to enable/disable the switch)
if (purple < white)

[self.view viewWithTag:99] .userInteractionEnabled = YES;
else

[self.view viewWithTag:99] .userInteractionEnabled = NO;

isLeft = !isLeft;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Recipe: General Core Animation Calls

The iPhone provides partial support for Core Animation calls. By partial, I mean that
some standard classes are missing in action, although they’re slowly showing up as the
iPhone SDK evolves. Core Image’s cIFilter is one such class. Its not included in Cocoa
Touch, although the caLayer and caTransition classes are both filter-aware. If you’re
willing to work through these limits, you can freely use standard Core Animation calls in
your programs.

Recipe 6-12 shows iPhone native Core Animation code based on a sample from Lucas
Newman (http://lucasnewman.com). When run, this method scales down and fades away
the contents of a UTTmageView.
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Recipe: General Core Animation Calls

This code remains virtually unchanged from the Mac OS X sample it was based on. More
complex Core Animation samples may offer porting challenges, but for simple reflections,
shadows, and transforms, all the functionality you need can be had at the native iPhone level.

Recipe 6-12 Using Standard Core Animation Calls on the iPhone

- (void) action: (id) sender

{

self.navigationItem.rightBarButtonItem = nil;

UlView *theView = [self.view viewWithTag:101];

[CATransaction begin];

[CATransaction setValue: [NSNumber numberWithFloat: 8.0f]
forKey:kCATransactionAnimationDuration] ;

// scale it down

CABasicAnimation *shrinkAnimation = [CABasicAnimation
animationWithKeyPath:@"transform.scale"];

shrinkAnimation.delegate = self;

shrinkAnimation.timingFunction = [CAMediaTimingFunction
functionWithName:kCAMediaTimingFunctionEaseIn] ;

shrinkAnimation.toValue = [NSNumber numberWithFloat:0.0];

[[theView layer] addAnimation:shrinkAnimation
forKey:@"shrinkAnimation"] ;

// fade it out

CABasicAnimation *fadeAnimation = [CABasicAnimation
animationWithKeyPath:@"opacity"];

fadeAnimation.toValue = [NSNumber numberWithFloat:0.0];

fadeAnimation.timingFunction = [CAMediaTimingFunction
functionWithName:kCAMediaTimingFunctionEaselIn] ;

[[theView layer] addAnimation:fadeAnimation
forKey:@"fadeAnimation"] ;

// make it jump a couple of times with a keyframe animation
CAKeyframeAnimation *positionAnimation = [CAKeyframeAnimation
animationWithKeyPath:@"position"];
CGMutablePathRef positionPath =
CGAutorelease (CGPathCreateMutable()) ;

CGPathMoveToPoint (positionPath, NULL,

[theView layer] .position.x, [theView layer].position.y);
CGPathAddQuadCurveToPoint (positionPath, NULL,

[theView layer].position.x, - [theView layer].position.y,

[theView layer] .position.x, [theView layer].position.y);
CGPathAddQuadCurveToPoint (positionPath, NULL,

[theView layer] .position.x, - [theView layer].position.y *

1.5, [theView layer] .position.x, [theView layer].position.y);
CGPathAddQuadCurveToPoint (positionPath, NULL,

[theView layer] .position.x, - [theView layer].position.y *
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Recipe 6-12 Continued

2.0, [theView layer] .position.x, [theView layer] .position.y);
positionAnimation.path = positionPath;
positionAnimation.timingFunction = [CAMediaTimingFunction

functionWithName:kCAMediaTimingFunctionEaselIn] ;

// Add the animation
[[theView layer] addAnimation:positionAnimation

forKey:@"positionAnimation”] ;

[CATransaction commit] ;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Curl Transitions

The previous two recipes introduced two important concepts: UIView animation transi-
tions and Core Animation transitions. These approaches allow you to animate the way
your application moves from displaying one view to showing another. In addition to the
two flip transitions, the UIView class supports a pair of curl transitions, namely
UIViewAnimationTransitionCurlUp and UIViewAnimationTransitionCurlDown. These
curl-based transitions offer another way to change views, in this case curling up the view
until the new view gets revealed. Figure 6-5 shows the page curl in action.

Figure 6-5 Using UlView curl animations
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Curl Transitions

You build and apply the animation the same way you did with the built-in flip transition.
Apply the transition to a backdrop that owns the two views you want to animate and
exchange those views. Table 6-1 lists the transitions available on the iPhone.

CGContextRef context = UIGraphicsGetCurrentContext () ;
[UIView beginAnimations:nil context:context];

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;
[UIView setAnimationDuration:1.0];

// Bpply the animation to the backdrop

UIView *whiteBackdrop = [self.view viewWithTag:100];n

[UIView setAnimationTransition: UIViewAnimationTransitionCurlUp
forView:whiteBackdrop cache:YES];

// Exchange the two foreground views

NSInteger purple = [[whiteBackdrop subviews]
indexOfObject: [whiteBackdrop viewWithTag:999]];
NSInteger maroon = [[whiteBackdrop subviews]

indexOfObject: [whiteBackdrop viewWithTag:998]];
[whiteBackdrop exchangeSubviewAtIndex:purple
withSubviewAtIndex:maroon] ;

[UIView commitAnimations] ;

Table 6-1 Cocoa Touch Transitions

Transition Key Usage

UIViewAnimationTransition UlView transition that flips from left to right,
=FlipFromLeft replacing the old view with the new.
UlViewAnimationTransition UlView transition that flips from right to left, hiding
=FlipFromRight the old view, revealing the new.
UIViewAnimationTransition UlView transition that curls up from the bottom to
= CurlUp reveal the new view.
UIViewAnimationTransition UlView transition where the new view curls down
=CurlDown onto the old view.

kCATransitionFade Core Animation cross fade transition where the new

view fades into place and the old one fades out.

kCATransitionMovelIn Core Animation transition where the new view moves
in over the old view, as if a piece of paper were being
pushed over. Use with up, down, left, and right styles.

kCATransitionPush Core Animation transition where the new view
pushes the old view out of the way. Can be used with
up, down, left, and right styles.

kCATransitionReveal Core Animation transition pulls the old view out of
the way to reveal the new underneath. Works with
up, down, left, and right styles.
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Recipe: Bouncing Views as They Appear

Apple often uses two animation blocks one called after another finishes to add bounce
to their animations. For example, they might zoom into a view a bit more than needed
and then use a second animation to bring that enlarged view down to its final size. Us-
ing “bounces” adds a little more life to your animation sequences, adding an extra physi-
cal touch.

When calling one animation after another, be sure that the animations do not overlap.
There are two “standard” ways to create sequential UTView animation blocks without us-
ing CAKeyframeAnimation. (Core Animation keyframe animation is the preferred and
more straightforward approach to doing this and is demonstrated later in this chapter.)

Neither of these is ideal; they create a bit of a programming nightmare, as control needs
to keep moving between methods. Standard solutions include adding a delay so that the
second animation does not start until the first ends (performSelector:withObject:
afterDelay:) and assigning an animation delegate callback (animationDidStop:
finished:context: ) or, if you ignore the callback arguments, a simpler method like
animationFinished:) to catch the end of the first animation before starting the second.

From a simple programming point of view, it’s a lot easier to build an animation that
blocks until it finishes. Listing 6-2 does exactly that. It extends the UTIView class to intro-
duce a new class method called commitModalanimations.You call this instead of
commitAnimations. It creates a new runloop, running it until the animation finishes. This
ensures that the commitModalAnimations method does not return control to the calling
method until the animation completes. With this extension, you can place blocks sequen-
tially in your code and need no further work to avoid overlaps.

Listing 6-2 Creating a Modal Animation by Using a Run Loop

@interface UIView (ModalAnimationHelper)
+ (void) commitModalAnimations;
@end

@interface UIViewDelegate : NSObject

{

CFRunLoopRef currentLoop;

}

@end

@implementation UIViewDelegate

-(id) initWithRunLoop: (CFRunLoopRef)runLoop

{
if (self = [super init]) currentLoop = runLoop;
return self;
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Listing 6-2  Continued

- (void) animationFinished: (id) sender

{
}

@end

CFRunLoopStop (currentLoop) ;

@implementation UIView (ModalAnimationHelper)
+ (void) commitModalAnimations
{
CFRunLoopRef currentLoop = CFRunLoopGetCurrent () ;
UIViewDelegate *uivdelegate = [[UIViewDelegate alloc]
initWithRunLoop:currentLoop] ;
[UIView setAnimationDelegate:uivdelegate];

[UIView setAnimationDidStopSelector:@selector (animationFinished:)];
[UIView commitAnimations];

CFRunLoopRun () ;
[uivdelegate release];

}

@end

This modal approach allows you to create the bounced presentation demonstrated in
Recipe 6-13. Here, each animation block ends with the modal commit. That method’s
runloop prevents the next block from starting until the previous block finishes.

Recipe 6-13 Bouncing Views

- (void) animate: (id) sender

{
// Hide the bar button and show the view
self.navigationItem.rightBarButtonItem = nil;
[self.view viewWithTag:101] .alpha = 1.0f;

// Bounce to 115% of the normal size

UIView beginAnimations:nil context:UIGraphicsGetCurrentContext ()] ;
UIView setAnimationCurve:UIViewAnimationCurveEaseInOut];

UIView setAnimationDuration:0.4f];

self.view viewWithTag:101] .transform =
CGAffineTransformMakeScale(1.15f, 1.15f);
[UIView commitModalAnimations] ;

// Return back to 100%

[UIView beginAnimations:nil context:UIGraphicsGetCurrentContext()];
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Recipe 6-13 Continued

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;

[UIView setAnimationDuration:0.3f];

[self.view viewWithTag:101].transform =
CGAffineTransformMakeScale(1.0f, 1.0f);

[UIView commitModalAnimations];

// Pause for a second and appreciate the presentation
[NSThread sleepUntilDate: [NSDate
dateWithTimeIntervalSinceNow:1.0f]];

// Slowly zoom back down and hide the view

[UIView beginAnimations:nil context:UIGraphicsGetCurrentContext()];

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;

[UIView setAnimationDuration:1.0f];

[self.view viewWithTag:101].transform =
CGAffineTransformMakeScale (0.01f, 0.01f);

[UIView commitModalAnimations];

[self.view viewWithTag:101] .alpha = 0.0f;
// Restore the bar button

self.navigationItem.rightBarButtonItem = BARBUTTON (@"Bounce",

@selector (animate:)) ;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

Recipe: Image View Animations

In addition to displaying static pictures, the UIImageView class supports built-in anima-
tion. After loading an array of images, you can tell instances to animate them. Recipe 6-14
shows you how.

Start by creating an array populated by individual images loaded from files and assign
this array to the UIImageView instance’s animationImages property. Set the
animationDuration to the total loop time for displaying all the images in the array.
Finally, begin animating by sending the startAnimating message. (There’s a matching
stopAnimating method available for use as well.)

Once you add the animating image view into your interface, you can place it into a
single location, or you can animate it just as you could animate any other UIView instance.
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Recipe 6-14 Using UllmageView Animation

NSMutableArray *bflies = [NSMutableArray array];
// Load the butterfly images
for (int 1 = 1; i <= 17; i++)
[bflies addObject: [UIImage imageWithContentsOfFile:
[ [NSBundle mainBundle]
pathForResource: [NSString stringWithFormat:@"bf %d", i]
ofType:@"png"]1];

// Create the view
UIlmageView *butterflyView = [[UIImageView alloc]
initWithFrame:CGRectMake (40.0f, 300.0f, 60.0f, 60.0f)];

// Set the animation cells, and duration
butterflyView.animationImages = bflies;
butterflyView.animationDuration = 0.75f;
[butterflyView startAnimating];

// Add the view to the parent and release
[self.view addSubview:butterflyView];
[butterflyView release];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 6 and open the project for this recipe.

One More Thing: Adding Reflections to Views

Reflections enhance the reality of onscreen objects. They provide a little extra visual spice
beyond the views-floating-over-a-backsplash, which prevails as the norm. Reflections
aren’t hard to implement, depending on how particular you want the results to be.

The simplest reflections involve nothing more than a flipped copy of the original view
and, perhaps, adjusting the reflection’s alpha levels to offer a more ethereal presentation.
Listing 6-3 shows a basic Core Animation-based reflection that copies the view into a
new layer, flips it via a scale transform, and displaces it a set distance. Figure 6-6 shows this
kind of basic reflection in action.

With this approach, the reflection layer travels with the view. When you move the
view, the reflection moves with it.

Listing 6-3  Creating Reflections

const CGFloat kReflectPercent = -0.25f;
const CGFloat kReflectOpacity = 0.3f;
const CGFloat kReflectDistance = 10.0f;

+ (void) addSimpleReflectionToView: (UIView *) theView

{
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Listing 6-3 Continued

CALayer *reflectionlayer = [CALayer layer];

reflectionlLayer.contents = [theView layer].contents;

reflectionlLayer.opacity = kReflectOpacity;

reflectionlayer.frame = CGRectMake(0.0f, 0.0f,
theView.frame.size.width, theView.frame.size.height *
kReflectPercent) ;

CATransform3D stransform = CATransform3DMakeScale(1.0f, -1.0f,
1.0f);

CATransform3D transform = CATransform3DTranslate(stransform, 0.0f,
- (kReflectDistance + theView.frame.size.height), 0.0f);

reflectionlayer.transform = transform;

reflectionLayer.sublayerTransform = reflectionLayer.transform;

[[theView layer] addSublayer:reflectionLayer] ;
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Figure 6-6 A basic Core Animation reflection
uses scaling, transparency, and a slight vertical
offset.

Better Reflections

Although full-size reflections work well in simple interfaces, a better reflection fades away
at its bottom. This provides a slicker, more “Apple-y” presentation. Core Graphics func-
tions allow you to create these flipped, masked reflections shown in Figure 6-7.
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Figure 6-7 Masking away the bottom of a re-
flected image creates a more Apple-like reflection.

This solution comes admittedly at a slightly higher cost than the basic solution from
Listing 6-3.The faded-reflection solution, which you can see in Listing 6-4, relies on
copying the view contents to a shortened bitmap and applying a gradient-based mask.
These results, which are returned as a UIImage, are added to the original view as a new
UIImageView. Using this subview approach provides another simple solution that allows
the reflection to stick to its parent.

To make this reflection effect work, it’s vital that you disable view clipping. Set the
view’s clipsToView to NO.That ensures the parent view won't clip away the reflection; it
remains completely viewable, even those parts that fall outside the parent’s bounds.

Listing 6-4 Masking Reflections with Core Graphics

+ (CGImageRef) createGradientImage: (CGSize)size

{

CGFloat colors[] = {0.0, 1.0, 1.0, 1.0};

// Create gradient in gray device color space
CGColorSpaceRef colorSpace = CGColorSpaceCreateDeviceGray () ;
CGContextRef context = CGBitmapContextCreate(nil, size.width,
size.height, 8, 0, colorSpace, kCGImageAlphaNone) ;
CGGradientRef gradient =
CGGradientCreateWithColorComponents (colorSpace, colors,
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Listing 6-4 Continued

NULL, 2);
CGColorSpaceRelease (colorSpace) ;

// Draw the linear gradient

CGPoint pl = CGPointZero;

CGPoint p2 = CGPointMake (0, size.height);

CGContextDrawLinearGradient (context, gradient, pl, p2,
kCGGradientDrawsAfterEndLocation) ;

// Return the CGImage

CGImageRef theCGImage = CGBitmapContextCreatelImage (context) ;
CFRelease (gradient) ;

CGContextRelease (context) ;

return theCGImage;

// Create a shrunken frame for the reflection
+ (UIImage *) reflectionOfView: (UIView *)theView
withPercent: (CGFloat) percent

// Retain the width but shrink the height
CGSize size = CGSizeMake (theView.frame.size.width,
theView.frame.size.height * percent);

// Shrink the view

UIGraphicsBeginImageContext (size) ;

CGContextRef context = UIGraphicsGetCurrentContext () ;

[theView.layer renderInContext:context];

UIlmage *partialimg =
UIGraphicsGetImageFromCurrentImageContext () ;

UIGraphicsEndImageContext () ;

// build the mask

CGImageRef mask = [ImageHelper createGradientImage:sizel;
CGImageRef ref = CGImageCreateWithMask (partialimg.CGImage, mask) ;
UIImage *theImage = [UIImage imageWithCGImage:ref];
CGImageRelease (ref) ;

CGImageRelease (mask) ;

return thelImage;

const CGFloat kReflectDistance = 10.0f;
+ (void) addReflectionToView: (UIView *) theView

{

theView.clipsToBounds = NO;
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Listing 6-4  Continued

UIImageView *reflection = [[UIImageView alloc] initWithImage:
[ImageHelper reflectionOfView:theView withPercent: 0.45f]];

CGRect frame = reflection.frame;

frame.origin = CGPointMake (0.0f, theView.frame.size.height +
kReflectDistance) ;

reflection.frame = frame;

// add the reflection as a simple subview
[theView addSubview:reflection];
[reflection release];

Summary

UIViews provide the onscreen components your users see and interact with. As this chap-
ter showed, even in their most basic form, they oftfer incredible flexibility and power.You
discovered how to use views to build up elements on a screen, retrieve views by tag or
name, and introduce eye-catching animation. Here’s a collection of thoughts about the
recipes you saw in this chapter that you might want to ponder before moving on:

» When dealing with multiple onscreen views, hierarchy should always remain in
your mind. Use your view hierarchy vocabulary (bringSubviewToFront :,
sendSubviewToBack:,exchangeSubviewAtIndex:withSubviewAtIndex:)totake
charge of your views and always present the proper visual context to your users.

= Don't let the Core Graphics frame/UIKit center dichotomy stand in your way.
Use functions that help you move between these structures to produce the results
you need.

= Make friends with tags. They provide immediate access to views in the same way
that your program’s symbol table provides access to variables.

= Animate everything. Animations don’t have to be loud, splashy, or bad design. The
iPhone’s strong animation support enables you to add smooth transitions between
user tasks. The essence of the iPhone experience is subtle, smooth transitions. Short,
smooth, focused changes are the iPhone’s bread and butter.
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7

Working with Images

n the iPhone, images and views play two distinct roles. Unlike views, images have
O no onscreen presence. Although views can use and display images, they are not

themselves images, not even UIImageView objects. This chapter introduces
images, specifically the UIImage class, and teaches you all the basic know-how you need
for working with iPhone images.You learn how to load, store, and modify image data in
your applications.You see how to add images to views and how to convert views into
images.You discover how to process image data to create special effects, how to access

images on a byte-by-byte basis, and how to take photos with your iPhone’s built-in camera.

Recipe: Finding and Loading Images

iPhone images are generally stored in one of four places. These four sources allow you to
access image data and display that data in your programs. These sources include the photo
album, the application bundle, the sandbox, and the Internet:

= Photo album—The iPhone’s photo album contains both a camera roll (for camera-
able units) and photos synced from the user’s computer. Users can request images
from this album using the interactive dialog supplied by the UIImagePicker
=Controller class. The dialog lets users browse through stored photos and select the
image they want to work with.

= Application bundle—Your application bundle may store images along with your
application executable, Info.plist file, and other resources.You can read these bun-
dle-based images using their local file paths and display them in your application.

= Sandbox—Your application can also write image files into your sandbox and read
them back as needed. The sandbox lets you store files to the Documents, Library,
and tmp folders. Each of these folders is readable by your application, and you can
create new images by supplying a file path. Although parts of the iPhone outside
the sandbox are technically readable, Apple has made it clear that these areas are off-
limits for App Store applications.

= Internet—Your application can download images from the Net using URL
resources to point to web-based files. To make this work, the iPhone needs an active
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web connection, but once connected the data from a remote image is just as acces-
sible as data stored locally.

Reading Image Data

An image’s file location controls how you can read its data.You’'d imagine that you could
just use a method like UIImage’s imageWithContentsOfFile: to load all four types. In
reality, you cannot. Photo album pictures and their paths are (at least officially) hidden
from direct application access. Only end users are allowed to browse and choose images,
making the chosen image available to the application. Images also cannot be directly ini-
tialized with URLs, although this is easy to work around. Here’s a roundup that discusses
how to read data from each source type with details on doing so.

Loading Images from the Application Bundle
The UIImage class offers a simple method that loads any image stored in the application
bundle. Call imageNamed: with a filename, including its extension, for example:

myImage = [UIImage imageNamed:@"icon.png"];

This method looks for an image with the supplied name in the top-level folder of the
application bundle. If found, the image loads and is cached by the iPhone system. That
means the image is (theoretically) memory managed by that cache.

In reality, the imageNamed: method cannot be used as freely as that. The image cache
does not, in fact, respond properly to memory warnings and release its objects. This isn’t a
problem for simple applications. It’s not a problem for small images that get reused over
and over within an application. It is a huge problem, however, for large apps that must
carefully allocate and release memory with little room to spare. In response to the built-in
cache issues, many developers have chosen to design their own image caches as demon-
strated in the sample code in Chapter 2, “Building Your First Project.”

Substitute imageWithContentsOfFile: for imageNamed: This method returns an
image loaded from the path supplied as an argument. To retrieve an image path from the
bundle, query the NSBundle class to find the path for a given resource. This snippet loads
icon.png from the top level of the application bundle. Notice how the filename and file
extension are supplied as separate arguments.

NSString *path = [[NSBundle mainBundle]

pathForResource:@"icon" ofType:@"png"] ;
myImage = [UIImage imageWithContentsOfFile:path];

Note

The iPhone supports the following image types: PNG, JPG, THM, JPEG, TIF, TIFF, GIF, BMR
BMPF, ICO, CUR, XBM, and PDF.

Loading Images from the Sandbox

By default, each sandbox contains three folders: Documents, Library, and tmp. Application-
generated data such as images normally reside in the Documents folder. This folder does
exactly what the name suggests.You store documents to and access them from this
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directory. Apple recommends you keep file data here that is created by or browsed from
your progran.

The Library folder stores user defaults and other state information for your program.
The tmp folder provides a place to create transient files on-the-fly. Unlike tmp, files in
Documents and Library are not transient. iTunes backs up all Documents and Library files
whenever the iPhone syncs. In contrast the iPhone discards any tmp files when it reboots.

These directories demonstrate one of the key differences between Macintosh and
iPhone programming. You're free to use both standard and nonstandard file locations on
the Macintosh. The iPhone with its sandbox is far more structured—rigidly so by Apple’s
dictates; its files appear in better-defined locations. On the Macintosh, locating the Docu-
ments folder usually means searching the user domain. This is the standard way to locate
Documents folders:

NSArray *paths = [NSSearchPathForDirectoriesInDomains (
NSDocumentDirectory, NSUserDomainMask, YES);
return [paths lastObject];

The iPhone is more constrained.You can reliably locate the top sandbox folder by calling
a utility home directory function. The result of NSHomeDirectory () lets you navigate
down one level to Documents with full assurance of reaching the proper destination. The
following function provides a handy way to return a path to the Documents folder.

NSString *documentsFolder ()

{

return [NSHomeDirectory ()
stringByAppendingPathComponent :@"Documents"] ;

}

To load your image, append its filename to the returned path and tell UIImage to create a
new image with those contents. This code loads a file named image.png from the top level
of the documents folder and returns a UIImage instance initialized with that data.

path = [documentsFolder () stringByAppendingPathComponent:@"image.png"];
return [UIImage imageWithContentsOfFile:path];

Loading Images from URLs
The urImage class can load images from NSData instances, but it cannot do so directly
from URL strings or NSURL objects. So supply UITmage with data already downloaded
from a URL.This snippet downloads the latest United States weather map from
weather.com and then creates a new image using the weather data. First, it constructs an
NSURL object, and then creates an NSData instance initialized with the contents of that
URL.The data returned helps build the UTImage instance.
NSURL *url = [NSURL URLWithString:
@"http://image.weather.com/images/maps/current/curwx 600x405.jpg"];
Ullmage *img = [UIImage imageWithData:
[NSData dataWithContentsOfURL:url]];
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It’s easy enough to write a method that handles this process for you, letting you supply a
URL string to retrieve a UIImage. This method takes one argument, a URL string, and
returns a UIImage built from that resource.

+ (UIImage *) imageFromURLString: (NSString *) urlstring

{

// This call is synchronous and blocking
return [UIImage imageWithData: [NSData
dataWithContentsOfURL: [NSURL URLWithString:urlstring]]l];

}

This is a synchronous method, with certain drawbacks. It may fail without feedback and
doesn’t have a built-in time-out. See Chapter 13, “Networking,” for an in-depth discus-
sion about retrieving resources from URLs.

Loading Data from the Photo Album

The UIImagePickerController class helps users select images from the iPhone photo
album. It provides a stand-alone view controller that you present modally. The controller
sends back delegate messages reflecting the image choice made by the user.

Loading Image Files

Recipe 7-1 introduces a class that will be used throughout this chapter, namely
ImageHelper. This helper class provides handy image routines. All routines are imple-
mented as class methods, letting you avoid allocating an actual ImageHelper object. Just
query the class to retrieve the results you need.

ImageHelper’s version of imageNamed: loads files using UIImage’s imageWithContents
=O0fFile: method, avoiding the caching hazards of the native imageNamed: method.The
method searches through the application bundle first, and then if the file is not found,
performs a second search in the sandbox documents folder. Both searches are deep. They
exhaustively descend through all subfolders. The search ends upon finding the first match
or when the completed search is unsuccessful.

Recipe 7-1’s imageFromURLString: method implements an image retrieval request
from a URL as discussed earlier in this section. No checks are done here to test whether
the unit is currently connected to the Internet. If you need to add such checks, use a per-
sistent Wi-Fi flag in Info.plist (see Appendix A, “Info.plist Keys”) or perform a connection
test (see Chapter 13, “Networking”).

Recipe 7-1 Loading Image Files Using ImageHelper

NSString *documentsFolder ()

{

// Return the sandbox documents folder
return [NSHomeDirectory ()
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stringByAppendingPathComponent :@"Documents"] ;

NSString *bundleFolder ()
{
// Return the app bundle folder
return [[NSBundle mainBundle] bundlePath];

@implementation ImageHelper (Files)

+ (NSString *) pathForItemNamed: (NSString *) fname
inFolder: (NSString *) path

// Return a complete path for the named item
NSString *file;
NSDirectoryEnumerator *dirEnum =

[ [NSFileManager defaultManager] enumeratorAtPath:path];
while (file = [dirEnum nextObject])

if ([[file lastPathComponent] isEqualToString:fname])

return [path stringByAppendingPathComponent:filel;

return nil;

// Searches bundle first then documents folder
+ (UIImage *) imageNamed: (NSString *) aName
{
// Return a UIImage for the named item
NSString *path = [ImageHelper pathForItemNamed:aName
inFolder:bundleFolder()];
path = path ? path : [ImageHelper pathForItemNamed:aName
inFolder:documentsFolder ()] ;
if (!path) return nil;
return [UIImage imageWithContentsOfFile:pathl];

+ (UIImage *) imageFromURLString: (NSString *) urlstring
{

// Download the image located at the URL

// This method is blocking

NSURL *url = [NSURL URLWithString:urlstring];

if (!url) return nil;

return [UIImage imageWithData:

[NSData dataWithContentsOfURL: urll];
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Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Accessing Photos from the iPhone
Photo Album

The UTImagePickerController class offers a highly specialized interface with relatively
few public methods and some modest quirks. It’s designed to operate solely as a modal
dialog, and it has its own navigation controller built in. If you push it onto an existing
navigation controller-based view scheme, it adds a second navigation bar below the first.
That means that although you can use it with a tab bar and as an independent view sys-
tem, you can’t really push it onto an existing navigation stack and have it look right.

Recipe 7-2 shows the picker in its simplest mode. It enables users to select an image
from any of the onboard albums; this operation is seen in Figure 7-1. Set the picker to use
any of the legal source types. The three kinds of sources follow.

[-atlCarrier = 10:11 AM

Figure 7-1  Apple supplies several prebuilt
albums, including this trip to Slovenia, for
in-simulator testing.

» UIImagePickerControllerSourceTypePhotoLibrary—All images
synced to the iPhone plus any camera roll including pictures snapped by the user


http://github.com/erica/iphone-3.0-cookbook-

Recipe: Accessing Photos from the iPhone Photo Album

» UIImagePickerControllerSourceTypeSavedPhotosAlbum—Also
called the camera roll

» UIImagePickerControllerSourceTypeCamera—Allows users to shoot
pictures with the built-in iPhone camera

Working with the Image Picker

Recipe 7-2 follows a basic work path. Select an album, select an image, display the
selected image, and then repeat. This simple flow works because there’s no image editing
involved. That’s because the picker’s image editing property defaults to No. This property,
which is allowsImageEditing for SDKs prior to 3.1, and allowsEditing for the 3.1
SDK and later, tells the image picker whether to allow users to frame and stretch an
image. When disabled, any selection (basically any image tap) redirects control to the
UIImagePickerControllerDelegate object via the finished picking image method.

The delegate for an image picker must conform to two protocols, namely
UINavigationControllerDelegate and UIImagePickerControllerDelegate. Be sure to
declare these in the interface for the object you set as the picker delegate.

This recipe includes not one but two callbacks, a 3.x version and a 2.x version. If you
intend to deploy your software to both 2.x and 3.x systems, increasing your user base to
the highest audience possible, your code must respond to callbacks for both OS versions.
That’s because the 2.x callback has been deprecated in 3.0.

Adding 2.x Support

For simple image selection, 2.x support proves trivial. The 2.x callback redirects to the 3.x
one, passing a constructed dictionary with the selected image. As you see in Recipe 7-3,
that callback redirection becomes a little more complicated when the image picker returns
editing information.

The image sent by the delegate method is basically guaranteed to be non-nil, although
you can add a check in the 2.x method before attempting to construct a dictionary.
Should the user cancel, the delegate receives an imagePickerControllerDidCancel:
callback. When users cancel, the picker automatically dismisses and is released.

You can see this, along with the general memory consuming behavior of the image
picker, by running Instruments; the memory levels return down after cancelling. When
you choose to implement this callback (Apple describes it as optional but “expected”),
make sure to dismiss and release the controller manually.

For nontrivial applications, make sure you’ve implemented memory management in
your program and can respond to memory warnings when using the image picker. Its a
memory hog in any of its basic forms: image picking or camera use.

Adding 3.1 Support

The allowsImageEditing property was deprecated in the 3.1 SDK. At the time of writing
this book, it remains available for use in your applications. It will likely remain so for a
while but not forever. Deprecated methods may disappear without warning in future SDKs.
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If you plan to deploy to a mix of firmware, both earlier than 3.1 as well as 3.1 and
later, make sure to check whether your image picker instances respond to
setAllowsImageEditing: and/or setAllowsEditing:. Use the NSObject
respondsToSelector: method to test.

Note

The NSObject utility category at http://github.com/erica addresses this issue by scanning
through a list of selectors until it finds one that an object can respond to. See the sample
code that accompanies the category for examples of use.

Picking Video

Despite its name, the UIImagePickerController is not limited to picking images.You
can configure it to select both images and videos from your onboard media library. See
Chapter 15,“Audio, Video, and MediaKit,” for details on configuring the picker’s media
types.You’ll also read about selecting, recording, and editing video resources.

Recipe 7-2 Simple UllmagePickerController Image Selection

#define SETIMAGE (X) [(UIImageView *)self.view setImage:X];

@interface TestBedViewController : UIViewController
= UINavigationControllerDelegate, UIImagePickerControllerDelegate>

@end

@implementation TestBedViewController

// 3.x callback
- (void) imagePickerController: (UIImagePickerController *)picker
didFinishPickingMediaWithInfo: (NSDictionary *)info

SETIMAGE ( [info objectForKey:

@"UIImagePickerControllerOriginalImage"]) ;
[self dismissModalViewControllerAnimated:YES];
[picker releasel;

// 2.x callback, which redirects to 3.x callback

- (void)imagePickerController: (UIImagePickerController *)picker
didFinishPickingImage: (UIImage *)image
editingInfo: (NSDictionary *)editingInfo

NSDictionary *dict = [NSDictionary dictionaryWithObject:image
forKey:@"UIImagePickerControllerOriginalImage"] ;

[self imagePickerController:picker
didFinishPickingMediaWithInfo:dict];
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// Optional but "expected" dismiss
- (void) imagePickerControllerDidCancel:
(UIImagePickerController *)picker

[self dismissModalViewControllerAnimated:YES];
[picker release];

// Present the image picker
- (void) pickImage: (id) sender

{

UIImagePickerController *ipc = [[UIImagePickerController alloc]
init];
ipc.sourceType = UIImagePickerControllerSourceTypePhotoLibrary;

ipc.delegate = self;
ipc.allowsImageEditing = NO; // allowsEditing in 3.1
[self presentModalViewController:ipc animated:YES];

- (void) viewDidLoad
{
self .navigationItem.rightBarButtonItem = BARBUTTON (@"Pick",
@selector (pickImage)) ;
self.title = @"Image Picker";

}

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Selecting and Customizing Images from
the Camera Roll

Recipe 7-3 extends image picker interaction to add user-controlled edits. To enable image
editing in a UIImagePickerController, set the allowsImageEditing (3.0 and earlier) or
allowsEditing (3.1 and later) property to YES.This allows users to scale and position
images after selection, or in the case of camera shots, after snapping a photo.You can see
this editor in action on the iPhone when using the Set Wallpaper feature of Settings.
Figure 7-2 shows the post-selection editor for the 3.x and 2.x firmware.

This window allows users to move and scale the image as desired. Pinching and
unpinching changes the image scale. Dragging resets the image origin.
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.uil Carrier = 10:48 AM =t

il Carrier = 10:47 AM

Move and Scale

Cancel

Figure 7-2  The interactive image editor allows users to move, scale, and
choose their final presentation. The 3.x editor appears on the left, the 2.x
editor on the right. As the left image shows, the words “Move and Scale” do
not always appear, even when the iPhone is in edit mode.

When the user taps Choose, control moves to the picker delegate, and your program picks
up from there. Something different happens when users tap Cancel. Control returns to the
album view, allowing the user to select another image and start over.

Recovering Image Edit Information

The 3.x callback returns a dictionary containing information about the selected image.
The info dictionary returned by the 3.x firmware contains four keys that provide access to
important dictionary data:

» UIImagePickerControllerMediaType—Defines the kind of media
selected by the user, normally public.image. Media types are defined in the
UTCoreTypes.h header file, which is part of the Mobile Core Services framework
and is new to 3.0. Media types are primarily used for adding items to the system
pasteboard.

» UIImagePickerControllerCropRect—Returns the section of the image
selected by the user. Oddly enough, this returns as an NSRect, a data type equivalent
to CGRect but more normally used on the Macintosh rather than the iPhone.

» UIImagePickerControllerOriginalImage—Stores a UIImage instance
with the original (nonedited) image contents.
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» UIImagePickerControllerEditedImage—Provides the edited version of
the image, containing the portion of the picture selected by the user. The UTImage
returned is small, sized to fit the iPhone screen.

When working with 2.x firmware, the delegate method imagePickerController:
didFinishPickingImage: editingInfo: returns the edited version of the ﬁnageasim
second argument. This image reflects the scaling and translation specified by the user.
The third argument, the editingInfo dictionary, contains the copy of the original
image and the rectangle that represents the image cropping. Recipe 7-3 provides 2.x
compliance by adding the edited image into the info dictionary and passing that to the
3.x delegate method.

Note

To populate the camera roll on the iPhone simulator, locate the mobile user file system in
~/Library/Application Support/iPhone Simulator/User. Navigate down to Media/DCIM and
copy a 100APPLE folder from a real iPhone to that folder. Make sure to copy both the JPG
images and the small THM thumbnail files.

Recipe 7-3  Allowing Users to Edit Selected Images

- (void)imagePickerController: (UIImagePickerController *)picker
didFinishPickingMediaWithInfo: (NSDictionary *)info

CFShow (info); // review the info dictionary
SETIMAGE ([info objectForKey:

@"UIImagePickerControllerEditedImage"]) ;
[self dismissModalViewControllerAnimated:YES];
[picker release];

// Provide 2.x compliance

- (void)imagePickerController: (UIImagePickerController *)picker
didFinishPickingImage: (UIImage *)image
editingInfo: (NSDictionary *)editingInfo

NSMutableDictionary *dict = [NSMutableDictionary
dictionaryWithDictionary:editingInfo];

[dict setObject:image
forKey:@"UIImagePickerControllerEditedImage"] ;

[self imagePickerController:picker
didFinishPickingMediaWithInfo:dict];

- (void) pickImage: (id) sender

{
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// Present the photo library image picker

UIImagePickerController *ipc = [[UIImagePickerController alloc]
init];
ipc.sourceType = UIImagePickerControllerSourceTypePhotoLibrary;

ipc.delegate = self;
ipc.allowsImageEditing = YES; // allowsEditing 3.1 and later
[self presentModalViewController:ipc animated:YES];

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Snapping Photos and Writing Them to
the Photo Album

Recipes 7-2 and 7-3 showed how to select and edit images using the image picker con-
troller. Recipe 7-4 introduces a different mode, snapping photos with the iPhone’s built-in
camera. The image picker lets users shoot a picture and decide whether to use that image.
Because cameras are not available on all iPhone units (specifically, the first generations of
the iPod touch), begin by checking whether the system running the application supports
camera usage. This snippet checks for a camera, limiting access to the “Snap” button.

if ([UIImagePickerController isSourceTypeAvailable:
UIImagePickerControllerSourceTypeCameral)
self.navigationItem.rightBarButtonItem =
BARBUTTON (@"Snap", @selector (snapImage)) ;
else
showAlert (CAMERA NOT_ AVAILABLE_STRING) ;

As with other modes, you can allow or disallow image editing as part of the photo-capture
process. One feature the camera interaction brings that has no parallel is the Preview
screen. This displays after the user taps the camera icon, which is shown in Figure 7-3.The
Preview screen lets users retake the photo or use the photo as is. On tapping Use (or Use
Photo under 2.x), control passes to the next phase. If you’ve enabled image editing, the
user can do so next. If not, control moves to the standard “did finish picking” method.

The sample code that accompanies this recipe assigns the returned image to the
UIImageView that forms the application background. Notice that just a part of the image
is shown. That’s because the captured picture is much larger than the iPhone screen.
Recipes for resizing a large image follow later in this chapter.

This code also saves the snapped image to the photo album by calling
UIImageWriteToSavedPhotosAlbum (). This function can save any image, not just those
from the onboard camera. Its second and third arguments specify a callback target and
selector. The selector must take three arguments itself, as shown in Recipe 7-4; these are
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an image, an error, and a pointer to context information. Photos snapped from applica-

tions do not contain geotagging information.

11:37 AM

Figure 7-3  After pressing the snap button (Camera icon, left), the Preview

screen lets users chose whether to use or retake the image.

Recipe 7-4 Snapping Images with the Onboard Camera

- (void) snapImage: (id) sender

// Present the camera interface

UIImagePickerController *ipc = [[UIImagePickerController alloc]
init];
ipc.sourceType = UIImagePickerControllerSourceTypeCamera;

ipc.delegate = self;
ipc.allowsImageEditing = NO; // allowsEditing in 3.1
[self presentModalViewController:ipc animated:YES];

- (void)image: (UIImage *)image didFinishSavingWithError:
(NSError *)error contextInfo: (void *)contextInfo;

// Handle the end of the image write process
if (lerror)

showAlert (@"Image written to photo album");
else

showAlert (@"Error writing to photo album: %e@",
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[error localizedDescription]) ;

- (void) imagePickerController: (UIImagePickerController *)picker
didFinishPickingMediaWithInfo: (NSDictionary *)info

// Recover the snapped image
UIlmage *image = [info
objectForKey:@"UIImagePickerControllerOriginalImage"] ;
SETIMAGE (image) ;
// Save the image to the album
UIImageWriteToSavedPhotosAlbum(image, self,
@selector (imagedidFinishSavingWithError:contextInfo:), nil);
[self dismissModalViewControllerAnimated:YES];

[picker releasel;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Saving Pictures to the Documents Folder

Each ulimage can convert itself into JPEG or PNG data. Two built-in UIKit functions
produce the necessary NSData from UIImage instances. These functions are
UIImageJPEGRepresentation() and UIImagePNGRepresentation ().The JPEG version
takes two arguments—the image and a compression quality that ranges from 0.0 (lowest
quality, maximum compression) to 1.0 (highest quality, minimum compression). The PNG
version takes one argument—the image.

To write the image to file, use the NSData object that is returned by either function
and call the writeToFile: atomically: method.This stores the image data to a path
that you specify. Setting the second argument to YES ensures that the entire file gets writ-
ten before being placed into that path. This guarantees that you won’t have to handle the
consequences of partial writes.

Recipe 7-5 uses an image picker controller to select items already in the iPhone
library. The code stores whatever item was selected to the application’s Documents folder
in the sandbox. The finduniquesSaveprath method defined in the recipe returns a unique
name. It searches until it generates a name that does not match an existing file. The picker
delegate method uses that name to save the image.

At the end of the callback, a list of files is printed to the debugging console. This allows
you to see which items have been created, which is handy when you’re running this
recipe on an iPhone device rather than in the simulator.

File-writing speed varies. On the simulator, it runs very fast. On older, first generation
iPhones, it may proceed far more slowly especially for full-size photos that have been
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snapped by the camera. Saving a photo may take up to 5 or 10 seconds, which is a good
time to display an ongoing activity alert like the one used in Recipe 7-11 later in this
chapter.

Recipe 7-5 Saving Images to File

// Return a unique save path in the Documents folder
- (NSString *) findUniqueSavePath
{
int 1 = 1;
NSString *path;
do {
// iterate until a name does not match an existing file
path = [NSString stringWithFormat:
@"%$@/Documents/IMAGE %04d.PNG", NSHomeDirectory(), i++];
} while ([[NSFileManager defaultManager] fileExistsAtPath:pathl);

return path;

- (void)imagePickerController: (UIImagePickerController *)picker
didFinishPickingMediaWithInfo: (NSDictionary *)info

// Retrieve the selected image

UIImage *image = [info objectForKey:
@"UIImagePickerControllerOriginalImage"] ;

[self dismissModalViewControllerAnimated:YES] ;

[picker releasel;

// Write it to file
[UIImageJPEGRepresentation(image, 1.0f) writeToFile:
[self findUniqueSavePath] atomically:YES];

// Set the background
SETIMAGE (image) ;

// Show the current contents of the documents folder

CFShow ( [ [NSFileManager defaultManager]
directoryContentsAtPath: [NSHomeDirectory ()
stringByAppendingString:@"/Documents"]]) ;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.
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Recipe: E-Mailing Pictures

New to the 3.0 SDK, the Message Ul framework allows users to compose e-mail directly
within applications. Add this to your applications by setting up and initializing instances of
MFMailComposeViewController. Recipe 7-6 shows you how to set up a composition
view and initialize its contents.

The mail composition controller operates in a similar fashion to the image picker con-
troller. Your primary view controller presents it as a modal controller and waits for results
via a delegate callback. Make sure to declare the MFMailComposeViewController
=Delegate protocol and implement the single callback that is responsible for dismissing
the controller. Be sure to give the image picker time to finish shutting down before pre-
senting the composition controller.

Set the composition controller’s mostly optional properties to build the message. The
subject and bodies are defined via setSubject: and setMessageBody:.These methods
take strings as their arguments. Creating the attachment requires slightly more work.

To add an attachment, you need to provide all the file components expected by the
mail client. Supply data (via an NSData object), a MIME type (a string), and a filename
(another string). Retrieve the image data using the same UIImageJPEGRepresentation ()
function discussed in Recipe 7-5. Like that recipe, this function takes some time, often
several seconds, to work. So expect a delay before the message view appears.

This example uses a MIME type of image/jpeg. If you want to send other data types,
search on the Internet for the proper MIME representations. The receiving e-mail uses the
file name you specify to store the data you send. Use any arbitrary name you like.

Recipe 7-6  Sending Images by E-Mail

- (void)mailComposeController: (MFMailComposeViewController*)controller
didFinishWithResult: (MFMailComposeResult) result
error: (NSError*)error

// Dismiss the e-mail controller once the user is done
[self dismissModalViewControllerAnimated:YES];

- (void) emailImage: (UIImage *) image

// Requires 3.0 or later, set the base SDK accordingly
if ([MFMailComposeViewController canSendMaill)
{
// Customize the e-mail
MFMailComposeViewController *mcvc =
[[ [MFMailComposeViewController alloc] init] autorelease];
mcvce.mailComposeDelegate = self;
[mcve setSubject:@"Here’s a great photo!"];
NSString *body = @"<hl>Check this out</hl>\
<p>I selected this image from the\
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<code><b>UIImagePickerController</b></code>.</p>";

[mcve setMessageBody:body isHTML:YES];

[mcve addAttachmentData:UIImageJPEGRepresentation (image, 1.0f)
mimeType:@"image/jpeg" fileName:@"pickerimage.jpg"];

// Present the e-mail composition controller
[self presentModalViewController:mcvc animated:YES];

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Capturing Time Lapse Photos

There are times that you just want to use the camera to take a quick shot without user
interaction. For example, you might write a utility that does time lapse photography as
you’re biking, or you may want to build an application that builds stop motion animation.
Recipe 7-7 demonstrates how to achieve this by using new 3.1 SDK features with the
camera from the UI ImagePickerController.

Two 3.1 API changes enable this kind of capture. The showsCameraControls property
allows you to hide the normal camera GUI, presenting a full-screen camera preview
instead. Set this property to NO.

ipc.showsCameraControls = NO;

To programmatically capture an image rather than depend on user input, call the
takePicture method. This begins the photo acquisition process, just as if a user had
pressed the snap button. When the photo is ready, the picker sends the
imagePickerController:didFinishPickingMediaWithInfo:Caﬂbacktoitsdekga&i
You cannot capture another picture until after this method is called.

Recipe 7-7 takes a series of three pictures, one after another. It saves each image to the
photo album and then snaps the next shot. Each image is a full-resolution photo, taking
up 2 or 3 megabytes of memory each.You could easily add a timer to space out the pho-
tos for longer delays.

When using the iPhone in a dock to snap photos over a long period of time, make sure
to disable the UIApplication’s idle timer as follows. This code ensures that the device will
not sleep even though a user has not interacted with it for a while.

[UIApplication sharedApplication].idleTimerDisabled = YES;

Note

Consider combining Recipe 7-7’s time-lapse photography with Recipe 13-11's Twitpic
uploader to create a security camera system with a spare iPhone.
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Recipe 7-7 Time Lapse Photos

@implementation TestBedViewController

- (void)image: (UIImage *)image
didFinishSavingWithError: (NSError *)error
contextInfo: (void *)contextInfo;

// Respond to the file save results
if (lerror)
NSLog (@"Image written to photo album");
else
NSLog (@"Error writing to photo album: %@",
[error localizedDescription]) ;

// Take three photos and then stop

if (count++ == 3)

{
[self dismissModalViewControllerAnimated:YES];
[ipc release];
ipc = nil;

}

else [ipc takePicturel];

- (void) imagePickerController: (UIImagePickerController *)picker
didFinishPickingMediaWithInfo: (NSDictionary *)info

// Save snapped image to photo album
UIlmage *image = [info objectForKey:
@"UIImagePickerControllerOriginalImage"] ;
UIImageWriteToSavedPhotosAlbum(image, self,
@selector (imagedidFinishSavingWithError:contextInfo:), nil);

- (void) snapImage: (id) sender

{

count = 0; // will take a total of 3 snaps

// initialize the image picker

ipc = [[UIImagePickerController alloc] init];
ipc.sourceType = UIImagePickerControllerSourceTypeCamera;
ipc.delegate = self;

ipc.allowsEditing = NO;

ipc.showsCameraControls = NO;

[self presentModalViewController:ipc animated:YES];
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// Wait for camera set up and then snap a picture
[NSTimer scheduledTimerWithTimeInterval:2.0f target:ipc
selector:@selector (takePicture) userInfo:nil repeats:NOJ;

- (void) viewDidLoad
{
if ([UIImagePickerController isSourceTypeAvailable:
UIImagePickerControllerSourceTypeCameral)
self.navigationItem.rightBarButtonItem =
BARBUTTON (@"Snap", @selector (snapImage));
else
showAlert (@"This demo relies on camera access.");
self.title = @"Image Picker";

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Using a Custom Camera Overlay

With the 3.1 firmware, you can now add custom overlays to the camera interface. Use this
feature to create a GUI that floats over the live camera preview.You can add buttons and
other user interface controls to snap photographs and dismiss the controller. Figure 7-4
shows a rudimentary overlay with two buttons: one for snapping a photo, the other (the
small circled “X”) for dismissing the image picker controller.

The light gray bar behind the Snap button was added in Interface Builder when laying
out the overlay. In Figure 7-4, this bar sits partway in the image area and partway in the
black control area, which is left blank for your use.

Set the overlay by assigning a view to the picker’s cameraoverlayView property and
hide the normal controls. When you present the picker, the custom overlay, not the built-
in one, appears.

Another 3.1 feature, the cameraViewTransform property, provides a way to change
how the camera view is shown. Recipe 7-8 uses this property to spin the preview while
an image is being saved. In normal use, this property comes in handy for videoconferenc-
ing should Apple ever release a front-mounted iPhone or (more likely) iPod camera.

Recipe 7-8 highlights these two features and demonstrates how to use them in your
iPhone applications.

275


http://github.com/erica/iphone-3.0-cookbook-

276 Chapter 7 Working with Images

Figure 7-4  Snapping photos with a custom
image picker overlay.

Recipe 7-8 Custom Camera Overlays and Transforms

@implementation TestBedViewController
- (void)image: (UIImage *)image didFinishSavingWithError:
(NSError *)error contextInfo: (void *)contextInfo;

// Respond to the file save success
if (lerror)
NSLog (@"Image written to photo album");
else
NSLog (@"Error writing to photo album: %e@",
[error localizedDescription]);

// Restore the picker controller standards
overlay.alpha = 1.0f;

[timer invalidate];

ipc.cameraViewTransform = CGAffineTransformIdentity;

- (void) imagePickerController: (UIImagePickerController *)picker
didFinishPickingMediaWithInfo: (NSDictionary *)info

// Retrieve and save the image

UIImage *image = [info objectForKey:
@"UIImagePickerControllerOriginalImage"];

UIImageWriteToSavedPhotosAlbum(image, self,
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@selector (imagedidFinishSavingWithError:contextInfo:), nil);

(void) rotate

// Rotate the camera view
ipc.cameraViewTransform =
CGAffineTransformMakeRotation(2.0f*M PI*((float)count/100.0f));

o

count = (count + 10) % 100;

(void) snap: (id) sender

// Prepare to snap a photo

overlay.alpha = 0.0f;

[ipc takePicture] ;

count = 0;

timer = [NSTimer scheduledTimerWithTimeInterval:0.1f
target:self selector:@selector (rotate) userInfo:nil
repeats:YES] ;

(void) dismiss: (id) sender

// Dismiss the image picker interface

[self dismissModalViewControllerAnimated:YES] ;
[ipc release];

ipc = nil;

(void) takePics: (id) sender

// Create and present the image picker interface

ipc = [[UIImagePickerController alloc] init];
ipc.sourceType = UIImagePickerControllerSourceTypeCamera;
ipc.delegate = self;

ipc.allowsEditing = NO;

ipc.showsCameraControls = NO;

ipc.cameraOverlayView = overlay;

[self presentModalViewController:ipc animated:YES];

(void) viewDidLoad

if ([UIImagePickerController
isSourceTypeAvailable:
UIImagePickerControllerSourceTypeCameral)
self.navigationItem.rightBarButtonItem =
BARBUTTON (@"Camera", @selector (takePics)) ;
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else
showAlert (@"This demo relies on camera access.");
self.title = @"Image Picker";

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Displaying Images in a Scrollable View

Image display is all about memory. Treat large and small image display as separate prob-
lems. The uIwebview class easily handles memory-intense data.You might load a larger
image into a web view using a method like this. This approach works well with bulky
PDF images. UIWwebviews offer a complete package of image presentation including built-
in scrolling and resizing.

- (void) loadImageIntoWebView: (NSString *) path

{

// Automatically fit the image to the view
self .webView.scalesPageToFit = YES;

// Load the image by creating a request

NSURL *fileURL = [NSURL fileURLWithPath:path];

NSURLRequest *request = [NSURLRequest requestWithURL:fileURL];
[self.webView loadRequest:request];

}

With smaller images, say less than half a megabyte in size when compressed, you can load
them directly to UTImageviews and add them to your interface. Apple recommends that
UIImage images never exceed 1024-by-1024 pixels due to memory concerns.

The problem with basic image views is that they are static. Unlike web views, they do
not respond to user scrolls and pinches. Embedding into a UIScrollview solves this prob-
lem. Scroll views provide those user interactions, allowing users to manipulate any image
placed on the scroll view surface.

Recipe 7-9 demonstrates how to do this. It adds a scroll view to the interface and a
weather map to the scroll view, as shown in Figure 7-5.Then it calculates a pair of mini-
mum values based on the core size of the image, namely the least degree of zoom that
allows the image to be fully seen in the scroll view. It assigns this value to the scroll view’s
minimumZoomScale. The maximum scale is set, arbitrarily to three times the image size.
These settings allow full user interaction with the image while limiting that interaction to
a reasonable scope.

The delegate method shown in the recipe identifies which view responds to zooming.
For this recipe, that corresponds to the single image view placed onto the scroll view.
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Scroll views do not automatically know anything about any subviews you add to them.
Defining this delegate method binds the zoom to your image.

Weather Scroller

Current Surface

RAIN/DRZZLE IMOD/HVY RAIN |IRAIN/ICE/SNOW | |LT SHOW!

Figure 7-5 This live weather map is downloaded
from a World Wide Web URL and layered onto a
scroll view that allows users to scale and pan
through the image.

Note

As with other views, you can set a UIImageView's properties in Interface Builder. IB’s
inspectors enable you to change the view’s alpha setting, size, location, and so forth.
There’s one quirk though. When you use an image view as your primary view, IB balks at
adding subviews. If you run into this problem, create another view as your main view, and
edit your image view as needed. After, delete the main view. Control-drag from your applica-
tion delegate and assign the edited image view to the view outlet.

Recipe 7-9 Embedding an Image onto a Scroller

@implementation TestBedViewController
@synthesize weathermap;

- (UIView *)viewForZoomingInScrollView: (UIScrollView *)scrollView

return [self.view viewWithTag:201];

- (void) viewDidLoad
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// Create the scroll view and set its content size and delegate

UIScrollView *sv = [[[UIScrollView alloc]
initWithFrame:CGRectMake (0.0f, 0.0f, 320.0f, 284.0f)
autorelease] ;

sv.contentSize = self.weathermap.size;
sv.delegate = self;

// Create an image view and add it to the scroll view

self.weathermap = URLIMAGE (MAP_URL) ;

UIImageView *iv = [[[UIImageView alloc]
initWithImage:self.weathermap] autorelease];

iv.userInteractionEnabled = YES;

iv.tag = 201;

// Calculate and set the zoom scale values

float minzoomx = sv.frame.size.width/self.weathermap.size.width;
float minzoomy = sv.frame.size.height/self.weathermap.size.height;
sv.minimumZoomScale = MIN(minzoomx, minzoomy) ;

sv.maximumZoomScale = 3.0f;

// Add in the subviews
[sv addSubview:iv];

[self.view addSubview:sv];

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’'ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Creating a Multiimage Paged Scroll

Scroll views aren’t just about zooming. The UIScrollview’s paging property allows you to
place images (or other views, for that matter) in a scroll view and move through them one
view-width at a time. The key lies in ensuring that each image loaded exactly matches the
width of the scroll view frame for horizontal presentations or its height for vertical ones.

Set the pagingEnabled property to YES. This allows users to flick their way from one
image to another. Recipe 7-10 demonstrates how to do this. What this recipe offers is a
page-by-page presentation of several image views.You can use this same approach to pres-
ent views that aren’t just images.
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Note

Adding zooming to a paged view presents a more difficult problem than the simple scrolling
shown here. It’'s a problem that has been solved ably and extensively by Joe Hewitt, devel-
oper of the iPhone Facebook application. His open source three20 project (http://github.
com/joehewitt/three20) offers photo-album style interactions including image zooming from
within a paged scroller. The repository provides a wide range of useful and beautiful view util-
ity classes.

Recipe 7-10 Creating a Paged Image Presentation

{

(void) viewDidLoad

// Create the scroll view and set its content size and delegate

UIScrollView *sv = [[[UIScrollvView alloc]
initWithFrame:CGRectMake (0.0f, 0.0f, 320.0f, BASEHEIGHT)]
autorelease] ;

sv.contentSize = CGSizeMake (NPAGES * 320.0f, sv.frame.size.height);
sv.pagingEnabled = YES;
sv.delegate = self;

// Load in all the pages
for (int 1 = 0; 1 < NPAGES; i++)
{
NSString *filename = [NSString stringWithFormat:@"image%d.png",
i+1];
UIlmageView *iv = [[UIImageView alloc] initWithImage:
[UIImage imageNamed:filenamel];
iv.frame = CGRectMake(i * 320.0f, 0.0f, 320.0f, BASEHEIGHT) ;
[sv addSubview:iv];
[iv release];

[self.view addSubview:sv];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Creating New Images from Scratch

In addition to loading images from files and from the Web, Cocoa Touch allows you to
create new images on-the-fly. This blends UIKit functions with standard Quartz 2D
graphics to build new UIImage instances.
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So why would build new images from scratch? The answers are many.You might create
a thumbnail by shrinking a full-size picture into a new image.You could programmatically
lay out a labeled game piece.You might generate a semitransparent backsplash for custom
alert views.You can also add effects to existing images like the reflection discussed in
Chapter 6, “Assembling Views and Animations,” or you might just want to customize an
image in some other way. Each of these examples builds a new image in code, whether
that image is based on another or built entirely from new elements.

Cocoa Touch provides a simple way to build new images. As this code shows, you
just create a new image context, draw to it, and then transform the context into a
UIImage object.

UIGraphicsBeginImageContext (CGSizeMake (40.0f, 40.0f));
CGContextRef context = UIGraphicsGetCurrentContext () ;

// Draw to the context here

UIImage *theImage = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;

The drawing commands you use may consist of a combination of UIKit calls (like
drawAtPoint: and drawInRect:) and Core Graphics Quartz calls like the ones used in
Recipe 7-11. Recipe 7-11 builds new image views and populates them with images
drawn from scratch. As Figure 7-6 shows, these images are circles with random colors,
labeled with a number. These numbers are drawn directly into the image; they are not
added with a separate UILabel.

Recipe 7-11 Creating Ullmage Instances from Scratch

// Draw centered text into the context
void centerText (CGContextRef context, NSString *fontname,
float textsize, NSString *text, CGPoint point, UIColor *color)

CGContextSaveGState (context) ;
CGContextSelectFont (context, [fontname UTF8Stringl, 24.0f,
kCGEncodingMacRoman) ;

// Retrieve the text width without actually drawing anything

CGContextSaveGState (context) ;

CGContextSetTextDrawingMode (context, kCGTextInvisible);

CGContextShowTextAtPoint (context, 0.0f, 0.0f, [text UTF8String],
text.length) ;

CGPoint endpoint = CGContextGetTextPosition (context) ;

CFShow (NSStringFromCGPoint (endpoint) ) ;

CGContextRestoreGState (context) ;
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// Query for size to recover height. Width is less reliable
CGSize stringSize = [text sizeWithFont:
[UIFont fontWithName:fontname size:textsizel];

// Draw the text

CGContextSetShouldAntialias (context, true);
CGContextSetTextDrawingMode (context, kCGTextFill);
CGContextSetFillColorWithColor (context, [color CGColorl]) ;
CGContextSetTextMatrix (context,

CGAffineTransformMake(1, 0, 0, -1, 0, 0));
CGContextShowTextAtPoint (context, point.x - endpoint.x / 2.0f,
point.y + stringSize.height / 3.0f, [text UTF8String],

text.length) ;
CGContextRestoreGState (context) ;

(UIImage *) createImageWithColor: (UIColor *) color

// Create a new 40x40 image context
UIGraphicsBeginImageContext (CGSizeMake (40.0f, 40.0f));
CGContextRef context = UIGraphicsGetCurrentContext () ;

// Create a filled circle
CGContextSetFillColorWithColor (context, [color CGColor]) ;
CGContextAddEllipseInRect (context,

CGRectMake (0.0f, 0.0f, 40.0f, 40.0f));
CGContextFillPath (context) ;
CGContextClip (context) ;

// Label with a number
CGContextSetFillColorWithColor (context,
[[UIColor whiteColor] CGColor]);
NSString *numstring = [NSString stringWithFormat:@"$d", count++];
centerText (context, @"Georgia", 18.0f, numstring,
CGPointMake (20.0f, 20.0f), [UIColor whiteColorl]) ;

// Outline the circle with a slight (2-pixel) inset
CGContextSetStrokeColorWithColor (context,

[[UIColor whiteColor] CGColor]) ;
CGContextAddEllipselInRect (context,

CGRectMake (2.0f, 2.0f, 36.0f, 36.0f));
CGContextStrokePath (context) ;

// Return the new image

UIImage *theImage = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;

return thelmage;
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- (void) add: (id) sender
{
// Create a random color
CGFloat red = (random() % 128) / 256.0f;
CGFloat green = (random() % 128) / 256.0f;
CGFloat blue = (random() % 128) / 256.0f;
UIColor *color = [UIColor colorWithRed:red green:green
blue:blue alpha:1.0f];

// Request the new image and place it into a UIImageView

UIImage *newimage = [self createImageWithColor:color];

UIImageView *newview = [[UIImageView alloc]
initWithImage:newimage] ;

// Randomly position the image view
newview.center = [newview randomCenterInView:

[self.view viewWithTag:101] withInset:0];
[[self.view viewWithTag:101] addSubview:newview] ;
[newview release];

-aill Carrier = 2:14 PM

Figure 7-6  Each circle represents an image cre-
ated entirely with Core Graphics/Quartz calls.
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Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Recipe: Building Thumbnails from Images

Thumbnails play an important role in any application that uses images. Often you need to
resize an image to fit into a smaller space. Sure, you can load up a UIImageview with the
tully leaded original and resize its frame, but you can save a lot of memory by redrawing
that image into fewer bytes Thumbnails can use one of three approaches, which are
demonstrated in Figure 7-7.You can

» Resize the image while retaining its proportions. Depending on the image’s aspect
ratio, you’ll need to either letterbox or pillarbox some extra area, matting the image
with transparent pixels.

= Punch out part of the image to match the available space. The example in Figure 7-7
chooses a centered subimage and crops any elements that fall outside the pixel area.

» Fill the image by matching the height and width to the available space. Every pixel
gets used, but the image will get cropped, either horizontally or vertically. This cor-
responds to the full-screen film presentation shown on nonwidescreen TVs, which
tend to lose details at either side of the movie.

Figure 7-7 These screenshots represent three ways to create image
thumbnails. Fitting (left) preserves original aspect ratios, padding the image
as needed with extra space. Centering (center) uses the original image pix-
els, cropping from the center out. Filling (right) ensures that every available

pixel is filled, cropping only those portions that fall outside the frame.
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Recipe 7-12 shows how to create these three thumbnail effects. The methods in this code
allow you to pass an image and a size. They return a new thumbnail respectively using the
fit, center, or fill technique.

Recipe 7-12 Creating Thumbnails

// Calculate a size that fits in another size while retaining its
// original proportions
+ (CGSize) fitSize: (CGSize)thisSize inSize: (CGSize) aSize
{
CGFloat scale;
CGSize newsize = thisSize;

if (newsize.height && (newsize.height > aSize.height))
{
scale = aSize.height / newsize.height;
newsize.width *= scale;
newsize.height *= scale;

if (newsize.width && (newsize.width >= aSize.width))

scale = aSize.width / newsize.width;
newsize.width *= scale;
newsize.height *= scale;

return newsize;

// Proportionately resize, completely fit in view, no cropping
+ (UIImage *) image: (UIImage *) image fitInSize: (CGSize) viewsize

{

// calculate the fitted size
CGSize size = [ImageHelper fitSize:image.size inSize:viewsizel;

UIGraphicsBeginImageContext (viewsize) ;
// Calculate any matting needed for image spacing
float dwidth = (viewsize.width - size.width) / 2.0f;

float dheight = (viewsize.height - size.height) / 2.0f;

CGRect rect = CGRectMake (dwidth, dheight, size.width, size.height);
[image drawInRect:rect];

UIlmage *newimg = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;
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return newimg;

// No resize, may crop
+ (UIImage *) image: (UIImage *) image centerInSize: (CGSize) viewsize

{

CGSize size = image.size;
UIGraphicsBeginImageContext (viewsize) ;

// Calculate the offset to ensure that the image center is set
// to the view center

float dwidth = (viewsize.width - size.width) / 2.0f;

float dheight = (viewsize.height - size.height) / 2.0f;

CGRect rect = CGRectMake (dwidth, dheight, size.width, size.height);
[image drawInRect:rect];

UIlmage *newimg = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;

return newimg;

// Fill every view pixel with no black borders,
// resize and crop if needed
+ (UIImage *) image: (UIImage *) image fillSize: (CGSize) viewsize

CGSize size = image.size;

// Choose the scale factor that requires the least scaling
CGFloat scalex = viewsize.width / size.width;

CGFloat scaley = viewsize.height / size.height;

CGFloat scale = MAX(scalex, scaley);

UIGraphicsBeginImageContext (viewsize) ;
CGFloat width = size.width * scale;

CGFloat height = size.height * scale;

// Center the scaled image
float dwidth = ((viewsize.width - width) / 2.0f);
float dheight = ((viewsize.height - height) / 2.0f);
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CGRect rect = CGRectMake (dwidth, dheight,
size.width * scale,
size.height * scale);

[image drawInRect:rect];

UIImage *newimg = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;

return newimg;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

Fixing Photo Orientation

Any photo snapped with a digital camera may be tagged with an intrinsic orientation; this
orientation reflects how the camera was held during shooting. For example, if the user
positioned the camera to the left or right to snap a landscape picture, the EXIF metadata
stored with that image may contain an orientation property. The UIImage class reads in
this metadata along with the image and uses it to set its imageOrientation property.

Cocoa Touch handles eight kinds of UIImageOrientation values. These correspond to
up, down, left, right plus four more values that provide mirrored versions of the same ori-
entation. These orientations are

= UIImageOrientationUp

m UIImageOrientationLeft

= UIImageOrientationRight

® UIImageOrientationDown

®» UIImageOrientationUpMirrored

m UIImageOrientationLeftMirrored
= UIImageOrientationRightMirrored

m UIImageOrientationDownMirrored

Mirrored images are typically captured when using webcams. The webcam software
reverses the image automatically; mirrored images feel more natural when looking at a live
webcam feed of yourself.

This issue can be important when loading images from files in byte order, without
regard to orientation. That means a picture snapped with some alternate orientation may
load sideways, upside down, or mirrored into a bitmap. Fixing image orientation allows
you to ensure that the displayed image matches the photographer’s perception.
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Fixing Photo Orientation

Listing 7-1 demonstrates how to return an unrotated version of any UIImage. It works
by recovering the imageOrientation property and drawing the image into a graphics
context that has been transformed to match the original camera properties. For the most
part you won'’t need to use this approach unless you're dealing directly with bits. The
UIImageView class automatically handles most image orientation issues for you.

Listing 7-1  Unrotating Ullmage Instances

// Orientation convenience macros
#define MIRRORED ((image.imageOrientation ==

UllmageOrientationUpMirrored) || (image.imageOrientation ==
UllmageOrientationLeftMirrored) || (image.imageOrientation ==
UllmageOrientationRightMirrored) || (image.imageOrientation ==
UIImageOrientationDownMirrored))

#define ROTATED90 ((image.imageOrientation ==
UllmageOrientationLeft) || (image.imageOrientation ==
UllmageOrientationLeftMirrored) || (image.imageOrientation ==
UllmageOrientationRight) || (image.imageOrientation ==

UIImageOrientationRightMirrored))

// Return an unrotated version of the image
+ (UIImage *) doUnrotateImage: (UIImage *) image
CGSize size = image.size;
if (ROTATED90) size = CGSizeMake (image.size.height,
image.size.width) ;

UIGraphicsBeginImageContext (size) ;
CGContextRef context = UIGraphicsGetCurrentContext () ;
CGAffineTransform transform = CGAffineTransformIdentity;

// Rotate as needed
switch(image.imageOrientation)
{
case UIImageOrientationLeft:
case UIImageOrientationRightMirrored:
transform = CGAffineTransformRotate (transform,
M PI / 2.0f);
transform = CGAffineTransformTranslate (transform,
0.0f, -size.width);
size = CGSizeMake (size.height, size.width);
CGContextConcatCTM (context, transform);
break;
case UIImageOrientationRight:
case UIImageOrientationLeftMirrored:
transform = CGAffineTransformRotate (transform,
-M PI / 2.0f);
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transform = CGAffineTransformTranslate (transform,
-size.height, 0.0f);
size = CGSizeMake (size.height, size.width);
CGContextConcatCTM (context, transform);
break;
case UIImageOrientationDown:
case UIImageOrientationDownMirrored:
transform = CGAffineTransformRotate (transform, M _PI);
transform = CGAffineTransformTranslate (transform,
-size.width, -size.height);
CGContextConcatCTM (context, transform);
break;
default:
break;

if (MIRRORED)

{
// de-mirror
transform = CGAffineTransformMakeTranslation(size.width, 0.0f);
transform = CGAffineTransformScale (transform, -1.0f, 1.0f);
CGContextConcatCTM (context, transform);

// Draw the image into the transformed context and return the image
[image drawAtPoint:CGPointMake (0.0f, 0.0f)];

UIlmage *newimg = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;

return newimg;

Adding Test Images

It’s simple enough to a snap a set of test pictures using the four main orientations (left,
right, up, down) using your built-in iPhone camera. Add them to the simulator by copying
them to your home Library/Application Support/iPhone Simulator/User/Media/
DCIM/100APPLE/ folder.You'll need to create the DCIM/100APPLE subfolder.

Taking Screenshots

As Listing 7-2 demonstrates, you can draw views into image contexts and transform
those contexts into UIImage instances. This code works by using Core Graphic’s
renderInContext call for CALayer instances. It produces a screenshot not only of the
view but all the views that view owns.
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There are, of course, limits. You cannot screenshot the entire window (the status bar
will be missing in action) and you cannot screenshot videos or the camera previews.
OpenGLES views may also not be captured.

Listing 7-2  Screenshotting a View

+ (UIImage *) imageFromView: (UIView *) theView

{
// Draw a view’s contents into an image context
UIGraphicsBeginImageContext (theView.frame.size) ;
CGContextRef context = UIGraphicsGetCurrentContext () ;
[theView.layer renderInContext:context];
UIImage *theImage = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;
return thelImage;

Recipe: Working Directly with Bitmaps

Although Cocoa Touch provides excellent resolution-independence tools for working
with many images, there are times you need to reach down to the bits that underlie a pic-
ture and access data on a bit-by-bit basis. For example, you might apply edge detection or
blurring routines. These functions calculate their results by convolving matrices against
actual byte values.

Figure 7-8 shows the result of Canny Edge Detection on an iPhone image. The Canny
operator in its most basic form is one of the first algorithms taught in image processing
classes. The version used to produce the image shown here uses a hardwired 3x3 mask.

Drawing into a Bitmap Context

To get started with image processing, draw an image into a bitmap context and then
retrieve bytes as a char * buffer. This code does exactly that, retrieving the bits from the
context once the image has been drawn.

+ (unsigned char *) bitmapFromImage: (UIImage *) image
// Create bitmap data for the given image
CGContextRef context = CreateARGBBitmapContext (image.size);
if (context == NULL) return NULL;

CGRect rect = CGRectMake(0.0f, 0.0f,

image.size.width, image.size.height);
CGContextDrawImage (context, rect, image.CGImage);
unsigned char *data = CGBitmapContextGetData (context);
CGContextRelease (context) ;
return data;

291



292

Chapter 7 Working with Images

No Service = 11:49 AM =} |No Service = 11:49 AM ==

Swap Edge Detection Pick

Swap Edge Detection

Figure 7-8 Applying edge detection to an image produces a result that out-
lines areas where byte values experience the greatest changes.

This routine relies on a special bitmap context that allocates memory for the bitmap data.
Here is the function that creates that context. It produces an AR GB bitmap context using
an Alpha-R ed-Green-Blue representation, one byte per channel, 256 levels per unsigned
byte.

CGContextRef CreateARGBBitmapContext (CGSize size)

{

// Create the new color space
CGColorSpaceRef colorSpace = CGColorSpaceCreateDeviceRGB() ;
if (colorSpace == NULL)
{
fprintf (stderr, "Error allocating color space\n");
return NULL;

// Allocate memory for the bitmap data
void *bitmapData = malloc(size.width * size.height * 4);
if (bitmapData == NULL)
{
fprintf (stderr, "Error: Memory not allocated!");
CGColorSpaceRelease (colorSpace) ;
return NULL;
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// Build an 8-bit per channel context

CGContextRef context = CGBitmapContextCreate (bitmapData,
size.width, size.height, 8, size.width * 4, colorSpace,
kCGImageAlphaPremultipliedFirst) ;

CGColorSpaceRelease (colorSpace ) ;

if (context == NULL)

{

fprintf (stderr, "Error: Context not created!");
free (bitmapData) ;
return NULL;

return context;

}

Once the image bytes are available, you can access them directly. The following functions
return offsets for any point (x,y) inside an ARGB bitmap using width w. The height is not
needed for these calculations; the width of each row allows you to determine a two-
dimensional point in what is really a one-dimensional bufter. Notice how the data is
interleaved. Each 4-byte sequence contains a level for alpha, red, green, and then blue.
Each byte ranges from 0 (0%) to 255 (100%). Convert to a float and divide by 255.0 to
retrieve the AR GB value.

NSUInteger alphaOffset (NSUInteger x, NSUInteger y, NSUInteger w)
{return y * w * 4 + x * 4 + 0;}

NSUInteger redOffset (NSUInteger x, NSUInteger y, NSUInteger w)
{return y * w * 4 + x * 4 + 1;}

NSUInteger greenOffset (NSUInteger x, NSUInteger y, NSUInteger w)
{return y * w * 4 + x * 4 + 2;}

NSUInteger blueOffset (NSUInteger x, NSUInteger y, NSUInteger w)
{return y * w * 4 + x * 4 + 3;}

Applying Image Processing

It’s relatively easy then to convolve an image by recovering its bytes and applying some
image-processing algorithm. This routine uses the basic Canny edge detection mentioned
earlier. It calculates both the vertical and horizontal edge results for each color channel,
and then scales the sum of those two results into a single value that falls within [0, 255].
The output alpha value preserves the original level.

+ (UIImage *) convolveImageWithEdgeDetection: (UIImage *) image
{

// Dimensions

int theheight = (int) image.size.height;

int thewidth = (int) image.size.width;

293



294 Chapter 7 Working with Images

// Get input and create output bits

unsigned char *inbits = (unsigned char *) [ImageHelper
bitmapFromImage:imagel ;

unsigned char *outbits = (unsigned char *)malloc(theheight *
thewidth * 4);

int radius = 1;

// Iterate through each available pixel (leaving a radius-sized
// boundary)
for (int y = radius; y < (theheight - radius); y++)
for (int x = radius; x < (thewidth - radius); x++)
{
int sumrl = 0, sumr2 = 0;
int sumgl = 0, sumg2 = 0;
int sumbl = 0, sumb2 = 0;

// Basic Canny Edge Detection
int matrix1(9] = {-1, 0, 1, -2, 0, 2, -1, 0, 1};
int matrix2[9] = {-1, -2, -1, 0, 0, 0, 1, 2, 1};
int offset = 0;
for (int j = -radius; j <= radius; j++)
for (int i = -radius; i <= radius; i++)
{
sumrl += inbits[redOffset (x+i, y+j, thewidth)] *
matrixl [offset];
sumr2 += inbits[redOffset (x+i, y+j, thewidth)] *
matrix2 [offset];

sumgl += inbits[greenOffset (x+i, y+j, thewidth)] *
matrixl [offset];

sumg2 += inbits[greenOffset (x+1i, y+j, thewidth)] *
matrix2 [offset];

sumbl += inbits[blueOffset (x+i, y+j, thewidth)] *
matrixl [offset];

sumb2 += inbits[blueOffset (x+i, y+j, thewidth)] *
matrix2 [offset];

offset++;

// Assign the outbits

int sumr = MIN(((ABS(sumrl) + ABS(sumr2)) / 2), 255);
int sumg = MIN(((ABS(sumgl) + ABS(sumg2)) / 2), 255);
int sumb = MIN(((ABS(sumbl) + ABS(sumb2)) / 2), 255);
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outbits[redOffset (x, y, thewidth)] = (unsigned char) sumr;

outbits [greenOffset (x, y, thewidth)] = (unsigned char)
sumg;

outbits [blueOffset (x, y, thewidth)] = (unsigned char) sumb;

outbits[alphaOffset (x, y, thewidth)] =
(unsigned char) inbits([alphaOffset(x, y, thewidth)];

// Release the original bitmap. imageWithBits frees outbits
free(inbits) ;
return [ImageHelper imageWithBits:outbits withSize:image.size];

Image Processing Realities

The iPhone is not a number-crunching powerhouse. Routines like these may slow down
applications significantly. Use them judiciously. Recipe 7-13 demonstrates how to balance
image-processing demands with iPhone limitations. It follows three main rules of iPhone
implementation:

» Provide meaningful feedback to the user when dealing with unavoidable delays.
» Perform processor-heavy functionality on a secondary thread.

= Only ever perform GUI updates on the main thread.

The flow for this solution is shown in Figure 7-9. A “Please Wait” Heads Up Display
(HUD) appears with a spinning activity indicator. It remains in view until a separate pro-
cessing thread finishes:

This indicator cannot display properly when all the processing happens in the main
thread. Heavy processing blocks GUI updates, causing the UIalertview that the HUD is
based on to delay its appearance until after the processing finishes. That counters the “pro-
vide meaningful feedback” directive so important to iPhone application development.
That’s why a two-thread approach is so important.

The process routine was designed to run on its own thread. It provides a separate
NSAutorelease pool and is spawned by the did-finish-picking method. Although it works
with image contexts, nothing in the method actually changes any GUI elements. Its job is
to redraw an image into a 320-by-416-pixel space and then perform Canny edge detec-
tion on that image.

When the thread finishes its heavy lifting, it calls a f£inish method on the main thread.
That method cleans up the GUI by dismissing the HUD, adding a Swap button, and set-
ting the displayed image.

Recipe 7-13 Providing an iPhone-Friendly GUI for Image Processing

@implementation TestBedViewController
@synthesize original;
@synthesize processed;
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#define SETIMAGE (X) [UIImageView*)self.view setImage:X];
// Allow user to swap between original and processed image
- (void) swap
{
// SETIMAGE works with 2.2 and later
if ([(UIImageView *)self.view image] == self.original)
SETIMAGE (self.processed)
else
SETIMAGE (self.original) ;

// Handle main thread GUI cleanup
- (void) finish
{
SETIMAGE (self.processed) ;
self.navigationItem.leftBarButtonItem = BARBUTTON (@"Swap",
@selector (swap)) ;
[ModalHUD dismiss] ;

// Perform calculation-heavy processing on a second thread

- (void) process

{
NSAutoreleasePool *pool = [[NSAutoreleasePool alloc] init];
CGSize coreSize = CGSizeMake (320.0f, 416.0f);

// Scale image

UIGraphicsBeginImageContext (coreSize) ;

[self.original drawInRect: [ImageHelper frameSize:self.original.size
inSize:coreSize]];

UIlmage *newimg = UIGraphicsGetImageFromCurrentImageContext () ;

UIGraphicsEndImageContext () ;

self.original = newimg;

// Calculate edge detection image
self.processed = [ImageHelper convolvelImageWithEdgeDetection:
self.originall;

// Clean up on the main thread

[self performSelectorOnMainThread:@selector (finish) withObject:nil
waitUntilDone:NO] ;

[pool release];
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// Display the HUD and start the processing thread
- (void)imagePickerController: (UIImagePickerController *)picker
didFinishPickingMediaWithInfo: (NSDictionary *)info

[ModalHUD showHUD:@"Processing\nPlease wait."];
self.original = [info objectForKey:

@"UIImagePickerControllerOriginalImage"] ;
[self dismissModalViewControllerAnimated:YES];
[picker releasel;

[NSThread detachNewThreadSelector:@selector (process)
toTarget:self withObject:nil];

// Provide 2.x compliance

- (void) imagePickerController: (UIImagePickerController *)picker
didFinishPickingImage: (UIImage *)image
editingInfo: (NSDictionary *)editingInfo

NSDictionary *dict = [NSDictionary dictionaryWithObject:image
forKey:@"UIImagePickerControllerOriginalImage"];

[self imagePickerController:picker
didFinishPickingMediaWithInfo:dict];

// Allow user to pick a new image to work on
- (void) pickImage: (id) sender

{

UIImagePickerController *ipc = [[UIImagePickerController alloc]
init];
ipc.sourceType = UIImagePickerControllerSourceTypePhotoLibrary;

ipc.delegate = self;
ipc.allowsImageEditing = NO; // .allowsEditing in 3.1
[self presentModalViewController:ipc animated:YES];

// Initialize title and bar button
- (void) viewDidLoad
{
self .navigationController.navigationBar.tintColor =
COOKBOOK_PURPLE COLOR;
self.navigationItem.rightBarButtonItem = BARBUTTON (@"Pick",
@selector (pickImage)) ;
self.title = @"Edge Detection";

@end
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Figure 7-9  Using two threads allows a “Please Wait” Heads Up Display (HUD) to block user
input until the image processing finishes.

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 7 and open the project for this recipe.

One More Thing: Going Grayscale

As Recipe 7-12 suggests, you can easily create a grayscale version of any image, not just
black and white masks. Listing 7-3 provides a general utility method that produces an
image drawn into a grayscale color space. Unlike the createMaskImage () function you
just saw, this method does not need to match the UIImage coordinate system with the
Quartz one, so it does not flip the context. It simply draws the image into the context
and returns the grayscale version.

Combine this function with the screenshot renderInContext: functionality described
earlier in this chapter and you can create an “inactive” backsplash that copies the current
GUI. Use this to provide a visual context that moves a user’s focus onto an ongoing oper-
ation such as a file download. This provides a creative alternative to the normal screen-
darkening overlay.

Listing 7-3  Returning the Grayscale Version of an Image

+ (UIImage *) grayscaleImage: (UIImage *) image
{
CGSize size = image.size;
CGRect rect = CGRectMake (0.0f, 0.0f, image.size.width,
image.size.height) ;
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// Create a mono/gray color space

CGColorSpaceRef colorSpace = CGColorSpaceCreateDeviceGray () ;

CGContextRef context = CGBitmapContextCreate(nil, size.width,
size.height, 8, 0, colorSpace, kCGImageAlphaNone) ;

CGColorSpaceRelease (colorSpace) ;

// Draw the image into the grayscale context
CGContextDrawImage (context, rect, [image CGImagel);
CGImageRef grayscale = CGBitmapContextCreateImage (context) ;
CGContextRelease (context) ;

// Recover the image

UIImage *img = [UIImage imageWithCGImage:grayscale];
CFRelease (grayscale) ;

return img;

Summary

This chapter introduced many ways to handle images, including picking, reading, modify-
ing, and saving. You saw recipes that showed you how to use the iPhone’s built-in editor
selection process and how to snap images with the camera.You also read about adding
images to the UIScrollview class and how to send pictures as e-mail attachments. Before
moving on from this chapter, here are some thoughts about the recipes you saw here:

= The built-in image picker is a memory hog. Develop your code around that basic
fact of life.

= Always provide user feedback when working with long processing delays. Most
image manipulation is slow. The simulator always outperforms the iPhone so test
your applications on the device as well as the simulator and provide a mechanism
like the HUD display used in this chapter that lets users know that ongoing opera-
tions may take some time.

» Sending image e-mail attachments from in-program is a great new 3.0 feature.
Make sure that you check that e-mail is available on your device before attempting
to use the controller and be aware that sending images can be very, very slow.

» Paged scrollers offer a handy GUI foundation. Use them for showing multiple
images or for presenting multiscreened, scrollable interfaces.

» Thumbnails use far less memory than loading all images at once. Consider precom-
puting icon versions of your pictures in addition to using the thumbnail-sizing rou-
tines shown in this chapter.
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Gestures and Touches

he touch represents the heart of iPhone interaction; it provides the most important

way that users communicate their intent to an application. Touches are not limited

to button presses and keyboard interaction.You can design and build applications
that work directly with users’ taps and other gestures. This chapter introduces direct
manipulation interfaces that go far beyond prebuilt controls.You see how to create views
that users can drag around the screen.You also discover how to distinguish and interpret
gestures and how to work with the iPhone’s built-in multitouch sensors. By the time you
finish reading this chapter, you’ll have read about many different ways you can implement
gesture control in your own applications.

Touches

Cocoa Touch implements direct manipulation in the simplest way possible. It sends touch
events to the view youre working with. As an iPhone developer, you tell the view how to
respond to each touch.

Touches convey information: where the touch took place (both the current and previ-
ous location), what phase of the touch was used (essentially mouse down, mouse moved,
mouse up in the desktop application world, corresponding to finger or touch down,
moved, and up in the direct manipulation world), a tap count (for example, single-
tap/double-tap), and when the touch took place (through a time stamp). Touches and
their information are stored in UITouch objects. Each object represents a single touch
event. Your applications receive these in the view class, which is where you need to
process and respond to them.

This may seem counterintuitive. You probably expect to separate the way an interface
looks (its view) from the way it responds to touches (its controller). In the iPhone world,
direct touch interaction follows a fairly primitive design pattern, offering little or no
Model-View-Controller design orthogonality. The rule for this is that you program in the
UIView class and not in the UIViewController class. This is an important point. Trying to
implement low-level gesture control in the wrong class has tripped up many new iPhone
developers.
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When working with low-level touch interaction, gesture interpretation and visual dis-
play become tightly intertwined. There are benefits to this organization.View controllers
can own multiple views, all of which can use touches difterently. If the view controller
handled all touches directly, its response routines would have to choose between responses
appropriate for each view. The code would quickly become complicated. Keeping that
programming at the view level simplifies each implementation. As a second benefit, pro-
gramming at the view level makes it possible for you to create custom user interface
objects that are completely self-contained.

In the following sections and recipes, you discover how touches work, how you can
incorporate them into your apps, and how you connect what a user sees with how that
user interacts with the screen.

Phases

Touches have life cycles. Each touch can pass through any of five phases that represent the
progress of the touch within an interface. These phases are as follows:

» UITouchPhaseBegan—Starts when users touch the screen.
» UITouchPhaseMoved—Means a touch has moved on the screen.

= UITouchPhaseStationary—Indicates that a touch remains on the screen
surface but that there has not been any movement since the previous event.

» UITouchPhaseEnded—Gets triggered when the touch is pulled away from the
screen.

= UITouchPhaseCancelled—Occurs when the iPhone OS system stops track-
ing a particular touch. This usually occurs due to a system interruption, such as
when the application is no longer active or the view is removed from the window.

Taken as a whole, these five phases form the interaction language for a touch event. They
describe all the possible ways that a touch can progress or fail to progress within an inter-
face and provide the basis for control for that interface. It’s up to you as the developer to
interpret those phases and provide reactions to them.You do that by implementing a
series of view methods.

Touches and View Methods

All members and children of the UIResponder class, including UIview, respond to
touches. Each class decides whether and how to respond. When choosing to do so, they
implement customized behavior when a user touches one or more fingers down in a
view or window.

Predefined callback methods handle the start, movement, and release of touches from
the screen. Corresponding to the phases you've already seen, the methods involved are as
follows. Notice that UITouchPhaseStationary does not generate a callback.



Touches

= touchesBegan:withEvent:
as the user starts touching the screen.

Gets called at the starting phase of the event,

= touchesMoved:withEvent:
time.

Handles the movement of the fingers over

= touchesEnded:withEvent:
ger or fingers are released. It provides an opportune time to clean up any work that
was handled during the movement sequence.

Concludes the touch process, where the fin-

= touchesCancelled:WithEvent :—Called when Cocoa Touch must

respond to a system interruption of the ongoing touch event.

Each of these is a UIResponder method, typically implemented in a UTview subclass. All
views inherit basic nonfunctional versions of the methods. When you want to add touch
behavior to your application, you override these methods and add a custom version that
provides the responses your application needs.

The recipes in this chapter implement some but not all of these methods. For real-
world deployment, you may want to add a touches cancelled event to handle the case of
incoming phone calls, which cancels an ongoing touch sequence. Apple recommends
overriding all four methods in UIview subclasses as a best practice.

Note
Views have a mode called exclusive touch that prevents touches from being delivered to

other views. When enabled, this property blocks other views from receiving touch events.
The primary view handles all touch events exclusively.

Touching Views

When dealing with many onscreen views, the iPhone automatically decides which view
the user touched and passes any touch events to the proper view for you.This helps you
write concrete direct manipulation interfaces where users touch, drag, and interact with
onscreen objects.

Just because a touch is passed to a view doesn’t mean that a view has to respond. Each
view can choose whether to handle a touch or to let that touch fall through to views
beneath it. As you see in the recipes that follow, you can use clever response strategies to
decide when your view should respond, particularly when youre using irregular art with
partial transparency.

Multitouch

The iPhone supports both single and multitouch interfaces. For single touch GUIs, you
handle just one touch at any time. This relieves you of any responsibility of trying to
determine which touch you were tracking. The one touch you receive is the only one you
need to work with.You look at its data, respond to it, and wait for the next event.
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When working with multitouch, that is, when you respond to multiple onscreen
touches at once, you receive an entire set of touches. It is up to you to order and respond
to that set.You can track each touch separately and see how it changes over time, provid-
ing a richer set of possible user interaction. Recipes for both single touch and multitouch
interaction follow in this chapter.

Recipe: Adding a Simple Direct Manipulation
Interface

The design focus moves from the UIViewController to the UIview when you work with
direct manipulation. The view, or more precisely the UIResponder, forms the heart of
direct manipulation development. Create touch-based interfaces by customizing methods
that derive from the UIResponder class.

Recipe 8-1 centers on touches in action. This example creates a child of UIImageview
called bragview and adds touch responsiveness to the class. Being an image view, it’s
important to enable user interaction, that is, set setUserInteractionEnabled to YES.This
property affects all the view’s children as well as the view itself.

The recipe works by updating a view’s center to match the movement of an onscreen
touch. When a user first touches any Dragview, the object stores the start location as an
offset from the view’s origin. As the user drags, the view moves along with the finger—
always maintaining the same origin offset so that the movement feels natural. Movement
occurs by updating the object’s center. Recipe 8-1 calculates x- and y-offsets and adjusts
the view center by those offsets after each touch movement.

Upon being touched, the view pops to the front. That’s due to a call in the
touchesMoved:withEvent: method.The code tells the superview that owns the
DragView to bring that view to the front. This allows the active element to always appear
foremost in the interface.

This recipe does not implement touches-ended or touches-cancelled methods. Its
interests lie only in the movement of onscreen objects. When the user stops interacting
with the screen, the class has no further work to do.

Recipe 8-1 Creating a Draggable View

@interface DragView : UIImageView
{
CGPoint startLocation;

}
@end

@implementation DragView
- (id) initWithImage: (UIImage *) anImage
{
if (self = [super initWithImage:anImage])
self.userInteractionEnabled = YES;
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return self;

}
- (void) touchesBegan: (NSSet*)touches withEvent: (UIEvent*)event
{
// Calculate and store offset, and pop view into front if needed
CGPoint pt = [[touches anyObject] locationInView:self];
startLocation = pt;
[[self superview] bringSubviewToFront:self];
}
- (void) touchesMoved: (NSSet*)touches withEvent: (UIEvent*)event
{
// Calculate offset
CGPoint pt = [[touches anyObject] locationInView:self];
float dx = pt.x - startLocation.x;
float dy = pt.y - startLocation.y;
CGPoint newcenter = CGPointMake(self.center.x + dx,
self.center.y + dy);
// Set new location
self.center = newcenter;
}
@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Constraining Movement

The problem with the simple approach of Recipe 8-1 is that it’s entirely possible to drag a
view offscreen to the point where the user cannot see or easily recover it. That recipe uses
completely unconstrained movement. There is no check to test whether the object
remains in view and is touchable. Recipe 8-2 fixes this problem by constraining a view’s
movement to within its parent.

It achieves this by limiting movement in each direction, splitting its checks into sepa-
rate x and y constraints. This two-check approach allows the view to continue to move
even when one direction has passed its maximum. If the view has hit the rightmost edge
of its parent, for example, it can still move up and down.

Figure 8-1 shows this interface. The flowers are constrained into the black rectangle in
the center of the interface and cannot be dragged off-view. The code is general and can
adapt to parent bounds and child views of any size.
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Figure 8-1 The movement of these flowers is
bounded into the black rectangle.

Recipe 8-2 Bounded Movement

- (void) touchesMoved: (NSSet*)touches withEvent: (UIEvent*)event

{

// Calculate offset

CGPoint pt = [[touches anyObject] locationInView:self];

float dx = pt.x - startLocation.x;

float dy = pt.y - startLocation.y;

CGPoint newcenter = CGPointMake(self.center.x + dx,
self.center.y + dy);

// Constrain movement into parent bounds

float halfx = CGRectGetMidX(self.bounds);

newcenter.x = MAX(halfx, newcenter.x);

newcenter.x = MIN(self.superview.bounds.size.width - halfx,
newcenter.x);

float halfy = CGRectGetMidY(self.bounds);

newcenter.y = MAX(halfy, newcenter.y);

newcenter.y = MIN(self.superview.bounds.size.height - halfy,
newcenter.y);
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// Set new location
self.center = newcenter;

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’'ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Testing Touches

Most onscreen view elements for direct manipulation interfaces are not rectangular. This
complicates touch detection because parts of the actual view rectangle may not corre-
spond to actual touch points. Figure 8-2 shows the problem in action. The screenshot on
the right shows the interface with its touch-based subviews. The shot on the left shows
the actual view bounds for each subview. The light gray areas around each onscreen circle
fall within the bounds, but touches to those areas should not “hit” the view in question.

.all Carrier = 11:54 AM .ull Carrier = 11:57 AM

Figure 8-2 The application should ignore touches to the gray areas that sur-
round each circle (left). The actual interface (right) uses zero alpha values to
hide the parts of the view that are not used.

The iPhone senses user taps throughout the entire view frame. This includes the undrawn
area such as the corners of the frame outside the actual circles of Figure 8-2 just as much
as the primary presentation. That means that unless you add some sort of hit test, users
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may attempt to tap through to a view that’s “obscured” by the clear portion of the UIview
frame.
Visualize your actual view bounds by setting a view’s background color, for example:

dragger.backgroundColor = [UIColor lightGrayColor];

This adds the backsplashes shown in Figure 8-2 (left) without affecting the actual
onscreen art. In this case, the art consists of a centered circle with a transparent back-
ground. Unless you add some sort of test, all taps to any portion of this frame are captured
by the view in question. Enabling background colors offers a convenient debugging aid to
visualize the true extent of each view; don’t forget to comment out the background color
assignment in production code.

Recipe 8-3 adds a simple hit test to the views, determining whether touches fall
within the circle. This test overrides the standard UIView pointInside:withEvent:
method. This method returns either YEs (the point falls inside the view) or No (it does
not). The test here uses basic geometry, checking whether the touch lies within the circle’s
radius.You can provide any test that works with your onscreen views. As you see in
Recipe 8-4, that test can be expanded for much finer control.

Recipe 8-3 Providing a Circular Hit Test

- (BOOL) pointInside:(CGPoint)point withEvent: (UIEvent *)event

{
CGPoint pt;
float HALFSIDE = SIDELENGTH / 2.0f;
// normalize with centered origin
pt.x = (point.x - HALFSIDE) / HALFSIDE;
pt.y = (point.y - HALFSIDE) / HALFSIDE;
// x"2 + y*2 = radius
float xsquared = pt.x * pt.x;
float ysquared = pt.y * pt.y;
// 1f the radius <= 1, the point is within the clipped circle
if ((xsquared + ysquared) <= 1.0) return YES;
return NO;
}

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.
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Recipe: Testing Against a Bitmap

Unfortunately, most views don’t fall into the simple geometries that make the hit test from
Recipe 8-3 so straightforward. The flowers shown in Figure 8-1, for example, offer irregu-
lar boundaries and varied transparencies. For complicated art, it helps to test touches
against a bitmap. Bitmaps provide byte-by-byte information about the contents of an
image-based view, allowing you to test whether a touch hits a solid portion of the image
or should pass through to any views below.

Recipe 8-4 extracts an image bitmap from a UIImageView. It assumes that the image
used provides a pixel-by-pixel representation of the view in question. When you distort
that view (normally by resizing a frame or applying a transform), update the math accord-
ingly. Keeping the art at a 1:1 proportion to the actual view pixels simplifies lookup.You
can recover the pixel in question, test its alpha level, and determine whether the touch has
hit a solid portion of the view.

This example uses a cutoff of 85.That corresponds to a minimum alpha level of 33%
(that is, 85 / 255).The pointInside: method considers any pixel with an alpha level
below 33% to be transparent. This is arbitrary. Use any level (or other test for that matter)
that works with the demands of your actual GUI.

Recipe 8-4 Testing Touches Against Bitmap Alpha Levels

// Return the offset for the alpha pixel at (x,y) for RGBA

// 4A-bytes-per-pixel bitmap data

NSUInteger alphaOffset(NSUInteger x, NSUInteger y, NSUInteger w)
{return y * w * 4 + x * 4;}

// Return the bitmap from a provided image
unsigned char *getBitmapFromImage (UIImage *image)

{

CGColorSpaceRef colorSpace = CGColorSpaceCreateDeviceRGB();
if (colorSpace == NULL)
{
fprintf(stderr, "Error allocating color space\n");
return NULL;

CGSize size = image.size;
void *bitmapData = malloc(size.width * size.height * 4);
if (bitmapData == NULL)
{
fprintf (stderr, "Error: Memory not allocated!");
CGColorSpaceRelease(colorSpace);
return NULL;
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CGContextRef context = CGBitmapContextCreate (bitmapData,
size.width, size.height, 8, size.width * 4, colorSpace,
kCGImageAlphaPremultipliedFirst);

CGColorSpaceRelease(colorSpace );

if (context == NULL)

{
fprintf (stderr, "Error: Context not created!");
free (bitmapData);
return NULL;

}

CGRect rect = CGRectMake(0.0f, 0.0f, size.width, size.height);
CGContextDrawImage (context, rect, image.CGImage);

unsigned char *data = CGBitmapContextGetData(context);
CGContextRelease(context);

return data;

@interface DragView : UIImageView
{
CGPoint startLocation;
unsigned char *bytes;
}
@end

@implementation DragView
- (id) initWithImage: (UIImage *) anImage

{
if (self = [super initWithImage:anImage])
{
self.userInteractionEnabled = YES;
bytes = getBitmapFromImage(anImage);
}
return self;
}
- (void) dealloc
{
free(bytes);
[super dealloc];
}

// Does the point hit the view?
- (BOOL) pointInside:(CGPoint)point withEvent:(UIEvent *)event
{

if (!CGRectContainsPoint(self.bounds, point)) return NO;
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return (bytes[alphaOffset(point.x, point.y,
self.image.size.width)] > 85);

- (void) touchesBegan: (NSSet*)touches withEvent:(UIEvent*)event

// Calculate and store offset, and pop view into front if needed
CGPoint pt = [[touches anyObject] locationInView:self];
startLocation = pt;

[[self superview] bringSubviewToFront:self];

- (void) touchesMoved: (NSSet*)touches withEvent: (UIEvent*)event
{
// Calculate offset
CGPoint pt = [[touches anyObject] locationInView:self];
float dx = pt.x - startLocation.x;
float dy = pt.y - startLocation.y;
CGPoint newcenter = CGPointMake(self.center.x + dx,
self.center.y + dy);

// Bound movement into parent bounds

float halfx = CGRectGetMidX(self.bounds);

newcenter.x = MAX(halfx, newcenter.x);

newcenter.x = MIN(self.superview.bounds.size.width - halfx, newcenter.x);

float halfy = CGRectGetMidY(self.bounds);
newcenter.y = MAX(halfy, newcenter.y);
newcenter.y = MIN(self.superview.bounds.size.height - halfy, newcenter.y);

// Set new location
self.center = newcenter;

}
@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Adding Persistence to Direct
Manipulation Interfaces

Persistence represents a key iPhone design touch point. After users leave a program, Apple
strongly recommends that they return to a state that matches as closely to where they left
off as possible. Adding persistence to a direct manipulation interface, in the simplest
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approach, involves storing a representation of the onscreen data when an application
terminates and restoring that state on startup.

Storing State

Every view knows its position because you can query its frame or center. This enables you
to easily recover and store positions for each onscreen flower. The flower type (green,
pink, or blue) is another matter. For each view to report its current flower, the Dragview
class must store that value, too. Adding a string instance variable enables the view to return
the image name used. Extending the bragview interface lets you do that.

@interface DragView : UIImageView
{
CGPoint startLocation;
NSString *whichFlower;

}

@property (retain) NSString *whichFlower;
@end

Adding this extra property lets the view controller that owns the flowers store both a list
of colors and a list of locations to its defaults file. Here, a simple loop collects both values
from each draggable view and then stores them.

- (void) updateDefaults

{
NSMutableArray *colors = [[NSMutableArray alloc] init];
NSMutableArray *locs = [[NSMutableArray alloc] init];
for (DragView *dv in [[self.view viewWithTag:201] subviews])
{
[colors addObject:dv.whichFlower];
[locs addObject:NSStringFromCGRect (dv.frame)];
}
[ [NSUserDefaults standardUserDefaults] setObject:colors
forKey:@"colors"];
[ [NSUserDefaults standardUserDefaults] setObject:locs
forKey:@"locs"];
[ [NSUserDefaults standardUserDefaults] synchronize];
[colors release];
[locs release];
}

Defaults, as you can see, work like a dictionary. Just assign an object to a key and the
iPhone updates the preferences file associated with your application ID. Defaults are stored
in Library/Preferences inside your application’s sandbox. Calling the synchronize function
updates those defaults immediately instead of waiting for the program to terminate.
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The NsstringFromCGRect () function provides a tight way to store frame information
as a string. To recover the rectangle, issue CGRectFromString(). Each call takes one argu-
ment: a CGRect in the first case, an NSString object in the second. The UIKit framework
provides functions that translate points and sizes as well as rectangles to and from strings.

This updatebDefaults method, which saves the current state to disk, should be called
in the application delegate’s applicationWillTerminate: method, just before the pro-
gram ends. The defaults are stored to reflect the final application state.

- (void) applicationWillTerminate: (UIApplication *) application

{
[self.tbvc updateDefaults]; // update the defaults on quit

Recovering State

To bring views back to life, re-create them in either the loadview or viewDidLoad meth-
ods of your view controller. (Persistence awareness can also reside in the view controller’s
init method if you’re not working with actual views.) Your methods should find any pre-
vious state information and update the interface to match that state.

When querying user defaults, Recipe 8-5 checks whether state data is unavailable (for
example, the value returned is nil). When state data goes missing, the method creates ran-
dom flowers at random points.

Note

When working with large data sources, you may want to initialize and populate your saved
object array in the UIViewController’s init method, and then draw them in loadview or
viewDidLoad. Where possible, use threading when working with many objects to avoid too
much processing on the main thread. This can make the program laggy or unresponsive by
blocking GUI updates.

Recipe 8-5 Checking for Previous State

- (void) loadFlowersInView: (UIView *) backdrop
{
// Attempt to read in previous colors and locations
NSMutableArray *colors = [[NSUserDefaults standardUserDefaults]
objectForKey:@"colors"];
NSMutableArray *locs = [[NSUserDefaults standardUserDefaults]
objectForKey:@"locs"];

// Add the flowers to random points on the screen
for (int i = 0; i < MAXFLOWERS; i++)
{

NSString *whichFlower = [[NSArray
arrayWithObjects:@"blueFlower.png", @"pinkFlower.png",
@"orangeFlower.png", nil] objectAtIndex:(random() % 3)];
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if (colors && ([colors count] == MAXFLOWERS)) whichFlower =
[colors objectAtIndex:i];

DragView *dragger = [[DragView alloc] initWithImage:[UIImage
imageNamed:whichFlower]];

dragger.center = randomPoint();

dragger.userInteractionEnabled = YES;

dragger.whichFlower = whichFlower;

if (locs && ([locs count] == MAXFLOWERS)) dragger.frame =
CGRectFromString([locs objectAtIndex:i]);

[backdrop addSubview:dragger];
[dragger release];

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Persistence Through Archiving

Recipe 8-5 created persistence via the user defaults system. It stored descriptions of the
onscreen views and built those views from the recovered description. Recipe 8-6 takes
things to the next level. Instead of storing descriptions, it archives the objects themselves,
or at least as much of the objects as is necessary to reconstruct them at launch time.

Two classes—NSKeyedArchiver and NSKeyedUnarchiver—provide an elegant solution
for archiving objects into a file for later retrieval. These archive classes provide an object
persistence API that allows you to restore objects between successive application sessions.
The example you're about to see uses the simplest archiving approach. It stores a single
root object, which in this case is an array of Dragviews, that is, the flowers.

To create an archivable object class, you must define a pair of methods. The first,
encodeWithCoder:, stores any information needed to rebuild the object. In this case, that
is the view’s frame and its flower. Both are stored as NSString objects. The second
method, initWithCoder:, recovers that information and initializes objects using saved
information. Here are the two methods defined for the bragview class, allowing objects of
this class to be encoded and retrieved from an archive.

- (void) encodeWithCoder: (NSCoder *)coder
{
[coder encodeCGRect:self.frame forKey:@"viewFrame"];
[coder encodeObject:self.whichFlower forKey:@"flowerType"];
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- (id) initWithCoder: (NSCoder *)coder

{
[super initWithFrame:CGRectZero];
self.frame = [coder decodeCGRectForKey:@"viewFrame"];
self.whichFlower = [coder decodeObjectForKey:@"flowerType"];
self.image = [UIImage imageNamed:self.whichFlower];
self.userInteractionEnabled = YES;
return self;

}

Each element is stored with a key name. Keys let you recover stored data in any order.
Special UIKit extensions to the NSCoder class add storage methods for points, sizes, rec-
tangles, affine transforms, and edge insets. This example takes advantage of the rectangle
method for encoding and decoding the view frame.

Data is saved to an actual file.You supply an archive path to that file. This example
stores its data in the Documents folder in the sandbox in a file called flowers.archive.

#define DATAPATH [NSString stringWithFormat:
@"%@/Documents/flowers.archive"”, NSHomeDirectory()]

So for this direct manipulation interface, how do you actually perform the archiving and
unarchiving? Recipe 8-6 shows the exact calls, which in this case are implemented in the
view controller. Here are two custom methods that collect the DragViews and archive
them to the file, and that retrieve the views from the file.

Notice that the latter method returns a Boolean value. This indicates whether the
views could be read in correctly. On fail, a fallback method generates a new set of sub-
views. It’s assumed that either the data was corrupted or that this is the first time running
the application. Either way, the application generates new data to populate the backdrop.

Recipe 8-6 Archiving Interfaces

- (void) archiveInterface

{
NSArray *flowers = [[self.view viewWithTag:201] subviews];
[NSKeyedArchiver archiveRootObject:flowers toFile:DATAPATH];
}
- (BOOL) unarchiveInterfacelInView: (UIView *) backdrop
{

NSArray *flowers = [NSKeyedUnarchiver
unarchiveObjectWithFile:DATAPATH];
if (!flowers) return NO;

for (UIView *aView in flowers)
[backdrop addSubview:aView];
return YES;
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Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Adding Undo Support

Undo support provides another important component of direct manipulation interfaces.
For a simple GUI, this involves little more than returning each object to a previous
onscreen position. Cocoa Touch offers the NSUndoManager class to provide a way to
reverse user actions.

Creating an Undo Manager

Define your undo manager in the most central location possible. You want to use just one
instance of this class for each primary view controller, sharing it with any child views in
your interface. The viewDidLoad or loadview methods provide a good place to allocate a
new undo manager.

// Initialize the undo manager for this application
self.undoManager = [[NSUndoManager alloc] init];
[self.undoManager setLevelsOfUndo:999];
[self.undoManager release];

The manager can store an arbitrary number of undo actions.You specify how deep that
stack goes. Each action can be complex, involving groups of undo activities, or the action
can be simple as in the example shown here. These undos do one thing: move a view to a
previous location.

Child-View Undo Support

All children of the uIResponder class can find the nearest undo manager in the responder
chain. This means that if you add bragview instances to a view whose view controller has
an undo manager, each Dragview automatically knows about that manager through its
undoManager property. This is enormously convenient as you can add undo support in
your main view controller, and all your child views basically pick up that support for free.

Working with Navigation Bars

‘When working with the navigation bar in any way, child views should store a pointer to
their view controller. A pointer to their view controller lets the children coordinate with
any navigation controller bar button items.You only want an Undo button to appear
when items are available on the undo stack.

@interface DragView : UIImageView

{
CGPoint startLocation;
NSString *whichFlower;
UIViewController *viewController;
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}

@property (retain) NSString *whichFlower;

@property (assign) UIViewController *viewController;
@end

Upon adding an undo item to the manager, you may want to display an Undo button as
this example does. The Undo button calls the manager’s undo method, which in turn uses
the target, action, and object set stored at the top of the undo stack to perform the actual
reversion. When the undo manager has no more undos to perform, the Undo button

should hide.

- (void) checkUndoAndUpdateNavBar

{
while ([self.undoManager isUndoing]);
// Don’t show the undo button if the undo stack is empty
if (!self.undoManager.canUndo)
self.navigationItem.leftBarButtonItem = nil;
else
self.navigationItem.leftBarButtonItem =
BARBUTTON(@"Undo", @€selector(undo));
}
- (void) undo
{
[self.undoManager undo];
}

Notice that this method waits for the undo manager to finish any ongoing undo actions
before proceeding to update the navigation bar.

Registering Undos

Here is the simplest call to register an undo. It stores the object location at the start of a
touch sequence, specifying that upon undo, the object should reset its position to this start
location. This call is made from the child view, and not from the view controller. This
approach tells the undo manager how to reset an object to its previous attributes.

[self.undoManager registerUndoWithTarget:self
selector:@selector(resetPosition)
object:NSStringFromCGPoint (self.center)];

An alternative, preferred approach uses an invocation instead of a target and selector. The
invocation records a message for reverting state, that is, it stores a way that it can jump
back to the previous state. Perform this preparation before you change the object’ state.

[[self.undoManager prepareWithInvocationTarget:self] setPosition:self.center];

With invocations, you can use a method with any number of arguments and argument
types. This invocation simplifies adding redo support, which is why it is preferred.
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There are several ways to approach the undo registration process in a direct manipula-
tion interface. Placing a call to a setter/unsetter method from the touchesBegan:
=withEvent: provides the easiest solution, as shown in Recipe 8-7.

Be aware that if users touch an object and release without moving it, undo results may
be imperceptible. You may want to add a check into the touches ended routine to make
sure that an object was actually moved. If not, remove the last item from the undo stack by
issuing undo.

Recipe 8-7 lists the actual undo code. The setPosition: method provides both a set
and reset solution for the undo manager. Upon registration, it stores the position of a view
into the undo stack. Upon undo, it animates the view back to that position, providing a
visual connection between the new value and the old. Although redo support is not used
in this recipe (see Recipe 8-8), the setPosition: method is redo compliant. When called
by the undo manager, the repeat preparewithInvocationTarget: call gets added to the
redo stack.

The delayed selector in this method, checkUndoAndUpdateNavBar :, triggers after the
animation has completed. This allows the setPosition: method to finish before any
checks are made against the undo stack.

The stack will not decrease its count until after the registered method returns. If you
call the method directly, the Undo button on the navigation controller will not dismiss
even though there are no further undos to perform.The while loop that checks for
isUndoing would never clear and setPosition: would never return.

Recipe 8-7 Creating a Custom Undo Routine

- (void) setPosition: (CGPoint) pos

{
[[self.undoManager prepareWithInvocationTarget:self]
setPosition:self.center];

[self.viewController
performSelector:@selector (checkUndoAndUpdateNavBar)
withObject:nil afterDelay:0.2f];

[UIView beginAnimations:@"" context:nil];

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut];
[UIView setAnimationDuration:0.1f];

self.center = pos; // animate

[UIView commitAnimations];

- (void) touchesBegan: (NSSet*)touches withEvent: (UIEvent*)event

{

[self setPosition:self.center];
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// Calculate and store offset, and pop view into front if needed
CGPoint pt = [[touches anyObject] locationInView:self];
startLocation = pt;

[[self superview] bringSubviewToFront:self];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Adding Shake-Controlled Undo Support

New to the 3.0 SDK, shake-to-undo support offers a whimsical feature that automatically
produces an undo/redo menu. When users shake the phone, this menu appears, connected
to the current undo manager. The menu allows users to undo the previous action or redo
an action that has been undone. Figure 8-3 shows the shake-to-undo menu.

Figure 8-3 Shake-to-undo provides an undo/redo
menu for users.

Shake-to-edit is a clever concept, but it’s not entirely practical in application. Training
your users to shake the phone rather than press an Undo button presents a real-world
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hurdle. Even trained, it’s a pain to keep shaking the phone to process a series of undo
events. If you plan to include this feature in your applications, consider using it to enhance
and extend an existing undo setup rather than replace it.

Adding support for shake-to-edit takes just a few steps. Here is an item-by-item list of
the changes you make to offer this feature in your application.

Add an Action Name for Undo and Redo

Action names provide the word or words that appear after “Undo” and “Redo,” as shown
in Figure 8-3. Here, the action name is set to “movement.” The undo menu option is
therefore Undo Movement. Extend the setPosition: method to provide this name by
adding this line right after you prepare the invocation target.

if (![self.undoManager isUndoing])
[self.undoManager setActionName:@"movement"];

Provide Shake-To-Edit Support

Locate the applicationDidFinishLaunching: method of your application delegate. In
that method add this line. Setting the applicationSupportsshakeToEdit property
explicitly adds shake-to-edit support to the application as a whole.

application.applicationSupportsShakeToEdit = YES;

Force First Responder

For a view controller to handle undo/redo, it must always be first responder. Since each
application may be handling several undo manager clients, the application must match
each undo manager to a particular view controller. Only the first responder receives
undo/redo calls.

As the undo manager typically lives inside a UIViewController instance, make sure to
add the routines from Recipe 8-8 to your view controller. These ensure that it becomes
first responder whenever it appears onscreen and that its undo manager is used.

Recipe 8-8 Providing Shake-to-Edit Support by Becoming First Responder

- (BOOL)canBecomeFirstResponder {
return YES;

(void)viewDidAppear: (BOOL)animated {
[super viewDidAppear:animated];
[self becomeFirstResponder];



Recipe: Drawing Onscreen

- (void)viewWillDisappear: (BOOL)animated {
[super viewWillDisappear:animated];
[self resignFirstResponder];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Drawing Onscreen

As with gestures, the UIView hosts the realm of direct onscreen drawing. Its drawRect :
method offers a low-level way to draw content directly, letting you create and display arbi-
trary elements using Quartz 2D calls. These two elements can join together to build con-
crete, manipulatable interfaces.

Recipe 8-9 combines gestures with drawRect to create touch-based painting. As a user
touches the screen, the Touchview class collects a series of points. At each touch move-
ment, the touchesMoved:withEvent: method calls setNeedsDisplay. This, in turn, trig-
gers a call to drawRect :, where the view draws a series of line segments from those points
to create a visual onscreen path. Figure 8-4 shows the interface with a user-created path.

il Carrier 12:01 PM

Simple Draw

Figure 8-4 A simple painting tool for the iPhone
requires little more than collecting touches along a
path and painting that path with Quartz 2D calls.
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Recipe 8-9 Touch-Based Painting in a UIView

@interface TouchView : UIView

{
NSMutableArray *points;
}
@property (retain) NSMutableArray *points;
@end

@implementation TouchView
@synthesize points;

- (BOOL) isMultipleTouchEnabled {return NO;}

// Start new array
- (void) touchesBegan: (NSSet *) touches withEvent:(UIEvent *) event

{
self.points = [NSMutableArray array];
CGPoint pt = [[touches anyObject] locationInView:self];
[self.points addObject:[NSValue valueWithCGPoint:pt]];
}

// Add each point to array
- (void) touchesMoved: (NSSet *) touches withEvent:(UIEvent *) event

{
CGPoint pt = [[touches anyObject] locationInView:self];
[self.points addObject:[NSValue valueWithCGPoint:pt]];
[self setNeedsDisplay];

}

// Draw all points
- (void) drawRect: (CGRect) rect
{
if (!self.points) return;
if (self.points.count < 2) return;

[[UIColor whiteColor] set];
CGContextSetLineWidth(context, 4.0f);

CGContextRef context = UIGraphicsGetCurrentContext();

for (int i = 0; i < (self.points.count - 1); i++)
{
CGPoint ptl = POINT(i);
CGPoint pt2 = POINT(i+l);
CGContextMoveToPoint (context, ptl.x, ptl.y);
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CGContextAddLineToPoint (context, pt2.x, pt2.y);
CGContextStrokePath(context);

}
@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Calculating Lines

When user input relies primarily on touches, applied geometry can help interpret those
gestures. In this recipe and the next, computational solutions filter user input to create
simpler data sets that are more application appropriate. Recipe 8-10 collects the same
touch array that was shown in Recipe 8-9. When the gesture finishes, that is, at touch-up,
this code analyzes that array and creates a minimized set of line segments to match the
freeform points.

A reduced point set accomplishes two things. First, it creates a straighter, better-looking
presentation. The right image in Figure 8-5 is much cleaner than the one on the left. Sec-
ond, it produces a set of points that are better matched to interpretation. The six-point
line segments shown in Figure 8-5 on the right are far easier to analyze than the more
than 50 points on the left.

The extra line segments are due to a slight finger squiggle at the top-right of the trian-
gle. Converting a freeform gesture into meaningful user intent can be a significantly hard
problem. Although it’s obvious to a human that the user meant to draw a triangle, compu-
tational algorithms are never perfect. When you need to interpret gestures, a certain
amount of hand waving accommodation is necessary.

Recipe 8-10 works by analyzing sets of three points at a time. For each triplet, it cen-
ters the first and third points around the origin of the second. It then takes the dot prod-
uct of the vectors to the first and third points. The dot product returns a value that is the
cosine of the angle between the two vectors. If those points are collinear, that is, the
angle between them is roughly 180 degrees (give or take), the algorithm discards the
middle point.

The cosine of 180 degrees is -1. This code discards all points where the vector cosine
falls below -0.75. Increasing the tolerance (by raising the cosine check, say to -0.6 or -0.5)
produces flatter results but may also discard intentional direction changes from users. If
your goal is to check for triangles, squares, and other simple polygons, the tolerance can be
quite robust. To produce “prettier” line drawings, use a tighter tolerance to retain user-pro-
vided detail.
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Linear Drawing Linear Drawing

Figure 8-5 Computational solutions can manage user input. Here, a line
detection algorithm reduces the number of input points by converting user
intent into a better geometric representation.

Recipe 8-10 Creating Line Segments from Freeform Gestures

// Return dot product of two vectors normalized
float dotproduct (CGPoint vl, CGPoint v2)

{
float dot = (vl.x * v2.x) + (vl.y * v2.y);
float a = ABS(sqrt(vl.x * vl.x + vl.y * vl.y));
float b = ABS(sqrt(v2.x * v2.x + v2.y * v2.y));
dot /= (a * b);
return dot;

}

// remove all intermediate points that are approximately colinear
- (void) touchesEnded: (NSSet *) touches withEvent:(UIEvent *) event
{

if (!self.points) return;

if (self.points.count < 3) return;

// Create the filtered array

NSMutableArray *newpoints = [NSMutableArray array];
[newpoints addObject:[self.points objectAtIndex:0]];
CGPoint pl = POINT(O);
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// Add only those points that are inflections
for (int 1 = 1; i < (self.points.count - 1); i++)

{
CGPoint p2 = POINT(i);
CGPoint p3 = POINT(i+l);
// Cast vectors around p2 origin
CGPoint v1 = CGPointMake(pl.x - p2.x, pl.y - p2.y);
CGPoint v2 = CGPointMake(p3.x - p2.X, p3.y - p2.y);
float dot = dotproduct(vl, v2);
// Colinear items need to be as close as possible
// to 180 degrees
if (dot < -0.75f) continue;
pl = p2;
[newpoints addObject:[self.points objectAtIndex:i]];
}

// Add final point
if ([newpoints lastObject] != [self.points lastObject])
[newpoints addObject:[self.points lastObject]];

// Report initial and final point counts
NSLog(@"%@", [NSString stringWithFormat@"$d points to %d points",
self.points.count, newpoints.count]);

// Update with the filtered points and draw
self.points = newpoints;
[self setNeedsDisplay];

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Detecting Circles

In a direct manipulation interface like the iPhone, you'd imagine that most people could
get by just pointing to items onscreen. And yet, circle detection remains one of the most
requested gestures. Developers like having people circle items onscreen with their fingers.
In the spirit of providing solutions that readers have requested, Recipe 8-11 offers a rela-
tively simple circle detector, which 1s shown in Figure 8-6.

In this implementation, detection uses a two-step test. First, there’s a convergence test.
The circle must start and end close enough together that the points are somehow related.
A fair amount of leeway is needed because when you don’t provide direct visual feedback,
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users tend to undershoot or overshoot where they began. The pixel distance used here is a
generous 60 pixels, approximately a third of the view size.

_all Carrier =

Circle Maker

Figure 8-6 The dot and the outer ellipse show
the key features of the detected circle.

The second test looks at movement around a central point. It adds up the arcs traveled,
which should equal 360 degrees in a perfect circle. This sample allows any movement that
falls within 45 degrees of that number.

Upon passing the two tests, the algorithm produces a least bounding rectangle and
centers that rectangle on the geometric mean of the points from the original gesture. This
result is assigned to the circle instance variable. It’s not a perfect detection system (you can
try to fool it when testing the sample code), but it’s robust enough to provide reasonably
good circle checks for many iPhone applications.

Recipe 8-11 Detecting Circles

// At the end of touches, determine whether a circle was drawn
- (void) touchesEnded: (NSSet *) touches withEvent:(UIEvent *) event
{

if (!self.points) return;

if (self.points.count < 3) return;

// Test 1: The start and end points must be between

// 60 pixels of each other

CGRect tcircle;

if (distance(POINT(0), POINT(self.points.count - 1)) < 60.0f)
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tcircle = [self centeredRectangle];

// Test 2: Count the distance traveled in degrees. Must fall

// within 45 degrees of 2 PI

CGPoint center = CGPointMake(CGRectGetMidX(tcircle),
CGRectGetMidY (tcircle));

float distance = ABS(acos(dotproduct(centerPoint (POINT(0), center),
centerPoint (POINT(1), center))));

for (int i = 1; i < (self.points.count - 1); i++)
distance += ABS(acos(dotproduct(centerPoint(POINT(i), center),

centerPoint (POINT(i+l), center))));
if ((ABS(distance - 2 * M PI) < (M _PI / 4.0f))) circle = tcircle;

[self setNeedsDisplay];

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Recipe: Detecting Multitouch

Enabling multitouch interaction in your UlViews lets the iPhone recover and respond to
more than one finger touch at a time. Set the UIView property multipleTouchEnabled to
YES or override isMultipleTouchEnabled for your view. When multitouch is enabled
each touch callback returns an entire set of touches. When that set’s count exceeds one,
you know you're dealing with multitouch.

In theory, the iPhone could support an arbitrary number of touches. On the iPhone,
multitouch is limited to five finger touches at a time. Even five at a time goes beyond
what most developers need. There aren’t many meaningful gestures you can make with
five fingers at once. This particularly holds true when you grasp the iPhone with one hand
and touch with the other.

Touches are not grouped. If, for example, you touch the screen with two fingers from
each hand, there’s no way to determine which touches belong to which hand. The touch
order is arbitrary. Although grouped touches retain the same finger order for the lifetime
of a single touch event (down, move, up), the order may change the next time your user
touches the screen. When you need to distinguish touches from each other, build a touch
dictionary indexed by the touch objects.

Perhaps it’s a comfort to know that if you need to, the extra finger support has been
built in. Unfortunately, when you are using three or more touches at a time, the screen has
a pronounced tendency to lose track of one or more of those fingers. It’s hard to program-
matically track smooth gestures when you go beyond two finger touches.

Recipe 8-12 adds multitouch to a UIView (via the isMultipleToucheEnabled
method) and draws lines between each touch location onscreen. When you limit your
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input to two touches, it produces a reasonably steady response, maintaining a line between
those two fingers. Add a third touch to the screen and the lines start to flicker. That’s
because the iPhone does not steadily detect all the touches.

Unfortunately, multitouch detection is not nearly as stable and dependable as single
touch interaction.You see that in this recipe and see an even more pronounced example
in Recipe 8-13. While multitouch is available and, admittedly, an exciting technology, its
limits mean you should use it cautiously and with heavy testing before deployment to
real-world applications.

Recipe 8-12 Adding Basic Multitouch

@implementation TouchView
@synthesize points;

- (BOOL) isMultipleTouchEnabled {return YES;}

- (void) touchesBegan: (NSSet *) touches withEvent: (UIEvent *) event

{
self.points = [touches allObjects];
[self setNeedsDisplay];

}

- (void) touchesMoved: (NSSet *) touches withEvent: (UIEvent *) event

{
self.points = [touches allObjects];
[self setNeedsDisplay];

}

- (void) drawRect: (CGRect) rect

{

if (!self.points) return;
if (self.points.count < 2) return;

CGContextRef context = UIGraphicsGetCurrentContext();
CGContextSetLineWidth(context, 4.0f);
[[UIColor redColor] set];

// Draw lines between each point
CGPoint ptl = POINT(0);
CGContextMoveToPoint (context, ptl.x, ptl.y);

for (int i = 1; i < self.points.count; i++)

{
ptl = POINT(i % self.points.count);
CGPoint pt2 = POINT((i + 1) % self.points.count);
CGContextAddLineToPoint (context, pt2.x, pt2.y);
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CGContextStrokePath(context);

}
@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

Note
Apple provides many Core Graphics/Quartz 2D resources on its developer Web site.

Although many of these forums, mailing lists, and source code samples are not iPhone spe-
cific, they offer an invaluable resource for expanding your iPhone Core Graphics knowledge.

Recipe: Gesture Distinction

Standard Apple iPhone applications support a variety of gestures that have become a basic
language for touch interaction. Users can tap, double-tap, swipe, and drag the screen, and
Apple applications interpret those gestures accordingly. Unfortunately, Apple does not
offer a public API that performs the heavy lifting. You need to interpret your own ges-
tures. Recipe 8-13 offers a gesture detection system that waits for user input and then
evaluates that input.

Distinguishing gestures is not trivial, particularly when you add multitouch into the
equation. As Recipe 8-12 demonstrated, iPhone touch sensors are less reliable in multi-
touch mode. A two-touch drag, for example, might flip back and forth between detecting
two fingers and one.

The solution in Recipe 8-13 for working with this inconsistency is twofold. First, the
code tries to find the most immediate solution for matching input to a known gesture as
quickly as possible. When matched, it sets a “finished” flag so the first gesture matched
wins. Second, this code may invalidate a match should user input continue beyond a rea-
sonable limit. For example, taps are short; a tap should not involve 20 or 30 UlTouch
instances. Here are the gestures that Recipe 8-13 handles, and how it interprets them:

= Swipes—Swipes are short, single-touch gestures that move in a single cardinal
direction: up, down, left, or right. They cannot move too far off course from that
primary direction. The code here checks for touches that travel at least 16 pixels in
X orY, without straying more than 8 pixels in another direction.

» Pinches—To pinch or unpinch, a user must move two fingers together or apart in a
single movement. That gesture must compress or expand by at least 8 pixels to regis-
ter with this code.

» Taps—Although a tap should ideally represent a single touch to the screen, extra
callbacks may register. Recipe 8-13 uses a point limit of 3 for single-touch taps, and
10 for double-touch taps. And yes, that high tolerance is needed. Empirical testing
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set the levels used in this recipe. Users touched one or two fingers to the screen at
once, and the code counted the UlTouch instances produced.

= Double-taps—Each touch object provides a tap count, letting you check whether
users tapped once or twice. However, a double-tap is not counted until a single-tap
has already been processed. When looking to distinguish between single- and
double-taps, be aware of this behavior.

» Drags—For the purpose of this example, a drag refers to any single-touch event
that is not a tap, a double-tap, or a swipe.

Recipe 8-13 Interpreting Gestures

@interface TouchView : UIView

{
BOOL multitouch;
BOOL finished;
CGPoint startPoint;
NSUInteger touchtype;
NSUInteger pointCount;
UIViewController *vc;
}
@property (assign) UIViewController *vc;
@end

@implementation TouchView
@synthesize vc;

#define SWIPE_DRAG_MIN 16
#define DRAGLIMIT MAX 8
#define POINT TOLERANCE 16
#define MIN_PINCH 8

- (BOOL) isMultipleTouchEnabled {return YES;}

- (void) touchesBegan: (NSSet *) touches withEvent: (UIEvent *) event

{
finished = NO;
startPoint = [[touches anyObject] locationInView:self];
multitouch = (touches.count > 1);
pointCount = 1;
}
- (void) touchesMoved: (NSSet *) touches withEvent: (UIEvent *) event
{

pointCount++;
if (finished) return;
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// Handle multitouch
if (touches.count > 1)

{
// get touches
UITouch *touchl = [[touches allObjects] objectAtIndex:0];
UITouch *touch2 = [[touches allObjects] objectAtIndex:1];
// find current and previous points
CGPoint cpointl = [touchl locationInView:self];
CGPoint ppointl = [touchl previousLocationInView:self];
CGPoint cpoint2 = [touch2 locationInView:self];
CGPoint ppoint2 = [touch2 previousLocationInView:self];
// calculate distances between the points
CGFloat cdist = distance(cpointl, cpoint2);
CGFloat pdist = distance(ppointl, ppoint2);
multitouch = YES;
// The pinch has to exceed a minimum distance to trigger
if (ABS(cdist - pdist) < MIN PINCH) return;
if (cdist < pdist)
touchtype = UITouchPinchIn;
else
touchtype = UITouchPinchOut;
finished = YES;
return;
}
else
{

// Check single touch for swipe

CGPoint cpoint = [[touches anyObject] locationInView:self];
float dx = DX(cpoint, startPoint);

float dy = DY(cpoint, startPoint);

multitouch = NO;

finished = YES;

if ((dx > SWIPE DRAG MIN) && (ABS(dy) < DRAGLIMIT MAX))
touchtype = UITouchSwipeLeft;

else if ((-dx > SWIPE DRAG MIN) && (ABS(dy) < DRAGLIMIT MAX))
touchtype = UITouchSwipeRight;

else if ((dy > SWIPE DRAG MIN) && (ABS(dx) < DRAGLIMIT MAX))
touchtype = UITouchSwipeUp;

else if ((-dy > SWIPE_DRAG MIN) && (ABS(dx) < DRAGLIMIT MAX))
touchtype = UITouchSwipeDown;
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- (void) touchesEnded: (NSSet *) touches withEvent:

{
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whichItem = @"Double Tap";

else if (touchtype == UITouchDrag)
whichItem = @"Drag";

else if (touchtype == UITouchMultitouchTap)
whichItem = @"Multitouch Tap";

else if (touchtype == UITouchMultitouchDoubleTap)
whichItem = @"Multitouch Double Tap";

else if (touchtype == UITouchSwipeLeft)
whichItem = @"Swipe Left";

else if (touchtype == UITouchSwipeRight)
whichItem = @"Swipe Right";

else if (touchtype == UITouchSwipeUp)
whichItem = @"Swipe Up";

else if (touchtype == UITouchSwipeDown)
whichItem = @"Swipe Down";

else if (touchtype == UITouchPinchIn)
whichItem = @"Pinch In";

else if (touchtype == UITouchPinchOut)
whichItem = @"Pinch Out";

[self.vc performSelector:@selector (updateStatewithPoints:)
withObject:whichItem

withObject: [NSNumber numberWithInt:pointCount]];

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’'ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 8 and open the project for this recipe.

One More Thing: Interactive Resize and Rotation

As the recipes in this chapter have shown, if youre willing to bring math to the table, the
iPhone can respond in powerful ways. Listing 8-1 demonstrates that power by combining
the bragview class shown throughout this chapter with Apple sample code. This code
creates a touchable, interactive view that responds to single and double touches by trans-
lating, rotating, and zooming.

This implementation, whose features are due to Apple and whose mistakes are down
solely to me, stores a set of points at the beginning of each touch. It then creates incre-
mental affine transforms based on touch progress, comparing the touch locations to their
starting positions and updating the view transform in real time.

It’s a complicated way to approach direct manipulation, but the results are outstanding.
This class responds directly to user interaction to match the view to its touches.
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Listing 8-1 Resizing and Rotating Views

@implementation DragView

// Prepare the drag view
- (id) initWithImage: (UIImage *) anImage

{
if (self = [super initWithImage:anImage])
{
self.userInteractionEnabled = YES;
self.multipleTouchEnabled = YES;
self.exclusiveTouch = NO;
originalSize = anImage.size;
originalTransform = CGAffineTransformIdentity;
touchBeginPoints = CFDictionaryCreateMutable(NULL, O,
NULL, NULL);
}
return self;
}

// Create an incremental transform matching the current touch set
- (CGAffineTransform)incrementalTransformWithTouches: (NSSet *)touches
{
// Sort the touches by their memory addresses
NSArray *sortedTouches = [[touches allObjects]
sortedArrayUsingSelector:@selector (compareAddress)];
NSInteger numTouches = [sortedTouches count];

// 1f there are no touches, simply return identify transform.
if (numTouches == 0) return CGAffineTransformIdentity;

// Handle single touch as a translation
if (numTouches == 1) {
UITouch *touch = [sortedTouches objectAtIndex:0];
CGPoint beginPoint = *(CGPoint *)
CFDictionaryGetValue(touchBeginPoints, touch);
CGPoint currentPoint = [touch locationInView:self.superview];
return CGAffineTransformMakeTranslation(currentPoint.x —
beginPoint.x, currentPoint.y - beginPoint.y);

// If two or more touches, go with the first two
UITouch *touchl = [sortedTouches objectAtIndex:0];
UITouch *touch2 = [sortedTouches objectAtIndex:1];

CGPoint beginPointl = *(CGPoint *)
CFDictionaryGetValue(touchBeginPoints, touchl);
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CGPoint currentPointl = [touchl locationInView:self.superview];

CGPoint beginPoint2 = *(CGPoint *)
CFDictionaryGetValue(touchBeginPoints, touch2);

CGPoint currentPoint2 = [touch2 locationInView:self.superview];

double layerX = self.center.x;
double layerY = self.center.y;

double x1 = beginPointl.x - layerX;
double yl = beginPointl.y - layerY;
double x2 = beginPoint2.x - layerX;
double y2 = beginPoint2.y - layerY;

double x3 = currentPointl.x - layerX;

double y3 = currentPointl.y - layery;

double x4 = currentPoint2.x - layerX;

double y4 = currentPoint2.y - layerY;

// Solve the system:

// [abtl, -bat2, 00 1] * [x1, y1, 1] = [x3, y3, 1]
// labtl, -bat2, 001] * [x2, y2, 1] = [x4, y4, 1]

double D = (yl-y2)*(yl-y2) + (x1-x2)*(x1-x2);
if (D < 0.1) {
return CGAffineTransformMakeTranslation(x3-x1, y3-yl);

}

double a = (yl-y2)*(y3-y4) + (x1-x2)*(x3-x4);

double b = (yl-y2)*(x3-x4) - (x1-x2)*(y3-y4);

double tx = (yl*x2 - xl*y2)*(yd-y3) - (x1*x2 + yl*y2)*(x3+x4) +

x3*(y2*y2 + x2*x2) + xd*(yl*yl + xl*xl);
double ty = (x1*x2 + yl*y2)*(-y4-y3) + (yl*x2 - x1*y2)*(x3-x4) +
y3*(y2*y2 + x2*x2) + yd*(yl*yl + xl*xl);

return CGAffineTransformMake(a/D, -b/D, b/D, a/D, tx/D, ty/D);

// Cache where each touch started
- (void)cacheBeginPointForTouches: (NSSet *)touches
{
for (UITouch *touch in touches) {
CGPoint *point = (CGPoint *)
CFDictionaryGetValue(touchBeginPoints, touch);
if (point == NULL) {
point = (CGPoint *)malloc(sizeof(CGPoint));
CFDictionarySetValue(touchBeginPoints, touch, point);
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*point = [touch locationInView:self.superview];

// Clear out touches from the cache
- (void)removeTouchesFromCache: (NSSet *)touches

{
for (UITouch *touch in touches) {
CGPoint *point = (CGPoint *)
CFDictionaryGetValue(touchBeginPoints, touch);
if (point != NULL) {
free((void *)CFDictionaryGetValue(touchBeginPoints,
touch));
CFDictionaryRemoveValue(touchBeginPoints, touch);
}
}
}

// Limit zoom to a max and min value
- (void) setConstrainedTransform: (CGAffineTransform) aTransform
{

self.transform = aTransform;

CGAffineTransform concat;

CGSize asize = self.frame.size;

if (asize.width > MAXZOOM * originalSize.width)

{
concat = CGAffineTransformConcat(self.transform,
CGAffineTransformMakeScale( (MAXZOOM * originalSize.width /
asize.width), 1.0f));
self.transform = concat;
}
else if (asize.width < MINZOOM * originalSize.width)
{
concat = CGAffineTransformConcat(self.transform,
CGAffineTransformMakeScale( (MINZOOM * originalSize.width /
asize.width), 1.0f));
self.transform = concat;
}
if (asize.height > MAXZOOM * originalSize.height)
{

concat = CGAffineTransformConcat(self.transform,
CGAffineTransformMakeScale(1.0f, (MAXZOOM *
originalSize.height / asize.height)));
self.transform = concat;
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else if (asize.height < MINZOOM * originalSize.height)

{
concat = CGAffineTransformConcat(self.transform,
CGAffineTransformMakeScale(1.0f, (MINZOOM *
originalSize.height / asize.height)));
self.transform = concat;
}

// BApply touches to create transform
- (void)updateOriginalTransformForTouches: (NSSet *)touches
{
if ([touches count] > 0) {
CGAffineTransform incrementalTransform = [self
incrementalTransformWithTouches:touches];
[self setConstrainedTransform:
CGAffineTransformConcat (originalTransform,
incrementalTransform)];
originalTransform = self.transform;

// At start, store the touch begin points and set an original transform
- (void)touchesBegan: (NSSet *)touches withEvent:(UIEvent *)event
{
[[self superview] bringSubviewToFront:self];
NSMutableSet *currentTouches = [[[event touchesForView:self]
mutableCopy] autorelease];
[currentTouches minusSet:touches];
if ([currentTouches count] > 0) {
[self updateOriginalTransformForTouches:currentTouches];
[self cacheBeginPointForTouches:currentTouches];

}

[self cacheBeginPointForTouches:touches];

// During movement, update the transform to match the touches
- (void)touchesMoved: (NSSet *)touches withEvent:(UIEvent *)event
{
CGAffineTransform incrementalTransform = [self
incrementalTransformWithTouches:[event touchesForView:self]];
[self setConstrainedTransform:
CGAffineTransformConcat (originalTransform,
incrementalTransform)];
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// Finish by removing touches, handling double-tap requests
- (void)touchesEnded: (NSSet *)touches withEvent:(UIEvent *)event
{
[self updateOriginalTransformForTouches: [event
touchesForView:self]];
[self removeTouchesFromCache:touches];

for (UITouch *touch in touches) {
if (touch.tapCount >= 2) {
[self.superview bringSubviewToFront:self];

NSMutableSet *remainingTouches = [[[event touchesForView:self]
mutableCopy] autorelease];

[remainingTouches minusSet:touches];

[self cacheBeginPointForTouches:remainingTouches];

// Redirect cancel to ended
- (void)touchesCancelled: (NSSet *)touches withEvent:(UIEvent *)event

{
[self touchesEnded:touches withEvent:event];

}

- (void)dealloc {
if (touchBeginPoints) CFRelease(touchBeginPoints);
[super dealloc];

}

@end

Summary

UlViews provide the onscreen components your users see. Gestures give views the ability
to interact with those users via the UITouch class. As this chapter has shown, even in their
most basic form, touch-based interfaces offer easy-to-implement flexibility and power.
You discovered how to move views around the screen and how to bound that movement.
You read about testing touches to see whether views should or should not respond to
them. Several recipes covered both persistence and undo support for direct manipulation
interfaces. You saw how to “paint” on a view and how to process user touches to interpret
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and respond to gestures. Here’s a collection of thoughts about the recipes in this chapter
that you might want to ponder before moving on:

= Be concrete. The iPhone has a perfectly good touch screen. Why not let your users
drag items around the screen with their fingers? It adds to the reality and the plat-
form’s interactive nature.

= Users typically have five fingers per hand. Don’t limit yourself to a one-finger inter-
face when it makes sense to expand your interaction into multitouch territory.

= A solid grounding in Quartz graphics and Core Animation will be your friend.
Using drawRect :, you can build any kind of custom UIview presentation you'd
like, including text, Bézier curves, scribbles, and so forth.

= Explore! This chapter only touched lightly on the ways you can use direct manipu-
lation in your applications. Use this material as a jumping-off point to explore the
full vocabulary of the UITouch class.
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Building and Using Controls

he UIControl class provides the basis for many iPhone interactive elements,

including buttons, text fields, sliders, and switches. These onscreen objects have

more in common than their ancestor class. Controls all use similar layout and tar-
get-action approaches. This chapter introduces controls and their use.You discover how to
build and customize controls in a variety of ways. From the prosaic to the obscure, this
chapter introduces a range of control recipes you can reuse in your programs.

The UlControl Class

On the iPhone, controls refer to a library of prebuilt onscreen objects designed for user
interaction. Controls include buttons and text fields, sliders and switches, along with other
Apple-supplied objects. A control’s role is to transform user interactions into callbacks.
Users touch and manipulate controls and in doing so communicate with your application.

The UIcontrol class lies at the root of the control class tree. All controls define a visual
interface and implement ways to dispatch messages when users interact with that inter-
face. Controls send those messages using target-action. When you define a new onscreen
control, you tell it who receives messages, what messages to send, and when to send those
messages.

Kinds of Controls

The members of the UIControl family include buttons, segmented controls, switches,
sliders, page controls, and text fields. Each of these controls can be found in Interface
Builder’s Object Library (Tools > Library > Objects) in the Inputs & Values section, as
shown in Figure 9-1. Control objects correspond to Inputs. The label, progress indicator,
and activity indicator represent the Values.

Control Events

Controls respond primarily to three kinds of events: those based on touch, those based on
value, and those based on edits. Table 9-1 lists the full range of event types available to
controls.
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Figure 9-1 Interface Builder groups controls
together in the Inputs & Values section of the
Object Library.

Table 9-1 UIControl Event Types

Event

UIControlEvent
TouchDown

UIControlEvent
TouchUpInside

UIControlEvent
TouchUpOutside
UIControlEvent
TouchDragEnter
UIControlEvent
TouchDragExit
UIControlEvent
TouchDragInside
UIControlEvent
TouchDragOutside

Type Use

Touch
trol’s bounds.

Touch A touch up event anywhere within a control’s
bounds. This is the most common event type
used for buttons.

Touch A touch up event that falls strictly outside a
control’s bounds.

Touch Events corresponding to drags that cross into
or out from the control’s bounds.

Touch Drag events limited to inside the control

bounds or to just outside the control bounds.

A touch down event anywhere within a con-



Table 9-1 Continued

Event

UIControlEvent
TouchDownRepeat

UIControlEvent
TouchCancel

UIControlEvent
AllTouchEvents

UIControlEvent
ValueChanged

UIControlEvent
EditingDidBegin
UIControlEvent
EditingDidEnd

UIControlEvent
EditingChanged
UIControlEvent
EditingDidEndOn
Exit
UIControlEvent
AllEditingEvents

UIControlEvent
Application
Reserved
UIControlEvent
SystemReserved
UIControlEvent
AllEvents

Type
Touch

Touch

Touch

Value

Editing

Editing

Editing

Editing

Application

System

Touch, Value,
Editing,
Application,
System

The UlControl Class

Use

A repeated touch down event with a tapCount
above 1, i.e., a double-tap.

A system event that cancels the current touch.
See Chapter 8, “Gestures and Touches,” for
more details about touch phases and life
cycles.

A mask that corresponds to all the touch
events listed above, used to catch any touch
event.

A user-initiated event that changes the value
of a control such as moving a slider’s thumb
or toggling a switch.

Touches inside or outside a UITextField. A
touch inside begins the editing session. A
touch outside ends it.

An editing change to the contents of the
UITextField contents.

An event that ends an editing session but not
necessarily a touch outside its bounds.

A mask of all editing events.

Application-specific event range (rarely if ever
used).

System-specific event range (rarely if ever
used).

A mask of all touch, value, editing, application,
and system events.

For the most part, Event types break down along the following lines. Buttons use touch

events; the single UIControlEventTouchUpInside event accounts for nearly all button

interaction.Value events (i.e., UIControlEventValueChanged) correspond to user-

initiated adjustments to segmented controls, switches, sliders, and page controls. When
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users switch, slide, or tap those objects, the control value changes. UITextField objects
trigger editing events. Users cause these events by tapping into (or out from) the text
field, or by changing the text field contents.

As with all iPhone GUI elements, you can lay out controls in Interface Builder or
build them directly in Xcode.This chapter discusses IB approaches but focuses more
intently on code-based solutions. IB layout, once mastered, remains pretty much the same
regardless of the item involved.You place an object into the interface, customize it with
inspectors, and connect it to other IB objects.

Buttons

UIButton instances provide simple onscreen buttons. Users can tap them to trigger a call-
back via target-action programming.You specify how the button looks, what art it uses,
and what text it displays.

The iPhone offers two ways to build buttons.You can use a precooked button type or
build a custom button from scratch. The current iPhone SDK offers the following pre-
cooked types. As you can see, the buttons available are not general purpose. They were
added to the SDK primarily for Apple’s convenience, not yours. Nonetheless, you can use
these in your programs as needed. Figure 9-2 shows each button.

©eo o ()

Figure 9-2  The iPhone SDK offers five precooked
button types, which you can access in Interface
Builder or build directly into your applications. From
left to right, these are the Detail Disclosure button,
the Info Light and Info Dark buttons, the Contact
Add button, and the Rounded Rectangle.

= Detail Disclosure—This is the same round, blue circle with the chevron you see
when you add a detail disclosure accessory to table cells. Detail disclosures are used
in tables to lead to a screen that shows details about the currently selected cell.

= Info Light and Info Dark—These two buttons offer a small circled i like you see
on a Macintosh’s Dashboard widget and are meant to provide access to an informa-
tion or settings screen. These are used in the Weather and Stocks application to flip
the view from one side to the other.

= Contact Add—This round, blue circle has a white + in its center and can be seen
in the Mail application for adding new recipients to a mail message.

= Rounded Rectangle—This button provides a simple onscreen rounded rectangle
that surrounds the button text. In its default state it is not an especially attractive
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button (that is, it’s not very “Apple” looking), but it is simple to program and use in
your applications.

To use a precooked button in code, allocate it, set its frame, and add a target. Don’t worry
about adding custom art or creating the overall look of the button. The SDK takes care of
all that. For example, here’s how to build a simple rounded rectangle button. Note that
buttonWithType: returns an autoreleased object.

UIButton *button = [UIButton buttonWithType:UIButtonTypeRoundedRect] ;

[button setFrame:CGRectMake(0.0f, 0.0f, 80.0f, 30.0f)];

[button setCenter:CGPointMake (160.0f, 208.0f)];

[button setTitle:@"Beep" forState:UIControlStateNormall];

[button addTarget:self action:@selector (playSound)
forControlEvents:UIControlEventTouchUpInside] ;

[contentView addSubview:button] ;

To build one of the other standard button types, omit the title line. Rounded rectangles is
the only precooked button type that uses a title.

Most buttons use the “touch up inside” trigger, where the user touch ends inside the
button’s bounds. iPhone UI standards allow users to cancel button presses by pulling their
fingers oft a button before releasing the finger from the screen. The
UIControlEventTouchUpInside event choice mirrors that standard.

When using a precooked button, you must conform to Apple’s Human Interface
Guidelines on how those buttons can be used. Adding a detail disclosure, for example, to
lead to an information page can get your application rejected from the App Store. It
might seem a proper extrapolation of the button’s role, but if it does not meet the exact
wording of how Apple expects the button to be used, it may not pass review. To avoid
potential issues, you may want to use rounded rectangle and custom buttons wherever

possible.

Adding Buttons in Interface Builder

Buttons appear in the Interface Builder library as Rounded Rect Button objects. To use
them, drag them into your interface.You can then change them to another button type
via the Attribute Inspector (Command-1). A button-type pop-up appears at the top of’
the inspector, as shown in Figure 9-3. Use this pop-up menu to select the button type.

If your button uses text (such as the word “Button” in Figure 9-2), you can enter that
text in the Title field. The Image and Background pull-downs let you choose a primary
and background image for the button.

Each button provides four configuration settings, which can be seen in Figure 9-3
(right). The four button states are default (the button in its normal state), highlighted
(when a user is currently touching the button), selected (an “on” version of the button for
buttons that support toggled states), and disabled (when the button is unavailable for user
interaction).
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Figure 9-3 Choose your button type from the Type pop-up in the
attributes inspector (left). Changes in the Button section apply to the
current configuration (right).

Changes in the Button Attributes > Button > Configuration section (i.e., the darkened
rectangle below the configuration pop-up) apply to the currently selected configuration.
You might, for example, use a different button text color for a button in its default state
versus its disabled state.

To preview each state, locate the three check boxes in Button Attributes > Control >
Content. The Highlighted, Selected, and Enabled options let you set the button state.
After previewing, and before you compile, make sure you returned the button to the
actual state it needs to be in when you first run the application.

Art

Apart from the precooked button types (disclosure, info, and add contact), you'll likely
want to create buttons using custom art. Figure 9-4 shows a variety of buttons built
around the Rounded Rect and Custom button classes.

Figure 9-4 shows that when working with Rounded Rect buttons, you are not limited
to just text (Button A).You can add an image along with text (Button B), use an image
instead of text (Button F), or even replace the background rounded rectangle style with
custom art (Button E), although this latter case does not make a lot of sense in the day-
to-day design process.

Custom buttons have no built-in look.You can make buttons with any size you like
(Buttons C and G) and add text (Button D) using the attributes inspector. What Figure 9-4
does not show is that these three buttons also represent other custom design decisions.

Button D uses the same art from Button B. Being a custom button, its text is centered
and not displayed on a rounded backsplash. Beyond that, there’s no big difference
between the B layout and the D layout. The button relies on the default highlighting pro-
vided by Interface Builder and the urButton class.

Button C represents a button created for highlighting on touch. Its relatively small size
allows it to work with Button Attributes > Button > Shows Touch On Highlight. When
touched, the button reveals a glowing halo. This halo is approximately 55-by-55 pixels in
size. Buttons larger than about 40-by-40 pixels cannot effectively use this visual pop.
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Figure 9-4 These examples show a variety of
custom art options for both Rounded Rect Buttons
and Custom Buttons.

‘What can’t be seen in this static screenshot is that Button G was built to display an alter-
nate image when pushed. Setting a second image in Button Attributes > Button > High-
lighted State Configuration lets a button change its look on touch. For Button G, that
image shows the same button but pushed into an indented position.

Connecting Buttons to Actions

When you Control-drag (right-drag) from a button to an IB object like the File’s Owner
view controller, IB presents a pop-up menu of actions to choose from. These actions are
polled from the target object’s available IBActions. Connecting to an action creates a
target-action pair for the button’s touch up inside event.

Alternatively, as Figure 9-5 shows, you can Control-click (right-click) the button, scroll
down to Touch Up Inside, and drag from the unfilled dot to the target you want to con-
nect to. The same pop-up menu appears with its list of available actions. Select the one
you want to use to finish defining the target-action callback.

Buttons That Are Not Buttons

In Interface Builder, you also encounter buttons that look like views and act like views
but are not, in fact, views. Bar button items (UIBarButtonItem) store the properties of
toolbar and navigation bar buttons but are not buttons themselves. See Chapter 5, “Work-
ing with View Controllers,” for more information about using bar button items.
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Figure 9-5  Control-clicking (right-clicking) a UlControl in Interface Builder
reveals a table of events that you can connect to a target. Available actions
appear in a pop-up menu after dragging out the connection.

Building Custom Buttons in Xcode

When using the UIButtonTypeCustom style, you supply all button art. The number of
images depends on how you want the button to work. For a simple pushbutton, you
might add a single background image and vary the label color to highlight when the but-
ton is pushed. For a toggle-style button, you might use four images: for the “off” state in a
normal presentation, the “oft” state when highlighted (that is, pressed), and two more for
the “on” state.You choose and design the interaction details.

Recipe 9-1 builds a button that toggles on and off, demonstrating the detail that goes
into building custom buttons. When tapped, the button switches its art from green (on) to
red (off), or from red to green. This allows your (noncolorblind) users to instantly identify
a current state. The displayed text reinforces the state setting. Figure 9-6 (left) shows the
button created by this recipe.

The UIImage stretchable image calls in this recipe play an important role in button
creation. Stretchable images enable you to create buttons of arbitrary width, turning cir-
cular art into lozenge-shaped buttons. You specify the caps at either end (that is, the art
that should not be stretched). In this case, the cap is 110 pixels wide. If you were to
change the button width from the 300 pixels used in this recipe to 220, the button loses
the middle stretch, as shown in Figure 9-6 (right).
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Figure 9-6 Use UIImage stretching to resize art for arbitrary button widths.
Set the left cap width to specify where the stretching can take place.

Note

The UIView contentStretch property provides view-specific stretching. The rectangle
stored in the property defines the portion of the view that can be stretched. The rectangle
values are normalized between 0.0 and 1.0, so to make only the middle portion of a view
stretchable, you might set that rectangle to (0.25, 0.25, 0.5, 0.5). Using a contentStretch
property lets a view maintain the kind of crisp borders seen in Figure 9-6.

Recipe 9-1 Building a UIButton That Toggles On and Off

- (void) toggleButton: (UIButton *) button
{
if (isOn = !isOn)
{
[button setTitle:@"On" forState:UIControlStateNormal] ;
[button setTitle:@"On" forState:UIControlStateHighlighted];
[button setBackgroundImage:baseGreen
forState:UIControlStateNormal] ;
[button setBackgroundImage:altGreen
forState:UIControlStateHighlighted] ;

else

[button setTitle:@"Off" forState:UIControlStateNormal];
[button setTitle:@"Off" forState:UIControlStateHighlighted];
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[button setBackgroundImage:baseRed
forState:UIControlStateNormall] ;

[button setBackgroundImage:altRed
forState:UIControlStateHighlighted] ;

- (void) viewDidLoad

{

self.title = @"Toggle Button";

baseGreen = [[[UIImage imageNamed:@"green.png"]
stretchableImageWithLeftCapWidth:110.0f topCapHeight:0.0f]
retain] ;

baseRed = [[[UIImage imageNamed:@"red.png"]
stretchableImageWithLeftCapWidth:110.0f topCapHeight:0.0f]
retain] ;

altGreen = [[[UIImage imageNamed:@"green2.png"]
stretchableImageWithLeftCapWidth:110.0f topCapHeight:0.0f]
retain] ;

altGreen = [[[UIImage imageNamed:@"red2.png"]
stretchableImageWithLeftCapWidth:110.0f topCapHeight:0.0f]
retain] ;

// Create a button sized to our art

UIButton *button = [UIButton buttonWithType:UIButtonTypeCustom] ;
button.frame = CGRectMake(0.0f, 0.0f, 300.0f, 233.0f);
button.center = CGPointMake (160.0f, 140.0f);

// Set up the button alignment properties

button.contentVerticalAlignment =
UIControlContentVerticalAlignmentCenter;

button.contentHorizontalAlignment =
UIControlContentHorizontalAlignmentCenter;

// Set the font and color

[button setTitleColor: [UIColor whiteColor]
forState:UIControlStateNormall] ;

[button setTitleColor: [UIColor lightGrayColor]
forState:UIControlStateHighlighted] ;

button.titleLabel.font = [UIFont boldSystemFontOfSize:24.0f];

// Add action
[button addTarget:self action:@selector (toggleButton)
forControlEvents: UIControlEventTouchUpInside];



Adding Animated Elements to Buttons

// For tracking the two states
isOn = NO;
[self toggleButton:button];

// Place the button into the view. The button is autoreleased.
[self.view addSubview:button] ;

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Multiline Button Text

New to the 3.0 SDK, UlIButtons now ofter access to their title label via the titleLabel
property. By exposing this property, the SDK allows you to modify the title attributes
directly, including its font and line break mode. Here, the font is set to a very large value
(basically ensuring that the text needs to wrap to display correctly) and used with word
wrap and centered alignment.

button.titleLabel.font = [UIFont boldSystemFontOfSize:36.0f];

[button setTitle:@"Lorem Ipsum Dolor Sit" forState:
UIControlStateNormall] ;

button.titleLabel.textAlignment = UITextAlignmentCenter;

button.titleLabel.lineBreakMode = UILineBreakModeWordWrap;

Be aware that the default label stretches from one end of your button to the other. This
means that text may extend farther out than you might otherwise want, possibly beyond
the edges of your button art.To fix this problem, you can force carriage returns in word
wrap mode by embedding new line literals (i.e., \n) into the text. This allows you to con-
trol how much text appears on each line of the button title.

Adding Animated Elements to Buttons

When working with buttons, you can creatively layer art in front of or behind them. Use
the standard UTview hierarchy to do this, making sure to disable user interaction for any
view that might otherwise obscure your button (setUserInteractionEnabled:NO).
Figure 9-7 shows what happens when you combine semitranslucent button art with an
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animated UIImageview behind it. The image view contents “leak” through to the viewer,
enabling you to add live animation elements to the button.
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Toggle Button

Figure 9-7 Combine semitranslucent button art
with animated UllmageViews to build eye-catching
Ul elements. In this concept, the butterfly flaps
“within” the button.

Recipe: Animating Button Responses

There’s more to UIControl instances than frames and target-action. All controls inherit
from the UIView class. This means you can use UIView animation blocks when working
with controls just as you would with standard views. Recipe 9-2 builds a toggle switch
that flips around using UIViewAnimationTransitionFlipFromLeft to spin the button
while changing states.

Unlike Recipe 9-1, this code doesn’t switch art. Instead, it switches buttons. There are
two: an on button and an off button, both of which rest on a clear UIview backdrop. Giv-
ing the two buttons a see-through parent enables you to apply the flip to just those but-
tons without involving the rest of the user interface. Skip the clear background, and you
end up spinning the entire window—not a good UI choice.

As this recipe uses the same semitranslucent art as the previous recipes, it’s important
that only one button appears onscreen at any time. To make this happen, the current but-
ton hides (sets its alpha value to 0.0) while in the animation block.The button with the
opposite state takes its place. Figure 9-8 shows the flipping button in midflip.
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Toggle Button

Figure 9-8 Use UIView animation blocks to flip
between control states. Here, a button twirls
around to move between Off and On.

Recipe 9-2 Adding UIView Animation Blocks to Controls

- (IBAction) flip: (UIButton *) button

{

// Hide the view that’s going away

[self.view viewWithTag:BUTTON1] .alpha 1.0f;
[self.view viewWithTag:BUTTON2] .alpha = 1.0f;
[button setAlpha:0.0f];

// Decide which animation to use

UIViewAnimationTransition trans;

trans = (button.tag == BUTTON1) ?
UIViewAnimationTransitionFlipFromLeft
UIViewAnimationTransitionFlipFromRight;

// Animate the flip

[UIView beginAnimations:nil context:NULL] ;

[UIView setAnimationDuration:1.0f];

[UIView setAnimationTransition:trans forView: [self.view
viewWithTag:CLEARVIEW] cache:YES];

[[self.view viewWithTag:CLEARVIEW] exchangeSubviewAtIndex:0
withSubviewAtIndex:1];
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[UIView commitAnimations];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Working with Switches

The UTswitch object offers a simple ON/OFF toggle that lets users choose a Boolean
value. The switch object contains a single (settable) value property, called on. This returns
either YEs or No, depending on current state of the control. You can programmatically
update a switch’s value by changing the property value directly or calling
setOn:animated:, which offers a way to animate the change.

Interface Builder offers relatively few options for working with switches.You can
enable it and set its initial value, but beyond that there’s not much to customize. Switches
produce a value-changed event when a user adjusts them. Recipe 9-3 uses that behavior
to trigger an IBAction callback. When the switch updates, it enables or disables an associ-
ated button.

As with all IB work, make sure you’ve defined your outlets and actions in the Library
> Classes pane before you make your connections. The switch should trigger on Value
Changed and send the doswitch: action to the File’s Owner, that is, the main view con-
troller. The controller then sets the enabled property for the button. Unfortunately, you
cannot connect the switch directly to the button inside IB to tie the switch value to the
button’s enabled property. If you are a longtime IB user, you will recall that there was a
time when such connections were allowed.

This recipe builds on the modal animations introduced in Chapter 6, “Assembling
Views and Animations,” and the control animation shown in Recipe 9-2. When the
switch activates, it calls one or more animation requests that transform the button into its
active or inactive state.

Note

Do not name UISwitch instances as switch. Recall that switch is a reserved C word; it
is used for conditional statements. This simple oversight has tripped up many iPhone
developers.

Recipe 9-3  Using a Switch State to Enable/Disable a Guarded Button

@implementation TestBedViewController

- (void) expand: (NSNumber *) aFactor
// Cause the button to zoom to the given factor
dangerButton.transform =


http://github.com/erica/iphone-3.0-cookbook-

Recipe: Working with Switches

CGAffineTransformMakeScale (aFactor.intValue, aFactor.intValue);

- (void) rotate
{
// Rotate the button by 90 degrees
dangerButton.transform =
CGAffineTransformRotate (dangerButton.transform, M PI 2);

- (void) updateAlpha: (NSNumber *) level

{
// Set the button’s transparency to the given level
dangerButton.alpha = level.floatValue;

- (IBAction) doSwitch: (UISwitch *) aSwitch

{

dangerButton.enabled = aSwitch.isOn;

// Adjust button alpha level to match the enabled/disabled state
NSNumber *aLevel = NUMBER ((dangerButton.enabled) ? 1.0f : 0.25f);
[UIView modalAnimationWithTarget:self

selector:@selector (updateAlpha)

object:alevel duration:0.3f];
dangerButton.transform = CGAffineTransformIdentity;

if (!dangerButton.enabled) return;

// When the switch enables the button, add a little animation to
// introduce the change
[UIView modalAnimationWithTarget:self
selector:@selector (expand)
object :NUMBER (2.0f) duration:0.3f];
[UIView modalAnimationWithTarget:self
selector:@selector (expand)
object :NUMBER (1.0f) duration:0.3f];
for (int 1 = 0; 1 < 4; 1++)
[UIView modalAnimationWithTarget:self
selector:@selector (rotate)
object:nil duration:0.3f];

- (void) boom

{
// Display a "Boom" alert, as the consequence of tapping
// the danger button
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UIAlertView *av = [[[UIAlertView alloc] initWithTitle:@"Boom"
message:nil delegate:nil
cancelButtonTitle:@"OK"otherButtonTitlesnil] autorelease];

[av show] ;

- (void) viewDidLoad
{
// Initialize the danger button as semi-transparent
dangerButton.alpha = 0.25f;
[dangerButton addTarget:self action:@selector (boom)
forControlEvents:UIControlEventTouchUpInside] ;

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Adding Custom Slider Thumbs

UIslider instances provide a control allowing users to choose a value by sliding a knob
(called its “thumb”) between its left and right extent.You’ll have seen UlSliders in the
iPod/Music application, where the class is used to control volume.

Slider values default to 0.0 for the minimum and 1.0 for the maximum, although you
can easily customize this in the Interface Builder attributes inspector or by setting the
minimumvalue and maximumvalue properties. If you want to stylize the ends of the control,
you can add in a related pair of images (minimumvalueImage and maximumvalueImage)
that reinforce those settings. For example, you might show a snowman on one end and a
steaming cup of tea on the other for a slider that controls temperature settings.

The slider’s continuous property controls whether a slider continually sends value
updates as a user drags the thumb. When set to No (the default is YES), the slider only sends
an action event when the user releases the thumb.

Customizing UlSlider

In addition to setting minimum and maximum images, the UIslider class lets you
directly update its thumb component.You can set a thumb to whatever image you like by
calling setThumbImage: forState:. Recipe 9-4 takes advantage of this option to dynami-
cally build thumb images on the fly, as shown in Figure 9-9.The indicator bubble appears
above the user’s finger as part of the custom-built thumb. This bubble provides instant
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teedback both textually (the number inside the bubble) and graphically (the shade of the
bubble reflects the slider value, moving from black to white as the user drags).
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Custom Slider

Figure 9-9 Core Graphics/Quartz calls enable
this slider’s thumb image to dim or brighten based
on the current slider value. The text inside the
thumb bubbles mirrors that value.

This kind of dynamically built feedback could be based on any kind of data.You might
grab values from onboard sensors or make calls out to the Internet just as easily as you use
the user’s finger movement with a slider. No matter what live update scheme you use,
dynamic updates are certainly graphics intensive—but it’s not as expensive as you might
fear. The Core Graphics calls are fast, and the memory requirements for the thumb-sized
images are minimal.

This particular recipe assigns two thumb images to the slider. The bubble appears only
when the slider is in use, for its UIControlStateHighlighted. In its normal state, namely
UIControlStateNormal, only the smaller rectangular thumb appears. Users can tap on the
thumb to review the current setting. The context-specific feedback bubble mimics the let-
ter highlights on the standard iPhone keyboard.

To accommodate these changes in art, the slider updates its frame at the start and end
of each gesture. On being touched (UIControlEventTouchDown), the frame expands by
sixty pixels in height to the thumbFrame.This extra space provides enough room to show
the expanded thumb during interaction.
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When the finger is removed from the screen (UIControlEventTouchUpInside or
UIControlEventTouchUpOutside), the slider returns to its previous dimensions, the
baseFrame. This restores space to other onscreen objects, ensuring that the slider will not
activate unless a user directly touches it.

Adding Efficiency

This recipe stores a previous value for the slider to minimize the overall computational
burden on the iPhone. It updates the thumb with a new custom image when the slider
has changed by at least 0.1, or 10% in value.You can omit this check, if you want, and run
the recipe with full live updating. When tested, this provided reasonably fast updates, even
on a first generation iPod touch unit. It also avoids any issues at the ends of the slider,
namely when the thumb gets caught at 0.9 and won’t update properly to 1.0. In this
recipe, a hard-coded workaround for values above 0.98 handles that particular situation by
forcing updates.

Recipe 9-4 Building Dynamic Slider Thumbs

@implementation TestBedViewController

// Draw centered text into the context
void centerText (CGContextRef context,
NSString *fontname, float textsize,
NSString *text, CGPoint point, UIColor *color)

CGContextSaveGState (context) ;
CGContextSelectFont (context, [fontname UTF8Stringl, textsize,
kCGEncodingMacRoman) ;

// Retrieve the text width without actually drawing anything

CGContextSaveGState (context) ;

CGContextSetTextDrawingMode (context, kCGTextInvisible);

CGContextShowTextAtPoint (context, 0.0f, 0.0f, [text UTF8String],
text.length) ;

CGPoint endpoint = CGContextGetTextPosition (context) ;

CGContextRestoreGState (context) ;

// Query for size to recover height. Width is less reliable
CGSize stringSize = [text sizeWithFont: [UIFont
fontWithName:fontname size:textsizel];

// Draw the text

[color setFill];

CGContextSetShouldAntialias (context, true);

CGContextSetTextDrawingMode (context, kCGTextFill);

CGContextSetTextMatrix (context, CGAffineTransformMake(1l, 0, 0, -1,
0, 0));
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CGContextShowTextAtPoint (context, point.x - endpoint.x / 2.0f,
point.y + stringSize.height / 4.0f, [text UTF8String],
text.length) ;

CGContextRestoreGState (context) ;

// Create a thumb image using a grayscale/numeric level

{

(UIImage *) createImageWithLevel: (float) aLevel

UIGraphicsBeginImageContext (CGSizeMake (40.0f, 100.0f));
CGContextRef context = UIGraphicsGetCurrentContext () ;

float INSET AMT = 1.5f;

// Create a filled rect for the thumb

[[UIColor darkGrayColor] setFill];

CGContextAddRect (context, CGRectMake (INSET_AMT, 40.0f + INSET AMT,
40.0f - 2.0f * INSET AMT, 20.0f - 2.0f * INSETiAMT));

CGContextFillPath (context) ;

// Outline the thumb

[[UIColor whiteColor] setStroke];

CGContextSetLineWidth (context, 2.0f);

CGContextAddRect (context, CGRectMake (2.0f * INSET AMT,
40.0f + 2.0f * INSET AMT, 40.0f - 4.0f * INSET AMT,
20.0f - 4.0f * INSET_AMT));

CGContextStrokePath (context) ;

// Create a filled ellipse for the indicator

[[UIColor colorWithWhite:aLevel alpha:1.0f] setFill];

CGContextAddEllipseInRect (context, CGRectMake(0.0f, 0.0f, 40.0f,
40.0f)) ;

CGContextFillPath (context) ;

// Label with a number
NSString *numstring = [NSString stringWithFormat:@"%0.1f", aLevell];
UIColor *textColor = (aLevel > 0.5f) ? [UIColor blackColor]
[UIColor whiteColor];
centerText (context, @"Georgia", 20.0f, numstring,
CGPointMake (20.0f, 20.0f), textColor);

// Outline the indicator circle

[[UIColor grayColor] setStroke];

CGContextSetLineWidth (context, 3.0f);

CGContextAddEllipseInRect (context, CGRectMake (INSET AMT, INSET_AMT,
40.0f - 2.0f * INSET AMT, 40.0f - 2.0f * INSET AMT));

CGContextStrokePath (context) ;
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// Build and return the image

UIImage *theImage = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;

return theImage;

// Return a base thumb image without the bubble

UIlmage *createSimpleThumb ()

{
float INSET_AMT = 1.5f;
UIGraphicsBeginImageContext (CGSizeMake (40.0£f, 100.0f));
CGContextRef context = UIGraphicsGetCurrentContext () ;

// Create a filled rect for the thumb

[[UIColor darkGrayColor] setFill];

CGContextAddRect (context, CGRectMake (INSET_AMT, 40.0f + INSET AMT,
40.0f - 2.0f * INSET AMT, 20.0f - 2.0f * INSETiAMT));

CGContextFillPath (context) ;

// Outline the thumb

[[UIColor whiteColor] setStroke];

CGContextSetLineWidth (context, 2.0f);

CGContextAddRect (context, CGRectMake (2.0f * INSET AMT,
40.0f + 2.0f * INSET AMT, 40.0f - 4.0f * INSET AMT,
20.0f - 4.0f * INSET_AMT));

CGContextStrokePath (context) ;

UIImage *theImage = UIGraphicsGetImageFromCurrentImageContext () ;
UIGraphicsEndImageContext () ;
return thelImage;

// Update the thumb images as needed
- (void) updateThumb: (UISlider *) aSlider
{
// Only update the thumb when registering significant changes
if ((aSlider.value < 0.98) &&
(ABS (aSlider.value - previousValue) < 0.1f)) return;

// create a new custom thumb image and use for highlighted state

UIImage *customimg = [self createImageWithLevel:aSlider.value];

[aSlider setThumbImage: simpleThumbImage forState:
UIControlStateNormall] ;

[aSlider setThumbImage: customimg forState:
UIControlStateHighlighted];

previousValue = aSlider.value;
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xpand the slider to accommodate the bigger thumb
oid) startDrag: (UISlider *) aSlider

aSlider.frame = thumbFrame;
aSlider.center = CGPointMake (160.0f, 140.0f);

// At release, shrink the frame back to normal

- (v

{

- (v

{

@end

0id) endDrag: (UISlider *) aSlider

aSlider.frame = baseFrame;
aSlider.center = CGPointMake (160.0f, 140.0f);

0id) viewDidLoad
self.title = @"Custom Slider";

// Initialize slider settings

previousValue = -99.0f;

simpleThumbImage = [createSimpleThumb () retain];
thumbFrame = CGRectMake(0.0f, 0.0f, 280.0f, 100.0f);
baseFrame = CGRectMake(0.0f, 0.0f, 280.0f, 40.0f);

// Create slider

UISlider *slider = [[UISlider alloc] initWithFrame:baseFrame] ;
slider.center = CGPointMake (160.0f, 140.0f);

slider.value = 0.0f;

// Create the callbacks for touch, move, and release
[slider addTarget:self action:@selector (startDrag)
forControlEvents:UIControlEventTouchDown] ;
[slider addTarget:self action:@selector (updateThumb)
forControlEvents:UIControlEventValueChanged] ;
[slider addTarget:self action:@selector (endDrag)
forControlEvents:UIControlEventTouchUpInside |
UIControlEventTouchUpOutside] ;

// Present the slider

[self.view addSubview:slider];

[self performSelector:@selector (updateThumb) withObject:slider
afterDelay:0.1f];
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Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Creating a Twice-Tappable Segmented
Control

The UIsegmentedControl class presents a multiple button interface, where users can
choose one choice out of a group. The control provides two styles of use. In its normal
radio-button style mode, a button once selected remains selected. Users can tap on other
buttons, but they cannot generate a new event by re-tapping their existing choice. The
alternative momentary style lets users tap on each button as many times as desired but
stores no state about a currently selected item. It provides no highlights to indicate the
most recent selection.

Recipe 9-5 builds a hybrid approach. It allows users to see their currently selected
option and to reselect that choice if needed. This is not the way segmented controls nor-
mally work. There are times, though, that you want to generate a new result on reselection
(as in momentary mode) while visually showing the most recent selection (as in radio
button mode).

Unfortunately, “obvious” solutions to create this desired behavior don’t work.You
cannot add target-action pairs that detect UIControlEventTouchUpInside.
UIControlEventValueChanged is the only control event generated by
UISegmentedControl instances. (You can easily test this yourself by adding a target-action
pair for touch events.)

Here is where subclassing comes in to play. It’s relatively simple to create a new class
based on UISegmentedControl that does respond to that second tap. Recipe 9-5 defines
that class. Its code works by detecting when a touch has occurred, operating independ-
ently of the segmented control’s internal touch handlers that are subclassed from
UIControl.

Segment switches remain unaffected; they’ll continue to update and switch back and
forth as users tap them. Unlike the parent class, here touches on an already-touched seg-
ment continue to do something. In this case, they request that the object’s delegate pro-
duce the performSegmentaAction method.

Don’t add target-action pairs to your segmented controllers the way you’d normally
do. Since all touch down events are detected, target-actions for value-changed events
would add a second callback and trigger twice whenever you switched segments. Instead,
implement the delegate callback and let object delegation handle the updates.
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Recipe 9-5 Creating a Segmented Control Subclass That Responds to a Second Tap

@class DoubleTapSegmentedControl;

@protocol DoubleTapSegmentedControlDelegate <NSObjects>
- (void) performSegmentAction: (DoubleTapSegmentedControl *) aDTSC;
@end

@interface DoubleTapSegmentedControl : UISegmentedControl

{

id <DoubleTapSegmentedControlDelegate> delegate;
}
@property (nonatomic, retain) id delegate;
@end

@implementation DoubleTapSegmentedControl
@synthesize delegate;

- (void) touchesBegan: (NSSet *)touches withEvent: (UIEvent *)event
{
[super touchesBegan:touches withEvent:event];
if (self.delegate)
[self.delegate performSegmentAction:self];

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Subclassing UlControl

Apple provides several prebuilt controls that you can use directly in your applications. But
you don’t have to limit yourself to Apple-supplied items. Recipe 9-6 demonstrates how to
subclass UTControl and build new controls. This example creates a touch wheel, like the
ones used on older model iPods.

Touch wheels provide an infinitely scrollable input. Users can rotate their finger clock-
wise or counterclockwise, and the object’s value increases or decreases accordingly. Each
complete turn around the wheel, that is, a traversal of 360 degrees, corresponds to a value
change of 1.0. Clockwise changes are positive; counterclockwise changes are negative. The
value accumulates on each touch, although it can be reset; simply assign the control’s
value property back to 0.0.This property is not a standard part of UIControl instances
even though many controls use values.

This recipe computes user changes by casting out vectors from the control’s center. The
code adds difterences in the angle as the finger moves, updating the current value accord-
ingly. For example, three spins around the touch wheel adds or subtracts 3 to the current
value, depending on the direction of movement.
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Tracking Touches

UIControl instances use an embedded method set to work with touches. These methods
allow the control to track touches throughout their interaction with the control object:

Gets called when a touch

» beginTrackingWithTouch:withEvent:
enters a control’s bounds.

» continueTrackingWithTouch:withEvent :—Follows the touch with
repeated calls as the touch remains within the control bounds.

Handles the last touch for the

» endTrackingWithTouch:withEvent:
event.

= cancelTrackingWithEvent :—Manages a touch cancellation.

Add your custom control logic by implementing any or all of these methods in a
UIControl subclass. Recipe 9-6 uses the begin and continue versions to locate the user
touch and track it until the touch is lifted or otherwise leaves the control.

Dispatching Events

Controls use target-action pairs to communicate changes triggered by events. When you
build a new control, you must decide what kind of events your object will generate and
add code to trigger those events.

Add a dispatch message to your custom control by calling sendactionsFor
= ControlEvents:. This method lets you send an event, in this case UIControlEvent
=valueChanged to the specified target. Controls transmit these updates by messaging the
UIApplication singleton. As Apple notes, the application acts as the centralized dispatch
point for all messages.

Note

The basic wheel defined in Recipe 9-6 tracks touch rotation but does little else. The original
iPod scroll wheel offered five click points: in the center circle and at the four cardinal points
of the wheel. Adding click support and the associated button-like event support (for
UIControlEventTouchUpInside) are left as an exercise for the reader.

Recipe 9-6 Building a Touch Wheel Control

@implementation ScrollWheel
@synthesize value;
@synthesize theta;

- (id) initWithFrame: (CGRect) aFrame

{

if (self = [super initWithFrame:aFrame])

{

// This control uses a fixed 200x200 sized frame
self.frame = CGRectMake(0.0f, 0.0f, 200.0f, 200.0f);
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self.center = CGPointMake (CGRectGetMidX (aFrame),
CGRectGetMidY (aFrame) ) ;

// Add the touchwheel art

UIImageView *iv = [[UIImageView alloc] initWithImage: [UIImage
imageNamed:@"wheel.png"]];

[self addSubview:iv];

[iv release];

return self;

}
- (id) 1init
{
return [self initWithFrame:CGRectZero];
}
+ (id) scrollWheel
{
return [[[self alloc] init] autorelease];
1
- (BOOL)beginTrackingWithTouch: (UITouch *)touch
withEvent: (UIEvent *)event
{
CGPoint p = [touch locationInView:self];
CGPoint cp = CGPointMake (self.bounds.size.width / 2.0f,
self.bounds.size.height / 2.0f);
// self.value = 0.0f; // Uncomment for separate event values
// First touch must touch the gray part of the wheel
if (!pointInsideRadius(p, cp.x, cp)) return NO;
if (pointInsideRadius(p, 30.0f, cp)) return NO;
// Set the initial angle
self.theta = getangle([touch locationInView:self], cp);
return YES;
1
- (BOOL) continueTrackingWithTouch: (UITouch *)touch
withEvent: (UIEvent *)event
{

CGPoint p = [touch locationInView:self];
CGPoint cp = CGPointMake (self.bounds.size.width / 2.0f,
self .bounds.size.height / 2.0f);
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// falls outside too far, with boundary of 50 pixels.
// Inside strokes treated as touched
if (!pointInsideRadius(p, cp.x + 50.0f, cp)) return NO;

float newtheta = getangle([touch locationInView:self], cp);
float dtheta = newtheta - self.theta;

// correct for edge conditions
int ntimes = 0;
while ((ABS(dtheta) > 300.0f) && (ntimes++ < 4))
if (dtheta > 0.0f) dtheta -= 360.0f; else dtheta += 360.0f;

// Update current values
self.value -= dtheta / 360.0f;
self.theta = newtheta;

// Send value changed alert
[self sendActionsForControlEvents:UIControlEventValueChanged] ;

return YES;

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Dismissing a UlTextField Keyboard

The most commonly asked question about the UITextField control is, “How do I dismiss
the keyboard?” There’s no built-in way to automatically detect this. When users finish
editing the contents of a UITextField, the keyboard should go away.

Fortunately, it takes little work to respond to the end of edits. By watching for the
Return key, you can resign first-responder status. This moves the keyboard out of sight, as
Recipe 9-7 shows. Here are a few key points about doing this:

= Optionally, set the Return key type to UIReturnKeyDone.You can do this in Inter-
face Builder’s Attribute Inspector or by assignment to the text field’s returnkeyType
property. Using a “Done”-style Return key tells the user how to finish editing.
Figure 9-10 shows a keyboard using the Done key style.

= Be the delegate. You must set the text fields delegate property to your view con-
troller in code. Interface Builder does not provide a way to make that assignment
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graphically. Make sure your view controller implements the UITextFieldDelegate
protocol.
» Implement textFieldShouldReturn:.This method catches all Return key

presses—no matter how they are named. Use the method to resign first responder.
This hides the keyboard until the user touches another text field or text view.
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Figure 9-10 Setting the name of the Return key to Done (left) tells

your user how to finish editing the field. Specify this directly in code

or use Interface Builder’s text field attributes inspector (right) to cus-
tomize the way the text field looks and acts.

Note

You can also use textFieldShouldReturn: to perform an action when the Return key is
pressed as well as dismissing the keyboard.

Your code needs to handle each of these points to create a smooth interaction process for
your UITextField instances.

Text Trait Properties

Text fields implement the UIText InputTraits protocol. This protocol provides seven
properties that you can set to define the way the field handles text input. Those traits are
as follows:

» autocapitalizationType—Defines the text autocapitalization style. Available
styles use sentence capitalization (UITextAutocapitalizationTypeSentences), word
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capitalization (UITextAutocapitalizationTypeWords),all caps
(UITextAutocapitalizationTypeAllCharacters),and no capitalization
(UITextAutocapitalizationTypeNone). Avoid capitalizing when working with
account name entry. Use word capitalization for proper names and street address entry.

» autocorrectionType—Specifies whether the text is subject to the iPhone’s
autocorrect feature like the bubble shown in Figure 9-10.When enabled (set to
UITextAutocorrectionTypeYes), the iPhone suggests replacement words to the user.

» enablesReturnKeyAutomatically—Helps control whether the Return
key is disabled when there’s no text in an entry field or view. If you set this prop-
erty to YES, the Return key becomes enabled after the user types in at least one
character.

» keyboardAppearance—Provides two keyboard presentation styles: the default
style and a style meant to be used with an alert panel.

» keyboardType—Lets you choose the keyboard that first appears when a user
interacts with a field or text view. The available keyboard types are
UIKeyboardTypeDefault, UIKeyboardTypeASCIICapable,
UIKeyboardTypeNumbersAndPunctuation, UIKeyboardTypeURL,
UIKeyboardTypeNumberPad, UIKeyboardTypePhonePad,
UIKeyboardTypeNamePhonePad, and UIKeyboardTypeEmailAddress. Each key—
board has its advantages and disadvantages in terms of the mix of characters it pres-
ents. The Email keyboard, for example, is meant to help enter addresses and includes
the @ symbol, along with text.

» returnKeyType—Specifies the text shown on the keyboard’s Return key. You
can choose from the default (“Return”), Go, Google, Join, Next, Route, Search,
Send,Yahoo, Done, and Emergency Call.

» secureTextEntry—Toggles a text hiding feature meant to provide more secure
text entry. When enabled, you can see the last character typed, but all other charac-
ters are shown as a series of dots. Switch this feature for password text fields.

Other Text Field Properties

In addition to the standard text traits, text fields offer several other properties that control
how the field is presented. The placeholder text is shown in light gray when the text
field is empty, providing a user prompt. Use the placeholder to provide usage hints like
“User Name” or “E-mail address.”

Text fields allow you to control the type of borderstyle displayed around the text
area.You can choose from a simple line, a bezel, and a rounded rectangle presentation.
These are best seen in Interface Builder, where the attributes inspector lets you toggle
between each style.

The text field clear button appears as an X in the right side of the entry area. Set the
clearButtonMode to specify if and when this button appears: always, never, when editing,
or unless editing is ongoing.
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Recipe 9-7 Using the Done Key to Dismiss a Text Field Keyboard

@interface TestBedViewController : UIViewController <UITextFieldDelegate>
@end

@implementation TestBedViewController
- (BOOL) textFieldShouldReturn: (UITextField *)textField
{

[textField resignFirstResponder] ;

return YES;

- (void) viewDidLoad
self.title = @"Keyboard Dismissal";

// Customize text field from Interface Builder
UlITextField *tf = (UITextField *) [self.view viewWithTag:101];
tf.delegate = self;

// Create a text field by hand

tf = [[UITextField alloc] initWithFrame:CGRectMake (0.0f, 0.0f,
100.0f, 30.0f)1;

tf.center = CGPointMake (160.0f, 120.0f);

tf.borderStyle = UITextBorderStyleRoundedRect;

tf.autocorrectionType = UITextAutocorrectionTypeNo;

tf.placeholder = @"Name";

tf.returnKeyType = UIReturnKeyDone;

tf.clearButtonMode = UITextFieldViewModeWhileEditing;

tf.delegate = self;

[self.view addSubview:tf];

[tf release];

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.
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Recipe: Dismissing UlTextView Keyboards

When dismissing keyboards, UITextView instances require a slightly different approach
than UITextField ones. Users should be able to tap Return in the text view, adding car-
riage returns without dismissing the keyboard. Instead, add a Done button to the general
interface when the text view becomes active, as shown in Figure 9-11. Use this key to
resign first-responder status when the user finishes his or her edits.
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Figure 9-11 Add a Done key to the navigation

bar when users start interacting with a text view.

This offers users an obvious way to finish editing
and dismiss the keyboard.

To sense text view activity, your view controller must implement the UITextView
=Delegate protocol, and it must be set as the text view’s delegate. The textview
=DidBeginEditing: delegate method triggers whenever a user taps the view. Detecting
this enables you to either add or enable the Done button. Users can then tap on Done
after they’ve finished editing. The Done button offers an obvious way to finish editing and
dismiss the keyboard.

Recipe 9-8 demonstrates how to add the navigation item button in the delegate
method call and how to remove it when the user is done editing. Reveal the Done button
when the view becomes active. Hide it when resigning the view’s first-responder status.



Recipe: Building a Better Text Editor

Recipe 9-8 Adding a Done Button to Active UITextView Sessions

@interface TestBedViewController : UIViewController <UITextViewDelegate>
@end

@implementation TestBedViewController

// Reveal a Done button when editing starts
- (void) textViewDidBeginEditing: (UITextView *) textView
self.navigationItem.rightBarButtonItem = BARBUTTON (@"Done",
@selector (doneEditing)) ;

// Remove the Done button and dismiss the keyboard
- (void) doneEditing: (id) sender
{
[self.view resignFirstResponder] ;
self.navigationItem.rightBarButtonItem = nil;

- (void) viewDidLoad
{
[ (UITextView *)self.view setDelegate:self];
[(UITextView *)self.view setFont: [UIFont systemFontOfSize:16.0f]];

}

@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Building a Better Text Editor

Recipe 9-8 showed how to catch user interactions within a text view. Recipe 9-9 expands
upon this notion to add a number of critical features that make a better text editor. These
features are easy to implement in your own programs.

First, the view controller adds undo support. Users can shake the iPhone to load the
undo/redo editor that was first introduced in Chapter 8. UITextView objects ship in an
undo-ready state. They provide built-in support that works hand-in-hand with select, cut,
copy, and paste. The undo manager understands these actions, so possible user messages
might include “Undo Paste,” “Redo Cut,” and so forth. All the view controller needs to
do is instantiate an undo manager; it leaves the rest of the work to the built-in objects.

Second, the view uses persistence. It archives its contents to file in the
performArchive method. The application delegate calls this method right before the
application is due to quit.
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- (void) applicationWillTerminate: (UIApplication *) application

{

// update the defaults on quit by calling
// the test bed view controller’s archive method
[self.tbvc performArchive] ;

}

On launch, any data in that file is read in to initialize the text view instance.

Finally, the text view automatically updates its size when the keyboard appears. This
ensures that the keyboard does not hide any part of the text. That’s especially important
when you want to edit the end of a long text entry. By shrinking the text view so it
appears fully above the keyboard, users can access every part of the text.

To make this happen, Recipe 9-9 listens for two standard notifications that are sent
when the keyboard is about to show or hide. The code adds observers that can respond to
the keyboard state and adjust the text view height to match the keyboard presentation.

Recipe 9-9 Adding Undo Support, Persistence, and Autoresizing to Text Views

@interface TestBedViewController : UIViewController <UITextViewDelegate>
NSUndoManager *undoManager;
IBOutlet UITextView *textView;

@property (retain) NSUndoManager *undoManager;

@end

@implementation TestBedViewController
@synthesize undoManager;

- (void) performArchive
{
[[textView text] writeToFile:DATAPATH atomically:YES
encoding:NSUTF8StringEncoding error:nil];

// Reveal a Done button when editing starts
- (void) textViewDidBeginEditing: (UITextView *) aTextView
self.navigationItem.rightBarButtonItem = BARBUTTON (@"Done",
@selector (doneEditing)) ;

// Remove the Done button and dismiss the keyboard
- (void) doneEditing: (id) sender
{
[textView resignFirstResponder] ;
self.navigationItem.rightBarButtonItem = nil;



Recipe: Building a Better Text Editor

// Prepare to resize for keyboard. Courtesy of August Joki
- (void) keyboardWillShow: (NSNotification *)notification
{
NSDictionary *userInfo = [notification userInfo];
CGRect bounds;
[(NSValue *) [userInfo objectForKey:UIKeyboardBoundsUserInfoKey]
getValue: &bounds] ;

// Resize text view

CGRect aFrame = textView.frame;
aFrame.size.height -= bounds.size.height;
textView.frame = aFrame;

// Expand textview on keyboard dismissal.

- (void)keyboardWillHide: (NSNotification *)notification

{
// Resize text view
CGRect aFrame = CGRectMake(0.0f, 0.0f, 320.0f, 416.0f);
textView.frame = aFrame;

- (void) viewDidLoad
{
// Initialize text view
textView.delegate = self;
textView.font = [UIFont systemFontOfSize:16.0f];
textView.text = [NSString stringWithContentsOfFile:DATAPATH] ;

// Prepare undo manager

[[UIApplication sharedApplication]
setApplicationSupportsShakeToEdit:YES] ;

self.undoManager = [[NSUndoManager alloc] init];

[self.undoManager setLevelsOfUndo:99];

[self.undoManager release];

// Listen for keyboard

[[NSNotificationCenter defaultCenter] addObserver:self
selector:@selector (keyboardWwillShow)
name : UIKeyboardWillShowNotification object:nil];

[ [NSNotificationCenter defaultCenter] addObserver:self
selector:@selector (keyboardWwillHide)
name:UIKeyboardWillHideNotification object:nil];
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- (void) dealloc
{
// Clean up
[ [NSNotificationCenter defaultCenter] removeObserver:self];
self.undoManager = nil;
[super dealloc];

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Text Entry Filtering

At times you want to ensure that a user enters only a certain subset of characters. For
example, you might want to create a numeric-only text field that does not handle letters.
Although you can use predicates to test the final entry against a regular expression (the
NSpPredicate class’s MATCH operator supports regex values), for filtered data it’s easier to
check each new character as it’s typed against a legal set.

A UITextField delegate can catch those characters as they are typed and decide
whether to add the character to the active text field. The optional textField:
= shouldChangeCharactersInRange:replacementString: ddﬁga&inﬁﬁhodreﬁuns
either YES, allowing the newly typed character(s) or No, disallowing it or them. In practice,
this works on a character-by-character basis being called after each user keyboard tap.
However, with 3.0s new pasteboard support, the replacement string could theoretically be
longer when text is pasted to a text field.

Recipe 9-10 works by looking for any disallowed characters within the new string.
When it finds them, it rejects the entry leaving the text field unedited. So a paste of mixed
allowed and disallowed text would be rejected entirely.

This recipe considers four scenarios: alphabetic text entry only, numeric, numeric with
an allowed decimal point, and a mix of alphanumeric characters.You can adapt this exam-
ple to any set of legal characters you want.

The third entry type, numbers with a decimal point, uses a little trick to ensure that
only one decimal point gets typed. Once it finds a period character in the associated text
field, it switches the characters it accepts from a set with the period to a set without it.Yes,
you can sneak your way around this using paste, although it’s unlikely that users will resort
to doing so.

Recipe 9-10 Filtering User Text Entry

#define ALPHA @"ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopgrstuvwxyz "
#define NUMBERS @"0123456789"
#define ALPHANUM \
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@"ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopgrstuvwxyz0123456789 "
#define NUMBERSPERIOD @"0123456789."

@implementation TestBedViewController

- (BOOL) textField: (UITextField *)textField
shouldChangeCharactersInRange: (NSRange) range
replacementString: (NSString *)string

NSCharacterSet *cs;

switch (SEGMENT)

{

case 0:
cs = [[NSCharacterSet characterSetWithCharactersInString:
ALPHA] invertedSet];
break;
case 1:
cs = [[NSCharacterSet characterSetWithCharactersInString:
NUMBERS] invertedSet];
break;
case 2:
cs = [[NSCharacterSet characterSetWithCharactersInString:
NUMBERS] invertedSet];
if ([textField.text rangeOfString:@"."].location ==
NSNotFound)
cs = [[NSCharacterSet
characterSetWithCharactersInString:NUMBERSPERIOD]
invertedSet] ;
break;
case 3:
cs = [[NSCharacterSet characterSetWithCharactersInString:
ALPHANUM] invertedSet];
break;
default:
break;
}
NSString *filtered = [[string componentsSeparatedByCharactersInSet:

cs] componentsJoinedByString:@""];
BOOL basicTest = [string isEqualToString:filtered];
return basicTest;

- (void) segmentChanged: (UISegmentedControl *) seg

{

[ (UITextField *) [self.view viewWithTag:101] setText:@""];
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- (void) viewDidLoad
{
// Text field defined in interface builder
[ (UITextField *) [self.view viewWithTag:101] setDelegate:self];

// Add segmented control with entry options

UISegmentedControl *seg = [[UISegmentedControl alloc]
initWithItems: [@"ABC 123 2.3 A2C"
componentsSeparatedByString:@" "]1;

seg.segmentedControlStyle = UISegmentedControlStyleBar;

seg.selectedSegmentIndex = 0;

[seg addTarget:self action:@selector (segmentChanged)
forControlEvents:UIControlEventValueChanged] ;

self.navigationItem.titleView = seg;

[seg releasel;

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Recipe: Adding a Page Indicator Control

The urrPagecontrol class provides a line of dots that indicates which item of a multipage
view is currently displayed. The dots at the bottom of the SpringBoard home page present
an example of this kind of control in action. Sadly, the UIPageControl class is a disap-
pointment in action. The UIPageControl class is awkward to handle, hard to tap, and will
generally annoy your users. So when using it, make sure you add alternative navigation
options so that the page control acts more as an indicator and less as a control.

Figure 9-12 shows a page control with three pages. Taps to the left or right of the
bright-colored current page indicator trigger UIControlEventValueChanged events,
launching whatever method you set as the control’s action.You can query the control for
its new value by calling currentPage and set the available page count by adjusting the
numberOfPages property. SpringBoard limits the number of dots representing pages to
nine, but your application can use a higher number, particularly in landscape mode.

Recipe 9-11 uses a UIScrollview instance to display three pages of images. Users can
scroll through the pictures using swipes, and the page indicator updates to reflect the cur-
rent page shown. Similarly, users can tap on the page control and the scroller animates the
selected page into place. This two-way relationship is built by adding a target-action call-
back to the page control and a delegate callback to the scroller. Each callback updates the
other object, providing a tight coupling between the two.
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_all Carrier = 12:57 PM

Image Scroller

Figure 9-12 The UIPageControl class offers
an interactive indicator for multipage presenta-
tions. Taps to the left or right of the active dot

enable users to select new pages. At least they do

in theory. The page control is hard to tap, requires
excessive user precision, and offers poor response
performance.

Recipe 9-11 Using the UIPageControl Indicator

@implementation TestBedViewController
- (void) pageTurn: (UIPageControl *) aPageControl

{

// Update the scroller to match the page turn
int whichPage = aPageControl.currentPage;

[UIView beginAnimations:nil context:NULL] ;
[UIView setAnimationDuration:0.3f];

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;
sv.contentOffset = CGPointMake (320.0f * whichPage, 0.0f);

[UIView commitAnimations] ;

- (void) scrollvViewDidScroll: (UIScrollView *)

{

aScrollvView
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// Update the page control to match the scroller
CGPoint offset = aScrollView.contentOffset;
pageControl.currentPage = offset.x / 320.0f;

1
- (void) viewDidLoad
{
// Create the scroll view and set its content size and delegate
sv = [[UIScrollView alloc] initWithFrame:
CGRectMake (0.0f, 0.0f, 320.0f, BASEHEIGHT)];
sv.contentSize = CGSizeMake (NPAGES * 320.0f, sv.frame.size.height);
sv.pagingEnabled = YES;
sv.delegate = self;
[sv release];
// Load in all the pages
for (int i = 0; i < NPAGES; i++)
{
NSString *filename = [NSString stringWithFormat:
@"image%d.png", i+1];
UIlmageView *iv = [[UIImageView alloc] initWithImage: [UIImage
imageNamed:filename]];
iv.frame = CGRectMake(i * 320.0f, 0.0f, 320.0f, BASEHEIGHT) ;
[sv addSubview:iv];
[iv release];
}
[self.view addSubview:sv];
// Initialize the page control, which was added in IB
pageControl .numberOfPages = 3;
pageControl.currentPage = 0;
[pageControl addTarget:self action:@selector (pageTurn)
forControlEvents:UIControlEventValueChanged] ;
}
@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.
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Recipe: Creating a Customizable Paged Scroller

Recipe 9-11 introduced a basic paged scroller but didn’t add any dynamic interaction to
the equation. That sample started and ended with three pages. In real life, page controls are
far more useful when you can add and delete pages on the fly. Recipe 9-12 does exactly
that. It adds buttons that build and remove views for the UlScrollView.

This approach uses not two but four separate controls to produce the add-and-remove
interface of Figure 9-13.The four buttons include an add button built using the standard
Contacts Add button style, a delete button that mimics that style, a confirm button that
looks like an “X,” which is built to fit over the delete button, and a full-screen, completely
clear cancel button.

-aill Carrier < 2:39 PM

Super Paged Scroller

Figure 9-13 The + and - buttons let users add
and remove paged views from the scroller. Deletion
requires an extra step as a confirm button ani-
mates into place.

The buttons work like this. So long as there are fewer than eight buttons, the user can tap
Add to create a new view in the UlScrollView. On add, the number of pages for the page
control updates, and the new view scrolls into place. There’s also a check for the current
page count; when that page count hits the maximum, the code disables the add button.The
eight-page limit is arbitrary. You can adjust the code for a larger or smaller number.

Upon tapping Delete, a confirm button animates into place and the invisible cancel
button is enabled, covering the rest of the screen. If the user taps Confirm, the page
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deletes. A tap anywhere else causes the action to cancel, hiding the confirm button with-
out performing a page deletion.

This confirm/cancel approach mirrors Apple’s delete-with-caution policy that’s seen in
table edits and in other user interfaces. It takes two taps to delete a page and the user can
cancel out without penalty. This prevents accidental page deletion and provides a safe exit
route should the user decide not to continue.

Recipe 9-12 Adding and Deleting Pages On the Fly

@implementation TestBedViewController

- (void) pageTurn: (UIPageControl *) aPageControl

{
// Update the page control and animate the new page into place
int whichPage = aPageControl.currentPage;
[UIView beginAnimations:nil context:NULL] ;
[UIView setAnimationDuration:0.3f];
[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;
sv.contentOffset = CGPointMake (320.0f * whichPage, 0.0f);
[UIView commitAnimations];

- (void) scrollviewDidScroll: (UIScrollView *) aScrollView

// Mirror user scrolls on the page control
CGPoint offset = aScrollView.contentOffset;
pageControl.currentPage = offset.x / 320.0f;

- (UIColor *)randomColor

// Return a random color

float red = (64 + (random() % 191)) / 256.0f;

float green = (64 + (random() % 191)) / 256.0f;

float blue = (64 + (random() % 191)) / 256.0f;

return [UIColor colorWithRed:red green:green blue:blue alpha:1.0f];

- (void) addPage

// All new pages are added to the end of the scroll view
pageControl.numberOfPages = pageControl.numberOfPages + 1;
pageControl.currentPage = pageControl.numberOfPages - 1;

// Increase the scroll view size and add the new page
sv.contentSize = CGSizeMake (pageControl.numberOfPages * 320.0f,
BASEHEIGHT) ;
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UlView *aView = [[UIView alloc] initWithFrame:
CGRectMake (pageControl.currentPage * 320.0f, 0.0f, 320.0f,
BASEHEIGHT) ] ;

aView.backgroundColor = [self randomColor];

[sv addSubview:aView] ;

[aView release] ;

(void) requestAdd: (UIButton *) button

// Add the page and update the buttons as needed

[self addPage] ;

addButton.enabled = (pageControl.numberOfPages < 8) ? YES : NO;
deleteButton.enabled = YES;

[self pageTurn:pageControl];

(void) deletePage

// Always delete the currently displayed page
int whichPage = pageControl.currentPage;
pageControl.numberOfPages = pageControl.numberOfPages - 1;

// Remove the view in question
NSMutableArray *properViews = [NSMutableArray array];
for (UIView *view in sv.subviews)
if ([[[view class] description] isEqualToString:@"UIView"] &&
(view.frame.size.width == 320.0f))
[properViews addObject:view] ;

[UIView beginAnimations:nil context:NULL] ;
[UIView setAnimationDuration:0.3f];
[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;

UIView *whichView = [properViews objectAtIndex:whichPage];

// Move other pages into place
for (int i = whichPage + 1; 1 < [properViews count]; i++)
{
UlView *aView = [properViews objectAtIndex:i];
CGRect frame = aView.frame;
frame.origin.x = frame.origin.x - 320.0f;
aView.frame = frame;

[UIView commitAnimations];
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// Remove the page after the animation finishes
[whichView performSelector:@selector (removeFromSuperview)
withObject:nil afterDelay:0.3f];

sv.contentSize = CGSizeMake (sv.contentSize.width - 320.0f,
BASEHEIGHT) ;

// BAnimate the confirm button away and hide cancel
- (void) hideConfirmAndCancel

{

cancelButton.enabled = NO;

[UIView beginAnimations:nil context:NULL] ;

[UIView setAnimationDuration:0.3f];

[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;

confirmButton.center = CGPointMake (deleteButton.center.x + 100.0f,
deleteButton.center.y) ;

[UIView commitAnimations];

// Perform delete on confirm and update the buttons
- (void) confirmDelete: (UIButton *) button
{
[self deletePage];
addButton.enabled = YES;
deleteButton.enabled = (pageControl.numberOfPages > 1) ? YES : NO;
[self pageTurn:pageControl];
[self hideConfirmAndCancell] ;

// On cancel, simply hide confirm and cancel
- (void) cancelDelete: (UIButton *) button

{

[self hideConfirmAndCancel] ;

// Respond to a delete request by showing the confirmation button
- (void) requestDelete: (UIButton *) button
{
// Bring forth the cancel and confirm buttons
[cancelButton. superview bringSubviewToFront:cancelButton] ;
[confirmButton.superview bringSubviewToFront:confirmButton] ;
cancelButton.enabled = YES;

// Animate the confirm button into place
confirmButton.center = CGPointMake (deleteButton.center.x + 100.0f,
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deleteButton.center.y) ;
[UIView beginAnimations:nil context:NULL] ;
[UIView setAnimationDuration:0.3f];
[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut] ;
confirmButton.center = deleteButton.center;
[UIView commitAnimations] ;

- (void) viewDidLoad
{
// Create the scroll view and set its content size and delegate
sv = [[UIScrollview alloc] initWithFrame:CGRectMake (0.0f, 0.0f,
320.0f, BASEHEIGHT)];
sv.contentSize = CGSizeZero;
sv.pagingEnabled = YES;
sv.delegate = self;
[self.view addSubview:sv];
[sv release];

pageControl.numberOfPages = 0;
[pageControl addTarget:self action:@selector (pageTurn)
forControlEvents:UIControlEventValueChanged] ;

// Load in all the pages
for (int i = 0; 1 < INITPAGES; i++) [self addPage];
pageControl.currentPage = 0;

// Move the confirm button off screen
confirmButton.center = CGPointMake (deleteButton.center.x + 100.0f,
deleteButton.center.y) ;

// Set up the target-action pairs for all the buttons
[addButton addTarget:self action:@selector (requestAdd)
forControlEvents:UIControlEventTouchUpInside] ;
[cancelButton addTarget:self action:@selector (cancelDelete)
forControlEvents:UIControlEventTouchUpInside] ;
[deleteButton addTarget:self action:@selector (requestDelete)
forControlEvents:UIControlEventTouchUpInside] ;
[confirmButton addTarget:self action:@selector (confirmDelete)
forControlEvents:UIControlEventTouchUpInside] ;

@end
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Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Building a Toolbar

You can build toolbars in Interface Builder and in Xcode, but when push comes to shove,
it’s often a lot easier in Xcode. That’s because the IB user interface for adding and cus-
tomizing a toolbar’s bar button items is pretty dreadful. You need to keep switching
between palettes and inspectors, and things quickly get messy.

After dragging a toolbar into an IB view, you must add and then customize each bar
button item. Drag in one bar button item for each element you plan to add. Toolbar ele-
ments include both view items like buttons and spacers that lie between those buttons, as
shown in Figure 9-14 (left).

80 7| ¥ Bar Button Item
= Style | Custom
Identifier
ar Item
Title el
Edit
IB Toolbar Image Done
o Cancel
L Save
Undo
Redo
Compose
Xcode Toolbar Reply
Action
Organize
Trash
Bookmarks
Search
Refresh
Stop
Camera
Play
Pause
Rewind
Fast Forward

Figure 9-14  Adding bar button items in Interface Builder can be a
complex process.

Once added, the bar button item attributes inspector (Command-1) shown in Figure 9-14
(right) lets you choose which kind of item each bar button represents. Use the Custom
style to create custom text- and image-based items. Otherwise, pick from the list of
system-defined icons. These include icons for playing media, accessing the camera, editing
a list, and more.
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Building a Toolbar

When using a system item, make sure your application uses that item in a manner that
complies with Apple’s Human Interface Guidelines. App Store reviewers take a dim view
of “creative” icon interpretations.

On a similar note, avoid creating your own buttons that look like any Apple products
or trademarks. Apps have been rejected for using icons that look like the iPhone and
Apple’s logo.

Building Toolbars in Xcode

It’s easy to define and lay out toolbars in Xcode provided that you've supplied yourself
with a few handy macro definitions. The following macros return proper bar button items
for the four available styles of items.

#define BARBUTTON (TITLE, SELECTOR) [[[UIBarButtonItem alloc] initWithTitle:TITLE
wstyle:UIBarButtonItemStylePlain target:self action:SELECTOR] autorelease]

#define IMGBARBUTTON (IMAGE, SELECTOR) [[[UIBarButtonItem alloc]
=initWithImage:IMAGE style:UIBarButtonItemStylePlain target:self action:SELECTOR]
= autorelease]

#define SYSBARBUTTON (ITEM, SELECTOR) [[[UIBarButtonItem alloc]
=initWithBarButtonSystemItem:ITEM target:self action:SELECTOR] autorelease]

#define CUSTOMBARBUTTON (VIEW) [[[UIBarButtonItem alloc] initWithCustomView:VIEW]
=autorelease]

Those styles are text items, image items, system items, and custom view items. Each of these
macros provides an autoreleased UIBarButtonItem that can be placed into a UIToolbar.
Recipe 9-13 demonstrates these macros in action, showing how to add each style including
spacers.You can even add a custom view to your toolbars, as Recipe 9-13 does. It inserts a
UISwitch instance as one of the bar button items, as shown in Figure 9-15.

The fixed space bar button item represents the only instance where you need to move
beyond these handy macros. You must set the item’s width property to define how much
space the item occupies.

Recipe 9-13 Creating Toolbars in Xcode

@implementation TestBedViewController
- (void) action

{

// no action actually happens

- (void) viewDidLoad
{
UlToolbar *tb = [[UIToolbar alloc] initWithFrame:
CGRectMake (0.0f, 0.0f, 320.0f, 44.0f)];
tb.center = CGPointMake (160.0f, 200.0f);
NSMutableArray *tbitems = [NSMutableArray array];
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// Set up the items for the toolbar

[tbitems addObject:BARBUTTON (@"Title", @selector(action))];

[tbitems addObject:SYSBARBUTTON (UIBarButtonSystemItemAdd,
@selector (action))];
[tbitems addObject:IMGBARBUTTON ( [UIImage
imageNamed:@"TBUmbrella.png"], @selector(action))];
[tbitems addObject:CUSTOMBARBUTTON ([ [[UISwitch alloc] init]
autorelease])];

[tbitems addObject:SYSBARBUTTON (UIBarButtonSystemItemFlexibleSpace,
nil)];

[tbitems addObject:IMGBARBUTTON ( [UIImage
imageNamed:@"TBPuzzle.png"], @selector(action))];

// Add fixed 20 pixel width

UIBarButtonItem *bbi = [[[UIBarButtonItem alloc]
initWithBarButtonSystemItem:UIBarButtonSystemItemFixedSpace
target:nil action:nil] autorelease];

bbi.width = 20.0f;

[tbitems addObject:bbi] ;

tb.items = tbitems;
[self.view addSubview:tb];
[tb release];

}

@end

-aill Carrier = 3:44 PM =
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IB Toolbar
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Xcode Toolbar

Figure 9-15 Custom toolbar items can include
views like this switch.
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Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 9 and open the project for this recipe.

Toolbar Tips

When working with toolbars, here are a few tricks of the trade that might come in handy:

» Fixed spaces can have widths—Of all UlBarButtonItems, only
UIBarButtonSystemItemFixedSpace items can be assigned a width. So create the
spacer item, set its width, and only then add it to your items array.

» Use a single flexible space for left or right alignment—Adding a single
UIBarButtonSystemItemFlexibleSpace at the start of an items list right-aligns all
the remaining items. Adding one to the end, left-aligns. Use two, one at the start and
one at the end, to create center alignments.

» Take missing items into account—When hiding bar button items due to con-
text, don’t just use flexible spacing to get rid of the item. Instead, replace the item
with a fixed-width space that matches the item’s original size. That preserves the
layout and leaves all the other icons in the same position both before and after the
item disappears.

One More Thing: Smart Labels

Unfortunately, the built-in UILabel class isn’t very smart when it comes to providing
clickable elements like phone numbers and Web addresses. That’s where the UITextvView
class can step in. Text views offer a new 3.0 property called dataDetectorTypes, which
specifies which data types get converted to clickable URLs. The available types are phone
numbers (UIDataDetectorTypePhoneNumber) and links (UIDataDetectorTypesLink).To
enable all types, choose the all flag (UIDataDetectorTypeall) as used here.

- (void) viewDidLoad

{

UlTextView *tv = (UITextView *) [self.view viewWithTag:101];
tv.dataDetectorTypes = UIDataDetectorTypeAll;

}

You also find individual check boxes for links and phone numbers in the Interface Builder
text view attributes inspector.

When replacing UILabel instances with UITextView instances make sure to disable
scrolling. Set the view’s editable property to NO, either in code or in Interface Builder.
Use carriage return constants (\n) to provide line breaks and carefully consider your text
alignment choices. Figure 9-16 shows a UITextView stepping in and acting like a label
while offering automatic URL creation.
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_aill Carrier = 9:25 AM (=~
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Figure 9-16 This “label” is actually a text view
with its data detectors enabled.

‘When working with embedded URLs be aware that links take users to the requested
resource without any further confirmation. In contrast, telephone numbers require user
confirmation before dialing.

Note

Ever need to work with fonts outside those supplied with Cocoa Touch? A an open source
iPhone project called FontLabel (http://github.com/zynga/FontLabel), developed by iPhone
guru Kevin Ballard, uses the Core Graphics CGFont class to bypass the iPhone’s UIFont
limitations. FontLabel is in active development at the time this book was written, with regular
updates.

Summary

This chapter introduced many ways to interact with and get the most from the controls
in your applications. Before you move on to the next chapter, here are a few thoughts for
you to ponder:

= Just because an item belongs to the UIControl class doesn’t mean you can'’t treat it
like a uzview. Give it subviews, resize it, animate it, move it around the screen, or
tag it for later.


http://github.com/zynga/FontLabel

Summary

Core Graphics and Quartz 2D let you build visual elements as needed. Combine
the comfort of the SDK classes with a little real-time wow to add punch to your
presentation.

If the iPhone SDK hasn’t delivered the control you need, consider adapting an
existing control or building a new control from scratch.

Apple provides top-notch examples of user interface excellence. Consider mimick-
ing their examples when creating new interaction styles like the confirm button
used in this chapter to safeguard a delete action.

Interface Builder doesn’t always provide the best solution for creating interfaces.

‘With toolbars, you may save time in Xcode rather than customizing each element
by hand in IB.
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10

Alerting Users

t times, you need to grab your user’s attention. New messages might arrive or the
system status might change.You might want to tell your user that there’s going to
be a wait before anything more happens—or that the wait is over and it’s time
to come back and pay attention. The iPhone offers many ways to provide that heads-up
to the user: from alerts and progress bars to audio pings. In this chapter, you discover how
to build these indications into your applications and expand your user-alert vocabulary.
You see real-life examples that showcase these classes and discover how to make sure your
user pays attention at the right time.

Talking Directly to Your User Through Alerts

Alerts speak to your user. Members of the UTAlertView and UIActionSheet classes pop
up or scroll in above other views to deliver their messages. These lightweight classes add
two-way dialog to your apps. Alerts visually “speak” to users and can prompt them to
reply.You present your alert onscreen, get user acknowledgment, and then dismiss the
alert to move on with other tasks.

If you think that alerts are nothing more than messages with an attached OK button,
think again. Alert objects provide incredible versatility. With alert sheets, you can actually
build menus, text input, queries, and more. In this chapter’s recipes, you see how to create
a wide range of useful alerts that you can use in your own programs.

Building Simple Alerts

To create alert sheets, allocate a UTAlertview object. Initialize it with a title and a button
array. The title is an NSString, and the button array includes NSStrings, where each string
represents a single button that should be shown.

The method snippet shown here creates and displays the simplest alert scenario. It
shows a message with a single OK button. The alert is autoreleased, avoiding any require-
ments for a delegate and callbacks. When you use non-autorelease alerts, make sure a del-
egate takes responsibility for releasing the alert after a user taps a button.

- (void) showAlert: (NSString *) theMessage
{
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UIAlertView *av = [[[UIAlertView alloc] initWithTitle:@"Title"
message:theMessage delegate:nil
cancelButtonTitle:@"OK" otherButtonTitles:nil] autorelease];
[av show];

}

To add more buttons, introduce them as parameters to otherButtonTitles:. Make sure
you end your list of buttons with nil.This argument takes an arbitrary number of param-
eters. Adding nil tells the method where your list finishes.

The following snippet creates an alert with three buttons (Cancel, Option, and OK).
Since this code does not declare a delegate, there’s no way to recover the alert and deter-
mine which of the three buttons was pushed. The alert displays until a user tap and then it
automatically dismisses without any further effect.

- (void) showAlert: (NSString *) theMessage

{

UIAlertView *av = [[[UIAlertView alloc] initWithTitle:@"Title"
message:theMessage delegate:nil cancelButtonTitle:@"Cancel"
otherButtonTitles: @"Option", @"OK", nil] autorelease];

[av show];

}

‘When working with alerts, space is often at a premium. Adding more than two buttons
causes the alert to display in multiline mode. Figure 10-1 shows a pair of alerts depicting
both two-button (side-by-side display) and three-button (line-by-line display) presenta-
tions. Limit the number of alert buttons you add at any time to no more than three or
four. Fewer buttons work better; one or two is ideal. If you need to use more buttons,
consider using action sheet objects, which are discussed later in this chapter, rather than
alert views.

UIAlertView objects provide no visual “default” button highlights. The only highlight-
ing is for the Cancel button, as you can see in Figure 10-1. As a rule, Cancel buttons
appear at the bottom or left of alerts.

Alert Delegates

Alerts use delegates to recover user choices. Unless you have some compelling reason to
do otherwise, set the delegate to your primary (active) UIViewController object. The
delegate implements the UTAlertViewDelegate protocol. UIAlertView instances require
this delegate support to respond to button taps, at a minimum.

Delegate methods enable you to customize your responses when different buttons are
pressed. As you've already seen, you can omit that delegate support if all you need to do is
show some message with an OK button.

After the user has seen and interacted with your alert, they raise the following delegate
method call: alertview:clickedButtonAtIndex:. This call indicates which button was
pressed with its second argument. Button numbering begins with zero. The Cancel but-
ton, when defined, is always button 0. Even though it appears at the left in some views
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and the bottom at others, its button numbering remains the same. This is not true for
action sheet objects, which are discussed later in this chapter.

Title
Test Alert
Title

Test Alert SpHon

Cancel oK

Cancel

Figure 10-1  Alerts work best with one or two buttons (left). Alerts with
more than two buttons stack the buttons as a list, producing a less elegant
presentation (right).

Here is a simple example of an alert presentation and callback, which prints out the
selected button number to the debugging console:

@interface TestBedViewController : UIViewController <UIAlertViewDelegate>
@end

@implementation TestBedViewController

- (void) alertView: (UIAlertView *) alertView
clickedButtonAtIndex: (int) index

printf("User selected button %d\n", index);
[alertView release];

- (void) showAlert: (NSString *) message
{

UIAlertView *av = [[UIAlertView alloc] initWithTitle:@"Title"
message:message delegate:self cancelButtonTitle:@"Cancel"
otherButtonTitles:@"One", @"Two", @"Three", nil];

av.tag = MAIN_ALERT;
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[av show];

}
@end

‘When working with many alerts at once, tag your objects. Tags help you identify which
alert produced a given callback. Unlike controls that use target-action pairs, all alerts
trigger the same methods. Adding an alert-tag-based switch statement lets you differenti-
ate your responses to each alert.

Note

Notice that this snippet does not use an autorelease alert. The object is released in the
callback.

Displaying the Alert

As you've seen, the show method is used to tell your alert to appear onscreen. When
shown, the alert works in a modal fashion. That is, it dims the screen behind it and blocks
user interaction with your application behind the modal window. This modal interaction
continues until your user acknowledges the alert through a button tap, typically by select-
ing OK or Cancel.

After creating the alert sheet, you may customize the alert by updating its message
property. That’s the optional text that appears below the alert title and above its buttons.
As you see in recipes later in this chapter, you can also change the alert’s frame and add
subviews.

Alert Classes

In early releases of the iPhone firmware, UTActionSheet and UIAlertView were imple-
mented by the same class, UTAlertview. This one class provided both pop-up alert and
menu functionality. Then Apple replaced alert sheets with uIModalview and subclassed
these new objects from that base class.

Later, Apple removed UIModalview, and in new versions of the SDK, UIActionSheet
and UIAlertview are no longer derived from that class. (They both descend from
uIview.) Like their predecessors, they remain siblings in their behavior and use similar
underlying technology to present themselves onscreen.

This history presents an important lesson. Although Apple stands behind its APIs and
published methods, you cannot depend on the underlying classes to remain stable. The
iPhone is a rapidly evolving platform.

Recipe: No-Button Alerts

When you want to display an asynchronous message without involving user interaction,
you can create a UIAlertView instance without buttons.You can build this alert and show
it just as you would a normal buttoned version. No-button alerts provide an excellent way
to throw up a “Please Wait” message, as shown in Figure 10-2.
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Please Wait

Figure 10-2  Removing buttons from an alert lets
you create heads-up displays about ongoing
actions.

No-button alerts present a special challenge because they do not properly call back to a
delegate method. They do not autodismiss, even when tapped. Instead, you must manually
dismiss the alert when you are done displaying it. Call
dismissWithClickedButtonIndex:animated: to do so.

Recipe 10-1 adds a UIActivityIndicator instance below the alert title. This creates
the progress wheel you see at the bottom of the alert in Figure 10-2. This provides visual
feedback to the user that some activity or process is ongoing that prevents user interac-
tion. In Recipe 10-1 that “activity” is simply a three-second wait. In real applications,
you’d use this kind of alert more meaningfully.

Once an alert is created, it works like any other view and you can add subviews and
otherwise update its look. Unfortunately, Interface Builder does not offer alert views in its
library so all customization must be done in code, as shown here. Recipe 10-1 builds the
subview and adds it to the alert after first presenting the alert with show. Showing the alert
allows it to build a real onscreen view that you can modify and customize.

Be aware that alerts display in a separate window. The view is not part of your main
window’s hierarchy. Another thing to note is that removing buttons can create an imbal-
ance in the overall presentation geometry. The space that the buttons normally occupy
does not go away. In Recipe 10-1, that space is used for the activity indicator. When just
using text, adding a carriage return (@"\n") to the start of your message helps balance the
bottom where buttons normally go with the spacing at the top.
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Recipe 10-1 Displaying and Dismissing a No-Button Alert

- (void) performDismiss

{
[baseAlert dismissWithClickedButtonIndex:0 animated:NO];

- (void) action: (UIBarButtonItem *) item
{
baseAlert = [[[UIAlertView alloc] initWithTitle:@"Please Wait"
message:nil delegate:self cancelButtonTitle:nil
otherButtonTitles: nil] autorelease];
[baseAlert show];

// Create and add the activity indicator

UIActivityIndicatorView *aiv = [[UIActivityIndicatorView alloc]
initWithActivityIndicatorStyle:
UIActivityIndicatorViewStyleWhiteLarge];

aiv.center = CGPointMake(baseAlert.bounds.size.width / 2.0f,
baseAlert.bounds.size.height - 40.0f);

[aiv startAnimating];

[baseAlert addSubview:aiv];

[aiv release];

// Auto dismiss after 3 seconds for this example
[self performSelector:@selector (performDismiss) withObject:nil
afterDelay:3.0f];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Creating Modal Alerts with Run Loops

The indirect nature of the alert, namely its delegate callback approach, can produce
unnecessarily complex code. It’s relatively easy to build a custom class that directly returns
a button choice value. Consider the following code. It requests an answer from the alert
shown in Figure 10-3 (left) and then uses the answer that the class method returns.

- (void) confirm: (id) sender

{
NSUInteger answer = [ModalAlert confirm:@"Are you sure?"];
[self showAlert:[NSString stringWithFormat:@"You %@ confirm",
answer ? @"did" : @"did not"]];
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Are you sure? Are you sure?

—
Cancel OK

Yes No

Figure 10-3 These modal alerts return immediate answers because they
are built using their own run loops.

To create an alert that returns an immediate result requires a bit of ingenuity. The
ModalAlert class in Recipe 10-2 introduces a second run loop. It creates the alert as you'd
normally do but after presentation, the code calls CFRunLoopRun ( ). This makes the
method sit and wait until the user finishes interacting with the alert. The method goes no
further as the run loop runs.

It’s up to the custom modal alert delegate class (ModalalertDelegate) to cancel that
run loop on a button click and return the value of the selected item. When the user fin-
ishes interacting, the calling method can finally proceed past the run loop.

This Modalalert class offers two class methods that display the Cancel/OK and
Yes/No styles shown in Figure 10-3.These return either O or 1, or 1 and 0, respectively.
(Cancel and No are the 0-value choices.)

This recipe could easily be generalized for other button counts and titles. When you're
unsure of how many buttons you need to work with, it helps to pass an array to custom
classes. The UIAlertview addButtonWithTitle: method lets you avoid the variadic dec-
laration (that is, the initialization call that uses a series of arguments separated by commas
and that ends with a nil argument) to add buttons from an array, for example:

ModalAlertDelegate *madelegate = [[ModalAlertDelegate alloc]
initWithRunLoop:currentLoop];

UIAlertView *alertView = [[UIAlertView alloc] initWithTitle:question
message:nil delegate:madelegate cancelButtonTitle:cancelTitle
otherButtonTitles:nil];

for (int i = 1; i < buttons.count; i++) [alertView
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addButtonWithTitle:[buttons objectAtIndex:i]];
[alertView show];

Be aware that while you can run one alert after another using this method that sometimes
the calls may crowd each other. Leave enough time for the previous alert to disappear
before presenting the next. Should an alert fail to show onscreen, it’s probably due to this
overlap issue. In such a case, use a delayed selector to call the next alert request. A tenth of
a second offers plenty of time to allow the new alert to show.

Recipe 10-2 Creating Alerts That Return Immediate Results

@interface ModalAlertDelegate : NSObject <UIAlertViewDelegate>
{
CFRunLoopRef currentLoop;
NSUInteger index;
}
@property (readonly) NSUInteger index;
@end

@implementation ModalAlertDelegate
@synthesize index;

// Initialize with the supplied run loop

-(id) initWithRunLoop: (CFRunLoopRef)runLoop

{
if (self = [super init]) currentLoop = runLoop;
return self;

// User pressed button. Retrieve results
-(void) alertView: (UIAlertView*)aView clickedButtonAtIndex: (NSInteger)anIndex
{

index = anIndex;

CFRunLoopStop (currentLoop) ;

}
@end

@implementation ModalAlert
+(NSUInteger) queryWith: (NSString *)question
buttonl: (NSString *)buttonl button2: (NSString *)button2

CFRunLoopRef currentLoop = CFRunLoopGetCurrent();

// Create Alert

ModalAlertDelegate *madelegate = [[ModalAlertDelegate alloc]
initWithRunLoop:currentLoop];

UIAlertView *alertView = [[UIAlertView alloc]
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initWithTitle:question message:nil delegate:madelegate
cancelButtonTitle:buttonl otherButtonTitles:button2, nil];

[alertView show];

// Wait for response
CFRunLoopRun( ) ;

// Retrieve answer

NSUInteger answer = madelegate.index;
[alertView release];

[madelegate release];

return answer;

// Ask a Yes-No question
+ (BOOL) ask: (NSString *) question
{
return ([ModalAlert queryWith:question
buttonl: @"Yes" button2: @"No"] == 0);

// Ask a Cancel-OK question
+ (BOOL) confirm: (NSString *) statement
{
return [ModalAlert queryWith:statement
buttonl: @"Cancel" button2: @"OK"];

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Soliciting Text Input from the User

Alert views provide an especially simple way to prompt your user for text. Instances take
hold of the screen, focusing the user on providing an answer before moving forward with
those results. As with Recipe 10-2, it helps to retrieve an answer directly without having
to deal with delegate callbacks. For example, the following code snippet requests the user’s

name and then uses that string immediately.

-(void) action: (UIBarButtonItem *) item

{

NSString *answer = [ModalAlert ask:@"What is your name?"

withTextPrompt:@"Name"];
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[self showAlert:[NSString stringWithFormat:
@"Nice to meet you, %@.", answer]];

}

To make this happen you can use the same run loop approach and the same Modalalert
and ModalalertDelegate classes from Recipe 10-2 with a few slight alterations.

Recipe 10-3 builds an alert, adds a text field to it, and displays it. Unfortunately, the
normal onscreen alert position precludes using a keyboard with that text field. The key-
board would partially block the alert.You can work around this issue by moving the alert
into place to allow the keyboard to appear beneath it.

This method animates the text field above the space normally occupied by the key-
board so the keyboard will not block it. This approach uses hard-coded values for the alert
center. A better approach would query the keyboard for its bounds to calculate how much
to move.

// Move alert into place to allow keyboard to appear
- (void) moveAlert: (UIAlertView *) alertView

{
CGContextRef context = UIGraphicsGetCurrentContext();
[UIView beginAnimations:nil context:context];
[UIView setAnimationCurve:UIViewAnimationCurveEaseInOut];
[UIView setAnimationDuration:0.25f];
if (![self isLandscape])
alertView.center = CGPointMake(160.0f, 180.0f);
else
alertView.center = CGPointMake(240.0f, 90.0f);
[UIView commitAnimations];
[[alertView viewWithTag:TEXT FIELD TAG] becomeFirstResponder];
}

The preceding code, which is called from Recipe 10-3, animates the alert out of the way
and sets the text field as first responder. Doing so calls out the keyboard, showing both the
alert and keyboard at once, as shown in Figure 10-4.

Note

A console message regarding “wait_fences: failed to receive reply” usually indicates that a
child view is rendered before its parent. You can avoid this message by removing custom
views from an alert in the alertview:clickedButtonAtIndex: method.

Recipe 10-3 Building a Modal Text Query Alert

+(NSString *) textQueryWith: (NSString *)question
prompt: (NSString *)prompt buttonl: (NSString *)buttonl
button2: (NSString *) button2

// Create alert
CFRunLoopRef currentLoop = CFRunLoopGetCurrent();
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ModalAlertDelegate *madelegate = [[ModalAlertDelegate alloc]
initWithRunLoop:currentLoop];
UIAlertView *alertView = [[UIAlertView alloc]

initWithTitle:question message:@"\n" delegate:madelegate
cancelButtonTitle:buttonl otherButtonTitles:button2, nil];

// Build text field

UITextField *tf = [[UITextField alloc]
initWithFrame:CGRectMake(0.0£f, 0.0f, 260.0f, 30.0f)];

tf.borderStyle = UITextBorderStyleRoundedRect;

tf.tag = TEXT_FIELD TAG;

tf.placeholder = prompt;

tf.clearButtonMode = UITextFieldViewModeWhileEditing;

tf.keyboardType = UIKeyboardTypeAlphabet;

tf.keyboardAppearance = UIKeyboardAppearanceAlert;

tf.autocapitalizationType = UITextAutocapitalizationTypeWords;

tf.autocorrectionType = UITextAutocorrectionTypeNo;

tf.contentVerticalAlignment =
UIControlContentVerticalAlignmentCenter;

// Show alert and wait for it to finish displaying
[alertView show];
while (CGRectEqualToRect(alertView.bounds, CGRectZero));

// Find the center for the text field and add it

CGRect bounds = alertView.bounds;

tf.center = CGPointMake(bounds.size.width / 2.0f,
bounds.size.height / 2.0f - 10.0f);

[alertView addSubview:tf];

[tf release];

// Set the field to first responder and move it into place
[madelegate performSelector:@selector(moveAlert)
withObject:alertvView afterDelay: 0.7f];

// Start the run loop
CFRunLoopRun( ) ;

// Retrieve the user choices

NSUInteger index = madelegate.index;

NSString *answer = [[madelegate.text copy] autorelease];

if (index == 0) answer = nil; // assumes cancel in position 0

[alertView release];
[madelegate release];
return answer;
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What is your name?
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Figure 10-4  Using careful space management
and omitting the title and body text, you can add
several text entry fields to a UlAlertView at once.
You probably want to limit your UlAlertViews to one
or two text fields.

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Using Variadic Arguments with Alert Views

Methods that can take a variable number of arguments are called variadic. They are
declared using ellipses after the last parameter. Both NSLog and print£ are variadic.You
can supply them with a format string along with any number of arguments.

Since most alerts center on text, it’s handy to build methods that create alerts using for-
mat strings. Recipe 10-4 creates the say: method that collects the arguments passed to it
and builds a string with them. The string is then passed to an autoreleased alert view, pro-
viding a handy instant display.

The say: method does not parse or otherwise analyze its parameters. Instead, it grabs
the first argument, uses that as the format string, and passes the remaining items to the
NSString initWwithFormat:arguments: method. This builds a string, which is then passed
to a one-button alert view as its title.
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Defining your own utility methods with variadic arguments lets you skip several steps
where you have to build a string with a format and then call a method. With say: you
can combine this into a single call, as follows:

[self say:@"I am so happy to meet you, %@", yourName];

Note

You must import <stdarg.h> to use the variadic argument calls shown in Recipe 10-4.

Recipe 10-4 Using a Variadic Method for UlAlertView Creation

- (void) say: (id)formatstring,...

{

va_list arglist;

va_start(arglist, formatstring);

id statement = [[NSString alloc] initWithFormat:formatstring
arguments:arglist];

va_end(arglist);

UIAlertView *av = [[[UIAlertView alloc] initWithTitle:statement
message:nil delegate:self cancelButtonTitle:@"Okay"
otherButtonTitles:nil] autorelease];

[av show];

[statement release];

}
-(void) action: (UIBarButtonItem *) item
{

NSDateFormatter *formatter = [[[NSDateFormatter alloc] init]
autorelease];

formatter.dateFormat = @"MM/dd/YY HH:mm:ss";

NSString *timestamp = [formatter stringFromDate:[NSDate date]];

[self say:@"At the chime, the time will be %@", timestamp];

}

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Presenting Simple Menus

When it comes to menus, UIActionSheet instances supply the iPhone answer. They slide
choices, basically a list of buttons representing possible actions, onto the screen and wait
for the user to respond. Action sheets are different from pop-ups. Pop-ups stand apart from
the interface and are better used for demanding attention. Menus slide into a view and
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better integrate with ongoing application work. Cocoa Touch supplies two ways to pres-
ent menus:

» showInView—Presenting your sheet in a view is pretty much the ideal way to
use menus and is the method used here. This method slides the menu up from the
exact bottom of the view (see Figure 10-5).

File Management

File Management

Delete File

Email File

Cancel Cancel

Figure 10-5 Use showInView: to create simple menu presentations.
The menu slides in from the bottom of the view. Although the Delete File
menu button appears gray here (left), it is red on your iPhone and indicates
permanent actions with possible negative consequences to your users.
Adding many menu items produces the scrolling list on the right.

» showFromToolBar: and showFromTabBar—When working with toolbars,
tab bars, or any other kinds of bars that provide those horizontally grouped buttons
that you see at the bottom of many applications, these methods align the menu with
the top of the bar and slide it out exactly where it should be.

Recipe 10-5 shows how to initialize and present a simple UTActionSheet instance. Its ini-
tialization method introduces a concept missing from UIAlertview: the destructive but-
ton. Colored in red, a destructive button indicates an action from which there is no
return, such as permanently deleting a file (see Figure 10-5). Its bright red color warns the
user about the choice. Use this option sparingly.

Action sheet values are returned in button order. In the Figure 10-5 example, the
Delete button is number 0 and the Cancel button is number 3. This behavior contradicts
alert view values, where the Cancel button returns 0.



Recipe: Displaying Text in Action Sheets

Scrolling Menus

As a rough rule of thumb, you can fit a maximum of about seven buttons (including Can-
cel) into a portrait orientation and about four buttons into landscape. Going beyond this
number in iPhone OS 3.0 and later triggers the scrolling presentation shown in Figure
10-5 (right). Notice that the Cancel button is presented below the list. Its numbering
remains consistent with shorter menu presentations. The Cancel button is always num-
bered after any previous buttons. As Figure 10-5 demonstrates, this presentation falls low
on the aesthetics scale and should be avoided where possible.

Note

You can use the same second run loop approach shown in Recipe 10-2 to retrieve results
with action sheets as you can with alert views.

Recipe 10-5 Displaying Simple Menus

- (void)actionSheet: (UIActionSheet *)actionSheet
clickedButtonAtIndex: (NSInteger)buttonIndex

{
[actionSheet release];
[self say:@"User Pressed Button %d\n", buttonIndex + 1];
}
-(void) action: (UIBarButtonItem *) item
{

UIActionSheet *menu = [[UIActionSheet alloc] initWithTitle:
@"File Management" delegate:self cancelButtonTitle:@"Cancel"
destructiveButtonTitle:@"Delete File"
otherButtonTitles:@"Rename File", @"Email File", nil];

[menu showInView:self.view];

}

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Displaying Text in Action Sheets

Action sheets offer many of the same text presentation features as alert views, but they do
so with a much bigger canvas. Recipe 10-6 demonstrates how to display a text message
using a UIActionsheet object.This code builds off Recipe 10-4 but adapts that method
to an action sheet presentation.

Recipe 10-6 Presenting Text in Action Sheets

- (void) show: (id)formatstring,...

{
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va_list arglist;

va_start(arglist, formatstring);

id statement = [[NSString alloc] initWithFormat:formatstring
arguments:arglist];

va_end(arglist);

UIActionSheet *actionSheet = [[[UIActionSheet alloc]
initWithTitle:statement delegate:nil cancelButtonTitle:nil
destructiveButtonTitle:nil otherButtonTitles:@"OK", nil]
autorelease];

[actionSheet showInView:self.view];

[statement release];

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you’ve downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

“Please Wait”: Showing Progress to Your User

Waiting is an intrinsic part of the computing experience and will remain so for the fore-
seeable future. It’s your job as a developer to communicate that fact to your users. Cocoa
Touch provides classes that tell your user to wait for a process to complete. These progress
indicators come in two forms: as a spinning wheel that persists for the duration of its pres-
entation and as a bar that fills from left to right as your process moves forward from start
to end. The classes that provide these indications are as follows:

» UIActivityIndicatorView—A progress indicator offers a spinning circle
that tells your user to wait without providing specific information about its degree
of completion. The iPhone activity indicator is small, but its live animation catches
the user’s eye and is best suited for quick disruptions in a normal application.
Recipe 10-1 showed a simple alert that embedded an activity indicator.

» UIProgressView—This view presents a progress bar. The bar provides concrete
feedback as to how much work has been done and how much remains while occu-
pying a relatively small onscreen space. It presents as a thin, horizontal rectangle that
fills itself from left to right as progress takes place. This classic user interface element
works best for long delays, where users want to know to what degree the job has
finished.

Be aware of blocking. Both of these classes must be used on your main thread, as is the
rule with GUI objects. Computationally heavy code can keep views from displaying in
real time. Should you need to display asynchronous feedback, use threading. The edge-
detection discussed in Recipe 7-11 in Chapter 7,“Working with Images,” provides a good
example. It uses a UIActivityIndicatorView on the main thread and performs its com-
putation on a second thread.
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Using UlActivitylndicatorView

UIActivityIndicatorView instances offer lightweight views that display a standard rotat-
ing progress wheel, as shown previously in Figure 10-2.The keyword to keep in mind
when working with these views is small. All activity indicators are tiny and do not look
right when zoomed past their natural size.

The iPhone offers several different styles of the UIActivityIndicatorview class.
UIActivityIndicatorViewStyleWhite and UIActivityIndicatorViewStyleGray are
20x20 pixels in size. The white version looks best against a black background, and the gray
looks best against white. It’s a thin, sharp style.

Take care when choosing whether to use white or gray. An all-white presentation does
not show at all against a white backdrop. Unfortunately, UTActivityIndicatorview
=StyleWhiteLarge is available only for use on dark backgrounds. It provides the largest,
clearest indicator at 37x37 pixels in size.

UIActivityIndicatorView *aiv = [[UIActivityIndicatorView alloc]
initWithActivityIndicatorStyle:
UIActivityIndicatorViewStyleWhitelLarge];

You need not center indicators on the screen. Place them wherever they work best for
you. As a clear-backed view, the indicator blends over whatever backdrop view lies behind
it. The predominant color of that backdrop helps select which style of indicator to use.

For general use, just add the activity indicator as a subview to the window, view, tool-
bar, or navigation bar you want to overlay as shown previously in Recipe 10-1. Allocate
the indicator and initialize it with a frame, preferably centered within whatever parent
view you’re using.

Start the indicator in action by sending startAnimating.To stop, call stopAnimating.
Cocoa Touch takes care of the rest, hiding the view when not in use.

Recipe: Building a UIProgressView

Progress views enable your users to follow task progress as it happens rather than just say-
ing “Please wait.” They present bars that fill from left to right. The bars indicate the degree
to which a task has finished. Progress bars work best for long waits where providing state
feedback enables your users to retain the feel of control.

To create a progress view, allocate it and set its frame. To use the bar, issue
setProgress:. This takes one argument, a floating-point number that ranges between
0.0 (no progress) and 1.0 (finished). Progress view bars come in two styles: basic white or
light gray. The setstyle: method chooses the kind you prefer, either
UIProgressViewStyleDefault or UIProgressViewStyleBar.

Unlike the other kinds of progress indicators, it’s completely up to you to show and
hide the progress bar’s view. There’s no setvisible: method. Adding progress bars to
action sheets simplifies both bringing them onto the screen and dismissing them. Another
advantage is that when alert sheets display, the rest of the screen dims. This forces a modal
presentation as your task progresses. Users cannot interact with the GUI until you dismiss
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the alert. Recipe 10-7 shows a UTActionSheet/UIProgressview sample that produces
the display shown in Figure 10-6. Several line feeds in the action sheet’s title keep the
progress bar from obscuring the title text.

Downloading data. Please Wait
e ]

Figure 10-6 Use UIProgressView instances

to track progress over an extended delay. Adding

them to a UIActionSheet simplifies their pres-
entation and dismissal.

Recipe 10-7 Presenting Progress on an Action Sheet

@interface TestBedViewController : UIViewController <UIActionSheetDelegate>
{
float amountDone;
UIProgressView *progressView;
UIActionSheet *actionSheet;
}
@property (retain) UIActionSheet *actionSheet;
@end

@implementation TestBedViewController
@synthesize actionSheet;

// This callback fakes progress via setProgress:
- (void) incrementBar: (id) timer

{



Recipe: Building Custom Overlays

amountDone += 1.0f;
[progressView setProgress: (amountDone / 20.0)];
if (amountDone > 20.0)

{
[self.actionSheet dismissWithClickedButtonIndex:0
animated:YES];
self.actionSheet = nil;
[timer invalidate];
}

// Load the progress bar onto an action sheet backing
-(void) action: (UIBarButtonItem *) item

{
amountDone = 0.0f;
self.actionSheet = [[[UIActionSheet alloc]
initwWithTitle:@"Downloading data. Please Wait\n\n\n"
delegate:nil cancelButtonTitle:nil destructiveButtonTitle: nil
otherButtonTitles: nil] autorelease];
progressView = [[UIProgressView alloc]
initWithFrame:CGRectMake(0.0f, 40.0f, 220.0f, 90.0f)];
[progressView setProgressViewStyle: UIProgressViewStyleDefault];
[actionSheet addSubview:progressView];
[progressView release];
// Create the demonstration updates
[progressView setProgress: (amountDone = 0.0f)];
[NSTimer scheduledTimerWithTimeInterval: 0.5 target: self
selector:@selector(incrementBar) userInfo: nil repeats: YES];
[actionSheet showInView:self.view];
progressView.center = CGPointMake(actionSheet.center.x,
progressView.center.y);
}
@end

Get This Recipe’s Code
To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or

if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Building Custom Overlays

Although ulalertview and UIActionSheet provide excellent modal progress indicators,
you can also roll your own completely from scratch. Recipe 10-8 uses a simple tinted
UIView overlay with a UTActivityIndicatorView to present the modal “in-progress”
feedback shown in Figure 10-7.
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Activity In Progress

Figure 10-7 Custom views provide handy modal
alerts without using prebuilt Apple classes.

This view was laid out in Interface Builder and connected to a custom class property
called overlay.The view occupies the entire screen size so no simulated screen elements
were enabled. Using the entire screen lets the overlay fit over the navigation bar. That’s
because the overlay view must be added to the application window and not, as you might
think, to the main UIViewController’s view. That view only occupies the space under the
navigation bar, allowing access to any buttons and other control items in the bar.

To restrict any user touches with the screen, the overlay sets its userInteraction
=Enabled property to YES.This catches any touch events, preventing them from reaching
the normal GUI below the alert, creating a modal presentation where interaction cannot
continue until the alert has finished.

This example uses a portrait-only presentation. As the view does not belong to a view
controller, it cannot and will not update itself during iPhone orientation changes. If you
need to work with a landscape/portrait aware system, you can catch that value before
showing the overlay as demonstrated in the upcoming Recipe 10-10.

Recipe 10-8 Presenting and Hiding a Custom Alert Overlay

- (void) finish
{
[ (UIActivityIndicatorView *)[self.overlay viewWithTag:202]
stopAnimating];
[self.overlay removeFromSuperview];



Recipe: Tappable Overlays

}
- (void) action: (id) sender
{
// Add the subview
[self.view.window addSubview:self.overlay];
// Start the activity indicator
[ (UIActivityIndicatorView *)[self.overlay viewWithTag:202]
startAnimating];
// call the finish method, on delay
[self performSelector:@selector(finish) withObject:nil
afterDelay:3.0f];
}

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Tappable Overlays

Use custom overlays to present information as well as to establish modal sequences.
Recipe 10-9 creates a custom class called Tappableoverlay. When tapped, this view
removes itself from the screen. This behavior makes it particularly suitable for showing
information in a way normally reserved for the UTAlertview class.

To use this class, create a view instance in Interface Builder. Add as many subviews and
design elements as needed. Use File > Read Class Files to import the TappableOverlay.h
header file. Then change the view class from UIView to TappableOverlay using the Iden-
tity Inspector (Command-4) and save the project.

To present the view, add it to the window just as Recipe 10-8 did.

- (void) action: (id) sender
{
// Add the overlay
[self.view.window addSubview:self.overlay];

}

No further programming is needed. The view waits for a user tap and when one is
recetved, it removes itself from the window.

Figure 10-8 shows a simple example of this kind of overlay; it displays “Tap to Con-
tinue.” It’s easy to see how you can extend this concept to show any kind of pertinent
information, creating a custom alternative to the UIAlertview class. As with Recipe 10-8,
this example does not use any orientation awareness.
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-all Carrier = 10:21 AM

Tap to Continue

Figure 10-8 This simple overlay dismisses itself
on receiving a user touch.

Recipe 10-9 Building a Custom Dismissible Alert View That Responds to User Taps

@interface TappableOverlay : UIView

@end

@implementation TappableOverlay

- (void)touchesEnded: (NSSet *)touches withEvent:(UIEvent *)event

{
// Remove this view when it is touched
[self removeFromSuperview];

}

@end

Get This Recipe’s Code

To get the code used for this recipe, go to http://github.com/erica/iphone-3.0-cookbook-, or
if you've downloaded the disk image containing all of the sample code from the book, go to
the folder for Chapter 10 and open the project for this recipe.

Recipe: Orientable Scroll-Down Alerts

You can extend the modal concepts introduced in Recipe 10-8 to create a noninteractive
overlay that acts as a backdrop for a scroll-down alert. In Recipe 10-10, that overlay hosts
a view with an embedded button as shown in Figure 10-9.This view is presented and


http://github.com/erica/iphone-3.0-cookbook-

Recipe: Orientable Scroll-Down Alerts

dismissed via a pair of simple UIView animation blocks; the OKAY button triggers the
dismiss: method that scrolls the view offscreen.

-all Carrier = 10:56 AM (=~

Lorem ipsum dolor sit amet,
consectetur adipiscing elit. Sed non
tempus arcu. Aenean rhoncus
consequat nibh eu ullamcorper. Ut
vitae felis arcu, a porttitor metus.
Nam et ante ipsum. Maecenas
sollicitudin justo nec ante interdum
sed facilisis arcu fermentum.

| okay

Figure 10-9 This modally presented message
scrolls down into view and is dismissed by tapping
the OKAY button.

The message view was created in Interface Builder as a standard uiview. It’s added to the
overlay as a subview in the viewbDidLoad method. Rather than adding and removing the
overlay from the main window, as Recipe 10-8 did, this recipe uses the overlay’s alpha
property to hide and show itself.

Unlike the previous two recipes, this recipe does pay attention to screen orientation. It
adapts its size and presentation to matc